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2. Getting Started with WebCenter

Use WebCenter to search for information and manage projects. Anyone can search for information,
but only Project Managers can manage projects. This document includes documentation for the most
common and often-used features, but you will find other features and abilities as you explore the site.

2.1. Opening WebCenter

1. Openyour web browser and navigate to http://yourservername/WebCenter_Inst or the URL that
your system administrator has provided.

Note:
« OnaPC using Microsoft Windows, Microsoft Edge or Mozilla Firefox or Google Chrome
are supported for use with WebCenter.

« 0OnMac 0S X, Safari, Mozilla Firefox and Google Chrome are supported for use with
WebCenter.

2. Once the page loads, enter your user name and password in the appropriate fields and click Log In.

Note:

If your administrator has enabled this, you can click the Forgot Password? link in the Log In
page if you can't remember your password.

Enter your Username or E-Mail address in the pop-up that opens, and click Request New
Password.

You will then receive an e-mail with a temporary password and a link to the Log In page.

After logging in, you will be asked to change your password.

The start page defined by your administrator appears (this is generally your My Work page).

Note: You can later change the contents of your start page.

n
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2.2. Understanding the WebCenter Page Layout

12

Header
The top right of the WebCenter page always shows:

« thename of the current user,

a E icon to go back to the user's start page,

10

a Discussions icon which indicates the unread messages and redirect to My Discussions. You
can view all discussions related to Project or Document or Tasks that you are involved in. For more
details, refer to Discussions in WebCenter on page 288

* theCart ,

-
Avatar@ icon displays the user initials (first letter of first name and last name),or an image, if any
is uploaded in the User page.

« alink to the WebCenter Welcome page,
« Admin (if the user is a member of the Admins group),
- Contact,

« Logout.
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Top Menu Bar

By default, the top menu bar contains the following menus: My Work, Projects, Task Types, Search,
My WebCenter, Create (if you are a Project Manager) and Upload (see The Default WebCenter Menus on
page 14 for more details). An administrator can customize the menus.

@ MyWork Projects~ Task Types+  Search~ MyWebConter~ Create~  Upload _ A &°

If you have the optional Task Management module and the User Can Create Task Type permission,
Task Types also appears in the top menu bar.

Documents Pages

Below is a sample of project's Documents page, in grid layout, for a user who is a Project Manager.

Area1is the project actions area, allowing you to perform actions on the whole project (for example,
mail a link to the project to a reviewer, add the project to your favorite projects...)

Project: Requestoo0 1)l 2
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fgh e
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4 - e—— - 5

« Area2isthe Project Details area, containing the project icon, the name and description of the
project, the project status...

« Area 3 shows links to the project pages. For example, click Members to view the project members.
The page you are on is shown in bold.

« Areas 4 andb are part of the content pane, that changes depending on the project page you are on.
Here, on the Documents page, they show the project folders and documents.

« Area4isthe Folders pane, showing the projects folders. Click a folder to see the documents it
contains.

« Areabisthe document pane, that can show the documents in a list or grid view, with or without
thumbnails.

Notes

- Toact on many documents at once, select their check boxes and then choose an actionin the
Actions menu.

- Toselect all documents in the current folder, select the check box before the Documents header.

13
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« Toswitchto alist layout, click Show as List.

« Hovering over a thumbnail shows a larger version of it in a pop-up window.

For Graphic documents viewable by the WebCenter Viewer, you can click the zoom icon to show

an even larger thumbnail (500 x 500 pixels). This is applied to all Graphic documents on which you
hover until the page is reloaded.

The pop-up window closes when you move the cursor off the thumbnail.

There is usually more than one way to accomplish a task by using a combination of menu entries,
action menus, and clicking status messages. Many methods will lead to the same result.

{ =l Note: This layout is the default layout. However, your layout might be different depending on
== your customization.

2.5. The Default WebCenter Menus

2.3.1. My Work

14

What is displayed?

Your My Work page lists the documents waiting for your approval, as well as the Tasks assigned to you,
ortoagroupyouarein.

Documents that are overdue have red due dates. Documents whose due dates are within the next day
have orange due dates, and documents that have far-off due dates have gray due dates. You can also
view the Discussions and messages in the discussions that you are part of, if you have chosen to view
discussion in My Work page.

- Ifyouhave alonglist of items to attend to, use the filter options in each panel: for example you

can limit the display to items assigned directly to you (Me), to one of the groups you are in (A
Group | AmIn), or both (Me or Group | Am In).

If you are an Approval Master, you can filter the approvals you need to follow up by status (for
example, to only show the approvals still Pending), by due date, etc.

My Work

¥ My Approvals

")---‘:--uvzcm » 2 Tha

\ /B
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Working from My Work page
« Click adocument name to go to the document, or click the project name to go to the project. Note
that the behavior may be different in case you are using a simplified My Work page.
« Toload multiple documents into the Viewer, select their checkboxes and click View and Annotate
in the actions menu.

You may then navigate between the documents by using the controls in the Viewer header.

To approve, reject or comment multiple documents, select their checkboxes, and click :l m or
© (choose a status that applies to all the documents you selected).

In the pop-up that opens, enter your comment (if applicable) and your password (if required by your
server)and click Commit.

= ] Note: For Page List documents, the My Work page also displays the number of pages that have
already been approved, as well as the total number of pages.

Indirectly Assigned Group Tasks

If you are a Group Representative, you will be the preferred assignee when a Role is assigned to this
Group. So the related approvals and tasks appear in your My Approvals or My Tasks sections on My
Work page.

When the Group Representative is absent, any of the Group Members can do the tasks on his or her
behalf. To do this,

1. Go to My Work > My Approvals >/ > My Tasks.
2. Click on the drop down Documents waiting for Approval and select the Me Indirectly option.

When you select this an additional drop down On Behalf Of will be displayed.

3. Select the Representative on whose behalf you are approving the document or doing the task. All
Documents/ Tasks to which he / she is assigned through a Role or on behalf of a Group are loaded
in this page.

You can now do the Approvals from the My Approvals section.

E A ] Note:
Project History will indicate that those Approvals / Tasks were executed on behalf of the
Role that is represented by the Group.

To know more about how to setup your My Work page, readMy Work Setup on page 15

2.3.2. My Work Setup

This is where you can customize your My Work page. To do this, click My Work > Edit My Work Setup.
Select the blocks you want to be displayed and drop it to My Work panel.

15
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My Work # Edit My Work Setup

This text can be translated

¥ Projects Report (Graph) -~ ¥ Discussions
b 4
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-_j Project PCM Demo Project [SOBK] 2014
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hi @
Completed © &b Project PCM Demo Project (SOBK)
SOBK_USER: check for ather user
Delayed o
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w test ]
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W 2ctive B Complefed W Active B Completed E o -g_ # t  Parent Projects Child Projects  Assigned to Assignee's L
W Delayed B Delayed g.
B Starf production B Start production
§ Delete  More...r B 1
Mame 1 Deseription Madified Due Praject

You can also select Show simplified My Work page (with no links to projects or documents) or you can
choose Reset to Default option. To know more about My Work page set up, read Edit the Default My
Work Page

Click Save when you are done.

Admin users can now create Dashboards with My Work context, which are suitable for all users. These
dashboards are visible in the gallery, My Work (custom) category.

You can drag the Dashboards block from the gallery to the My Work Dashboard. You can switch the
selected Dashboard to another Dashboard with the My Work context, in the configuration panel.

2.3.3. Projects

The Projects menu contains the following menu items:

« Favorite Projects on page 17,

16
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+ Projects(shows all projects visible to your user),

« Projects | Am Invited to on page 18,
If you are a Project Manager, you can also see:

« Projects | Manage on page 17,

« Create Project.

Favorite Projects

Favorite Projects shows those projects for which you have clicked Add to Favorites in the project's
Actions menu.

The Favorite Projects' Actions menus contains Remove from Favorites, Add to Cart, and Update
Project(s).

« Filter the list of projects by entering a filter in the Show Projects field, or by changing the value in
the Modified list, and clicking Go.

« Tosortthe list of projects, click the column header of the field on which you want to sort. For
example, click the Created column header to sort on project creation date. This preference is saved
in your profile, so it will become your new default sort option.

« Toview a project, click its name.
» Add to Favorites adds the selected projects to your list of Favorite Projects.

« The Cart lets you download multiple projects or documents at once, and also lets you e-mail links to
projects and documents. The recipients must have user names and passwords for your WebCenter
site in order to view the information when they click a link. The Cart retains its contents only until
you close the browser window or until you log off.

- Update Project(s) checks the version of each visible document in the selected projects and
updates each document to its latest version if needed.

To remove a project from the Favorite Projects list, select it and click Remove from Favorites in the
Actions menu.

Projects | Manage

Projects | Manage shows those projects for which you are the Project Manager, or which are managed
by a group of which you are a member. It only appears in the menu if you are a Project Manager (either
individually or through your group memberships).

In the Actions menu are Delete, Update Project(s), Add to Favorites, Add to Cart and Change
Manager.

« Filter the list of projects by entering a filter in the Show Projects field, or by changing the value in
the Modified list, and clicking Go.

« Tosort thelist of projects, click the column header of the field on which you want to sort. For
example, click the Created column header to sort on project creation date. This preference is saved
in your profile, so it will become your new default sort option.

« Toview a project, click its name.

17
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« Add to Favorites adds the selected projects to your list of Favorite Projects.

« The Cart lets you download multiple projects or documents at once, and also lets you e-mail links to
projects and documents. The recipients must have user names and passwords for your WebCenter
site in order to view the information when they click a link. The Cart retains its contents only until
you close the browser window or until you log off.

« Update Project(s) checks the version of each visible document in the selected projects and
updates each document to its latest version if needed.

Delete deletes the selected projects.

To have somebody else manage one of your projects, select the project, click Change Manager in the
Actions menu, then select the new Project Manager and click Finish.

Projects | Am Invited to
Projects am invited to shows all the projects of which you are an invited member.
In the Actions menu are Add to Favorites, Add to Cart, and Update Project(s).

« Filter the list of projects by entering a filter in the Show Projects field, or by changing the value in
the Modified list, and clicking Go.

« Tosort thelist of projects, click the column header of the field on which you want to sort. For
example, click the Created column header to sort on project creation date. This preference is saved
in your profile, so it will become your new default sort option.

« Toview a project, click its name.
« Add to Favorites adds the selected projects to your list of Favorite Projects.

« The Cart lets you download multiple projects or documents at once, and also lets you e-mail links to
projects and documents. The recipients must have user names and passwords for your WebCenter
site in order to view the information when they click a link. The Cart retains its contents only until
you close the browser window or until you log off.

- Update Project(s) checks the version of each visible document in the selected projects and
updates each document to its latest version if needed.

Task Types

You will only see this menu if you have the Task Management license. See Task Management in
WebCenter on page 293 for more information.

Search

Searching Content in WebCenter
When searching for projects or documents, you can use normal searching or keyword searching.

The normal method searches more fields than keyword searching, but keyword searching may be more
useful when you know less about the desired results.

Both are accessed by clicking Search in the main menu.
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Tip:

Keyword searching is also available in the header of every WebCenter page, at the top right
under Welcome, Contact, Logout... You can search for Projects, Documents or Saved
Searches in this search bar.

il Projects

[1 Documents

= Saved Search

By combining with the OR keyword, you can also search for properties which are empty have a specific
value, EMPTY OR some value.

Normal Searching

1. Inthe Search menu, click Projects, Documents or Tasks and Approvals, depending on what you
want to search.

2. When using normal searching, you see multiple fields to fill in. Click Keyword Search to search on
keywords alone.
To switch from keyword to normal searching, click the More options link.

3. Entersearchtermsin the fields as desired.

Note:

« Tosearch for Documents or Projects based on attributes:

+ click the Attributes link,

- select the Attribute Category,

« specify the values of the Attributes you are searching for,
» andclick Add to return to the Search page.

« Tosearch for Documents or Projects based on characteristics:

« click Characteristics,

« select the desired items in the characteristics tree or Find more characteristics.

You can choose to search on any of or all of the items selected. Click Add to return to
the Search page.

Searching on attributes and characteristics is available only using normal searching.

19
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Tip:

You can search for documents based on their Approval Status: select either a single
approval status or:

- All Approved to select documents with any approved status (Approved, Approved with
comments, Force Approved or Force Approved with comments).

- AllRejected to select documents with any rejected status (Rejected or Force Rejected).

- AllCompleted to select documents with any approved or rejected status.

Tip:

You can search for document revisions. The revision field can be shown in the search
results and can be used to sort the results.

You can search for revisions only if your administrator has set this up for you. Read about
this in Configure Search Crawler Setup.

You can specify the revision you want to search for from the drop down. Select:

- Latest Revision to search the latest revision of the document you are searching for. Only
the latest revision will appear in the results. A document can appear multiple times in
the search results if multiple versions are linked to different projects.

Note:

The search results will show only the document revisions linked to at least one
project. If a version is linked to a project, all the revisions prior to that can be
found in the search.

For example, a document has three revisions (Base- versions 1, 2 and 3; Revision
A- versions 4,5 and 6 and Revision B-version7).

If the revision indexing is not enabled, the search will find only version 7 if this is
the only version linked to a project currently. When revisions are indexed, all the
latest versions of the previous revisions will appear in the search results. The
search will find version 3(Base), 6(A) and 7(B).

- AllRevisions to display all revisions of the document.
« Base Revision to search for the first revision of the document.

- Specific Revision and specify the revision letter in the field.
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Tip:
Searching based on Project Status:

You can specify Project Status as a criteria in Project Search. To do so, select the Project
Status from the drop down. Read more in: Searching based on a Project Status on page
248

To type in a custom value (or to use wild cards /AND/ OR etc.) click the edit I button.

Tip: When you are searching for Tasks based on task specifications:

« click on the link Task Specifications and start typing the name of the specification

« orselect fromthe drop down listing all specifications.

Use the Search Results Options to determine what you want to see in your search results and in what
order.

You can also:

clear all fields: click Clear this form.
save the search query for future use (see To Save a Search on page 30).

Click Search to search using the criteria you entered.

Note: For normal searches, WebCenter searches all the fields available on the Search page.
Each document type in the Search for list has different searchable fields.

The Search Results page shows your results.

You can view your Project search results in a List or a Grid or a Card, and choose to view the
thumbnails or not.

Task and Approval Searches can be viewed only as a List

Document searches can be viewed as Card or List or Grid.
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Search Results Clear this Form Save This Search Save Search Results
Document Name Version Author  §r | & Me Author's Location
Description Modified v

i & v More...» Sort by Reversed Name v

GET SET_BOTTLE_OR.. = o FireWorn_window_clip.. = Expert Box_deke test... =

Management

Version Author:

Keizer, Debbie (DEKE

Author's Location:

Esko/Drupal2

Modified: -

Found: 3 items. Page 1 of 1

When using Card search, you have a catalog like view of your Documents. To view the related

information, click =.

The number of items displayed in Card, List or Grid is set in Preferences.

Note:

It is possible to configure a specific Saved Search to always show up as card view in the
Search Results Layout options.

The Card style Search provides a new way of displaying Document Search results. The new Card
style is more image-centric and allows to hide additional metadata initially.

Note: Search results display only projects or documents for which you have View
==Y permission.

Use Basic and Advanced Search Character

Basic Search

You can type in multiple words separated by spaces when searching and generally these words do not
need to be in a particular order. However, when in Document, Project, Template and Task names or
Attribute related fields, the order of the words is respected.
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Remember:

If there are no search characters (* ?"), basic or advanced, the search adds stars (*) around
every word. The results will show anything that starts, ends or contains the word you are
looking for. Text attributes have an exception that the stars are not added automatically.

For example, if you search for box company, it will return results which include both words but
it could also find boxed instead of box.

The basic search characters *, ?, NOT, OR, AND, EMPTY ," are always available when searching.
Searching with NOT You can use either NOT myvalue or * NOT myvalue*

Search AND /&&, OR/Il, NOT operator priority order

Note: If you have a saved search before WebCenter 20, where you use a combination of AND,
&&, OR, llor NOT without brackets in a single filter, then you might need to add brackets to get
the same behavior as before.

The new operator order is:

1. NOT
2. AND/ multiple parts without operator (implicit AND)
3. OR

Example:

EMPTY OR “esko webcenter” NOT test AND production will become: (EMPTY OR (“esko webcenter” AND
(NOT test) AND production))

In the example, first the part with NOT is executed, then executes everything next to each other
(including AND, words, wildcards and parts surrounded by quotes) and combine those parts with AND.
Lastly both sides of the OR are compared, to return the documents that match any of the two sides.
Add brackets to influence the order of execution.

See other examples below:

box company The search results will contain both box and company in no
specific order. The results may also contain boxed.

If you would like to search for a string with multiple words,
type them with a space in between them. The order is not
important. The search will return results containing both
words.

“box company” If you need the words to be exact (so not sub-strings)and to
be in a particular order, use ™ around the words.

box comp* If you want to only find results for prefix or suffixes, you can
use stars. The search will only look for the substrings for the
words where you added a *.

A search with box comp™* will find "company" and "box" but will
not find "boxed".

com?any Use ? as a placeholder for an unknown character.

The search will not find substrings when you use ?..
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A search with com?any will find "company".
box OR company If you don't need the results to contain all words but want to
find results that contain any of them, use OR (uppercase!).

The example will find results that contain "box" or
"company" (or both).

box AND company Use AND to combine words in the search.
The example will find all results containing both "box" and

‘company".

Note: Thisis the default behaviour when you type in
two words together.

box NOT company Use *NOT to exclude results that contain the term after the
NOT from the results.

For example you want to find all documents containing box
but not company.

EMPTY You can search on the keyword EMPTY which allows you to
search for any documents, projects or tasks where some text
attribute or other text property is not filled in.

For example, to search for projects that are not created
from a template, search with keyword EMPTY on the Project
Template field.

Project Termplate | EMPTY|

By combining with the OR
keyword, you can also search for properties which are empty
or have a specific value.

Advanced Search

If you want to perform a more precise search, enable Use Advanced Search Characters.

Enables strict imerpretation of brackets () and wildeards *.

Mote that OR, AND, NOT, EMPTY, *, 2, ™, &&, ||, (), ~ and \ are always available_

Note:

When using the advanced search characters, the search won't include the sub-strings. If you
would like sub-strings to be included, add *.

(box company) OR (apple raspberry) Use () to group queries. This example search
will find all documents containing box and
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company along with all documents with apple
and raspberry.

company~0.9 Use ~ after a word to find words which might
contain typing errors.

In the example, the search will find all words that
have a 90% match with "company". This will also
find "company” or "copany".

‘company boxes’~3 Combine ™ and ~ to search for words in a
particular order with some flexibility.

The example search will find "company" and
"boxes" in that order with up to 3 other words
between them. It will find “‘company that
produced boxes".

Jean\-Luc or"Jean Luc" If you need to search for a special character,
you can use "™ around it. You could also escape
the special character with the “\" character like:
Jean\-Luc.

box && company && does the same as AND, || does the same as
OR.

When Advanced Search Character option is OFF

When the option Advanced Search Character is not chosen, the search will try to guess whether you
want to use a special search character or not.

For brackets for example, typing: Esko (Belgium) will still search for the text “Esko (Belgium)' (brackets
are interpreted as text).

However, searching for (Esko (Belgium) OR Esko (Spain)) AND WebCenter will consider the first and
last brackets as special characters to group the OR while the other brackets are considered text.

i =l Note: When searching for Attribute values, the strict interpretation of Advanced Search
Characters is always on.

Search Result Options

Use the Search Results Options to determine what you want to see in your search results and in what
order.
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Search for Projects

Fill in one or more fields. Prefer less fields? Try  Keyword Search.

[ Use Advanced Search Characters €% Search Results Options
(] Search Panel Design ~ [J Enable SmartNames € View Cglr:':r" Editable Sort  Order
Project Name 1 O 1 &
Description 2 O
Project Status - T+ | 3 O
Project Calendar O &
Created ~ O ]
Started - O O
Modified - o4 O
Due - i+ |5 O
Completed -« | O % O
Duration | = « +- days O & ]
Timeleft | = ~ +- days O & O
Project Status Started -
Project Status Due -
Project Status Completed -
Project Status Duration d
Project Status Time Left -
Customer/Location O O
Salesperson | & | W O & O O
Project Creator | & | O &+ O
Project Manager | & | #& | i | 6 O
View

Select the information you want to see when viewing the results.

For example, when selecting Description, Created date and Project Manager (the Project Name is
always shown), your results are displayed as below.
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Search Results Save This Search Save Search Results
Maore. ..«
Mame Description Modified Due Date 4 Manager »#
@ Briefing_r May 31,2016
@ Briefing PDCO PCM (01 May 31,2016 May 31,2016 Da Costa, Patrick (PDCO
@ PCM Artw This project contains all the artworks May 17,2016
@ PCM Te This project contains all the artwork templates. May 20, 2016
@ PCM Text Library This project contains all the text content files May 17, 2016 ADMINS <Gr
B '-* PCM Text Templates This project contains all the content documen May 4, 2016 aemen, Karsten (KADA

Found: 7 itemns Page 1of1 H o

Note:

If the Administrator has enabled Editable items, you get an Edit -#| button next to the
selected items in the List View.

You can also show the time in the search results for the Project Due /Modified /Created dates
by enabling Show time in search results.

Column Order

Use the Column Order column to define how to display the information for each Project found: enter
numbers to order the columns (in List View) or the text under the project icon (in Grid View).

Note: The first column is always the Project Name.

Sort

Use the Sort column to define how you want your results sorted. First click the check box of the first
sorting criterion, then the check box of the second, etc. WebCenter shows numbers indicating the
sorting order.

For example, if you want your results to be sorted first by Project Manager then by date created, first
click the Sort check box for Project Manager (this shows a 1beside it), then the Sort check box for
Created (this shows a 2).

Read more about sorting in Sorting Search Results on page 28.

Order

The order column shows the sorting order(1, 2...) but also allows you to sort by ascending or
descending order.
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Ascending order I sorts fromAto Z (for alphabetical fields like Project Name) and from old to
new (for chronological fields like Created).

Descending order } sorts from Z to A (for alphabetical fields) and from new to old (for
chronological fields).

Configuration Options
Display User

To enable the navigation and filtering for specified users in the search results, you can choose to
configure fields like Project Manager, Project Creator, Sales Person, Version Author, Pending
Approver in the Search Results Options. You can choose to show the results either as Name or Avatar
and Name or Avatar only.

Configuration Options

. o % Show assignee details (original Group/Role)
SR 0 op 9 9 g p
Display User

Pending Approvers

Avatar and Name -

Name only
Avatar and Name
Avatar only

Similarly for Task Status, you have an option to show the results as Label only or Icon only or Label and
Icon in the searchresults.

Sorting Search Results

You can sort the search results in the List / Grid view based on sort-enabled search columns.

In the List Layout:

You can click on the primary sort field header I/ | to switch between ascending and descending. All
sortable fields will have the sort icon next to their header text.

To change the primary sort field, click on the sort icon next to it.

Up arrow I in the column header indicates that the results are sorted on this field in ascending

order. To sort the results in the reverse order, click l .

Downarrow | indicates that results are sorted on this field in descending order. To reverse the

order,click I

In the Grid Layout:

If the search results are in the grid layout, you will see a drop down with sortable fields instead of the
sorticons.
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Project Name v

Name
Reversed Name
Reversed Project Name
Description

Reversed Description
Project Manager
Reversed Project Manager
Modified

Reversed Modified

Due Date

Reversed Due Date
Project Status

Reversed Project Status

For example, sorting by Name / Reversed Name will make the name field in the ascending or
descending order.

Note:

The configured sort fields will be applicable in both the grid and list layouts.

You can navigate to the page number you want by typing the page number in the footer. If there
is only one page to show the results, then there is no footer shown.

Keyword Searching

You can use the Search setup page to search based on a vast array of parameters. However, it is also
possible to search using a single Keyword.

Itis also possible to setup a Keyword search in the Search Panel. This is useful when you want to create
Saved Searches with a Keyword field.

» The easiest way to access the search is using the top right menu bar. Enter the terms to search in
this Keyword Search field.

—QV- Tip:
Keyword searching is also available in the header of every WebCenter page, at the top right

under Welcome, Contact, Logout... You can search for Projects, Documents or Saved
Searches in this search bar.

il Projects

[b Documents

= Saved Search

« Alternatively, in the Search menu, click Projects, Documents or Tasks, depending on what you
want to search. From the normal Search page, you can use either:

+ the Keyword Search link.
« orthe Keyword field.
« Click the link Try Keyword Search to get a simplified page.

a) When using keyword searching, you see the Keyword Search field.
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b) Type in your Keyword and click Search.

» For keyword search of projects, WebCenter searches the project name, project description,
project characteristics, the modification date, and text attributes.

» For keyword search of documents, WebCenter searches the document name, document
description, document characteristics, project names, approval status, and text attributes.

c) Click Search to search using the keyword(s) you entered.

» Ifyoud like to use SmartNames in the Keyword field or if you want to create a Search Panel with the
Keyword field, use the Normal Searching page.

The Search Results page shows your results. If you want to save the search, click Save Search As...
Alternatively, you can choose Save Results to Excel to download your search results in excel format.

You can choose your desired view of results by clicking Show as List,Show as Grid, Show Thumbnails
or Hide Thumbnails.

Note: Search results display only projects or documents for which you have View permission.

Advanced Searches

Use the Search menu to search content in WebCenter. You can search for:
« Projects

» Documents including their revisions.

« Tasks

« Reports

You can create Saved Searches based on your chosen search criteria. If you are an administrator, you
can create advanced asset browsers this way. Read in Searching and Browsing Assets on page 32

To Save a Search

1. Inthe Search menu, click Projects, Documents or Tasks, depending on what you want to search.
2. Defineyour search criteria.

For more information, see Search on page 18.

3. Click Save Search As and the search results are downloaded in the excel format.
The Save Search page appears.
Alternatively, you can also Save Results to Excel .

4. Do one of the following:

« To create a new saved search, type a Name for the saved search.
« Toupdate/change an existing saved search, select it from the Your previously saved searches
list.

5. Administrators have to select one of the following Search scope options (other users can only save
personal searches):

« Personal, if only you should be able to see this saved search.
« Global, if all users of the system should be able to see this saved search.
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6. Click Save.
You can read more about working with Saved Searches in Creating Advanced Saved Searches on
page 31.

After editing an existing Saved Search, click Save to update the search and Save As to create a new
Saved Search.

Downloading Search Results
You can download the results of your search as an Excel file (. x1s).

1. Inthe Search Results page, click Save Search Results.

2. Inthe pop-up that opens, choose to Open the resulting Excel file in your spreadsheet application, or
Save it to your hard disk.
When the Save Search Results are generated to save in an Excel, a progress indicator is shown on
the button. This feature is currently not available in Safari Browser.

Creating Advanced Saved Searches

Normal and keyword searches may be saved for future use as a Saved Search and can be plugged into
menu items (of the main menu or Project details menu), My Work and as a document source during
project creation and in document referencing.

To access saved searches, click Search > Saved Searches. Shown below is a sample Saved Searches
page.
Searches can be saved as:

« aPersonal search visible only to the individual user.

« aGlobal search visible to all WebCenter users.

Note:

1. For each Global Saved Search, an Administrator can determine a set of Groups/
Companies/Locations whose members can view this Saved Search.

2. Itis not possible to set Visibility for Personal Saved Searches.

Saved Searches can be configured with advanced Drilldowns and extensive and visually enhanced
Dashboards. You can plug these

« Toexecute a Saved Search, simply click its name from the Saved Searches page. Or select it from
the Search window in the menu bar.

&l Projects

[ Documents

s Saved Search

To edit a saved search, click 4 Edit Search.

To Make Search Personal, click 2
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To Make Search Global, click &
Smart Names . enabled Searches do not have the Make Search Personal option.

To create Global Saved Searches dedicated to a company or group, click Edit Visibility @ link.

In the next window, select the Available Groups, Available Companies/Locations to whom you
want to give the exclusive visibility. In this case, if you assign the visibility to a group, a company or
location, the search will be visible to either the group or the company or both.

Visible to all
® Visible to selected Groups and Companies
Available Groups

Please select or start typing... -

Available Companies/Locations

Please select or start typing... -

All Locations -

E ] Note:

If you select a company without specifying any of its locations, all the company locations
will be able to access the saved search.

If you remove the Available Groups/Companies /Locations, the visibility settings will be
modified.

« To delete saved searches, select them and click Delete. Use Select All and click Delete to delete all
of them.

Running Reports

You can run pre-configured reports from the Search menu if your Admin has given you access to these
reports(see the Administration Guide for more information).

E b ] Note: This only includes system-wide reports. Project reports are available from within the
project.

1. Go to Search > Reports.
2. Click on the desired report name on the Reports page.

3. If thereport requires parameters, the Run Report page appears. Specify the report parameters(the
mandatory parameters are marked by an *)and click Run Now.

Searching and Browsing Assets

The asset browser is a user-friendly feature to search and find assets in a large collection of
WebCenter assets. The administrator can customize the Asset Browser into a Menu for easy access.
You can use the configured Asset Browser to browse for assets stored in the WebCenter.
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Search Results | Show Left and Top (image) Paqe v

Show Left Panel
Show Top (Image) Panel |
Show Left and Top (Image) Panel

- Select criterion —

Current Selection;

¥ Demo_Sheet Brand
> O Enfocus Val
P 1 Esko Value

¥ Demo_Shest Packaging n
> | Display < T o

¥ e N -
» (O Primary Annilh
B O Secondary 5, e, ]
» () Tertiary Demo_Shest

¥ Demo_Shest Product Brand

P O Lubricants

P [0 Speciality Your Cart is empty

In the Asset Browser you can:

1.

2.
3.

4,
5.

v

WebCenter

Clear this Form

@

O

enfocus

Enfocu_s Value

& Compare in Viewer 3 Download

Esko_\falue

Sort by

Name v

(5]

) Eco_Speed_front-wecr....

_| ErrorReduction. pdf =

Select the browsing options in the Asset Browser. You can choose to see the left Panel (the
browsing tree) or the top panel (with images). You can also choose to have both options.

results in addition to the tree selection.

Browse the tree(s) on the left panel to select the items based on the visible attributes.
You can use the options in the Search Panel at the top to refine the Asset Browsing (Searching)

If you opted for the image panel, you can browse through the image representations.
Select the assets from the results to download or view them (by clicking the Actions menu).

You can select the assets and start actions directly from the action list menu if you have all the assets
that you need in one single page. You can download the assets, view them or start a new projects with
the selected assets from action list.

If the Cart is configured in the Asset Browser, you can use it to collect items from several rounds of
searching. You can then download or start with a new project from the Cart.

Tree Browsing in the Asset Browser

You can see an example for tree browsing in Asset Browser below.
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Search Results

Current Selection:

® 5A5_Master Data ~ Design ~ Esko ~ DeskPack
@ SAS_Master Data ~ Design ~ Esko ~ Visualizer
@ sAS_Master Data ~ Design ~ Eske ~ Studio

(@ SAS_Master Data ~ Design ~ Esko ~ Dynamic
Content

¥ S4S_Master Data
[ ]
P [ Alcohol
B

 Automation

» (JCAD
B (JCAM
b ([ Color
¥ (JDesign
¥ [Esko
» @ DeskPack
b (¢|Dynamic Content
» [INeo
»- [Stora Visualizer
P @ studio
» @ Visuzlizer
b [JPantone
» [ X-Rite
» [IFlexo
- []Non Alcohel
B [ Palettisation
CPreflight
B (JPrepress

B

Document Name

Category | "Design’

‘S

Dynamic
Content

Your Cart is empty

O Speed Label Blue (bac. =

X
s
X »
[m}

EMEA

[ Compare in Viewer

O speed Label Blue (bac.

Brand

2 Dow

“Esko’ Approval Status

nload

Found: 4 items,

= Addto Cart || More..

O smilecarton (a).pdf =

Page1of 1

WebCenter

Clear this Form

Sortby | Name M

O smile Carton (a).pdf =

« There are different trees with multiple branches for each of these as well.

« Ifyouwant to select the sub-brands of Esko, select them one by one. In this example, DeskPack,
Dynamic Content, Studio and Visualizer are selected. Note that if you select the main branch, all
the sub-branches will be automatically included.

« Refine other criteria from other trees according to your needs.
« Click on Search to get the assets filtered to your criteria.

Note: If the Search button is not available in your Asset Browser, your results will be
automatically set according to your modified criteria.

You can see your selection on the top left hand side.

Note: You can change the result layout from card layout to grid or list layout by clicking on one
of the buttons at the bottom right.

Graphical Browsing in the Asset Browser

Graphical Browsing is possible when the administrator has configured the Attributes with associated
images. Image browsing is straightforward like tree browsing and an example is given below.
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Search Results Clear this Form
Curtent Selection: TS
¥ SAS Master Data Category Brand Approval Status e
>0
» O Aechol
¥ () Automation \‘
> 0 Enfocus < ‘ g
> (Esko .@. ,"
»Oca0
> Ccam ‘Automation ® ®
¥ () Color Enfocus. Esko
» (Pantone
> Cxate Vour Cartis empty
» (Design
» JFlexo
» (JNon Alcohol o] 3 = & Set Attribute (File Type) || & Set Attibut & set & set <) | More..v
» (Palettisation
» Crefight O Name Project FleType £ Category 2 Brand £ Product £ Market 2 don 4 Approval Status
> Prepress
e _i . Speed Label Blue (back) pdf 50014 - Enfocus - Connect YOU (Twins (Sleeved)) Artwork Automation  Enfocus  ConnectYOU  EMEA Belgium Gent (HQ) ¢
© [, SpeedLabelChill (back) Chilichp 50014 - Enfocus - Connect YOU (Twins (Sleeved) Artwork Setup Approval Cycle
[
© BeM: smieCarton (a)pf 50014 - Enfocus - Connect YOU (Twins (Sizeved) Artwork Aomation  Enfocus  ComnectYOU  EMEA Belgium Gent (k) Setup Approval Cycle

o B Speed Label Blue (back).pdf 50002 - Esko - Studio (Slices) Artwork Design Esko studio EMEA Paris <

o *l . Speed LabelBlue 50004 - Esko - Studio (Four Pacl Artwork Design Esko Studio EMEA Paris ¢

@ [E=..  speedLabelChill back) Chilichp 50002 - Esko - Studio (Slices) Artwork Setup Approval Cycle
o]

O fE=, SpeedLabel Chili (back) Chili.chp 50004 - Esko - Studio (Four Packs (sleeved)) Artwork Setup Approval Cycle
o]

There are three lists (Brand, Packaging and Product)in this example. You have multiple Attributes
under each of these lists. For graphical Asset Browsing, you need images configured for the lists
and Attributes.

Administrator rights are necessary for adding images to Attributes and lists.

To select sub-brands, click on the image representation. This will bring out the images representing
sub-brands on the top image pane. Note that if you select the main branch, all the sub-branches will
be automatically included as search criteria.

Refine other criteria from other lists according to your needs. In this example all Attributes under
Packaging and Product are selected by selecting the list images.

You can use the triangular back ( button to go back one step at a time.
Click on Search to get the assets filtered to your selections.

{ =u| Note: If the Search button is not available in your Asset Browser, your results will be
=% automatically set according to your criteria.

Using the Cart from the Asset Browser

You can use the Cart in the Asset Browser to assemble the assets selected from the Asset Browser.
From the Cart, you can:

start the viewer

download the assets

start a new project with these assets
modify the assets.

You can do several rounds of searching and browsing to add documents one by one to the Cart and then
proceed with the actions listed above.

{ =l Note: The Cart has to be configured by the administrator while determining the settings of the

=== Asset Browser (the Saved Search). Read more in Configuring the Cart in the Asset browser
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Search Results Show Leit and Top (Image) Panel ¥ Clear this Form
Current Selection: =D
¥ Demoshest Brand —Selectciterion—  »
» () Enfocus Val
» 0 Esko Value
¥ Demo.Shest Packaging 0\ b
» O Displ = y
ot < e _ [ esko |
5 s enfocus
- (0 Secondary |io, e, ]
» () Tertiary Demo_Sheet
¥ Demo.Sheet Product 2eead
» [ Lubri s
¥ O Speciality Currently in your Cart + Create Project from Cart. | = R omCort | @ Clear Cart
- @& car:
:‘a Eco_Speed_backwer._ (] _g Eco_Speed_back-wer. [ Final_Collar_Orange_d () [@S Final_Collar_Orange d_. () | | Final_Collar_Pear_dist
ected Sortby | Name

ErrorReduction.pdf = Final_330ml Label Or.. = | Final.330ml Label Pe.. = Final_330ml Lsbel Ra... =

R

--
S |

You can read more about Cart in Using the Cart on page 54

Creating a Project from the Asset Browser

Your Packaging Projects often involve modification of existing packaging or creation of new packaging
with recurring elements. You can use a template for the recurring elements. Asset Browser will help
you to browse for these templates and existing packaging projects. You can start creating a project
directly from the Asset Browser. You can do this by:

« using the Cart to collect items and starting a project using Create Project from Cart link.
« orbyselecting the Create Project from Selected option from action list menu.

This will lead to the WebCenter project creation user interface.

Note: The administrator has to enable project creation this in the Saved Search settings.
“==% Read more in Configure Project Creation from the Asset Browser.

Bulk Editing in Search Results

Fields selected as editable in the Search Results Options page during configuration are available in the
header of the Search Results page. You can also click on the pencil icon next to the field name in the
search results to perform bulk edit.

Note: Only Admin Users or Project Managers can set the fields to Editable for Project
“==% gearches whereas all users can select for Document and Task and Approval Searches. Admin
users can also enable Bulk editing in the Search Results Layout option.

You can select the item(s) for bulk edit in the pop-up or select the pencil icon next to any of the editable
field(s)in the header and choose the change both for the field and the rows.

You can add/remove items in the selection, sort columns or move to a different page of the search
without losing the current selection. While selecting, filtering and sorting, you will see an upto date
preview of the changes done.

Note: Inline editing of individual field is not possible when bulk editing is in progress.

A Warning is displayed, if the edit is not possible due to the permission not available for the user.
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Fields editable in Search Results

Search Results can be edited in Bulk by all the users (based on permissions)in Project or Document or
Tasks and Approval Search results. Only the Admin user can set certain fields like Task Specifications
and Attributes as Editable.

You can edit the following for

« Project Searches: Project Description, Project Status, Project Due date, Project Manager Project
Salesperson, Attributes

« Document Searches: Document Description, Attributes

« Task Searches: Task Description, Task Assignee, Task Due Date, Task Specifications, Task
Estimated Date, Task Status

Note: Tasks that require password for completion cannot be done in bulk editing.

4 2 change Assignee g% Change Due Date i Change Task Estimated

Set "Assigned to” for 2 selected itern(s)

~ - . F‘.HD‘.'!’.‘: itern(s) cannot be edited and isfar
=3 BLSA_approver (BLSA_APPROVER)

| LT Status Started Due # | Assignedte #

#bala_1 E Apr 23, 2020 at 11:14  Apr 23, 2020 at 11:30 .Q..'I h, Bala (BLSA)
Apr 30, 2020 at 1817 Apr 30, 2020 at 18117 = BLSA_Approver (BLSA_APPROVER

mfn_task_speciication_check ILd  Apr30, 2020 at 18:36  Apr 20, 2020 at 18:36 N\ BLSA_Approver (BLSA_APPROVER

[,
e e B
El
&3

I —=moo=zos .:. ————————hilzg---- : Aug 27, 2020 at 152

[
o

Aug 27, 200 gt 16200 . Sathish, Bala (BLSA)

An example of re-assigning tasks in bulk is shown in the image above. You can select some tasks and
bulk change the assignee. For the tasks you selected, changes are shown immediately and warning
message is displayed when changes are not done.

Bulk Operations in Saved Search

Updating Attribute Category, Project Member or Project Permissions in Bulk

You can change the Project Attribute Category of multiple projects from Project Search results in one
go. Also, you can add Project Members to multiple projects and set their permissions.

1. Goto Search> Saved Searches. Select one or more projects from the Saved Search Results.
2. Select the Projects for which you want to change the Project Parameters.
3. Use the buttons Change Attribute Category or Manage Members/Permissions in the table header.
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« Tochange the Attribute Category, pick an attribute category from the list.

« Toadd a Project Member, first choose whether you want to add a User, Group or Role. After
that, select a user, group or role from the list, or start typing to find the one you want. Once you
have selected your desired new project member you can immediately modify the new member's
project permissions.

You can specify Custom folder permissions for inviting Project Members in the bulk operation.
Use Add folder link to add a new line. Specify a set of permissions for the folder by typing in
the folder name inside the provided edit field. Only the specified folders' permissions will be
changed. Permissions on folders that do not exist in a given Project will be skipped

You can take out the Root permissions from the list. If no Root is in this list but the member is
new to the project, he will only get view rights on the Root.

E ) ] Note: The selected User, Group or Role will be invited if it is not yet present in the
Project.

4. Click Start and wait for the action to complete. You will be notified of any issues regarding the
operation.

5. Click Close to close the dialog. Your search results will automatically update.

Updating Role Members in Bulk

1. Goto Search> Saved Searches. Select one or more projects from the Saved Search Results.
2. Select the Projects for which you want to change the Project Parameters.
3. Click the pencil icon for the Role you want. Or select the desired bulk action from the table header.

Due Date -*| Manager -# TEMA_DESIGN |-#

Assign Project Role Member dialog will open.
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Assign Project Role Member

Role Group User [ Assignee Invite Group Actions

DESIGNER |DESIGNER HADW GROUP | [michalik, jakub (3am1) - =]
DESIGNER GENT ¥ | |«eizer, Debbie (DEKE) - ” o®

®

Add member(s) to role.
Replace member(s) of role.

Start | Close

bulk_operations_test_0001
bulk_operations_test_0002
bulk_operations_test_0003

bulk_operations_test_0004

4. In this window, you can Add members to role or Replace members of role.
5. Change the value of the desired parameter:

a) SelectaUser and/or Group to assign to the role.
b) You may add multiple assignments using the actions buttons.
c) Select whether to add the members to the group and replace the members.

If the members are replaced, all blocking tasks and approvals will be moved to the first of the
new members.

6. Click Start and wait for the action to complete.
The dialog will indicate which projects were successfully modified. It will also list all of the
problems.

7. Click Close to update your search results.

Searching on Documents

Search by Document Size
Users can search for documents which are of a certain size range using Version Size.

Version size will only show the size of the version of the document shown in the results. The size of the
previous version of the document is not shown.

The Version Size criterion is available for all document types. You can search, sort and facet on the size
of the document version (in bytes).

Search by Document Created Date

You can search the documents based on the creation date in arange or in the specified previous
number of days and make it hidden or visible or available in the results.

Folder Search

You can search for the folders and it is described in detail here.

Live Text in Document

You can search for a text within a PDF, Al or Structured Content document using Live Text in
Document. This field is available for search, based on the setting in the Search Crawler configuration
set by the Admin user.
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Note: Searching for Live Text in Structured Content documents requires the Structured
Content license.

Note: Searching for Live Text will not produce results if the text is present within an image or
outlined text.

When the search results are shown as a Focus layout with a viewer block, the matches for the searched
text are highlighted in the document. You can navigate through the matches to see where the searched
text occurs. The number of instances of the text occurring in the document are shown in the header.

Note: This field does not support right to left text used in languages like Hebrew, Arabic.

Live Text in Document | tropical

[0 GET SET - Bottle Label - Coconut&Berry.ai 1ofgl < >

Text matches: 1/2 - '@ @ @

ENERGY DRINK

TROPICAL BLEND

You can navigate through the matches to see where the searched text occurs.
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S'Eﬂl'l:h REELIH:S Save Search As... Save Results to Excel
3]
[0 01_Green_Hanger_MP.pdf sof714 | < >

Text matches: 1/11 % la /2 Pages

1. Navigate through the text matches within the document
2. Navigate through the pages within the same document
3. Navigate to the next document in the search results

The number of instances of the text occurring in the document are shown in the header. When multiple
pages contain a match for the searched text, it is indicated with an asterisk and navigating through the
matches will also navigate through the different pages. By hovering over an arrow, you can also see the
number of pages containing a match.

Search for Live Text in Document only works on left to right text. For example, text in Arabic or Hebrew
are not supported yet.

Searching for Text Content Document

Search and Select Text Content in Search Menu
To search for Text Content, go to Search > Documents > Search for > Text Content.
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Search for Documents

Fill in one or more fields. Prefer less fields? Try Keyword Search.

Search for: | Text Content v|

[J Use Advanced Search Characters €

[ Search Panel Design (] Enable SmartNames €

TEXT CONTENT INFORMATION

Element Type -
Document Status -
Statement
Language  Danish -
Translation -
Text TR 3
Modified -~ | -+
Document Name
yesterday

before today
Version Author = & | ¢ | this week

last weelk
Author's Location this month
last month
this year
Description last year

maore options...

You can search based on the Text Content Criteria such as:
« Element Type: To search for adocument based on its Element Type, select it in this field. Smart
Names are available when Enable SmartNames is selected. Read more in: Element Types.

» Document Status: To search documents based on its status, select the status (Draft / Signed Off)
from the drop-down.

« Statements' criteria: These fields allow you to select and search based on:
« Language of the Text Element. For example, select English - United Statestosearch
for Master statements in English (US).
«  Whether the Element is a Translation or Master. It can be specified in the Translation drop-
down.

« Thedirectionality of the text will be based on the language selected. You can search both
Master and Translation languages for right to left languages like Arabic or Hebrew.
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Note: You can also leave these fields blank. If the language field is blank, all languages
2= (both Master and Translated)are searched for.

Actual Text from statements: Type the word you want to search in the Text field.

Text Element Status: Click ... and select the status from the drop- down. For example, you can
search for Signed-off statements with a particular text piece.

Modified: Specify the time line you wish to search for like today, yesterday or last month etc .
A combination of Text Statements' criteria

You can add new rows for additional search criteria by clicking +. When you have multiple rows,

you can use either AND or OR operation to refine the Search.

You can also ignore the search criteria mentioned and only display the results by choosing ™"
icon or you can choose the Any option to show results of text documents in any of the status.

Language | English-Ir Translation | Master - wW

Text  Mutrients e m

Language French - Frar - r
i = x
Teut Draft .
¢, Pending Signoff
w  Signed Off
. ¥ Signott Reject
* 2

In the example screen shot, the Search will find all Master Statements with Nutrientsinits
content AND with French- France as Translation.

Configuring Text Content Documents Search Results

The Search Results page shows all Text Content Documents that match the specified criteria. Each
statement row selected to View is represented as a single column in the Results.

Search Results Save This Search  Save Search Resulls
L
Hame | Descripiion  Project Elemant Typs Decumseni Status  Master: English - Uniied Staies Vergbon fusihor
L] - 1 . WITH 26
C o : gy deketosl  Contem UTRIENTS
1 clakn HUTRIENTS
L Iy - kan . WITH 24
Consey Briefing_KADA  Content IUTRIENT: v [ACEH
anm claimwes Test (01) elaim HUTRIENTS Comaray, Andany (AGON)
L} Content . _— FOWITH 24
. | Cpals B Centent HUTRIENTS wray, Antany (ACGON)
5 clatm
] o WITH 24
Content C Taer e Confent ITRIEHTS o ey (AR
« claim w HUTRIENTS iy, ¥ CACORN]
Page 1 of 1 (m] a3
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(7, l Note: You can save Text Document Searches in Excel. The document statuses are not included
in the Excel export.

Search Results Options
To customize the Search Results, select your criteria in the Search Result Options fields. The

Document Nameis selected by default but can also be removed by unchecking the box. Read in:Search
Result Options on page 25.

Search Panel Design
As an Admin, you can setup a Text Content Search with a Design Panel just like other document saved

searches. The users can select individual text statement criteria in the Panel to filter the search
results.

(f Note: When smartname is selected for the language field, to view each resolved language in a
separate column in the Search Results page, select the view as visible.

Search Results

Document Name. Document Status . Element Type

B Note:

- If no Statement language is selected from the language drop down, you will not be able to
view it as a separate column. The results will then match Text statements of any language.

. If the language chosen for the text has the directionality right to left or a custom font, then
the text is also rendered right to left or in the custom font in the search results.

Saved Search for Text Content Search

Text Document Searches

To view My Saved Searches, go to Search > Saved Searches, you can view the saved search in the table
under Text Document Searches. Saved Search for Text Content Document behaves exactly like any

other document saved in the WebCenter.

(f l Note: Only an Admin can modify the visibility of a Global Search.

Searching for Structured Content Segments

Search and Select Segments

To search for Segments, go to Search > Documents > Search for > Structured Content > Content
Type > Segments.
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The Content Type filter allows you to filter results as follows:

» Structured Content: filters the results to include Structured Content documents such as ditamap
and dita documents.

« Text Content: filters the results to include PCM documents.
« Segments: filters the results to include Segment documents.

The Language Code filter accepts one or multiple language codes. This filter will limit the results to
content which contains one of the specified language codes.

The Text In Document filter allows you to enter a string that will be used to search the actual content of
adocument. If any hits are found within the document content that Document will be returned.

Search for Documents

Fill in one or more fields. Prefer less fields? Try Keyword Search.

Search for: [ Structured Content v

() Use Advanced Search Characters

(J Search Panel Design (] Enable SmartNames Fo View

STRUCTURED CONTENT INFORMATION

Content Type = Segment X - O

Content Language Code O
Segment

Textin Document ) g1\ c1ured Content

(O Text Content

Search Strings Examples

Shown below are different search phrases and their results. For more extensive help on searching,

click % Help in the Search page.

Sample search string Results What it does not find

box box products bottle holders
box company

box co. inc.

bo* box products

box company

box co. inc.
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Sample search string

Results

What it does not find

bottle holders

box NOT “box company”

box products

box co. inc.

box company

bottle holders

box AND company

box company

box co. inc.
box products

bottle holders

“box company” OR “box co.”

box company

box co. inc.

box products

bottle holders

box AND (products OR company)

box company

box products

box co. inc.

bottle holders

*NOT *company*

box products

box co. inc.

box company

2.3.6. My WebCenter

46

The My WebCenter menu contains items specifically related to your user.

My Profile

My Profile is where you set your name, your e-mail address, your phone numbers, your function, picture

and your company/location.

User Avatar

You can choose to upload your picture or select one of your previously uploaded picture as an Avatar
which is reflected in all places in WebCenter like Dashboards, Discussions My Work and so on.

{ = ] Note: Your Administrator can also change your picture.

My Password

The Password field is where you change your password. Enter the new password in the Password and
Confirm Password fields and click Change. To set a blank password, enter nothing in the fields and

click Change.

{ = ] Note: This presents a security risk and is therefore not recommended.

If the Passwords must meet complexity requirements option is enabled by the Admin user, then your

WebCenter password:

» May not contain the user's username, first name, or last name
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« Must be at least "X" characters, where the minimum password length "X" is defined by your Admin
user.
« Must contain characters from three of the following four categories:

- English uppercase characters (A through Z)

« English lowercase characters (a through z)

« Base 10 digits (0 through 9)

« Non-alphanumeric characters (for example: ! S # %)

« Must be different from the previous " Number" password(s), where the number of previous
passwords is defined by your Admin user.

If the option is not enabled, then the only requirement is that the new password is not blank and not the
same as the previous password.

Single Sign-0On Settings

You can view the Single Sign On settings specific to your User account in the My WebCenter > My
Password page. This page will display the Single Sign On Instances that are enabled for your User
account.

You may modify configuration details of the Single Sign On Instance depending on your permissions to
do so. If you have permission to modify, all your values will be saved.

{ ' Note: User specific settings are possible when the Single Sign On Instance supports user

' specific configuration.

My Preferences

In My Preferences you set the unit system used to display data, the language used, the display of
thumbnails, your start page, and the grid size for search results (for Esko ArtiosCAD and Graphics
documents) and discussions.

General

« Language sets the language used by the user interface.

« Start Page sets the page that appears when you log on. You can, for example, select a Saved Search
with a visual Dashboard as the starting page.

« Units sets units for all measurements to either Metric (mm, cm, dm, m) or Imperial(in, ft, yd).
«  Thumbnails: selecting Show thumbnails shows thumbnails in document lists by default.

« Cart: Clear Cart on Logout is always enabled by default. Disable this option if you want to access
Cart contents in future sessions.

+ Your Browser Timezone shows the timezone used by your browser and WebCenter.

Project Lists

» Show ... Rows sets the number of projects displayed in the List layout.

Document Lists

- Default Layout sets the default view for document lists: Grid or List or Card layout.

« Show in Grid sets the number of documents displayed on a single page in the Grid layout (defined as
a number of Columns and Rows in the grid).

+ Show in List sets the number of documents displayed on a single page in the List layout (defined as
anumber of Rows in the list).
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Search Results- All

Show in List sets the number of documents displayed on a single page in the Search results List layout
(defined as a number of Rows in the list).

Search Results- Documents

- Default Layout sets the default view for document Search results pages to Grid, List or Cards
layout.

« Show in Grid sets the number of documents displayed on a single page in the Search Results Grid
layout (defined as a number of Columns and Rows in the grid).

« Show Cardssets the number of the documents displayed in Card View on a single page in the
Search Results.

Search Results- Projects

- Default Layout sets the default view for project Search results pages to Grid or List layout.
« Show in Grid sets the number of projects displayed on a single page in the Search results Grid
layout (defined as a number of Columns and Rows in the grid).

Discussions

- Discussions per Page sets the number of discussion threads displayed per page on the
Discussions pages.
« Postings per Page sets the number of discussion posts displayed per page on a Discussions page.

Viewer

- Viewer Workspace: Select any workspace from the dropdown or Create new Workspace by
selecting the option. Select the gear icon to open the Workspace Configuration pop-up window and
view the options available in workspace selected or to edit the configuration in the workspace.

You can choose to add or delete any tool or widget to the workspace or altogether delete the
workspace itself.

« Unregistered User Viewer Workspace: A workspace is configured specifically for unregistered
users who access WebCenter Viewer, when they are shared with a document to view or to approve.
Other workspaces or tools/ widgets are not visible apart from the workspace configured by the
Admin User. Admin user can also create a new workspace specifically for this purpose.

- Annotation Color sets the color in which annotations will be displayed in the Viewer (you can set
Viewer Default or choose a color from the list).

« Annotate Approved Documents sets if and how the users are allowed to annotate documents that
are already approved.

« Select Enabled if you want the users to be allowed to annotate approved documents.

« Select Warn if Approved if you want to display a warning before allowing the users to annotate
approved documents.

» Select Read-Only if Approved if you don't want the users to be allowed to annotate approved
documents.

- Select Warn if Approved or Rejected if you want to display a warning before allowing the users
to annotate approved or rejected documents.

« Select Read-Only if Approved or Rejected if you do not want the users to be allowed to annotate
approved or rejected documents.
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Annotate Documents under Approval sets who can add annotations in the documents under
approval.

Note: A document version is considered under approval as soon as an approval cycle is
started

Choose from the following settings:

« AllUsers: This is the default setting. All users with view access to a document can annotate that
document once the approval cycle has started.

« All Approvers and Approval Master: The Approvers and Approval master defined in the
document approval setup (all stages) for the current version can annotate during the approval
cycle.

- All Approvers: All approvers defined in the document approval setup (all stages) can annotate
the document while it is being approved.

- Pending Approvers and Approval Master: Only an approval master or approvers who can submit
an approval state (Approve or Reject) for the current version can annotate the document during
the approval cycle.

« Pending Approvers Only: Only approvers who can submit an approval state (Approve or Reject)
for the current version can annotate the document during the approval cycle.

Specify the Viewing Quality as:

- Best Performance (Default): In this mode, the Viewer uses less compression to transfer images.
These images are transferred faster but may contain small compression artifacts.

« Best Quality: In this mode, the Viewer uses less compression to transfer images. It takes longer
to transfer these images. However, you can view them without compression artifacts.

Settings for Automated Artwork

Note: The below options are visible only when Automated Artwork license is enabled.

- Task Type for Bulk Text Replace: Choose from the list of task types shown. The selected task
type is used in the Files marked for Edit widget when editing Artworks in the Viewer.

« Text Replace Library: Choose from the list of Text Document Saved Searches shown. The
selected Saved Search is used in the Action List Widget. Read more about it here.

Note: This option requires Packaging Content Management License.

« PCM Attribute for linking Text Statements: Choose from the list of document reference
attributes shown. The selected document reference attribute is used to attach text content
documents (such as .wcc) when saving a graphic file modified with Action Lists in the viewer.

Note: This option requires the Packaging Content Management License.

Log out user when inactive Select this option, to log out the users whose sessions are not active
for a period of time. Option is given to log in again and continue when the user returns to the viewer.

Stream video through WebCenter proxy Enable this option to open video files located in Asset
management system in the HTML5 viewer.
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« Show Discussions in Viewer Enable this option to view discussions widget in the viewer and view all
the discussion posts about the document viewed.

Note: Project Managers who can Force Approve or Force Reject is not considered an approver.
They can add annotations only if the setting is All Users.

ArtiosCAD

To open your document in the ArtiosCAD desktop application directly from the WebCenter server, you
need to set the ArtiosCAD Preferences accordingly.

Open ArtiosCAD Documents

« No Application: This is the default Preference. When this is selected, you cannot open the
documents in the ArtiosCAD desktop applications.

« ArtiosCAD Standard Edition: Select this setting to be able to download ArtiosCAD documents and
open them in your ArtiosCAD desktop application.

« ArtiosCAD Enterprise Edition: Select this to open your ArtiosCAD documents in the installed
ArtiosCAD Enterprise Edition directly from WebCenter.

The documents will open in the managed mode allowing you to make modifications to the file and
update it without having to browse to the corresponding project and folder.

Note: This optionis only supported from ArtiosCAD Enterprise 14 onwards.

Document Upload Preferences

« Allow raising Document Revision when uploading a new Document Version: Enable this to allow
the users to raise the revision while uploading a new document version.

« Allow Instant uploading when selecting documents: X Choose this option to start uploading
documents immediately when they are selected, while the rest of the page is still being filled in or
other documents are still being selected.

Workflow Editor
By default, HTML5 is used as Workflow editor.

User Creation

To create a new approval User from an approval page quickly, you can select and apply a particular
user's settings as the Approval User Template.

Tip: If you do not want to take up alicense for a Template User, deactivate the user by
unchecking the Active User option in the Profile page.

It is possible to configure this at two levels.

« To specify a global template, go to Admin > Preferences > General > User Creation Preferences.
Select a particular user existing in the system as your Approval User Template.

This template will be set as the system wide approval user template. However, it is possible to
override this in My WebCenter > My Preferences > User Creation Preferences.
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« To specify atemplate for a User who can create other users, go to My Preferences > User Creation
Preferences and specify an Approval User Template. You have the following options and your
choice will override the admin settings:

+ Do No Use a Template

« Use Global Approval User Template to apply the user template specified in the Admin
Preferences.

Note: If you have not explicitly selected the Do not Use a Template option or has any
other user specified as the template, the global template will be applied by default.

« You can select a particular user as your template. In the drop-down you will see your own Users if
you are a Project Manager and all Users if you are an administrator.

The following Preferences and settings of the template are copied to the newly created user:
1. Preferences:

- Language

+ Units

. Start Page

« User Menu

« My Work Setup

» Viewer Preferences

+ Collada Viewer Preferences

» Workflow Editor Preferences

« Document Upload Preferences

+ ArtiosCAD Preferences

- Download Formats(copied only if the user creating the new user is an Administrator)
« Group Memberships(copied only if the user creating the new user is an Administrator)

« Other Preferences are the user preferences not mentioned above (for example: show
thumbnails or not, search results layout, etc.).
2. The Authentication Settings(Deactivation, SSO, etc.)

My Locked Documents

My Locked Documents shows documents you have locked to indicate that you are currently working on
them. If other users try to download a locked document, they will have to confirm that they really want
to download a locked document.

Note: In order to lock a document you need specific permissions.
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Only the person who locked it, or the Project Manager, or a member of the Admins group can unlock a
locked document.

To unlock a locked document, select the checkbox to the left of its name and click Unlock. The
function Upload New Version of the document also unlocks the document.

My Locked Documents

Project

Locked Date

52

E ] Note:

Unlocking a document without uploading a new version does not make any changes to the document.
In order to change it, you must lock it, download it, change it as desired, and upload it as a new version.

My Users

In case you are a project manager with Create User rights, you can see the users that you have created
on the My Users page.

My Group's Tasks

In case you are the Group Task Manager for one or more groups, you can find the tasks assigned to your
group(s)on My Group's Tasks page.

My Group's Members

If you are a Group Manager of a specific Group (or multiple Groups), you can use My Group's Members to
manage your Group members.

= ] Note: The administrator has to give you the Group Manager permission to access the Group
E members.

« If you are the Group Manager for more than one group, specify the group by the Group Name. This
will allow you to see the members of the selected group.

« From this page, you can:
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Manage Group Members

Group Name  NAPR_CAPF_GROUPZ

Notification settings

Group E-mail Address *

Group E-mail Language

Usermname Last Name First Mame Company, Location

NAPR

MAPR

«  Remove User(s) from the members of the group.

E b ] Note: The group manager cannot remove himself / herself from the list.

Remember: If there are dependencies such as a pending approval associated with
the member being removed, the removal will not be effective. You will be warned about
those dependencies during your attempt to remove a member.

« Add Users to the group. Your permissions and visibility determine the potential users whom you
can add as the group members.

Ifyouarea:

+ Project Manager, your Visibility settings affect whom you can add as members.
» Normal User, you can add the Users associated with the same Company..
- Select from Notifications settings to Send notifications to a Group e-mail Address. You can set

the Group E-mail address and the language to be used in the group Group E-mail Language by
selecting from the drop-down menu. All notification mails will be sent to this e-mail address.

My Delegates

If you have added delegates, you can view the delegates and the details of delegation on this page. See
below:

The name of your delegate(s)

The start and end date of your delegation(s).

Permanently active delegation(s) which are the delegations without a specified end date.
Comments

An option to Delete the delegation in progress
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« Anoption to notify new delegates. This option when checked notifies the delegate of any changes
you made to the relevant delegation.

2.3.7. Create

2.3.8.

You can use this menu to create projects or users. You can only see it if you are a Project Manager. See
Project Management in WebCenter on page 229 for more information.

Upload

Use this menu to upload documents into any WebCenter project for which you have upload
permissions.

See Different Ways to Upload Documents on page 59 for more information.

2.4. Filtering Content

As more information is managed over time by WebCenter, some pages can potentially show large
amounts of information. To reduce the time needed to show the page when it first loads, some pages
have afilter.

To use the filter, enter a search string with an asterisk either before it, surrounding it, or afteritin the
Search field, and click@ . For example, on the Companies page, to only see those companies with the
word Containers in their name, enter *Containers* and click &.

When filtering users, use the last name of the user.

To show all the items, up to the truncation limit, click Q with nothing in the field.

{ = ] Note: The truncation limit prevents lists of thousands of items from impacting response time;

== if you know in advance that your search will return that many items, refine it with the filter. The
truncation limit can be changed; contact Professional Services at your local Esko office for
more information.

2.5. Using the Cart

54

My Cart is a dedicated placeholder for a single user to gather a specified set of Projects and
Documents. You can add them to the Cart from the Project or the Document Actions menu. The Cart
also lets you Mail link to, Mail Download LinkRemove or Download multiple items at once.

A ¥?
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The contents of the Cart (the count is displayed next to the cart icon) are retained only for the current
login session by default.

{ = Note:

Your Cart contents can now be saved. Your can disable the option Clear Cart on Logout in My
Preferences to save the Cart contents for future sessions.

My Cart

The Cart will not be cleared on logout. Change in My Preferences

Click Change in My Preferences to clear/save cart on logout.

The Cart contents can also be cleared by clicking Clear Cartoption on the top-right corner.

{7] Note:

Downloading multiple documents at once or downloading projects requires having a
decompression utility, or operating system support for opening compressed archives.

Mac 0S X, Microsoft Windows XP, and Microsoft Windows 2003 Server have built-in support for
opening compressed archives.

When e-mailing an object from the Cart, only a link to that object is placed in the body of the e-mail
message. The recipient must have a username and password for your WebCenter site, so he or she can
log in to the site and see the object after clicking the link.

Shown below is a sample Cart.

My Cart EX3

The Cart will not be cleared on logout. Change in My Preferences
Documents Projects

More...~

Documents Version Description Projects Description  Manager Modified

I
mage @ DEKE_Show & Tell Sprint 70 Keizer, Debbie (DEKE) Apr 13,2016

'. pinklumi.png (992.1K8)
EERQ@ FlueBotilepng (755.4KE)

mEm[  GreenBottlepng (867.5KB)

ﬂ!!! berry.png (1.2MB)

You may start the Viewer on documents in the Cart by selecting the desired documents and selecting
View and Annotate or Compare in Viewer from the Actions menu.
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3. Working with Projects and Documents

This section contains information on using WebCenter from an everyday use (non-Project Manager’s)
perspective.

3.1. View a Project

To view a project, click its name in Search, Search Results, My Work, Favorite Projects, Projects |
Manage Projects | Am Invited to.

Click an underlined item to see more information about that item.

Click a folder name to open a folder.

Click a document name to see the Document Details page.

By default, clicking the document name leads to the Document Action History page, but if you click
a different page, WebCenter associates that desired page with the document type for the duration
of the session.

You can use the Actions menu to perform various actions, based on the security settings you have
in the project.

To view a document in a project, you can either click its name on any of its Details pages, or you
can download it to your computer if you have download permission. If you click its name, it will be
handled by your browser’s default method for files of that type.

3.2. Add Documents

One of the main functions of WebCenter is sharing documents between project members in a safe and
traceable way.

3.2.1. How Documents are Organized

Any document in WebCenter is placed at least in one project. The same document can however be
used in different projects at the same time, and are called linked documents. Linked documents

are used, when the same design needs to be re-used and synchronized between projects. If
synchronization is not needed, it's better to copy the document and each of the documents are placed
separately in WebCenter. The vast majority of documents are in just one project.

Projects are organized in folders. Documents are put into a folder or on the root folder of the project.
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Note:

Currently, WebCenter only allows going one level deep. In most circumstances, this is not a real
limitation, unless you try putting too many documents into the same project. WebCenter is well
equipped to work with extreme amounts of projects so it's better taking advantage of this than
creating projects with entire sub-projects put into a folder structure.

Note:

Document names within a project are unique. When trying to upload a second document with
the same name in a different folder of the same project, you will get an error message.

WebCenter is fully “version enabled”. This means that each document can have multiple versions. By
default, you'll only see the latest version, but you can go back to previous versions. In addition, there is
an action history showing when versions are uploaded and what actions took place on these versions
(for example approval actions). The viewer also allows comparing versions graphically.

3.2.2. Document Types

The following document types can be uploaded in WebCenter:

Note: You can hover on any viewable file to view the expanded thumbnail. You can further click
on theZoom icon on the right top corner to view a larger thumbnail.

Graphic file: WebCenter supports most common graphic formats. PDF, PS, EPS, Al, AP, EPF, DCS,
PSD, CT, LP, TIF, TIFF, PAF, GRS, PNG and JPG will all be recognized.

After upload, WebCenter will calculate preview data for the WebCenter Viewer.

If you don't want this, you need to upload the graphic file as an “other” file type. Typical examples are
office-based PDF files(manuals, quotes...) which are better viewed in Adobe Acrobat.

LENX: LEN is a bitmap file format developed for Esko's Cyrel Digital Imager ("CDI"). LENX is a special
version of the LEN file format developed for Esko's CDI Crystal Imager series and Crystal screens.

Note: You can also upload a ZIP file containing graphic files (a set of TIFF or LEN files,
or LENX files or a PDF, GRS or AP file with external images) as a "graphic file", and view it
directly in the Viewer.

ArtiosCAD: Native files of Esko ArtiosCAD. The standard extension
are .ARD(Design), .A3D(3D), .MFG (Manufacturing) and .ACD(Canvas).

Cape: Capeis a program to calculate pallets and truckloads. WebCenter allows two ways to upload
files from Cape:

« uploading a triplet of files (You need at least 2 files: the CLF and XML files. The report / diagram
file (usually a JPG)is optional).

« uploading asingle ZCP file.

When you have uploaded a ZCP file, check the Cape Information tab in the In the Document
details page to see the information from the XML document. To view the report / diagram file,
click on the document thumbnail.

Collada: Collada is an interchange file format for interactive 3D applications. Regular Collada files
have .DAE extension, Zipped Collada files use .ZAE.
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« Page List: a multi-page document that will be treated like a Page List in WebCenter. A Page List
represents an imposed multi-page document, the individual pages of which can be approved and
version-controlled separately in WebCenter.

» CHILI Package:

This is CHILI WebCenter document type. A CHILI Package version is linked to a native CHILI
document on the CHILI server. Read more about CHILIin Administrator Guide.

» Text Content
This Document Type is for Text Content in WebCenter. When Text Content Document Type is

enabled, a.wcc will be recognized as Text Document.

«  Component: Component is an unique file type which has no physical presence but acts a
placeholder for all the documents related to the product. Read detailed about Component file type
Component File Type on page 58 here.

« Other: any other file. Mostly these are office files like Microsoft Word, Excel, PowerPoint etc. Video
files must also be uploaded as "other".

» URL: Here you can enter a link to another document anywhere on the network or on the Internet.
WebCenter does nothing else than remembering this link and allowing to define attributes.

Component File Type

The Component document type in WebCenter is a document type for holding only a set of attributes.
This can represent a non-file packaging component like a Copy Sheet or a Barcode, an alternative to a
project or a placeholder document for holding a packaging specification.

For example a collection of all assets required for a Product Content Sheet(PCS), that includes images,
symbols, Barcode, text statements, CAD files, 3D, Collada files and so on.

The Component document type shares most properties with other document types, but there are a few
exceptions like

« Thisfile type does not have a physical file and have zero size.

« Document type will change depending on the extension of the uploaded document, when a new
version is uploaded

» Opening a Component will open a view of the Default attribute category

To Create/ Upload a Component Document

In the Upload page, choose the file type Component to create a new component type document. When
the mandatory fields are filled, click Save to create a new Component document.

You can restrict the file that can be uploaded by specifying a file type for the first version.

When no extension is defined for the first version, the document type is changed according to the
extension of the uploaded document.

Opening a Component document will allow you to view or update the attributes of the document.

Search for Component Document type

Component file type is available in the Search for drop down selector in the Document Search page.
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The available criteria are the same as for the All selector, but the results are filtered with the
Component document type.

Different Ways to Upload Documents

There are multiple ways to upload documents to WebCenter:

Upload via Upload Document: use this if you only have a single document to upload, or to upload
documents one by one.

Upload via Upload Multiple Documents: use this to upload multiple files at once, if you do not want
(or are not able) to use a Java applet.

Upload via Advanced Upload Applet: This opens a HTML5 applet allowing you to browse or drag-
and-drop multiple files. These files are all uploaded in one go.

Upload from a workflow system: Automation Engine can also upload documents to WebCenter.
In many cases, it is beneficial to upload graphic files using a workflow system, because:

« Itisquicker and automated.
« The workflow system can do calculation in advance.
« You have better control over the generation of the view data (when using Automation Engine).

Upload from ArtiosCAD. Use this to upload CAD files. You can only upload one document at a time
but you can make the project selection and document name automatic. This makes uploading a
one-click operation.

Upload by Drag and Drop Documents can be uploaded to projects or one of the folders of the
project by dragging and dropping them from the user's file browser.

Uploading a Document via Upload

1.

You can either go to the project/folder you want to upload the document into and click the

button, or just click the Upload menu item from anywhere.

When instant upload is configured by an Admin user, and a file is chosen for upload, the upload of

r

the file starts immediately. You can view the progress of the upload and there is an option to pause

or stop the upload.
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Target Folder | Upload Test

1 Select Files Save

Name
Browse: InstallerChanges.mp4 (6.85MB) Change File
InstallerChanges.mpd Description | L]
Upload Test v
Browse: WebCenter_18_1_1_Complete_Documentation.pdf (44.36 MB) Change File
20% o9 _
WebCenter_18_1_1_Complete_Documentation.pdf Description u
Upload Test -
Browse: AutomatedArtworkinternalDocumentation.pptx (8.7 ME) Change File
68% (1] -
AutomatedartworkinternalDocumentation pptx Description "
Upload Tast v
Browse: Home_And_Design_Trends_May_2020_desk.pdf (26.04 MB) Change File
0 _
Home_And_Design_Trends_May_2(20_desk_pdf Description L]
Upload Test v
Browse: LPMI_May-2020.pdf {12.58 MB) Change File
[ ]

LPMI_May-2020.pdf Description

Note: You can also drag and drop multiple files into the upload button, with the above
option selected.

2. Onthe Upload page, select the Project and Folder you will upload the document into (if you
are already in the project/folder, those are filled in automatically, but you can still Change the

Destination).

Note:

You can also select:

« Upload Multiple Documents to use the HTML5 upload. Just drag and drop files to upload
them.

- Copy/Create Multiple New Documents to add multiple documents at once (either from
your computer, from another project or from a template).

Upioad J——

Uplasd 1o Project
tema.copy. ol opEimizations

Change Destination

3. Select the document to upload as explained below.
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If you want to...

do this...

Upload a document saved on your computer or
network.

Select Browse in the Source list and click the
Browse... button to open a browser dialog.

Note:

If you are uploading Cape files, you can
upload a single . zcp file.

If you are uploading a Page List
document, you must also specify the
Name and Starting Index of the Page
List.

/1 Attention:

Graphic files must be self-contained
and may not contain references

to external files such as fonts or
placed images. Make sure fonts are
embedded.

In case you upload native files (GRS
or PDF Native), you should use the
Automation Engine Publish on Web
task.

If you need to upload manually anyway,
first make a self-contained file with
QOutright. You can also convert to PAF
and upload the PAF file.

Copy a document from another project.

Select Copy in the Source list, then select the
project to copy the document from, and the
document to copy.

Add alink to a document.

Select URL in the Source list and type in or
paste the URL to the document.

Create a document placeholder froma
document template.

Note: This is only available if the
project has been created from

a project/template containing
document templates.

Select New in the Source list, select the
document template to use in the pop-up, and
fill in any attributes that may be required.

Note: The document template's
document type will be used for the
document placeholder (except if that
document type cannot be copied, like
Page List).

See Document Templates in the Administration
Guide for more information about document
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If you want to... do this...

templates, and Assigning Document Attributes
on page 76 for more information about
attributes.

4. |If you browsed to a document, copied it from another project or created a placeholder from a
template, the Document Type and document Name are automatically detected.

You can still change them if needed (you cannot change the Document Type of a placeholder or a
copied document).

5. Enter a Description (optional but strongly advised).

6. If youwant to add this document to the Project's Bill of Materials, select Add to BOM, then enter the
Count of this document (how many copies are needed for the BOM).

Note:
You can only do this if:

« youare an Administrator,
« you are the Project Manager,
« you have the Change BOM permission.

7. If the document has attributes, fill them in (at least the required ones).

Tip: The document has the attribute category associated with its document type in the
Configure > Document Creation tab of the Project (see Document Types).

8. If you want to use the default approval settings of the project/folder for the document, select Apply
Default Approval Settings (this is not available for document URLs).

Note:
You can also:
- Set the approval Due Date (only if you have the Change Approval Setup permissions):

enter a date or pick one in the calendar, then choose an hour.

« Start the approval cycle.

9. Click the Upload button.

10. If you want to define approval settings specific to this document, click Setup document approval.
This will bring you to the Approval tab of the document details page.

If you have the task management license, you can also upload a document to a task in a project.

You can upload documents the same way as described and the document will immediately be linked to
the task.

Note: TIFF and JPG bitmap files using indexed color spaces or RGB are not supported by the
WebCenter Viewer.

Note: When you try uploading a document which already exists in the project, the upload of
this document will fail. You won't get a new version. Use Upload new version instead.
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The first time you save a project document, you enter all its database information. The next time you
work on that document, you can:

« lock adocument

« upload a new version or revision

Itis up to you to decide if it is a draft, revision, or version according to your company’s best practices.
Some people publish minor changes as revisions and major changes as versions; others do the
opposite, and yet others just save drafts.

Copy / Create Multiple Documents

1. You can either go to the project/folder you want to upload the document into and click the

button, or just click the Upload menu item from anywhere.

When instant upload is configured by an Admin user, and a file is chosen for upload, the upload of
the file starts immediately. You can view the progress of the upload and there is an option to pause
or stop the upload.

Target Folder = Upload Test «

1 Select Files Save

Name

Browse: InstallerChanges.mp# (6.85MB) Change File

E -
InstallerChanges.mpd Description "

Upload Test v
Browse: WebCenter_18_1_1_Complete_Documentation.pdf (44.36 MB) Change File
00
WebCenter_18_1_1_Complete_Documentation.pdf Description u
Upload Test v

Browse: AutomatedArtworkinternalDocumentation.pptx (8.7 ME) Change File

68% 00

AutomatedArtworkinternalDocumentation pptx Description L]
Upload Test w
Browse: Home_And_Design_Trends_May_2020_desk.pdf (26.04 MB) Change File
00 _
Home_And_Design_Trends_May_2020_desk.pdf Description "
Upload Test v
Browse: LPMI_May-2020.pdf {12.58 MB) Change File
LPMI_May-2020.pof Description .

Note: You can also drag and drop multiple files into the upload button, with the above
== option selected.

2. Onthe Upload page, select the Project and Folder you will upload the document into (if you
are already in the project/folder, those are filled in automatically, but you can still Change the
Destination).

3. Click Copy/Create Multiple New Documents.

Note: From this page, you can also click Upload Multiple Documents to use the HTML 5
=% Upload to upload multiple documents.

4. Add adocument as explained below.
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If you want to...

do this...

1.

Upload a document saved on your computer or
network.

Click Upload then click the Choose File button
to open a browser dialog.

Gl

Note: You cannot upload CAPE files,

or upload PDF files as page lists when
uploading multiple documents. Please
use the normal Upload option for this.

2.

Copy a document from another project.

Click Copy, then select the project to copy the
document from, and the document to copy.

3.

Create a document placeholder from a
document template.

Gl

Note: This is only available if the
project has been created from

a project/template containing
document templates.

Click New, select the document template to
use in the pop-up, and fill in any attributes that
may be required.

To collapse a document's attributes, click the
square minus sign in front of the document.
To collapse all documents' attributes, click
Collapse All at the top of the page.

See Document Templates in the Administration
Guide for more information about document
templates, and Assigning Document Attributes
on page 76 for more information about
attributes.

Documents
Source Document Template

Upload: Choose File | berry.png Please Select.

= New: Box1.ard
Select a Board!
Brown008 v

Length: Width:
100 mm 100
IsStandard

b

5. Repeat for each document you want to upload.

6.

64

Name Description
v berry.png

Box1.ard

Depth:

b ] Note: If you want to remove a document, click the delete button behind it.

If you want to use the default approval settings of the project/folder for these documents, select
Apply Default Approval Settings (they will not be applied to document URLs).
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Note:

You can also:

- Set the approval Due Date (only if you have the Change Approval Setup permissions):
enter a date or pick one in the calendar, then choose an hour.

« Start the approval cycle.

You cannot setup document-specific approval settings for several documents at once.

Click the Upload button.

Note: When you try uploading a document which already exists in the project, the upload of
this document will fail. You won't get a new version. Use Upload new version instead.

Upload Multiple Documents via the Upload Applet

You can Upload Multiple Documents in two ways:

1.

2.

5.

Click Projects on the Menu Header. Select the Project you want to upload the document to.

Click the d:Upload Multiple Documents option. Select the Target Folder from the drop-down
menu.

« Youcan also select menu Upload and upload multiple documents. In this case, select the
Project and the Folder you want to upload the documents to and click Upload Multiple
Documents.

You can either Select Files (one by one or by selecting a few) or drag-and-drop from any file browser
into the applet window.

You can change the destination Folder of each document if you want to.

If you want to use the default approval settings of the project / folder for these documents, select
Apply Default Approval Settings.

« Set the approval Due Date (only if you have the Change Approval Setup permissions): enter a
date or pick one in the calendar, then choose an hour.
« Start the approval cycle.

You cannot setup document-specific approval settings for several documents at once.
Click Upload.

The upload will start and you will see a progress window. Depending on how many files and how big they
are, this can take a while.

Note: You cannot upload ZIP files, individual CAPE files, or upload PDF files as page lists with
the upload applet. Please use the normal Upload option in the Project for this.

Note: When you try uploading a document which already exists in the project, the upload of
this document will fail. You can, however, upload it as a new Version.
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Upload from a Workflow System
You can upload documents to WebCenter from:

« aAutomation Engine workflow, using the Publish on Web task.

B Note:

You can also start an approval cycle on your uploaded document directly from the workflow. It
uses is the default approval cycle, inherited from the project or folder you upload the document
into.

If you have the Change Approval Setup permission, you can also set the approval due date.

For details on how to upload documents from Automation Engine, please see the corresponding user
manual.

Upload from ArtiosCAD

For details on how to upload documents from ArtiosCAD, please refer to the ArtiosCAD user manual.

(f l Note: You cannot start an approval cycle from ArtiosCAD.

Upload by Drag and Drop
You can upload documents by Drag and Drop. To do so, you can

1. Add adocument into a project or folder by dragging from your browser.
2. Upload Files to (Project Name) window is opened along with the document that is dragged.

3. You can add more documents by dragging into this window or use Select Files to browse. Select
Upload to add the documents to the project.

3.3. Working with Documents

Once a document has been uploaded to WebCenter, you perform a number of basic operations on it,
such as copying, deleting, updating or locking it, to ensure it completes its lifecycle within the system.

3.3.1. Move a Document

B Note:

When a document with approval settings is copied or moved to another project, the approval
settings are not copied or moved.

A document with a started approval cycle may not be moved or copied as a link until the
approval cycle is stopped.

A locked document cannot be moved.
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Open the project and folder containing the document to copy and select it. If desired, select more

than one document by selecting their checkboxes.

2. Click More.... Select Move Document(s) from the drop-down menu.
3. Choose to either Move inside the current Project or Move to another Project.
4. Do one of the following:
If you chose to move the document Then you must...
in the same project, Select the folder into which to move the
document.
to another project, « Choose the project into which to move the
document.
- If that project has folders, choose the folder
into which to move the document.
5. Click Move.

Move Document(s)

Selected D

show Projects

3.3.2. Copy a Document

1.

Open the project and folder containing the document to copy and select it. If desired, select more

than one document by selecting their checkboxes.

Click More.... Select Copy Document(s) from the drop-down menu.

Choose to either Copy inside the current Project or Copy to other Project(s).

SelectCopy as Link to copy a link to the destination folder or project.

E b ] Note: If you opt to Copy as Link, you will not be able to Rename Document or be able to

Copy Viewer Annotations.

Do one of the following:
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If you chose to copy the document Then you must...

in the same project, Select the folder into which to move the
document, or provide a new name for the copy
in the Rename Document field.

to another project, » Choose the project into which to copy the
document.

« If that project has folders, choose the folder
into which to copy the document.

6. Click Copy

The document is now available in both the source and target projects.

3.3.3. Delete a Document

{ = ] Note: A document with a started Approval Cycle cannot be deleted. The Approval Cycle must
be stopped before you can delete the document.

A locked document cannot be deleted.

If a document is used for a document reference attribute, it cannot be deleted

1. Open the project and folder containing the document to delete and select it. If desired, select more
than one document by selecting their checkboxes.

2. Click Delete Document(s)in the Actions Header.
3. Click OK to confirm the deletion.

The selection is deleted. If any selection is a linked document, only the particular link that was selected
is deleted; other instances of the link are not deleted.

3.3.4. Lock a Document

Locked documents are documents you have flagged as being in use so that other users do not
download them and work on them at the same time.

1. Openthe project and folder containing the document to lock.

2. Select the checkbox of the document to lock and click More....Select Lock from the drop-down
menu. To lock more than one document at a time, select more than document. You may not lock
URLs. The latest version of the document is selected for locking.
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The document is now marked as locked B . If other users try to download it, they will be asked to
confirm downloading a locked document.

3.3.5. Unlock a Document

1. Click My WebCenter > My Locked Documents.
2. Select the document(s)to unlock.

" Click the Unlock & "% ' ptton. The document(s) will no longer be shown on the list.

3.3.6. Upload a New Version or Revision of a Document

1. Openthe project and folder containing the document to which you will Upload New Version or
Raise to Revision.

2. Inthe Documents list, either:

« Hover over the document link and click More or the Upload button toUpload New Version.

1,488 Qﬁ!eE 1E
1 r

]

=T @+

H 1089+CAD pdf.pdf (3.7ME] 1

« click Upload New Version in the Actions Header.

004dro.dxf
= Mail link te Documant
€ Open In ArticaCAD b
. Description
More..~ Approval: No Appeoval Reguired
Qv
A
T
am
]
-
m
§
-
-

Make sure you use the buttons on the document's row.
3. Browse to select the new version of the document.

For document types that have more than one file, specify multiple files as needed. The filenames
can differ from the original file names, but they must of the same type (i.e. have the same
extension)as the original document.
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E b ] Note: By default, if the file name of the new version of the document is different from
the filename of the previous version, WebCenter will use the filename of the original or
previous version when you download the new version. This behavior can be changed;
contact Professional Services for assistance.

4. Inthe Version comment field, enter your comments regarding the new version.
5. You can make the new version a Revision by enabling Raise to Revision A.
This is only available if the admin has enabled this for you.

E b ] Note: The revisions will be denoted as A,B,C following the version number.

6. If thisis alinked document, select the project(s) to check the document into.

7. When you upload a new version of a document which has an approval cycle ongoing, the approval
cycle stops automatically. If you want to have the approval cycle restart immediately, select Start
approval cycle on new document version.

8. If you have the Change Approval Setup permission, you can adjust the approval cycle's due date (in
the Specify New Due Date option).

E b ] Note: If the document was in a staged approval cycle, where the cycle restarts from
depends on the When a new version is uploaded setting. See Define How to Handle a New
Document Version on page 262.

9. Click Finish.

= ] Note: To access a previous version of the document, click its number in the Version column on
the Action History page for that document.

3.3.7. Delete the Last Version of a Document

You can delete the last version of a multi-version document if:
« youare the Project Manager for the project containing that document, an Admin, or a project
member with Delete permission

« the project containing the document is active
« the documentis not checked out by another user
» the document has more than one version

« Onthe Document Details page, click More Actions... then Delete Version.

& Mail link 1o ) Document

Q open e Version: 4
2 Descriplion
[ Projet
More...= Approval: No Approval Required
T A
i
oM
L]
i ]
+ M
=
]
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Confirm your choice by clicking OK.

E ] Note:

If that document version is in a running approval cycle, WebCenter will show this message:
There is a running approval cycle on this document version. Are
you sure you want to delete this document version?

Clicking OK stops the approval cycle for that document version.
If the document came from Automation Engine, the Pilot will indicate the deletion.

If the deleted document version was linked in other projects, the link is updated (to link to
the previous document version)

The document record indicating the last version index is decreased by one.

3.3.8. Update a Document across Projects

If you have a document that is linked in many Projects, and upload a new version into only one Project,
the links in other Projects continue to reference the prior version.

E b ] Note: Project Managers may update entire Projects at once, not just the contents of a single
folder.

To update a document in a Project to ensure it references the latest version, do the following:

1. Open the project and folder containing the document to update.

2. Select the document to update. To update more than one document at a time, select as many as
desired.

3. Click Update from the More drop-down menu.
All documents in the folder that you selected for which you have Update permission are updated. A

list is shown of the updated document(s), the containing Project, the old version number, and the
new version number.

3.3.9. Open a Document

Opening a document means having WebCenter open the document using the document'’s default
application as defined in the Web browser. You need View and Download permissions to Open the
document.

1. Navigate to the document by searching for the document and clicking its name in Search Results, or
by clicking its name in a project.

2. Click Openonthe Document Actions Header.

3. The Open button has different behavior for different document types.

Document Type Behavior
CHILI Opens CHILI Viewer in new window
PDF Open button unavailable. Use Open in Acrobat.
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Document Type Behavior

ArtiosCad Design,Manufacturing, Canvas or 30 | Open button unavailable. Use Openin

ArtiosCAD

Graphics Open button unavailable. Use View and
Annotate

Other (text,xml, MS Word, MS Excel...) If the browser has a plug-in for the document

format extension, it shows the contents of the
file in a new window. If no plug-in is available,
the document is downloaded.

i =| Note: You can hover on any viewable file to view the expanded thumbnail of the document.
You can further click on the Zoom icon on the right top corner to view a larger thumbnail.

3.3.10. Download a Document

1. Navigate to the document by searching for the document and clicking its name in Search Results, or
by clicking its name in a project.

2. Inthe Documentlist, either:

« Click Download in the Actions Header.
« Hover over the document link and click Download

-

W e a6

« |Ifitisan ArtiosCAD document, choose the format in which to download it and click Download.
You may only download in formats for which you have the Download permission.

« Ifitisa CHILI document, choose from the download options (CHILI Package, CHILI XML, PDF),
and click Download.

« |Ifitisa Structured Content document the document is downloaded as a zip file along with all the
referenced topics, images, etc, of the selected document.

You can enable the notification for Document downloaded to keep track of who downloaded a
Document.

The document is downloaded and may be manipulated as desired.

3.3.11. Documents in Esko Cloud

It is now possible to store and retrieve documents from the Esko Cloud. This has been enabled with
the help of work flow nodes. This requires an Asset Management connection to be setup for Archiving
service.

Status of the document location is indicated in the document information with anicon.
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Upload and Download from Esko Cloud

With an existing connection for Archiving, documents can be uploaded in a workflow using the Upload
to Asset Management System workflow node.

You can select the Only archive old Versions of a Document option to upload all the versions that are
no longer linked from within a Project in WebCenter. Uploaded documents have an indication in the
document header with a cloud icon and the document information tab has the cloud connection link
along with the external document id.

You can select the Remove Document from Filestore after upload to Esko Cloud option to remove the
Document from the WebCenter Filestore after a successful upload to the Esko Cloud. After running

a Workflow with this option configured, the Document will still be useable in WebCenter. It is still
possible to download/generate view files for this Document, however the document data will be served
from the Esko Cloud. Read more about the work flow node here.

Restore from Esko cloud

You can restore the file back to WebCenter in a workflow using the work flow node Restore from Esko
cloud.

Choose the right archiving connection where the document is located and on execution the document
is backin the Filestore.

3.3.12. Download Multiple Documents

You can download several documents on a same page (in a Project or a Search Result page)in one go.

When you select multiple documents for download, WebCenter automatically adds themto a
compressed archive, and then the archive is downloaded (WebCenterDownload.zip).

To download multiple documents, do the following:

1. Select the checkboxes of the documents to download.
2. Click Download in the Actions Header.

Use a decompression utility to extract the documents from the archive. The documents are now on
the hard drive and may be manipulated as desired.

E h ] Note: To download all of a project's documents, click More actions... then click Download
in the header of the Project Details page.

3.3.13. Download Documents from Multiple Locations

To conveniently download documents from several projects, you can use the Cart. You can add
documents to download to the cart as you are browsing the projects, then download themin a zip
archive when you are done.

For each document that you want to download, click Add to Cart in the Actions Header.
Click the Cart button in the top row menu or next to a document name to go to the Cart.
Select the checkboxes of the documents to download.

s oo

If you are downloading ArtiosCAD or CHILI documents, choose the format in which to download
them and click Download in the Actions Header. You may only download in those formats for
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which you have permission, and you may only choose one download format for designs and one for
manufacturing files, respectively.

Use a decompression utility to extract the documents from the archive. The documents are now on
the hard drive and may be manipulated as desired.

3.3.14. Viewing and Printing a Document's Annotation Report

You can view the annotation report page with an overview of annotations done in a document without
opening the document in the viewer. To view the annotation report, go to:

« Document details > Annotations.

(f ’ Note: This feature is only enabled for graphic files.

You can view all the details related to the annotations in this page. In addition, you can also filter based
on Review status, User and Report style.

Click the Print link to print the Annotation Report.

(f’ Note: The print layout will follow your annotation filters.

This feature only works correctly in browsers supporting the HTML5 Canvas feature.

3.3.15. Online Document Editing with CHILI

74

Open CHILI Document in Editor

When a user opens a document, it will be opened in the CHILI Editor. In the editor, the user will be able
to edit the parts of the document, based on Workspace and Constraints. Read also Dynamically assign
workspaces and constraints to CHILI Documents

"oy

In the header bar, some document information will be shown. Below, the buttons “Return”, “Save as
Draft”and “Save as New Version” are shown. If the user who opened the editor is an approver, he can
see the approval options and from there, he can do all available approval actions. When the user
approved/rejected the document, the action button list will be updated.

NOTE: "Save as Draft” button is only available if the current User has ‘'CHECKOUT' permission for the
CHILI document; “Save as New Version” button is only available if the current User has ‘ADD’ permission
for the CHILI document.

Save a CHILI Document

When a user saves his document as a draft, it will be saved on the CHILI server. When he then reopens
the document in the editor, the changes are still there. However, when downloading the document
from WebCenter, the changes will not be visible. They are only visible in the editor.

In the document details page (header), a warning should be shown that there is a draft version of the
document.
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When a user saves his document as New Version, it will be saved on both the CHILI server and
WebCenter. The previous version will be restored to its original state in case there was a draft version.

When saving as a new version, a version comment is required. It is also possible to start approval and
set a due date. When saving a linked document, the user will also get the option to select in which
projects the document needs to be updated.

Using and Updating WebCenter Attributes from the CHILI editor

In a CHILI document, variables can be defined. Filling out those variables will change certain fields in
the document.

When loading the document in the CHILI editor, attributes can be pushed to the editor. If an attribute

in WebCenter (either project or document attribute, where document attribute gets priority) has the
same name as a variable in the CHILI document, the value in CHILI can automatically be filled out. The
user will be asked if he wants the variables to be updated when opening the editor on a clean document
(without a draft version). After this, the user will always be able to synchronize the values on demand by
clicking the “load attribute values” button. This update button can be clicked at any time.

i =w| Note: This panel and button will only be shown when there are actual matches between
attributes and variables.

When an attribute name and a variable name match, and that variable is edited, it is possible to save
these values back into the attribute category again when saving as a new version. When saving

the Document as a new version, a popup window will come in which the user can specify a version
comment and restart approval. In the same window you will have two check boxes to specify if you
want to update project and document attributes. Note that for linked documents, it is not possible to
save project attributes.

i = ] Note: Foralot of the variable types, conversions are foreseen in WebCenter. However, there
are some limitations:

« Thereis no conversion between the WebCenter Rich Text Attributes and CHILI's Formatted
Text variable.

« Multivalued Text attributes in WebCenter cannot be imported into the CHILI editor’s list
variable.

3.3.16. Viewing References of a Document

If your current Document (including all versions of the Document) is being referenced in other
Documents, you can view the details in the References Tab.

This tab will list the Documents referencing the current Document Version as a Document Reference.
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3.4. Assigning Document Attributes

Design Information ~ Document Information  Approval  Action History  Annotations

Version 3 (Current Version)

Documents Project

Projects  Attributes

’ Sandwich Salmon & Soft Cheese.pdf (11.7MB) KSJ Document Reference test

# show parent references for all versions

Version 2
Documents Project
‘ Sandwich Salmon & Soft Cheese 2.pdf (11.7MEB) KS.J Document Reference test

This tab provides a view of:

« the Documentsin which they are referenced,

» the Projects in which those Documents reside,

« the Version

« and details on who Uploaded the Document (Version)

References Characteristics

Version

WebCenter

More...~

Uploaded

Jul 3,2016 at 12:34 PM

Version

ADMIN (ADMIN)

Uploaded

Jul 3,2016 at 1:31 PM

ADMIN (ADMIN})

If the document has additional versions and one or more of these are explicitly referenced, a checkbox
Show parent references for all versions will be displayed. Enable this to view a list for each version

that are referenced.

Attributes are a way to assign user-configurable fields and their values to documents and projects.
They can be restricted to a group of preset values, or can be prompted so that the user has to set a

value each time it is used.

Attributes need to have been created by an Administrator before you can use them (see the

Administration Guide for more information).

3.4.1. Assign Document Attributes
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1. Openthe project and folder containing the document to change and click its name.

2. Click Attributes.

s Upload Multiple Documents Customer:
Due On: Feb 28,2014 4,
& Mail link to

\:‘w Modified: Sep 24, 2015
More...»

Description:

Specify Attribute Category

Change Attribute Category AE-WCB-BOM_TEMA

AE_OrderiD: yellow

AE_SubOrderiD: tulip
ae.p.prodid: jpg

Aftributes

ae.p.name: dot
ae.p.desc: flower
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3. Specify Attribute Category by selecting from Change Attribute Categorydrop-down. Click Save.
4. Inthe Attributes in Category page, fill in the desired values for the Attributes and click Save.

Change Document Attributes

1. Open the project and folder containing the document to change and click its name.
2. Click Attributes.
3. Change the Attributes values as desired and click Save. The values are changed.

Change an Attribute Category

Attribute Categories are related Attributes grouped together for convenience. If you change an
Attributes Category, the previous values are not saved.

Open the project and folder containing the document to change and click its name.
Click Attributes.

Click the Change Category link.

Select the new Attributes Category to use and click Save.

o owN

Enter the values for the new Attributes and click Save.

Export Attributes to JDF

To make working with other systems easier, you can export and import document Attributes by using
JDF (Job Definition Format)files. You can export the Attributes, modify them in another system, and
then import their changed values back into WebCenter.

Note that you cannot add more Attributes to a document this way; this only lets you change the values
for existing Attributes.

{ = Note: Option to Import from or Export to JDF buttons are enabled only when Allow importing
from/exporting to JDF is enabled in the WebCenter Security Preferences by the Administrator
users.

1. Navigate to the document with the Attributes to export.
2. Click Attributes.

3. Set the values for the Attributes as desired and click Save to set them. If they are already set as
desired, skip this step.

4. Click Export....

WebCenter automatically names the file <document name> attrs.jdf.Any periodsinthe
document name will be converted to underscores.
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5. Save thefilein the desired location.

3.4.5. Import Attributes from JDF

Important:

If you want to import Attributes that are not generated by another WebCenter system, you
should generate a sample JDF file for the people using the other system to use as a reference,
so that they format their JOF file correctly.

The important lines are the ones similar to <eg:SmartName Name="Attribute Name”
Value="Value”/>; there must be a Value tag for each Name tag.

{ =| Note: Option to Import from or Export to JOF buttons are enabled only when Allow
=== importing from/exporting to JDFis enabled in the WebCenter Security Preferences by
the Administrator users.

To import a JDF file containing Attributes with changed values for a document, do the following:

1. Navigate to the document with the Attributes to import.
2. Click Attributes.

3. Inthe Import from JDF file field, enter the path and name of the file, or click Browse... and select it
that way.

4. Click Import.

The values for existing Attributes are updated if necessary. If there are either too few or too many
Attributes defined in the file as compared to the document, WebCenter will mention it in a status
message.

3.5. Viewing Document References of a Document

3.6. Assigning Document Characteristics

Characteristics are descriptive tags that can be assigned to projects or documents to make them
easier to find.

Characteristics are hierarchical. This means there can be different levels of characteristics for various
product lines so that you can drill down through the information to find the exact characteristic desired
when searching the database.

{ = ] Note:
- Characteristics are linked to the document itself and not to a specific version.

So changing the characteristics of a linked document will affect all versions of the document,
in all projects that have the document linked (including inactive projects).

You can only assign characteristics to a document if:
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you are an Admin,
you are the Project Manager,
you have Change Properties rights for that document.

Important: If the project is inactive, you will not be able to edit a document's characteristics

42200 if your Admin has not enabled Allow changing attributes and characteristics of inactive

1.

2.

4,

projects in the Preferences (see the Administration Guide for details).

Open the project and folder containing the document to change and click its name.

Click the Characteristics tab of the Document Details page.

You can also find CAD design Characteristics (associated to ARD files) in the Characteristics tab.
When using ArtiosCAD Enterprise, the CAD design Characteristics you assign in WebCenter will be
reflected back in ArtiosCAD.

Select the checkboxes of the desired Characteristics. The selected Characteristics will appear
in the list of Characteristics. Click the + plus sign next to a Characteristic to see its child
Characteristics.

Click Save. The selected Characteristics will be associated with the document.

To remove Characteristics from a document, do the same as described above, but deselect the
checkboxes of the Characteristics to remove them from the list.

3.7. Downloading a Project

. Note:

]
Only those documents in a project for which you have Download permission are included when
downloading a project.

To download a project:

3.

4.
5.

Open the project.

. Add the project to the Cart by clicking Add to Cart on the Projects Header bar.

You can also select multiple projects in a project list and click Add to Cart in the Headerbar to
download them all at once.
Click the Cartbutton.

Select the project(s) to download and click Download in the Header bar.
If prompted, choose where to save the files and click Save.

The project is saved as a compressed ZIP archive with the same name as the project. Use the
decompression software of your choice to open it; some operating systems can open compressed
archives without the need for a separate program.

When downloading multiple projects, individual projects are compressed into their own archives and
then those archives are nested together in one master archive.

Your system may be configured to download and open the archive automatically, in which case you can
extract the files as desired.

79



ESKO

WebCenter

3.8. E-Mailing Links to Documents and Projects

80

You can send links to documents and Projects with any MAPI-compliant messaging program.

Note:

I R

The recipient(s) must be able to log in to your WebCenter system and have the appropriate
permissions to view the Documents or Projects referenced by the links. You canMail link To
single or multiple Documents and Projects.

To Mail link To single Project or Document:

Navigate to the Document or Project.

Click Mail link To from the Project or Document details page.

To Mail link To Multiple Projects or Documents:

Select the Documents/Projects you want to send. Click Add to Cart in the Document or Project
Header bar.

You can also add multiple documents or Projects to the cart. Simply repeat this step.

Click the Cart button.
Select the Documents or Projects you want to send.

6. Click Mail link To in the Header bar.

My Cart
4 on
Documents Projects
Q, View and Annctate = Ml link te 3 pownload  More...= & Mail Fink te ¥ Download W Remove from Cart
Dacuments Varsion Description Projects Dascription Manager
Other : .*
7 OKE:
2 &
[ B "
. 6.9k
e

7.

A message opens containing links to the documents or Projects in the body of the e-mail.

Address the message as desired and send it as usual.

Tip:

To send only one message containing links to both Documents and Projects, leave both
messages open and cut and paste links between messages as desired.
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3.9. E-Mailing Links to Download Documents

You can send a link to download a certain document (or multiple documents) to non-WebCenter users.
This link will only enable the recipient to download one specific file and has a fixed validity (number of
days that the link is available).

To use this functionality, an Admin user first needs to enable it and set the validity for the download link
(see the Administration Guide for details).

This functionality is available to Project Members that have Download permission for a given Project
Document Version and to the Project Manager of the parent Project.

The following steps describe how to send a download link(s) to a non-WebCenter user:

1. Select the checkboxes of the document / documents to download.

2. Choose Mail Download Link from the Header bar.
Your default e-mail client will open with an e-mail containing a link (URL) generated by WebCenter.

3. You can add a recipient and edit the content of the e-mail message.

4. Send your e-mail.

i = ] Note: You can also Mail Download Link from the pages below:

« MyCart
« Document Search Results
« Project Details documents

- BOMdocuments

« Therecipient of the e-mail will be able to use the download link to download the file
for as long as the link is valid. In case the link is no longer valid, the recipient will be
informed it has expired.

«  When arecipient clicks a link that is invalid, expired or tampered with (for example if the
URL was changed), he/she will see a web page stating that the link is invalid.

3.10. Viewing the Action History

The Action History page for a document shows all actions performed on the document such as version
Uploads and Approval Actions.

« Toview the action history, click the Action History link on a document.

The page displays these document details:
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Status  Stage Comment

reoval otane 3

Stage Stagel Overview - Approved

age started May 9, 2016 31 Z10PM

View Generation

« Version: An overview of document versions

« Event: An overview of:

+ Details of Upload Document/Upload Document Version, Approval, Lock document...
« View Generation (for Graphics only) with a link to Show Task Details.

» Annotations which display date, time, user and annotation comments.

Note: The document uploaded event also includes the description of the document.
When a document is copied from another project to the current project, the source
project information is also mentioned.

{ =

- Status displays the current status of the document (Approved, Rejected, Locked...)and theiricons.
« Stage: displays the Approval stage

- Date displays both Date and Time of action performed.

« The User that uploaded the Document/Document Version.

« Comment: displays Version/Approval/Annotations comments.

Note: The Document Action History varies according to the document types. Some display
page information too.

{ =

The changes done to the attributes of a document when uploading the document are also tracked in
the project history (under the attribute changed event type)

You may print a printer-friendly report of the Details page by clicking Print in the header. A new page
will open showing the entire Action History which you can print using the browser’s Print command.

Viewing ArtiosCAD meta-data

82

You can see the meta-data associated with the new ArtiosCAD Design (ARD) and Manufacturing (MFG)
documents uploaded via the WebCenter interface or via an ArtiosCAD Enterprise client version 14.0.2
(or later).

In the Design Information tab (for design files) or in the Manufacturing Information tab, you can see:

« the Grain / Flute Direction

+ the Default Side for the Design (ARD) and Manufacturing (MFG) documents.



ESKO®

WebCenter

Document: acad_00001.ard

B Mail link to
Q, Open
: annlnad

I'.I'Inre -

Version: 1
Description:

Document: acad_00007.ard(20KB)

Project: tema_admin_20292_project
Approval: Cycle Started - Pending (_:. Stop Cyele

Design Information Document Information Approval Action History Annotati

Geometry 2D View 3D View (Collada) 3D Model (VRML)

Design Information

Length x Width x
Depth

Blank Size

Area

Rule Length

Grain/Flute
Direction

Default Side

Board Code

Description

Caliper

Flute

0.0x0.0x 0.0 mm

234.35 ¥ 22493 mm

296.5043 sqcm

4663.16 mm

< Horizontal

i3l Qutside

0.417 mm

Note: You can also view the 3D Model of this document in the 3D View (Collada).

- the Die Side for the Manufacturing (MFG) documents.
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SRO11506_0K.MFG

SRO011506_0K. MFG(18KE)

: prmapriCreation

Mail fink to Documeant:
Open in ArtlosCAD Varsion: 1

Description:

View and Annotatae Project

More actions... Approval

Manufacturing Information | Document Information

Manufacturing  Frint items  View

Mo Approval Required

Approva

Width = Length 940.0 x 754.0 mm
Run Length 0

Diie Press: wijze van uitvoeren
Frinting Fress: XL105

!

Grain/Flute Direction: £, Horizontal
Default Side: [ Outside

Die Side 3.*% Back

Board Code: Materlal
Descriplion Material

Caliper: 0.0 mm

Flute

Action History

WebCenter

Test Sprint33.12 @&

Annotations

Note:

Older document versions or document versions uploaded from ArtiosCAD Enterprise client
14.0.1 or earlier will not show these data.

3.12. Viewing Project History

You can view the history of various events in the Project by navigating from View History page. You can
navigate from Project > More > View History.

Any user with access to a Project, can see the events history of the particular project. Based on the
notifications setup for the project or the template for various events, records are added to the project

history.

Events are added when a Project was created and information like Project name, Project description,
customer, customer location and Project Manager of the project are logged.

Any change of the information status, due date, attribute, attribute category or permission changes
are also logged as events in the project history.
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You can filter or sort the events by the date, time, user, or event type. You can also print the View
History page.

3.13. Running a Project Report

You can run pre-configured project reports from the projects you have access to if your Admin has
given you access to these reports (see the Administration Guide for more information).

E Note: This only includes project reports. System-wide reports are available from the Search
Y menu.

1. Inthe project, go to More actions... > Run Project Report.

2. Ifyou canrun several reports for this project, select the desired report on the Run Report for
Project page.

3. If the report requires parameters, specify them (mandatory parameters are marked by an *)and
click the Run Now button.
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4. The WebCenter Viewer

4.1. The HTMLbS Viewer

4.1.1. About the HTML5 Viewer

The HTML5 Viewer is a fast and comprehensive viewing tool introduced in WebCenter 14.

From WebCenter 21.07 onwards, the HTML5 Viewer is the only supported WebCenter Viewer.

What does the HTML5 Viewer offer you?

+ Speed: fast viewing for Graphics and CAD files. High speed 3D viewing (14.1and later).
« Compatibility: high speed performance on the new client browsers.

Browser Supported Version - Windows Supported Version-Mac 0S
0s

Microsoft Edge Latest -

Firefox 4.0 or higher 4.0 or higher

Chrome 5.0 or higher 5.0 or higher

Safari - 5.0 or higher

« Reliability: high accuracy in displaying your data.
« Detail: advanced zoom to see finest details, measuring exact distances. Fast zooming.

« Customizable widgets. You can even restrict access to certain features depending on the user
preferences.

« Keyboard shortcuts. To see all of them, press ?
« Easyaccess to help and knowledge base. Search in the Help widget or press F1to access help.

{ = Note: The HTML5S Viewer does not offer live collaboration or working together at the same
time. You can use annotation threads for discussions.

4.1.2. The Simplified Viewer

Two types of desktop layouts can be viewed when you open the viewer in a normal browser: the HTML5
Normal Viewer and the Restricted (New Look)/ the Simplified Viewer. This new viewer presents a
cleaner, less complicated and clutter-free look.

Viewing Simplified Viewer
The leaner viewer offers easy navigation through some of these features:

« The Simplified Viewer comes with all the enhanced features available in the HTML5 Viewer.
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« Inthe Simplified Viewer the side panels are collapsed by default. You can open the specific widgets
that you need.

+ The new viewer allows you to resize the opened widgets (even as the side panels remain collapsed).

« With some configuration, it also allows each widget to be hidden.

Opening the Viewer in Simplified Mode

In Viewer Preferences, select the Restricted (New Look) as the Viewer Style to open the Simplified
Viewer layout. It is set to Normal by default.

This layout consists of four sections: center, top bar, right and left side panels:

« The Information bar on the top consists details of the document, the user and buttons to execute
other actions The Information Bar on page 91

« Below the information bar, you have the top tool panel with all the toolbar components. Activating
these help you perform different functions on the document. Read more in: Top Tool Panel on page
95

«  You have the View area in the center.

« The collapsible side panels contain the Viewer Widgets which are collapsed by default.

Ordering and Collapsing Widgets in the Side Panels
The widgets display document information and help perform different functions. To facilitate ease of
view, you can adjust them in many ways:

« Click the Widget Header to collapse or expand the widget.

« You candrag the widgets to either of the two side panels. The height of each widget is
automatically adapted by the side panels.

« The side bars do not disappear on collapsing but remain as a thin bar containing the widgets icons
that represent the widgets. Click the icon needed. It opens next to the side bar.

{ =w| Note: You can open only one widget per side bar at a time. If you click another icon on the
== same bar, the first widget closes.

Collapsing and Resizing Side Panels
The side panels contain all the widgets and can be manipulated in different ways to maintain the leaner
look:

Resize and collapse side panels by using the H ornToggIe Right/Left Side Bar. The side panel
becomes a thin bar containing only the icons.

«  Whenyou click the expand toggle, the panels expand to fit in both side panels and the viewport.

« Torevert the side panels to their original size, click the toggle button.

Resizing Widgets in the Simplified Viewer
You can choose to have a full or partial view of the widgets when you:

« Resize opened widgets even when the side panels are collapsed

« Dragthe widget borders horizontally or vertically. You can also resize by dragging the bottom
corner. The width and height are saved and the widget will retain these dimensions when you open
the viewer the next time.

« Restore the widget to its default size by double clicking the respective icon on the side panel.

Tools in Simplified Viewer
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The Simplified Viewer offers tools that are similar to the Normal Viewer:

« TheInformation Bar on page 91

Project WFEditor Test Document 18271 SCOTTS SA 200ml ORANGE RR_V1.paf Version: 1 Usar: ADMIN, Sys (ADMIN) E {im/] _{ = ? b4

« Top Tool Panel on page 95

Use H or B to Toggle Side Panels.

« Toopenthe widgets, click the corresponding icons:
’ Navigator on page 120

) 3D View on page 120

E View on page 122

E Channels on page 132

m CAD on page 135

Approval Details on page 117

@ Info on page 121

Help on page 138

Document Select on page 112

E Attributes on page 131

@Annotation List on page 116
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4.1.3. The Viewer Window

The HTML5 ViewerViewer comes with a number of powerful tools that make it easy to navigate, view
and compare your artwork and design files.

In the Viewer Window, you can:

« quickly scan for information regarding the active document. For example, you can view the
document size, resolution and the axes in the Info widget.

« inspect the document using the top tools and the Navigator widget. The channels of the document
will be visible in the Channels widget.

« compare the document to a reference selected via the Document select widget.

« browse and inspect individual pages of your Page List using the Page List widget.

« view the approval details of your document.

« approve orreject your document

« view CAD design and CAD layout files. You can see the available layers in the CAD widget.

« view the annotations and comment on them. You can also annotate on your documents.

« view, compare, annotate and approve Page Lists and multi-page documents.

« view CAD Overlay referred in Graphics.

« view document attributes and document reference attributes, edit and save them.

« openthe HTML5 Collada Viewer to view documents in 3D.Viewing 3D in the HTML5 Collada Viewer on
page 182

Projecl: WCR-4857 variation 2 Document: -- Expart Text Content Demo ( i w Show Annolations Swilch 1o Edi . ) Sathish, Bata(BLSA) [g] T & = ? X
Hmvigatice on na =] e nnatation Share
a@ea@aaeaa® &M = =) [ i @,
(] = Document Select v Mavigator
Current: :
Text Conbent Demo (1).3i ...

Export Te:
Pr0|='rt WCR-4857 variation 2
Version: 1

<, CHYl
Click to select a Structure Documnent. - Flc‘},ﬂo:lr:g:\ll:;“ég[l + Channels
— H 4
3 Nutrition  PN*pms
3!“;“0: ::lrz(’:anlainer @ [l opagque white spot color
T Cyan
Magenta

EXCELLENT SOURCE
OF H.ECTHOLYTES

silver cold foil

Cut
@® [l gioss spot UV vamis
@ || matt spot UV varnis

GY D R I N K ———— = : v Approval Details

CALORIES SUGARS|  FAT SODILM

ALORES | suGaRs | FAT | soDIUM | 0 G&_; GTg OTS —1 A
000501 015 — B ©-- v

’ MANAGERS (LARGE GROUP)
1% [<1%] 1% | 9% 7 " {LARGE GROUP)

+ Info 3

Document Size: 205.78 x 90.05 mm s
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The Information Bar
Top Tool Panel
Toggle Side Bar
Document Select
Attributes
Annotation List
Approval Details
The View area

3D View

. Navigator
. View

. Channels
. CAD

. Info

15.

Help

See also: HTML5 Viewer video tutorial.

The Viewer Window Layout

The Viewer window will be in the desktop layout if it is opened in a HTMLb compatible desktop browser.

When you open the Viewer in a tablet or a smart phone, you will get a mobile optimized layout.

This example layout has:

I N

the top panel containing the information bar and the top tool panel.

the central panel where you will see the document / image being viewed.
the left sidebar

the right sidebar

collapsed widgets.

amodal widget

Customizing the Viewer Window Layout

You can customize your window to suit your needs. You can:

click-drag:
- awidget to the center of the window (outside of the side panels).

This will make this widget a modal window. You can make a widget modal when you want this
to always appear in the Viewer even when the browser window becomes small. The widget will
remain modal even when you restart the Viewer.

« awidget up or downin the same panel.

+ awidget from one panel to the other.

collapse or expand a widget by clicking on its header. The sizes of the widgets in the side panel will

adjust according to its contents. The scroll bars will help you navigate within the widgets.

adjust the width of the side panels by dragging the border line.

use the Toggle Sidebart option to collapse the sidebars.


https://www.youtube.com/watch?v=IlOeeIVf_5c#t=168
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Note: Your layout settings will be saved for your next use.

See also The Viewer Window on page 89.

Note: If your browser window becomes too small, the sidebars will be collapsed automatically.

Make your window larger to view the sidebars again. The modal widgets will stay in its location.

4.1.4. Opening a Document in the HTML5 Viewer

To View and Annotate in the HTML5 Viewer, you have to set your Viewer Type in the Preferences.

To open adocument in the Viewer, click the document's thumbnail or the Q button.
You can do this from:

« the My Work page (under My Approvals if you have documents to approve or under Approvals to
Follow Up if you are an Approval Master)

» the Documents tab in the project

« the header of the Document Details page.

« the View and Annotate link in the Documents/Bill Of Material page

To load multiple documents into the Viewer, select them and choose Actions > View and Annotate .

To open adocument in 3D, click 9 from the CAD on page 135 widget or the Document Select
widget. Read more in: Opening Documents in the 3D Viewer on page 185 and Viewing 3D in the
HTML5 Collada Viewer on page 182.

4.1.5. The Information Bar

The Information bar displays:

The Project name
The Document name

The CAD info icon: If your CAD files were saved using ArtiosCAD 14.0.2 or newer, you will see CAD

. . Deocument: BoxCo.ard (Version: 1 .
info icons (v )& B . The icons are:

« Grain/Flute direction (Horizontal or Vertical)

_0_180_ front.pdf (Version: 1) & ﬂ

Honzontal Flute (Corrugated) or Gramn (Folding Carton)
« Side(Inside or Outside)

- Die Side(Die Knife Side or Back Side, only for MFG files)

The Version number and the Revision letter.
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. Note:

|
In Compare mode, the two document names and version (revision) details will be visible
separated by /.

comparelb.pdf (Version: 1) / comparela.pdf (Version: 1]

- Show Annotations toggle button to make annotations visible in the document viewed.

« Switch to Edit Mode to enable editing functionality for Al (Adobe Illustrator) or PDF documents. This
option comes with the Automated Artwork license.

« Switch to Deep Zoom Mode to enable Deep Zoom functionality on Al (Adobe Illustrator) or PDF
documents. This option comes with the WebCenter Cloud Viewer license.

« The User Name

{ . Note: This will be used in Annotations and Approvals

« Configure Workspace to customize workspace according to the user preference or switch to
another workspace according to the user role. Read more about Workspace in Viewer here.

{ . Note: You can also switch between 'light' and 'dark’ style viewers in the workspace

‘ configuration.

4 4 of 3
Page Navigator

This is only available when a multi-page document is active.

Use this to navigate through the pages of open documents. Or navigate to a page by typing in the
number and pressing Enter.

Read also Viewing Multi-Page Documents and Page Lists on page 171

The PrintER button. This opens the Print Dialog.

* TheResetMbutton. Use it to reset the layout of the viewer to the default.
" The Show Keyboard Shortcuts button .

Click this or type in ? to see the keyboard shortcuts.

?
To Display Help Pages ~ button to open help pages.

Tip: To access online help, use the keyboard shortcut F1or click

The Close button X . Use this to close the viewer and return to WebCenter. If changes have been
made to annotations or to the approval state, the user will be prompted to save or discard the
changes.

Viewer Workspace

A Viewer Workspace is a customizable set of tools and widgets for a user in the viewer. Every user has
aworkspace assigned based on the role of the user in the project, a personal workspace or the system
default and same can be customised by the user in the Viewer.
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Admin users can choose to change the default workspaces to show/hide more widgets and tools for
each User or Role. To make the change to the workspace in the Viewer, navigate to the Information
Bar > Configure Workspace option.

Read more about Workspace configuration by Admin Users here.

Choosing a Workspace in Viewer

When the user is present in more than one role in any of the projects the document is present in, then
a drop- down with all the available user roles and its respective workspaces are available for selection.
You can choose the workspace you want to use in the Viewer.

Widgets and Tools Configuration

To customize a workspace as per your requirement, select the option Configure Workspace. A pop up
window is available to make changes to the workspace.
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Workspace Configuration >
Workspace

General preferences Workspace v

Color Theme
light »
Tools Widgets
» B Navigation & Approval Details
¥ B Orientation & Attributes
~ [ Measure {7) Component
== Ruler ¥ Discussions
N Barcode T Content
.. Braille [# Annotation List
1 Measure Color Percentages W CAD
#E Calculate screen ruling and angle (1 Document Select
T Caliper ® Info
> B Text E' Channels
> B Compare £ Navigator
+w [ Annotation ) 3D View
S F Add Annotation Q View
& Note Annotation B Keyframes
Toggle 2D0/3D I8 Files marked for Edit
Toggle Dynamic Content B Actions

> B Thumbnail
[ Share for Viewing
Assisted QA

Other Settings
Switch to Edit Mode

Allow loading more documents

Visible
Available Reset Workspace  Close EEVGERCRYL S G

Firstly choose the workspace that you wish to use and configure. You can also choose the Color Theme
of the viewer specific to the workspace.

Tools and Widgets set to Available or Visible for the workspace by the Admin user are shown. You can
further configure to suit your requirements.

« Visible: Check box is selected for for the tool or widget and is currently available in the viewer.

- Available: Check box with a dash or dot ( depending on the viewer). Tool or Widget is available but
unchecked and can be checked and added from the viewer.

« Hidden: These are not available in the Viewer Workspace at all and means it is a unselected by the
Administrator in the Setup.
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Any configuration changes made to a workspace does not have any impact on other users and are

saved only for the specific user. You can undo the changes made to your workspace by selecting Reset

Workspace.

4.1.6. Top Tool Panel

The Top Tools Panel contains some of the Viewer's most used tools. They help you in document
interaction.

Navigation Tools

Q Zoom tool

N Zoom in tool
elZoom out tool
l::E)»Zoom to 1:1Pixel

lE)»Zoom to Actual Size

e Fit Document in View tool

@Pan tool

See Interactive Zooming on page 97 for more information.

Orientation Tools

O Rotate view tool
FS Mirror view tool

See Rotate and Mirror on page 99.

Measure Tools

§ Ruler tool to Measure Distances and Angles on page 99

& Measure Color Percentages on page 102 (densitometer) tool

] Check Bar Codes on page 105 tool

Check Braille on page 102 (Powered by Global Vision) tool

X Caliper

Text
« Select Text
« Detect Font
« Check Font Sizes
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» If you have opened a document in the HTML5 Collada Viewer once, the top tool panel will show an

Open 3D View 9 putton.
Annotation Tools

ﬁ Hide Annotations on page 149 tool
D Add Annotation on page 138 tool

‘b“’] Note Annotation on page 142 tool

See Annotating in the Viewer on page 138 for more information.
Page List Tools (only when viewing a page list / multi-page document)
T M

Read more in Reader Spread View on page 172

Reader Spread view

4 P Arrowsto navigate between pages or spreads

. S

"I Mark the active page. A yellow star indicates that the active page is marked.

¥ Clear Mark from the active page.

Compare Tools (only when comparing)

You can only see the Compare tools when you have two documents open to compare (see ).

View Current Version

=l View Reference Version

%2 View Both- Blinking

IE‘—-I View Both-Show on Top
& View Both-Show Difference

S View Both- Side by Side

See Compare Documents in the Viewer on page 157 for more information.
Share Files

o [

Share for Viewing

Approval Tools (only when an Approval Cycle is set up)

The Approval tools are only available when an Approval Cycle is set-up and you are an approver for the

document. The number of Approval tools may vary depending on the approval setup.

‘ Approve
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. x| Reject

Forward

© Comment

If you are the Project Manager in WebCenter, you have tools to

~ Force Approve
.S Force Reject

See Approval on page 153 for more information.

Interactive Zooming

You can use the zoom tools from the Navigation Tools to view the fine details of your file.

Activating the zoom

Select the Zoom tool A to activate the zoom. Alternatively, activate the Zoom tool by pressing the Z
key.

When Zoom is activated, the mouse pointer changes to B icon. Use the following shortcuts to
effectively use the zoom function.

Click Zoom in by a factor of two
Right -click Zoom out by a factor of two
Alt + click Reverse the zoom to Zoom out a

scroll Zoom in/out with the location of the mouse as center.

Tip: Double-clicking on the zoom tool X will fit the document back to view from whatever
zoom factor it was in.

Zooming into a specific area

Use Click-drag action to zoom into a specific area to examine the finest details of your document.
When you hold the left mouse button and drag, a selection rectangle will appear. You can change the
size of the selection rectangle by dragging the mouse without releasing the left mouse button.

To move the selection rectangle around, hold the left mouse button and space bar while dragging.
When the left mouse button is released, the viewer zooms to fit this rectangle.

If you are zoomed in with a ratio 1:10 or more, each document pixel is displayed with a small border as a
grid. In compare modes, you will see the active document area as grid.

Zoom to 1:1Pixel

When you have artwork with a defined resolution, you can use it to zoom to the image resolution.

Right-click on Qand select from:

« Zoom to 1:1Pixel: use this to view the image in its rasterized resolution.
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» Zoom to Actual Size: use this to view your artwork or image in the size corresponding to the
printed size. You may need to set your monitor resolution to make this accurate.

{ . Note: When the monitor resolution is not set or when the image resolution is not set,

' the Viewer takes 72ppi as default.

- Set Monitor Resolution: use this option to set your monitor resolution. Your set monitor
resolution will be stored in the Viewer.

« You can specify the resolution as a decimal number (e.g. 36.05 ppcm) or as a fraction in the
pixels / size format. Read more about thisin the Knowledge Base article.

{ ' Note: Your settings will be saved for your later use.
]

Using the Pan Tool

To pan the view, click the @ Pan tool or activate the Pan tool by pressing the H key. The pan tool lets
you grab alocation in the document and drag it to a new location.

. Tip:
]
« You can pan the document by holding the space bar and dragging a line in the Viewer
window. When you release the space bar, it returns to the previous mode.

For a single pan action, use the@

. Tip:
]
While panning, you can zoom in/out with the mouse point as the center in the following ways:
« double-click to zoom in
» right-click to zoom out
» scrolltozoomin/out

Using the Navigator

When you are zooming in the document, the navigator shows the highlight area as the zoomed area. To
pan the document, hold the mouse and drag this selected rectangle around. The central view port will
display the area correspondingly. Clicking outside the rectangle will move the rectangle to the clicked
point and update the current visible area.

When the zoom is not activated, you may use these short-cuts to work with the zoom.

Ctrl+/Cmd + Zoom in one step

Ctrl-/Cmd - Zoom out one step

Ctrl0/Cmd 0 Zoom to fit. This will adapt the zoom to fit the entire image in the current
window.

Double click the zoom tool Zoom to fit
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Rotate and Mirror
You can rotate or mirror the document in view using the Orientation tools

A
O Rotate view: Rotates the current view by 90 degrees clockwise.

FS Mirror view: Mirrors the current view.

Use this to flip the document vertically from the center of the screen. If you are zoomed into an
area, the center of this area will be used as the reference.

Tip: The shortcut Ctrl+M can be used to flip the view.

Measure Distances and Angles

The Ruler tool calculates the distance between any two points in the work area with a click-drag-
release action.

When you measure from one point to another, a line is drawn and you can see measurement
information such as:

« The starting location(X and Y).
« The angle measured relative to the axis (A).
- The total distance (D), the Horizontal Distance (W) and the Vertical Distance (H).

inapop-upin the View.

Measuring the distance

1.
Select the § Ruler tool.

2. Specify the measurements in the pop-up tool bar that appears below.

E: Displays the Angle (A) and the Distance (D)

i
+=+: Displays the starting and end location (X and Y)

.
L'I'J: Displays the horizontal (W) and vertical (H) distances traveled from the x- and y-axes.

E Note: You can choose to display all of the measurements by selecting all of the above. If
you select just one, corresponding measurements will be displayed.

]ﬁ: Displays the Angle (A) positive upwards (Counter Clock Wise)
[\_{: Displays the Angle (A) positive downwards (Clock Wise)
) .: Changes the color of the Ruler line in the View

. : Resets the color of the Ruler
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3. Drag from the start to the end point.

1
An information pop-up located at the end point will display the measurements. The location += will
be visible at the start point.

You can drag the line to another point and the ruler will update its measurements. To move, drag the
start or end point to another location.

Qeaaads vk =1 N

Navigation Origpumsia

e e

!
A
FTERPSN

T o N A 1./ A Make Annotation _

Note: While viewing CAD data, then the Ruler will snap to the end points of most line segments
in the CAD drawing.

N4
)
ey

Tip: The Ruler tool can be combined with different view tools. You can for example indicate a
certain point, then change the view by zooming out, navigating, and then indicate the second
measuring point.

To make an annotation from this pop-up, click on the Make Annotation option. You will get an arrow
annotation with the current measurements as its content.

D: 24.60 mm
A: 50.68°

/" Make Annotation

Measure Screen Ruling
You can use the Screen Ruling and Angle & tool to measure the ruling and angle in digital film files.
Click ® to activate the tool and then select a point in your file or drag it to measure within an area.

The measurements are shown in the Channels panel and in a pop-up near the point or area you
measured.
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75.06°

M 58.48 Ipcm [/ 45.48°
M 58.48 lpcm / 14.93°
58.26 Ipcm / 89.96°

O mMake Annotation

AR H0PH v
...‘0..005

LR
CR Y
LR
X
XEy:
XX
RN
XY
TR R R

For each measured channel, you can see the lines per millimeter (lpmm) and the angle (degrees) of the
line in the pop-up. When there is no screen in a channel, the value will be blank.

You can change the units of the measurements from the information pop-up. Click the settings Q

button and select your preferred units. Your units will revert to the User Preference settings when you
close the active session.

lpmim

|pcm

Ipi

degree

l|pmm,degree
" |lpcm,degree

|pi,degree

Screen Orientation CW
& Screen Orientation CCW

To change the orientation of the angle to either clockwise (Screen Orientation CW) or counter
clockwise (Screen Orientation CCW).

To make an annotation from this pop-up, click on the Make Annotation D option. You will get a
rectangle annotation with the measurements as its content.
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Measure Color Percentages

You can use the densitometer & tool to measure ink coverage at a certain point or at the selected
area.

Click in your file with the densitometer tool to measure the color percentages at a certain point, or drag
it to measure densities within an area. The densities are shown in the Channels panel and in a pop-up
near the location you measured.

Channels Channels
= 0.00 % ==l IR
| 16.00 %
O 20,13 o [=][Jan 106.13 %
[ | 0.00 % =llc 0.00 %
] 0.00 % B I 16.00 %
| 106.13 % =] 50.13 %
[ [ Make Annotation [=]l« 0.00 %
[=| Il cut 0.00 %

You can also click the j tool button to make a measurement based on the current view. In this case,
the densities are only visible in the Channels panel.

@ Note:

© While viewing Digital Film files, you can change the units of the information pop-up. Click the

Unit Settings W button and select your preferred units. Your units will revert to the User
Preference settings when you close the active session.

To make an annotation from this pop-up, click on the Make Annotation D option. You will get a
rectangle annotation with the measurements as its content.

Check Braille

. . . .
Check Braille *"** tool allows you to analyze and interpret the Braille text in the selected language.

Note: The toolis visible only when the system has an Advanced Approval License.

Select the area around the Braille text with a click-drag-release action. You can also select the Braille

. il . . .
text areaandclickthe **** tool tointerpret the selection. The result appears in The Channels Panel
and in a pop-up near the location you measured.
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You can choose the language from the language list by clicking on the current language visible under

WebCenter

e English o

[1] test [2] braille [3] thinkinpress
[ make Annotation

the braille tool.

Note: By default, English is selected. See also: Braille Languages Supported in the Viewer on
=== page 103

The tool checks the validity according to the Marburg Medium Braille Specification. A green tick-mark

indicates a valid Braille. If the selected Braille contains at least one regional code that doesn't pass

these checks, you will see a warning.

@ Note:

The validation check has a Tolerance of +/- 0.1 mm and a dot diameter range of 1.3 - 1.6 mm.

See details below:

2.5 mm horizontal dot to dot

2.5 mm vertical dot to dot

6.0 mm from cell to cell

12.0 mm from cell to cell with single space in between
10.0 mm line spacing

When multiple lines are present in the Braille text, a line number in square brackets will be shown
before the text of each line. For example, [1] for the first line.

B [1] boots cold and flu [2] relief echinacea

To make an annotation from this pop-up, click on the Make Annotation D option. You will get a
rectangle annotation with the measurements as its content.

Braille Languages Supported in the Viewer
/1 1: English
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/12:
/13:
/1 4:
/15:
/1 6:
117:
/1 8:
/19:
/710

/111

1112
/113
/114
/115
/116
1117
/118
/119

French
Polish
Portuguese
Russian
Spanish
Finnish
German
Italian

: Latvian
Romanian
: Slovene

: Swedish

: Hungarian
: Dutch

: Maltese

: Danish

: Greek

: Bulgarian

/1 20: Czech

112

: Estonian

/1 22: Lithuanian

/1 23: Irish (Gaelic)
/1 24: Albanian

/1 25: Basque (Spain)

/1 26: Belarusian

/1 27: Catalan (Spain)
/1 28: Croatian

/1 29: English (UK)

// 30: Faroses (Denmark)

/131

: French(Traditional)

// 32: Galician (Spain)
/1 33: Greenlandic

/1 34: Icelandic

/1 35: Kazakh

/1 36: Norwegian
/1 37: Serbian

WebCenter
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/1 38: Slovakian
//39: Turkish
/1 40: Ukrainian
/1 41: Uzbek

Check Bar Codes

Use the Check Bar Code ] tool to analyze and interpret the Bar Code text in the selected language.

Select the area around the bar code with a click-drag-release using the left mouse button. You can also

select the area and click the ] tool to check the bar code. The result appears in The Channels Panel
and in a pop-up near the bar code.

The following information will appear in a pop-up:

« Type: The bar code type
« Value: The encoded value
» Magnification: The bar code magnification in percentage (visible only when the value is not 100%).

« Bar Width Reduction: The line width compensation in mm. (visible when the value is not 0).

Fi CArAl K ® 0 ©

Measure Annotation

Approval Details

No Approval Setup Defined

FL s L P—
Channels
“
= T . H 4
- = Al
B C39: 3563442 =-« E 00
o= .| =
u =T [ <55
m =|r- 3 % [=] Il 280 C39: 3563442
o =" g8 g [zl
=] = $‘ § B IS
[JMake Annotation 5 2| [=] Il oie
o < oo
[=][l 137
fovaniv] ‘ gg |=| M braille
\55 = > o=

Note: The information will be displayed in the following order :

<Type>: <Value> <Magnification> % [<Bar Width Reduction> mm]

. Eam15:0 8711743206100 101.0 % [-0.01 mm]

The tool is visible only when the system has an Advanced Approval License.

To make an annotation from this pop-up, click on the Make Annotation D option. You will get a
rectangle annotation with the measurements as its content.

105



ESKO

106

WebCenter

Caliper

Use the Caliper L tool to measure and standardize the height or width of aligned objects in the
Viewer. For example, you can use this to check the text height in your artwork. You can create a Preset
to customize your Caliper to your standardization and compliance needs.

Click the Caliper L putton from the Measure tools to activate the tool. You will get the Free style as
the default Caliper form. In the sub tool bar, you can:
« select the Style. Choose from the Style options:

- Free(Default)

- Fixed
+ Preset

» specify the Gap Size which is the distance between the start and end lines. If your selected style is:

+ Free, changing the Gap size will alter the end line.
+ Fixed, the distance between the start and end lines update according the Gap size.

« Preset, the saved Gap size will be applied

define the orientation as either vertical I H) or horizontal (*™W).

- Save the Gap size and orientation as a Preset. The saved Presets will be added to the Style drop
down. Use the Delete Gap option to delete the saved Presets.

Free (Default option):

» Hold down the left or right mouse button to draw the start line and drag to the end line. Release the
mouse when the desired width or height is achieved.

« Toadjust the height / width, simply drag the lines. You may also move the caliper form from one
location to another.

If the horizontal distance between two selected points is larger than the vertical distance, you will
get a vertical form to measure the width.

If the vertical distance measures more than the horizontal, you will get a horizontal form to measure
the height.

Note: The Caliper tool will switch to horizontal or vertical orientation corresponding to the
direction of your mouse movement.

A pop up will display the current gap size and the X/ Y coordinate of the end line. The information is
updated when you move the lines of the Caliper.

« You can Save/Delete the Gap size and the H/ W as a Preset on your profile. This allows you to have
a customized Caliper form for your future use.

Fixed:

In this mode, you can specify a fixed Gap size. Use this when you want to standardize your artwork
object to a pre-determined size. For example, if you have a certain text height needed in the artwork,
specify that as the gap size and check the artwork text.

« Specify the Gap size.
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« Use Hor W button to fix the Caliper orientation.

(7, l Note: When it is fixed, the your mouse movement will not alter the Caliper orientation.

« Hold down the left or right mouse button to draw the start line and the end line will be drawn
according to the Gap size.

« Click Save to create a Preset with the current measurements(the gap and the orientation).

Preset:
Select your saved Preset in the Style selector. Hold down the mouse to draw the lines with your preset
Gap size and Style.

(f ’ Note: In the Fixed and Preset mode, you can grab the start or end line to drag the form to
another position.

Press Esc to revert to initial state (no lines drawn).

Text Selection in Viewer

You can select the text in the document by clicking on Text Selection button for any PDF, Al files and
documents with SVG perspective in the Viewer.

When you select the text, you can also

=t M i x [E]A a % B Oe
x

ngradients 212w ~ Q e

. Searchintext: Search for specific text in the sub toolbar of the text selection tool. The searched
text is highlighted which you can zoom to or navigate to the selected text using the previous and
next buttons in the sub toolbar.

Select all text: Select all the text statements in the document using the Select All 2% You can also
alternatively select all the text using Ctrl+A keys in the keyboard. Right click on the selected text to
either highlight the text or add an annotation or copy.

You also have an option to find the font and the font sizes used in the document.

« Detect Font : Click on thisicon and then click on a selection of text to detect the fontin the
selected text. A pop over is shown with the Font, Font Size, Selected text and an hyperlink to make
annotation.

« Check Font Sizes: Click on thisicon and then select the font size using the text box or slider to
detect text which text is smaller than the selected font size.
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Text Edit Mode

Switch to Edit mode

You can edit the text in the artwork document by enabling the Switch to Edit Mode option. This allows
you to correct or change the text instantly from the WebCenter Viewer.

Click on the Switch to Edit Mode icon, to switch to edit mode. Following widgets are enabled when
you Switch to Edit mode.

« Annotation Widget
« Files marked for edit widget

« Actions widget

« Channels widget

« Navigator widget

« Infowidget

« Help widget

« Zoom/Pantools

« Rotate/Mirror tools

« Text Selection tools

« Switch back to view mode and save button

You can choose the files where the text has to be edited in bulk in Files Marked for Edit widget.

Deep Zoom Mode

You can load the artwork document in Deep Zoom Mode by clicking the Switch to Deep Zoom Mode
option. Deep Zoom functionality allows you to view Vector Graphics details with more accuracy. Apart
from that, Deep Zoom Mode brings some additional functionality.

Layers Widget

When a graphical document containing layers is opened in the Viewer's Deep Zoom mode, the Layers
widget becomes available, showing all the layers of the opened document. If no layers are defined

in the document, the Layers widget is hidden. Each layer can be enabled or disabled by clicking the
eye checkbox. The header contains an option to enable/disable all layers. Right-clicking an individual
layer's eye icon will only show that specific layer and disable all other layers.

The Layers widget also displays which layers are printable. When opening the application only the
printable layers will be enabled. The user has a reset arrow button available in the header of the widget
to return to thisinitial state at any time.

Some layers also have a type (or Processing Step), and a checkbox if the layer is marked as printable.
By default, when opening the application only the printable layers are enabled. If at least one layer
has a type specified, the user has a filter icon in the type header that allow him to disable/enable the
processing steps by type.

Color Management Widget

When viewing a document in Deep Zoom mode, the Color Management widget is available. This widget
allows you to enable and disable color managed viewing. When enabled, it will load the embedded color
profile and display the name of that profile.

If no color profile is embedded, it will fall back to “ISO Coated v2 300% (ECIY".
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Quality Control

The Quality control widget is used to check the print readiness of a PDF document. This widget is not
available by default. The widget is displayed whenever the Administrator enables it to a userin the
Viewer Preferences of Share and Approve.

To enable the Quality Control, click the Quality Control tool . and select the views from the drop-
down.

Object Screening

Quality Conirol

+ Object Screening +

Using the Object Screening Preview, which is the default option, you can get an indication of what
Screening Set is used on what objects. Objects using a specific screen set is shown in the document
window. Areas where multiple screen sets overlap are shown in different colors.

Total Area Coverage

Quality Control

+ Total Area Coverage v

Limit 5pp

The Total Area Coverage (TAC)is the sum of all separation-densities at a certain point in your
document.

To enable the Total Area Coverage preview, select "Total Area Coverage" from the Quality Control
dropdown list

Once the Total Area Coverage preview is enabled, the image in the preview pane is dimmed and areas
where the sum of the densities is higher than the TAC limit specified in the current Press Setting are
highlighted.

Limit
Limit is the maximal Total Area Coverage that your document may contain. This value depends on the

press and the substrate the design is printed on. Printer should provide you with the TAC Limit value to
use.

You can set the value up to 500%.
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Breakout

Quality Control

v Breakout

Limit qp

A Breakout is an area where the percentage of a single separation is lower than the First Printable Dot
value. This is used to track areas that are not shown in the print because the values are too low.

Your printer should provide you with the First Printable Dot value.
To enable the Breakout preview, select Breakout from the Quality Control drop-down list

Once Breakout is selected and enabled, all areas where a single separation has a value lower than the
First Printable Dot value (but higher than 0%), will be displayed in highlight color.

Moire Detection

Quality Control

¥ Moire Detection
Densities 5
Luminance gg
¥ Angles are the same

+ Difference between angles is not 30

¥ Rulings are different

¥ Dot shapes are different

Using the Moiré Detection preview, you can detect possible screening problems in your document.

If you enable Moiré Detection, the document is shown dimmed, and areas with possible screening
problems are highlighted.

A possible screening problem exists if one of these conditions is met:

« theangles for the separations used in that area are the same or do not differ 30 degrees.
« therulings for the separations used in that area are different.
« the dot shapes for the separations used in that area are different.
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Open 3D View
If you have opened a document in the HTML5 Collada Viewer once, the top tool panel will show an Open
3D View 9 button.

Click this to generate the 3D View.

Finishing Profile
When you select the 3D button in the top bar, two new widgets appear namely

« Print Finishing

«  Geometry

When your document is a PDF or Al Document, it is possible to simulate the Finishing effects in the
3D Viewer. To do that, the user can select a Finishing profile when a 3D structure is selected in the
Compare Widget.

The Finishing Profile is a file that can be exported by Studio. When stored in the same project as the
Graphic Document or in the StudioManager project, it will be possible to select it in the Viewer.

Note: Generation of the Graphics with a Finishing Profile may take a while.

25D

You can preview your artwork with finishing effects without having a Collada file available. In the
Document Select Geometry widget in the viewer, you can navigate to Structure Document Shape
option.

There is a built-in Structure Document curved sheet that is used to see how the artwork would render
ina 3D environment. You can change the angle of the curve as per requirement.

[:l v Document Select

Current:

GETSET_250ML_APPLE.pdf &
_ Project: lefr v

Version: 1

Compare with: | ] "‘ SPORTS
I HYDRATION

Click to select a Document (page)

Structure Document:

‘ U Show on Curved Sheet

Alignment: &
Finishing Profile | Metal - Dry Offset
Angle 90  degrees

m
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Click on the Open 3D view button, to show a surface in the angle that was chosen. The surface contains
the graphic, which will follow the selected Finishing Profile.

4.1.7. Document Select

12

The Document Select panel allows you to select the Current view from the multiple files (documents or
document versions)loaded into the Viewer.

The panel will contain three document lists:

¢ Current
« Compare with

« Structure Selector( only available with Graphic Documents)

» Document Select ha

Current: & £ 1of2 > B

732767 _tagged_MegaPack.ai "

Project: BLSA PCM New
Version: 1

-

Compare with:

s ArtFile.ai PN

" { Project: BLSA PCM New
Version: 1

From the Current list, select the file you want to view. You can switch to different documents view from
this list.

You can also add new documents in both Current or Compare With to the list by clicking on Find More
Documents. This opens a Select Document pop up window. You can filter the document based on the
Document Name or Project Name.

Note: If you do not want to compare documents or versions, leave the Compare with field
empty.

Compare To

The Compare To list contains the possible reference documents. Select the reference document from
this list to compare to the Current.

When a reference document is selected from the Compare to list, the lower part of the panel will
display controls for adjusting Channel Matching, Orientation and Alignment.

Read Compare Documents in the Viewer for more details.

Selecting Documents

You can select the current and the reference versions using the two document selectors in the
Document Select panel.
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E b ] Note: The reference document type has to be the same as the active document type. For
Example, when a CAD document is active only other CAD documents can be selected as the
reference.

The The Information Bar displays the selected active and reference document name and version.

The Viewer will start the last used compare mode except the Show Current and Show Reference
modes.

Selecting Multi-Page Documents
You can select the Current and Compare to pages using the two document selectors in the Document
Select panel.

While comparing multi-page documents, a Reset o button is enabled in the Document Select header.

If you have defined a special mapping for comparing pages of multi-page documents, you can use this
to reset the mapping. You have to specify whether to reset the mapping of the active page or for all
pages.

Read also Channel Matching, Orientation and Alignment in Compare Mode.

Structure Document Selector
While viewing a graphic file with CAD reference, the Document Select widget will have:

« aStructure Document selector listing all the CAD documents and 3D Documents opened in the
Viewer and the CAD references associated with the graphics file.

If a Structure /CAD reference is found, you will see this in the document select panel with a link ==
icon. You can select this to view together with the graphics document. If the graphics file does not
have a XMP link, you can use the document references feature to link them.

To remove the CAD link from the graphics file, click Turn off CAD Overlay in the CAD Overlay
selector and Save.

Read morein: Viewing CAD with Graphics.

Open 3D View & putton. Click this generate a 3D View.

E ] Note:

The 3D button will be available in this widget only when it is possible to generate a 3D from
the current Graphics and the selected or referred CAD overlay.

Use Ctrl+S to switch between Show Current and Show Reference compare modes

Multiple Documents Select option

You can view multiple documents one by one in the viewer. To view, select the multiple documentsin
the Documents panel and click View and Annotate. In the Viewer, Document Select panel, you can
choose the documents in the Current and Compare to options.

You have the option to go the first document, previous document, next document or to the last
document chosen with the arrow keys.

13
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» Document Select

Current: W € 1o0f2 3 B
| sadgfsdg.ard &
Project: NAPROOOZ -
Version: 1
Compare to:
Click to select a difference Document page. -

Current selected Document Index displays the number of documents selected and the number of the
current document displayed.

4.1.8. Page List

14

The Page list panel will be available when you open multi-page or page list documents.

~ Page list <]

Here you can:

« see the thumbnails of all the pages. Each row will contain two thumbnails.
« configure size to Small Thumbnails, Medium Thumbnails or Large Thumbnails

« view a specific page by clicking the corresponding thumbnail. The thumbnail of the active page will
be highlighted.

« view the page name or folio for the thumbnails. This allows you to select a page corresponding to a
folio or page name.

« view which pages are annotated. These pages will have a note on the thumbnail.

« view the approval status of individual pages of a Page list. A blue circle indicates the pending
approvals on a page. Read also Approval in Page Lists on page 174.

Note: You can define page by page approval in a page list. For a multi-page document, the
== approval set-up is for the entire document.

« view the blank and empty pages as thumbnails. The blank pages of a page list will be displayed as
white thumbnails and the empty pages as crossed thumbnails.
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Note: You cannot view empty pages. You can view the blank pages, but you cannot
&= annotate or compare them.

Tip: You can collapse other widgets to make more space for Page List panel while viewing
large multi-page or page list

=

Read also Viewing Multi-Page Documents and Page Lists on page 171

The page thumbnails of a page list or multi-page document are displayed according to the binding
type:

Left edge binding: The first page and the odd numbered pages are displayed on the right. The even
numbered pages will be on the left.

Page list

x
L%

=
LA™

Right edge binding: the first page and the odd numbered pages are displayed on the left. The even
numbered pages are displayed on the right.

Page list
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4.1.9. Annotation List

116

The Annotation list panel provides a listed view of the existing annotations in the currently viewed
image. You can collapse this panel to hide the annotation list panel.

You can see them in the created or modified order depending on the setting and filters. Replies are
visible immediately below the corresponding annotation in the created/modified order.

Annotation List é"_! [ -Q‘I
Customn Filter is Enabled v
Custom Filter is Enabled r
3 of 11 threads shown 4

2 0O peeters, mipe (MIPE1) dar 31, 2015

This is an old loge, please update the logo to the new one.

&/ "Accepted": Peeters, Michiel (MIPE)
" "Accepted": peeters, mipe (MIPEZ)

peeters, mipe (MIPE2) far 31, 2015

1 do not have the correct logo, can somebody else change it
please?

+" "Accepted": peeters, mipe (MIPEL)

Custom Annotation Filter X

Match | All ¥ | of the following:

Review State T ||is ¥ ||Accepted T

@ Add a Filter Row

The Annotation list panel has tools to:

« Save annotations
« Step through annotations

« Reload:

You can Reload the annotations of the active image. This reloads all annotations without restarting
the viewer. You will be warned about unsaved annotations while reloading.

« Annotation Options
« Filter Annotations

« Create Custom filters for annotations

If you select an annotation either in the annotation list or in the viewport, this will be highlighted in the
annotation list. You will also see the possible options concerning the annotation and its replies.
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{ = Note:

B

The time will be displayed as bh ago, yesterday, 2d ago... To see the exact time, hover over the
displayed time.

{ =l Note: Invideo annotations, start time and end time of the annotation is displayed in
= thelist.

Prakash, Mandini {(MAPR) 4m ago

Change the color schame

Tip:
If you click and hold the left mouse button on an annotation in the annotation list, the
annotation becomes highlighted in the view.

From within the Annotation list panel, you can:

Set Review State W of the annotation

Zoom to annotation e
If you are the author you can perform more actions via More actions ###

Edit Annotation
Duplicate Annotation

Use this to make a variation (e.g. correction) of an annotation made by another user.
Save Annotation
Delete Annotation

You can only delete comments that you have authored. All the replies to the deleted comments
will also be deleted, irrespective of the author.

Filter annotations by User or Review State.

Click Y Edit Custom Filter to get the Custom Annotation Filter window.

Lock Filter by clicking the pin #

If you lock a custom filter, it stays active for other documents and consequent viewer sessions.

Approval Details

In Approval Details, you can see:

the current approval status

n7



ESKO

« the approval actions
« approvalinfo.

Approval Details
Approved

Type: User
Status (Version): " Approved (1)
Approval Date: Sep 1, 2014 at 16:39

v

Approver: Van Ongevalle, Bram (BVON)

You can collapse/expand this widget and drag it around.

4.1.11. Content Widget

18

WebCenter

Artwork documents that contain Images, Symbols, Tables, Text Contents and Barcode as reference
documents can be viewed in the viewer. You can view all the above content or filter the specific

content to view in the Content Widget.

If the artwork (Al or normalized pdf) contains location information for any of the dynamic elements,

then an annotation is shown around the dynamic element.
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View and Filter Content

By default, when an artwork is viewed in the viewer, all the contents of the artwork are visible without
any filtering.

You can view all the content in the artwork or you can view and filter the contents based on

¢ T =2 M © i

« Text Content
« Tables

« Images

« Symbolsand
« Barcodes

Note: If there are no document references used in the artwork, then the content widget will
not be shown.

19
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Map Locale to Languages

You can view the locale id present in the artwork and map it to the languages existing in the project.
If either the Project or the Document attribute category contains the hard-coded attributes
LOCALE_XX, then locale mapping will be automatically taken from these attributes. If no locale id are
mapped to languages in the project or document attributes, then user can manually assign the values
in the viewer.

Compare Artwork with the requirements.

Read more about it here.

4.1.12. 3D View

The 3D View widget always shows the HTML5-version of the 3D viewer.

After the 3D generation, you can view the 30 mockups in this widget.

+ 3D View bl 4

From within this widget, you can:

* L3
Open the 3D Viewer £ % in a new window

« close the 3D View widget.

4.1.13. Navigator

When you open a document in the Viewer, you can view its thumbnail in the Navigator. This gives
an overview of the current view position. Use this widget to quickly navigate through the entire
document.

The navigator highlights the area visible in the view port with a dotted rectangle. If the zoom is not
active, the dotted rectangle will be around the entire document.
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+ Mavigator

—_— <4 25.00%

When you are zooming in the document, the navigator shows the highlight area as the zoomed area. To
pan the document, hold the mouse and drag this selected rectangle around. The central view port will
display the area correspondingly. Clicking outside the rectangle will move the rectangle to the clicked
point and update the current visible area.

You can see the current zoom percentage at the slider bar located below the document thumbnail. You
can adjust the slider or click the + or - to adjust the zoom level.

Note: By default, this widget is available on the right sidebar. You can drag this widget to the
center or to the other sidebar.

4.1.14. Info

This widget displays information about the document being viewed. You can see the following info:

« thesize of the active document
« the size of the trim box of the current page

« theresolution of the active document. If you are in compare mode, it will display the resolutions of
the current and reference documents.

« the current mouse position in the document
« the current selection within the current page document when using measuring tools

In this widget you can change the units for resolution and measurements. To change, click & and
select your preferred units.
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Note:
The changes made will be applied to all of the Viewer measurements for the current session:

« Offsetsin Compare panel
« Information Pop-ups of all measurement tools and Caliper tools

Note:

The changes made from the info widget are applied only to your current session. The next time
you start the Viewer, the units will be reset to the WebCenter User settings.

Note:

To switch units for resolution and measurement, use shortcut keys. While switching, it takes
the values of the next unit from the drop down list.

« Ctrl+U to toggle the units for the sizes used in the Viewer.

« Ctri+Shift+U to toggle the units for the current resolution and screen ruling units.

Info Q

Document Size: 214.00 x 305.00 mm
Trim Size: 210.00 x 297.00 mm

Resolution: 185.039 ppcm

+ I
X:86.32 mm X:91.45 mm
Y:200.41 mm Y:107.26 mm

W-87.60 mm
H:101.27 mm

This widget contains advanced tools for view manipulation such as:

changing the background color of the image or window

view from the back

highlighting overprint with colours

viewing or hiding the trimbox (margins)and clipping to trim box
viewing in inverse colors

compensate distortion and scaling while viewing

Change Background Color of the Image or Window

You can use this tool to manipulate the view with a different background color other than white. This is
especially useful when you are evaluating an image that will be printed in a colored background.

When you click the Change Image or Window Background Color i tool, you will get an additional row
of tools in the View widget.
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Change Image Background Color...

When you activate this option, you will get a color picker. Select the image background color and
clickﬂto return.

3@:— Tip: You can also click outside of this color picker to close the color picker and inspect the
S image with the new background.

O

Change Window Background Color...

Select your color as described above and inspect the image with the new window color.

O

Change Both Image and Window Background Color...

When you activate this option, you will get a color picker to select a color for the image and window

background. Select the image background color and click theuto view the result.

Note: Your color choices are remembered for your next session. When you enable the
“==% background color options, the same colors will be available.

5

Reset Background Colors

Note: The Viewer retains the last used colors for your next session. However, if you select
== different background colors for different pages or documents, those will be remembered only

in the current session.

To turn off the tool and view the image with white background, click the i again.

View from Back

Use the View from Back E}J to mirror the view. You can see the image from the back and the channel
sequence will be reversed.

This is a useful tool if you are inspecting an image to be printed on a transparent medium.
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Set Overprint Highlight Color

The Set Overprint Highlight Color = |ets you select a mask color to display in all areas where two or
more active channels are overlapping. This allows you to check if trapping is done correctly.

Click the = tool on or off to have the overprint color highlight on or off.
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Note: Click Ctrl+H to switch between No Overprint display and Overprint display with the last
selected color

Invert View

Use the Invert ViewlIh option to invert the image or images being viewed. While comparing, if you
enable Invert View option, both the images will be inverted.

I
The orientation and alignment tools in the Document Select widget has Invert Reference ImageLb
option. When this is enabled, the reference image will be inverted.

Note: If you enable the Invert View option in the View widget after inverting the reference
image, your reference image will be displayed in the original state.

Show or Hide Margins (Trimbox)

F—

The Show/Hide Margins(Trim Box)+—- option allows you to toggle the margin (trim box) lines on or off.

While viewing an image with trim box information, this option will display the trim box as colored
margin lines. If there is no trim box, the margin lines will follow the image outline (media box).
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Right-click on D for options:
- Show margins on current page
« Show margins on both pages in reader spread mode

« Set margin (trim box) color sets the margin color for the current image while comparing two
images.

. Set reference margin (trim box) color sets the margin color for the reference image while
comparing two images.

« Set current and reference margin color sets the margin color for both images while comparing.
« Reset margin colors reverts to the viewers default margin color settings.

Clip Document to Margin

The Clip Document to Margin (Trim Box) t-4, option limits the content to the trim box (margin).

r—-

Right-click on L4 to get more options:

« Clip Document to margin (trim box) in reader spread mode only prevents overlapping page
margins with image content in reader spread view mode. This option is useful while viewing multi-
page documents.

« Clip Document to margin (trim box) clears the content outside the trim box. This is the same as a

simple click on the Clip document to margin t-4, button.

Compensate Distortion and Scaling

Distortion is a technique used to pre-compensate graphics which will be printed with a non-uniform
printing technology. Distortion is typically done during the RIP'ping process. In some workflows scaling
is used in place of distortion to pre-compensate for distortion in printing process.

The Compensate Distortion tool allows to compensate both distortion and scaling.

You can use this tool while comparing files with and without distortion or with different distortion
values.
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Note: This tool is available in the View widget only when the active or reference file has a
%= distortion and/or scale.

Hover on the tool to see the current distortion and scale values for the documents.

Compensate Distortion (Currently Off)
Vertical Distorbon = 100.0 / 90.0 %
Honzontal Distortion = 90.0 / 100.0 %

Compensate Scale (Currently Off)
Vertical Scale = 50.0 %

Honzontal Scale = 100.0 %

Use this tool to compensate:

« thedistortion of the active and reference document when the documents only have distortion
« thescaleif the active documents only have scaling

« both the distortion and scale of the documents if the active documents have both.

To activate the tool, click on the Compensate Distortion tool.

-+ Info

Document Size: 198.89 x 153.00 mm
Resolution: 787.402 ppcm

You can:

« Compensate distortion only
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Compensate Distortion (Currently On)
Verbical Distorbon = 100.0 %
Honzontal Distortion = 90.0 %

Compensate Scale (Currently Off)
Vertical Scale = 50.0 %

Horzontal Scale = 100.0 %

Compensate scale only

Document Size:
Resolution:

+

220,99 x 153.00 mm

¥: 708.661 ppcm
Y¥: 787.402 ppcm

3
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- View

E O &

e

" Compensate Distortion (Currently Off)
Vertical Distorbion = 100.0 %
Honzontal Distorbon = 90.0 %

Compensate Scale (Currently On)
Vertical Scale = 50.0 %
Hornzontal Scale = 100.0 %

w Info

Document Size: 198.89 x 305.99 mm

Resolution: X: 787.402 ppcm
¥: 393.701 ppcm

- In]

-

« Compensate both distortion and scale
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Measure Annotation

« Info

Document Size: 220.99 x 305.99 mm -

Resolution: X: 708.661 ppcm
¥Y: 393.701 ppcm

You can activate or deactivate one of these options by clicking on that option.
After the compensation of distortion or scale or both:

« thetooltip displays the updated distortion and scale information.
« the Infowidget displays the updated resolution and size.

4.1.16. Attributes

If the document in the Viewer has an Attribute Category with a Viewer specific View, you will see the
Attributes widget in the Viewer.

Note: If the document does not have any attribute category or an attribute category with
== Viewer optimized view, you will not see this widget.

When you have multiple Views, they are listed alphabetically and the first applicable view is enabled by
default. You can:

Save Attributes E from this widget.

Note: Only the users with Project / Folder level Change Properties permissions can change
=% and save attributes from the attributes widget.

If the user does not have permissions to edit the attributes, the editing and saving is disabled in the
widget
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Your unsaved changes will be notified with a Save attributes g. warning. Click this to Save. When
the datais saved, you will see a notification.

Switch Viewz when you are a member of multiple Roles and/or Groups with dedicated Viewer
views. Refer this table.

Save your attribute changes before switching to another View. You will be warned if you try to
switch views without saving your changes.

Attributes é‘ 2
Info: This is the Viewer Legal Attributes wview.
 LEGAL
Legal Checklist MARKETING
Select All Deselect All TECHNICAL

Best Before
#| Check copy/text for errors
Check production date
Check recipe
Colors & Flavours
Customer Care details
Manufacturer name & address
Names of ingredients in descending order
Net Weight

4.1.17. Channels

The Channels panel shows the file's channels and offers separation viewing possibilities.

Channels
Hidl>
[=]Jan
[=/l<

[=] M cut

10W-40

o ‘
Y]
N

Viewing Separations

Click the View channels in separate windows button == to switch to a tiled view of the individual
separations. The separations will be visible in the same order as in the channel list.
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The composite view will always be shown as the first view followed by the visible channels in the
displayed order. Right-click EH to choose from:

« Automatic tiling
« Horizontal tiling

« Vertical tiling

Viewing and Hiding Channels

Channels Widget displays the channel list in the printing sequence. The firstin the list is a channel All.
The list displays:

activated channel ® button
» channel swatch indicating the color of the channel. In the case of All, swatch box will be white.

« thechannel name

for each channel.

Use ®button next to the channel name to hide it.

E ] Note:

By default all channels are enabled.

Viewing a single Channel

Right-click on the eye ™ button of a particular channel to view it as a single channel.
When all the channels are displayed, clicking on All will show only the first channel.
[ ( ] Tip:

Deselect the selected channel to select the next one. This allows stepping through the
channels one by one

From single channel viewing, click All to view all the channels.

[ ' ] Tip:

Alt+1 Alt+2 ... Alt+9 To select a particular channel in the sequence
(from channel 1to channel 9)

Ctrl+Alt+0, Ctrl + Alt +1... Ctrl + Alt +9 To select a particular channel in the sequence
(from channel 10 to channel 19)

Alt +N To view a single channel.
Use this to view the first channel when
multiple channels are displayed. Also use this
to step to the next channel while viewing a
single channel.

Alt+A To view all channels.
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Editing the Channel Color in the Viewer

Click the color swatch next to the channel name to open the Channel Colors window. You can redefine
the channel colors in the Viewer.

Original color definition: This section displays the name, the RGB values, the opacity and the color
swatch of the original channel color.

You can redefine all these parameters in Display color definition.

Channel Colors

Original Color Definition

current
Cyan

R: |0 G: 165 | Bi 232

Opague

Display Color Definition

new
Magerta * -
R: 235 G: 5D B: 135

[] Opaque

* Revert »

Display color definition: This section allows you to edit the color. You can choose a new color from
the drop-down, edit the RGB values and make the color opaque. The color swatch will display the new
channel color.

The Revert button resets the color definition back to the original.

The left \ and right b arrows let you to step through all the channels from within the dialog.

Note: Editing color definitions in the viewer does not change the actual image file.

Viewing a Channel Opaque

Click on the Show Single Channel as Black 4 button to make the selected separation/channel
opaque.

Note: This setting is remembered the next time you open the Viewer.

Right-click 4 to get the options:
« show single channel in channel color

In this setting, you see the separation in its original color.
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« show single channel as black

You can view single channels in black instead of its defined display color.

- show single channel as black with show all effect :

This eases the detection of areas with small dots by using black rather than a grey value for a
display pixel that represents a partially covered area in the channel.

Changing the Channel Order

Select the channel you want to move and click either Shift the active channel up # or Shift the active
channel down ¥ arrow. You may also drag a channel to a different position to change the order.

Moving the channels down will put them later in the printing sequence. This would cover the other
colors printed before.

Note: This only changes the order in the Viewer and does not influence the actual printing
sequence.

Reverting the Changes

Reset channel order and color definitions button = will undo all display color edits by default. Right-
click to specify :

+ Reset channel order only
« Reset color definitions only
+ Reset all channel information

4.1.18. CAD

The CAD panel will have options depending on the file you opened in the Viewer.

While Viewing CAD files and Manufacturing Data

CAD panel contains a list of layers and classes. You can select the parts of the CAD data to be displayed
in the view. This panel is only available if the viewed document contains CAD data.
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Layers:

All Layers

Sheet
Designs

Classes:

All Classes

Main Design
Outside Bleed

When you open a CAD document in the Viewer, this panel displays:

» Layerslist:

WebCenter

Here you can turn each CAD layer off so that it is hidden from the view. Only layers present in the

CAD data are shown in this list.

« Classeslist:

Manufacturing data usually contains a number of one-up designs consisting of a number of layers.
These layers belong to a layer class. In the Classes list, you can turn off the layer classes.

« Click All Layers / All Classes to view or hide all data at once.

be hidden from the view.

Use the eye button ™ to select the layers or classes in view.

Right-click on the eye ™ next to a layer or class to view just that one. All other layers / classes will

Note: The order of these layers and classes is defined in the CAD file.

CAD Options

=0

0

Help
Hide Bridges and Nicks
Show Nicks
Need Show Bridges
" Show Bridges and Nicks

Can

Layeil

. A Lighten Graphics Some

M Lighten Graphics More

" Normal Graphics

Dimensions

Approval Details
No Approval Setup Defined
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You can choose to view or hide Nicks and Bridges in the CAD file :
« Hide Bridges and Nicks or Show Bridges and Nicks
+ Show Nicks

Enable this to view Nicks in the display. You can also see the size of the nicks

« Show Bridges
With this option, you can view the bridge-gaps.

« Show one-up names

While viewing manufacturing data, you can see the names of the One-ups using this option. This
option is turned off by default. This button is disabled when displaying a single design file.

While viewing CAD linked with Graphics

When a Graphics file with a reference CAD file is opened, the CAD line work is shown on top of the
graphics file in the view. You have also options in the CAD panel to:

View both Graphics and CAD data i

View Graphics only hy

View CAD data only g

CAD 7 &k
e Al

Layers:
@ | All Layers
@& | Main

In CAD options, you can also set various degrees of dimming the graphics data to make the CAD data
more visible:

« Normal Graphics
« Lighten Graphics some

« Lighten Graphics more

i =l Note: When you re-open the viewer, CAD line work will be displayed on top of the graphics file.
The modes in the CAD widget are not persistent.

While viewing CAD in 3D
While viewing a CAD design file (or a graphic file with CAD reference ), the CAD widget will have an Open
3D View 2 button.

Click | & to open the file in the HTML5 Collada Viewer. The 3D Viewer will open up in the 30 View widget.
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Project: HTMLS Viewer 14.1 update  Document: Fire_Engine_FC.ard Version: 1 £ (i
User: ADMIN (ADMIN) 8 B £ ? X
Q @ Q@ @ | & Ff & | A x O @
[ Neigaton  Orientaton Measure nnotation ]

g ~ CAD @-
¢ Layers:

o| [@allLayers

Main

Outside Bleed

Overall Dimensions

Note:

Once you have opened the file in 30, the Open 3D View 9 button is added to the top tool
panel.

4.1.19. Help

You can search for information in the Search Knowledge Base panel from within the Viewer window.

N4
)
ey

Tip: To access online help, use the keyboard shortcut F1or click

4.1.20. Annotating in the Viewer

You can use the Viewer annotation tools to add annotations or comments to the Viewed image.

To add an annotation, Click on either the D Add Annotation on page 138 button or the D Note
Annotation on page 142 button.

Click the D to get a list of additional annotation options. If you select a different annotation type, this
button will change to the selected annotation type.

Add Annotation

Click the D Add Annotation button.

This opens a sub-menu of different annotation tool options. You can use these with a click-drag-
release action:
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Rectangle Annotation Tool I:I : Use this to select a rectangular area where you can annotate.

Oval Annotation Tool O : Use this to select an oval area within the image.

Freehand Annotation Tool : Use this to make a freehand marking within the image.

Line Annotation Tool / : Use this to make a line marking on the image.

Arrow Annotation tool ¢ : Use this to create an arrow marking on the image. The arrow head
will be at the place where the mouse is released.

Highlight Annotation Tool == Use this to select an area and highlight it in transparent yellow
overprint.

New Global Rectangle I:I : Click on this to create a rectangle annotation surrounding the
entire image without the dragging action. You may create multiple global rectangles.

You can also re size this global rectangle.

Change default annotation line color....

When you click this color block, a window opens from which you can select a new color. This new
preference is saved for all future annotations.

Reset default line color... L

When you reset the color, a message asks if you want to update all the annotations with this
color.

From the sub-menu, select the type of annotation.

The Viewer remembers the selected tool until another tool is selected.
Optionally, change the color of the annotation line. Otherwise, the default color (red) will be used.
You can change the annotation line color from the annotation window as well.

Click, drag and release within the image.

You can type and format your annotation in the Annotation Window on page 139. You may also
Change Color of the annotation.

Enter your comment inside the annotation window and save. Read also Annotation Window on page

Annotation Window

While creating an annotation, an annotation window appears where you can add comments.
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m ADMIN (ADMIN)
B 7 U S X X 4 a1 [1]

Check the new Right to Left icon |

. w Delete n

You can emphasize parts of the text using the formatting options. You may also undo and redo any
changes you made in the text.

You can also change the direction of the text based on the language used for annotations. For example,
you can use right to left or right to left buttons when working with languages like Arabic or Hebrew.

~@F| Tip: You can move the window to move the annotation to a new position.

Annotation Pop-up

If you select an existing annotation, the corresponding annotation pop-up opens. The pop-up
contains :

« the type of annotation

« the annotation sequence number
« the annotator's name

« theannotation text

« thelist of replies

« thelist of review states

- O peeters, mipe (MIPE2) X

Check if this needs to be removed.

v. @

9 "Canceled": peeters, mipe [MIPE1)

In the annotation pop-up you can:

« Pinthe annotation pop-up.

By default, the annotation pop-ups are unpinned. Use the of Pinicon to pin the annotation pop-up

to the location. To unpin, click on the Unpin -’ii button. The setting you choose will be remembered.
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« Close the annotation.

Set the review state @ of the annotation

Choose the review state from the sub-menu.

s —

= D rejected
@ Cancelled &
& Completed
None

The annotation list panel will display the new review state including the name of the reviewer. Save
your changes after setting the review state.

Zoom to annotation :QL

* domore actions via Actions Menu ###

Edit annotation

Delete the annotation

You can only delete comments that you have authored. All the replies to the deleted comments
will also be deleted, irrespective of the author.

Duplicate the annotation

Use this to make a variation (e.g. correction) of an annotation made by another user.

Save the annotation

i = ] Note: Only the original author can edit, delete or save.

« Reply. Click on the Reply field to get arich text editor and type in your reply. You can either Save or
Cancel the typed reply.

These replies are visible in the annotation window as well as in the Annotation List.

Tip: Only two of the latest replies are visible in the window. Click Show x more replies to
view the rest of the replies. To view less replies, click on the Show less replies button.

{ = ] Note:

In the Show only selected annotation setting, the annotation pop-ups of the selected ones are
shown.

When this setting is turned off, select Show only selected annotation pop-up to view the
selected one's pop-up and all other annotation markings. This setting overrules the Pinning.

Read more in Annotation Options on page 145.
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Note Annotation

You can create a text annotation at any specific point on the image using the & Note Annotation
tool.

Select the =S Note annotation tool
You can also set the color using :

« Change Default Note Annotation Color. The default is yellow.

When you click this color block, a window opens from which you can select a new color. This new
preference is saved for all future note annotations.

Reset Default Note Annotation Colorh’

« Click on the point on the image where you want the note.
The Annotation Window on page 139 will appear where you can enter your note.

The annotation will be marked by a small note icon in the image.

{ ' Note: When you select a note annotation, it will be displayed in inverted colors within the view.

Editing Annotations
You can edit or move the annotations in the Viewer.
» You can select your annotations by:

« grabbing the annotation shape. When you hover near an annotation shape, the mouse pointer
changes to a select arrow.

« selectingitinthe Annotation List on page 116. T

{ ' Note:
When selected,

- theannotation is highlighted in the annotation list with a yellow background.
« theannotation shape border thickness becomes double.

- the annotation shape displays handles to enable resizing.

« the Note Annotation on page 142 color is inverted in the view area.

- arectangle, line, arrow, oval and highlight annotations display anchor points.

« You candrag the annotation using the mouse.
« You can move a Note Annotation on page 142 or a Rectangle annotation by dragging it. When

you hover near a note annotation, the mouse pointer changes to a select arrow.

« Toresize rectangle annotations, click the anchor point and drag either one of the four border
lines. You can also grab one of the four corners and resize with the help of a resize cursor. To
move a rectangle annotation, click and drag it to the new location.
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{ . Note: Highlight annotations can be modified in the same way as Rectangle annotations.

- To change an oval annotation shape, use any of the anchor points. Click and drag to move the
annotation.

« Hold and drag the end-points to modify line annotations or arrow annotations. You can also
select and drag the line or arrow to another location.

» Select and drag freehand annotations to change its location within the image. However, the size
and shape cannot be changed.

« You can use More actions > Edit annotation in the annotation window (or in the Annotation List on
page 116) to edit the annotation or reply text.

{ ' Note: Thisis only possible if you are the author of the annotation/reply.

After editing, you can either Save or Cancel the text changes.

Linking Annotations
You can add multiple annotation areas to a single annotation note.

The linked annotations share the same text, sequence number, replies and review state. This helps you
to draw multiple areas to one single annotation.

1. Select the annotation to be linked with the new annotation shape.
2. Click on Add Annotation and choose the annotation shape.

3. Create the new annotation holding the Shift key.
The new annotation is linked to the selected annotation. The new annotation will share the same
annotation pop-up. You can connect many locations in the same image to one annotation this way.

Duplicate Annotations

You can duplicate annotations that were created by you or another user.

To duplicate an annotation created by another user, click the Duplicate icon %
« To duplicate your own annotation, use More actions > Duplicate Annotation in the Annotation Pop-
up on page 140

The annotation (and any linked annotations) from which you duplicated will be made into a new
annotation thread with your name as the author and the current time. The text will be duplicated as
well.

The color of the duplicated annotation will be the your default color for that annotation type.

Delete Annotations

You can delete your own annotations using the delete key. You cannot delete replies to your
annotations this way.

You can also delete annotations using Annotation List > More actions > Delete Annotation. From the
Annotation Pop-up on page 140, use More actions > Delete annotation.
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You have to confirm the deletion when you are deleting an annotation. However, if you are deleting
replies, a confirmation is not required.

Save Annotations
Your annotations and changes to annotations are not automatically saved to the server.
If you

« create anew annotation

« add/editareply

« move the pop-up

« pin/unpin pop-up

« change the annotation color

« setareview state

« edit text

« delete anannotation orareply

the Save in the Annotation List on page 116 warns that there are unsaved annotations (or unsaved
deletions). Save these annotations or changes by either clicking this icon, or by using the Save option
in the Annotation Pop-up on page 140.

Annotation List

All users

All Review States
ADMIN (ADMIN) Sep 3, 2013 .
Hello from admin

A message will indicate that the messages were saved successfully.

Viewing Annotations

When you open an annotated document, the annotations will be visible on the document and the
Annotation List on page 116 widget.

If you select an annotation either in the annotation list or in the viewport, this will be highlighted in the
annotation list. You will also see the possible options concerning the annotation and its replies.
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Note:

The time will be displayed as bh ago, yesterday, 2d ago... To see the exact time, hover over the
displayed time.

Note: Invideo annotations, start time and end time of the annotation is displayed in
the list.

Prakash, Nandini (MAPR) FM 390

Change the color schame

Tip:

If you click and hold the left mouse button on an annotation in the annotation list, the
annotation becomes highlighted in the view.

Step Through Annotations

?
You can step through all the listed annotations using the * button. By default it will step through each
annotation. After the last one, it will return to the first annotation again.

L
Tip: Hold the Shift and click ! o step backwards.

When you select an annotation, its comment window will appear.

You can set your preferred step through setting in Annotation Options on page 145. You can set your
preference as any of the four options available.

Step by Thread: This is the default mode. Will step through each annotation, but not through the
replies to the annotations.

Step by Decreasing Date: This mode will step through all annotation comments and replies sorted
according to their modification dates.

Step by Thread - Fit View: Same as "by thread", but will zoom the view to fit the selected
annotation.

Step by Area/Position - Fit View: Will step through all positions/areas of linked annotation and
zoom the view to fit the selected annotation part.

Annotation Options

Step through Options

You may choose to step through the annotation in any of the following ways.
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Step by Thread: This is the default mode. Will step through each annotation, but not through the
replies to the annotations.

Step by Decreasing Date: This mode will step through all annotation comments and replies sorted
according to their modification dates.

Step by Thread - Fit View: Same as "by thread", but will zoom the view to fit the selected
annotation.

Step by Area/Position - Fit View: Will step through all positions/areas of linked annotation and
zoom the view to fit the selected annotation part.

Show only Annotations

Use these two options to set the visibility of annotation and annotation pop-ups in the view. This helps
in simplifying the view by displaying only targeted annotations.

Show only selected annotation: Only the selected annotation is shown in the View and the pop-up
appears when the annotation is selected.

In this setting you will see a warning.
Warning! Only the selected annotations is shown.

Show Only Selected annotation pop-up

You can choose this option when the Show only selected annotation is unchecked.. All the
annotations will be in the View, but only the selected pop-up will be present in the view.

{ = ] Note: This setting overrules the Pinning.

A warning message will indicate your current setting.

Warning! Only the pop-up of the selected annotation is shown.

Always show Annotation pop-ups

Enable Always Show Annotation Pop-ups the Annotation List on page 116 settings. This setting is
persistent and will show the pop-ups when you reopen the Viewer.

When this setting is enabled, the Close button will not hide the pop-ups.

Show or hide sequence label on the annotation

Use this option to show or hide the sequence number of annotations.

Unlinked annotations with sequence label:

[ CD@//” 2

For linked annotations, the sequence number remains the same for all linked parts. A second number
after a hyphen indicates different annotation areas.
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Show or hide character and line count
You can track the exact number of characters and lines in the annotation texts using this option.

When you enable this, the character and line count will be shown in the Annotation pop-up and in
Annotation List panel.

|3 BEskva (SKVA) mli
Change color

Characters: 12, Lines: 1

To turn this off, disable this setting in the Annotation Options.

Fit View to the selected Annotation
Use this option to automatically fit the view and the zoom to the selected annotation. The Viewer will
remember this setting and will return to this view when you reopen.

Ordering the Annotations
You can order the annotations in the Annotation List in two ways:

« Ordered by creation date: All annotation comments and replies will be sorted according to their
creation dates.

- Ordered by modification date: All annotation comments and replies are sorted according to their
modification dates.

Filter Annotations
In the Annotation List on page 116, you can :
« filter annotations by user / author.

When you select a single author, only the annotation threads and replies made by this author is
displayed.

« filter annotations by its review state.

- Any Review State will select all where there is a review state on the main annotation or any of
the replies made.

« No Review State will select all where there is no review state on the main annotation. If the
review state is “None”, it will not be shown.

« Accepted will select all annotations and replies with Accepted review state.
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« Rejected will select all annotation threads and replies where the review state is Rejected.
« Cancelled will select all annotation threads and replies where the review state is Cancelled.
« Completed will select all annotation threads and replies where the review state is Completed .
+ None will select all annotation threads and replies where the review state is None.
« Youalso can filter using :
» AllExcept Accepted
« AllExcept Rejected
« AllExcept Cancelled
« AllExcept Completed
+ AllExcept None

» customize your own filter combining the author and review state. Read in Custom Filters for
Annotations on page 148.

Custom Filters for Annotations

Use custom filtering to create advanced filters.

Click the Custom Filter Y button to enable this option.

Annotation List é",-.i - -Q‘I
Custom Filter is Enabled A
Customn Filter is Enabled v
3 thre: A 4

2 0O peeters, mipe (MIPE1) far 31, 2015

This is an old loge, please update the logo to the new one.

&/ "Accepted": Peeters, Michiel (MIPE)
+/ "Accepted": peeters, mipe (MIPE2)
peeters, mipe (MIPE2) far 31, 2015

1 do not have the correct logo, can somebody else change it
please?

+ "Accepted": peeters, mipe (MIPEL)

Custom Annotation Filter X

Match | All ¥ | of the following:

Review State T |lis Y ||Accepted T

@ Add a Filter Row
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In the custom annotation filter dialog, you can combine the basic Author and Review State filters with
alogical AND/OR operator.

Click Apply Filter to apply the changes and close the dialog. An active custom filter will show a
message Custom Filter Enabled in the normal filter.

Locking the custom filter

Click the pin button to lock the custom filter. If you lock a custom filter # , it stays active for
other documents and consequent viewer sessions.

(f ’ Note: You can always switch back to the basic filter by selecting a value from the drop down.

Hide Annotations

To hide annotations, you can click b1 Hide annotations in the toolbar. You can view them again by
clicking on the same button.

Viewing Annotations in Compare
The annotations are hidden by default when comparing two documents. Set Show Annotations for:

« Current

« Reference

to display annotations from either the current or the reference version.

Show annotations for:

Y Current | g|Reference

In Blinking compare mode, the annotations are hidden.

B Note:

You can edit the annotations from the current document, but not from the reference
document.

Viewing External Annotations

You can view annotation information in the Viewer even when the annotations are created by external
tools such as Global Vision nodes of Automation Engine.
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[ | [m [l

T Il parcode (WebCenter)

val 659817

The Global Vision nodes create these five different types of annotations in an Automation Engine
workflow:

Barcode Annotations

Braille Annotations

Spell Check Annotations

[ Artwork Compare Annotations

Text Compare Annotations.

The Viewer also supports:

Acrobat Annotations from Adobe Acrobat

Editor Annotations from the Esko editors

* - . .
External Annotations coming from an unknown external tool.

{ =| Note: To view an external annotation in WebCenter Viewer, you have to ensure that the .xfdf
=== files are uploaded along with the pdf document.

When a document has Global Vision annotations, a group of buttons is shown in the Annotation Widget
of the Viewer. Select any of them to see their information.

There is also a button for [&] User Annotations. Learn more in Viewing Annotations on page 144.

{,] Note:

» Global Vision annotation buttons are only active when the document contains such
annotations.

« The other annotation buttons are only shown when the document contains such
annotations.

« Allthese externally created annotations are read-only. You cannot reply to them.

- TheFilter option is only displayed for user created annotations.

« Youcan view the Braille, Barcode and Spelling annotations on a single document checked in
Automation Engine.
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+ Document Select limiento.

Current: concept a la vente au détail:
label (1).pdf

Praject: GV Praject -
i Ve 2 van concept tot retail: Eske

Compane bo:

Click to select a difference Document page. -

oncept alla vendita al

+ Annotation List ST E~E
N 4 possible, But you

1 of 104 threads shown B 0O

Il garcode (WebCenter) Apr 7, 2016
Value: G7654321
Type: QR
Grade: 4
Bar Width Reduction: (Herizontal: 0.01 mm Vertical:
004 mm)

amb

Artwork Compare and Text Compare annotations are available when you have compared
documents in Automation Engine.
Praject: GV Praject Documant: labal 2. pdf varsion: 2 / labal. pdf version: 2 Usgr: ADMIN (ADMIN) E o T 5| ? b
Qaaaeaasdn A e B Em = I Ee X BoOoe®
:m] Navigarion Orientation Comipaz= Meas) CE
I Document Select label 2.pd EI label.pdf, )
« Annotation List SRV E~E
& o E m =
Show annatations for:
L‘J_-L‘ul-n:nt LJ..: Reference
10 of 277 threads shown =m0
A T toxt compare (WebCenter) A0S, 2016 =
7 | ot e B e e T s ™
e fis) m:——mm-—w-w— =TT
g T Text Compare (WebCenter) fipr 5, 2016
W
: ) ESKOO “@ SN
cERVIC, Y Nww /)
& €, e &
SAE
F T Text Compare (WebCenter) Apr 5. 2016
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Creating User Annotations out of External Annotations

Creating User Annotations out of External Annotations

You can copy and create new User Annotations out of the external annotations that a document
contains. You can choose to create from any one or all the external annotations; with or without text.

Note: You cannot create text annotations from Global Vision Artwork Compare Annotations.

To create such User Annotations:

created.

Click % Create a User Annotation Here button on an external annotation thread. The annotation is

Click I'El Create a Blank User Annotation Here button on an external annotation thread. The
annotation is copied, but without the text.

Click Create User Annotations From All Annotations button located on the Annotations

Widget, when filtering on a type of external annotation. This creates User Annotation out of all

currently displayed annotations.

Click O Create Blank User Annotations From All Annotations on the Annotation Widget, when

filtering on a type of external annotation. This creates User Annotations out of all currently
displayed annotations but without the text.

The newly created annotations have the same properties and are shown in the User Annotations list.

Annotation List

- Il Barcode {WebCenter)

Value: 40659817

Type: EANE

Grade: A

Magnification: 136.00 %

Bar Width Reduction: 0.06 mm

n Il Barcode {WebCenter)

Value: 17 13
Type: Lastus Pharma code
Grade: F

LY R o

[al

Createymultiple User_., (I |
Annotationsjinione

go

Hoverandjuse
thesetools)to) i
createjsingle, @
userannotation

Annotating in a Multi-page / Page List Document

While Viewing Multi-Page Documents and Page Lists on page 171, you can make annotations:
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When you draw annotations in the non-active page area, a message will ask you to confirm if you

on the active page
on the adjacent page
across both pages

WebCenter

want to draw an annotation outside the current page. This warning does not appear when you draw an

annotation across both pages.

4.1.21. Approval

You can evaluate and approve the documents in approval cycle from the Viewer using the approval
tools.

Note: Reader Spread View on page 172 displays only the annotations from the currently
active page.

You can view the status of the approval in the viewer.

Clicking on any of the approval tools opens the approval pop-up.

You may set a condition for your approval (if the approval cycle allows this). Select Set approval
condition and type in your condition.

P C v x

Approved
¥ Set Approval Condition
I

Commit Approval Cancel

You can give a reason for your rejection in the text box.

© v x EIER

approval
Rejected

Comment:

I
Commit Rejection Cancel i
g

You may also just Comment without approving or rejecting. Then the status of the documentisin
Pending, until you approve or reject it later.

Commit button to save your approval or rejection and comments to the server.

For example, if you reject a document because of a specific image detail, use annotations and add
this as an approval comment.

The approval status will be displayed in the top toolbar in the place of Approval tools. This status will be
Pending if the Approval Cycle is still on-going.
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Remember:

If you are in the Compare mode, you can only do the approval actions on the current document
page.
Read also Evaluate a Document in the Viewer on page 154

Evaluate a Document in the Viewer

When you evaluate a graphic file or a page list (see Document Types on page 57 for information about
the supported file types), you can first open it in the Viewer to look at it in detail. You can then approve,
reject, or share a document for approving or viewing or add a stage or comment it directly from the
Viewer.

1. Click the document's thumbnail or the = button.

You can do this from:

the My Work page (under My Approval if you have documents to approve or under Approvals to
Follow Up if you are an Approval Master),

the Documents tab in the project,
the header of the Document Details page.
the viewer

2. Inthe top toolbar, click:

o approve the document,

Hto reject it,

© to comment it,

Eto forward approval request

~ toforce approve it if you are a Project Manager

X to force reject it (if you are a Project Manager).

Alternatively these options are also available in the Approval Details widget. This is available
only if the user has Change Approval permissions.

i = ] Note: You can view the status of the approval of the document in top tool bar.

3. Inthe pop-up that opens, do the following:

if you are... you can...

approving or force approving the document set a condition for your approval if the approval

cycle allows this (see Allow Conditional
Approval or Not on page 264): select Set
Approval Condition and type your condition in
the box.

rejecting or force rejecting the document

type areason for your rejection in the box.

commenting the document

type your comment in the box.
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4. If the user has Change Approval permissions, then the user can access the Approval Setup in the

Approval details widget. Click fto open the Document Approval Setup pop-up window. User can
perform all actions as specified in

Defining Approval Settings on page 256

5. Itis possible to also Edit the approvers when the approval stage is in progress. When you click on
the Edit Document Approval Setup , you can add a new approver or replace an existing approver
based on the permission you have.

Document Approval Setup

»" Approve M Reject +4 Forward () Comment More. .~ Edit Approvers = Maore...»

Elage 1
Role Assignee(s) or Group Members Type Status (Verslon) Approval Date Las

One ol Role

A ADMIN (ADMIN) User

Due Date Mar 10, 2027 DE00

= 2 suge>

Approver Role Assignee(s) or Group Members Type Siatus (Version) Approval Date

@ s=thish, bala (DL5A USIR) User

Due Date Mar 11, 2027 000

[+
Setiings

You can read about it in detail.
6. Enteryour password, if your WebCenter server requires it.

In case, the approval cycle is completed and the document is in Approved state, then the user
cannot make any changes to the approval cycle from the viewer.

7. Click the Commit button.

A warning message is shown, if unsaved annotations are present, when you try to Approve / Reject
/Comment on a document.
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Once you have approved or rejected the document, you may not change its approval status later (only a
Pending status allows future changes).

If you have entered an approval condition, a rejection reason or a comment, it will be shown in:

« the Approval tab of the Document Details page,
« the Action History tab of the Document Details page,

« the Approval Details panel in the Viewer.

To see all the documents you have recently evaluated, go to My Work > My Recently Submitted
Approvals.

Note: If you cannot see My Recently Submitted Approvals, go to My Work and add it to your
=== My Work page.

Forwarding Approvals from WebCenter Viewer

An Approver can forward a document for approval to another user(s) from the viewer itself. Forward
option is enabled based on the preferences set by the Administrator in the Security Preferences.

You can view the Forward button in the document and clicking it opens the Forward Approval
window. You can select the User(s) from the list of approvers available or you can enter the email id
(unregistered user) for which you wish to forward the document for approval.

Forward Approval

ET )]

Comment

B The current Approver will not have to approve anymore

Option to Forward and remain as Approver or not
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Approve user has an additional option to forward the document for Approval and remain as Approver or
can forward the document and not remain as Approver.

4.1.22. Compare Documents in the Viewer

You can compare two versions of a document or two documents in the Viewer. Use the different
comparison modes to have a close look at the differences between the two files. First, select the
documents to compare and then align them as required.

Once you have opened the documents to compare, there will be extra comparison modes buttons in
the Top Tool Panel on page 95, Channels on page 132, Orientation and Alignment and Annotation
List.

Click... to...

view the current version (the file in the first document
selector). See: Show Current and Show Reference Modes
on page 166

. &
View Current Version

. . i view the reference version (the file you opened in the
View Reference Version second document selector ). See: Show Current and Show
Reference Modes on page 166

. o ['EI keep switching from the first to the second file rapidly.
View Both - Blinking Read details in View Both - Blinking on page 166

View both - Show on Top EIL._'I view both files on top of each other.

. ™ view both files on top of each other and highlight the
Difference Compare Mode differences in red. Read more in: Difference Compare
Mode (View both highlight differences)on page 167

=] view both files side by side.
View both - side by side — -

i = ] Note: Comparison of 3D files are possible with all the options above except Difference
Compare Mode. You can read more on 3D compare at Comparing 3D documents on page 170

{ = ] Note: Comparison of the following file formats are possible:

« compare two digital film sets
« compare a digital film set with a PDF

« compare two RGB images

i = ] Note: This feature is not available for video files.
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Checklist for Approval in Viewer

You can set up validation fields which are to be filled mandatory, before the approval in the viewer.
To set up validation, ensure that you have assigned an attribute category with a Viewer view of a
document that contains required attributes.

In case, the validation fields are not filled, then you cannot approve the document, although comments
may be updated.

« Thevalidation criteria may be set based on the role in which the user is approving. For example,
Artwork Designer Role may have to enter the answer for the questionland 2, while Marketing Role
has to answer for question 3 and 4.

« Ifthereis only aViewer View, then the view is validated regardless of role. If there is a specific view
for the role, then that view is validated.

« |If there are views for multiple roles that the user has, then the user approves on behalf of each of
the role and all the role views are validated.

« Ifthereis no view for the role the user is approving, but there are views for other roles the user
could approve as, no validation is done.

{ = ] Note: Force Approve and Force Reject options override filling the mandatory fields.

Channel Matching in Compare Mode

Channel Matching in Compare

The Channel Matching influences the way differences in images are displayed while comparing them.
For example :

- differencesin display color of the same channel in the current and reference document

- differencesinink names. For example, a design ink name could be different from its production ink
name.

When a Compare To (reference) document is selected, a message may prompt you to open the Channel
Matching Dialog on page 159. This happens only when there are unmatched channels in one of the
documents.

Alternatively, click on the Channel Matching @ button to open the Channel Matching Dialog on page
159.

Channel Matching: [3

Orientation and Alignment
Orientation: ti} F1 |Ih

Alignment: E E.E [:]

Offset X,¥: 0 0 mm
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Channel Matching Dialog

channel matching allows linking channels that have been changed in one of the documents/versions
while comparing. Channel matching can be done automatically or manually.

Channel Matching

Channel matching settings:

Match only if identical
Ignore display RGE differences
® Also use smart name matching

Make this setting the default

Matched Channels:

Channels Current: Current Reference Channels Referenc

B c

I | I

Ly vy

| I | X3

M cut B cut

[ Is83 [ Is83

M 546 W 7546

D weiss D weiss

Highlighted channels indicate which
channel definition will be used for
compare.

[\ WMl Save channel matching

There are three settings:

« Match only if identical: Select this to match only the channels with identical names and display
colors.

- Ignore display RGB differences: Select this to match channels with matching names. This setting
ignores the display color differences.

« Also use smart name matching: Select this to match the channels with related names. For
example :

« when the names differ in the letter case (Magenta - magenta)
- when the names differ in color book specification ( 660 - Pantone 660 C and Cyan-Process Cyan )
« whenthe names are known abbreviations. Example C - Cyan

E Note: This settingignores display color differences.

E Note: The selection of a particular channel matching setting applies only to the current
document. To make it default, enable the Make this setting the default check box.

It is possible to edit channel definitions of the current image to match those of the reference image (or
vice versa). Read in Manual Channel Matching in the Viewer on page 159

Manual Channel Matching in the Viewer
The Channel Matching Dialog on page 159 displays four channel columns listing:

» the Channels Current and the Channels Reference columns display the unmatched channels.

« the Current and the Reference columns represent the matched channels. Matched channels are
displayed next to each other.

1. Dragthe channel to be matched from the Channels Current column to the Current.
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2. Dragthe corresponding channel from the Channels Reference column to the Reference.

3. Click on the Channel from which the definition has to be copied. The clicked channel will be
highlighted in the dialog. This indicates that the corresponding channel copies the definition of the
highlighted one.

Matched Channels:

Channels Current: Current Reference Channels Referenc
M :vazsoc B B [ 583

| ENE [ ¥ [ vy B s

| B B« B« | | weiss

B ~rtios crease v Bw

M ~rtios cut B cut

Highlighted channels indicate which

channel definition will be used for
o:-)o2'Ml Save channel matching

compare.
4. Click Save Channel Matching. After saving, the modified channel is marked with an asterisk * next
to the name.

Matched Channels:

Current Reference
Mc Bc
v Ly
M « M«
B w L
Mo+ B cu

Highlighted channels indicate which
channel definition will be used for
compare.

Note:

Channels displayed in bold in the matched columns cannot be unmatched.

If you manually move the channels from the matched lists to the unmatched lists, the
channel definitions are reset.

Using Orientation Tools while Comparing

Use the Orientation tools to rotate, mirror or invert the reference document / version relatively to the
current document / version.
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View Both - Side by Side

Current:

PE_linked_0_180_front.pdf
._-.. Project: HTMLS Viewer 14.1 update -

Compare to:

PE_linked_0_90_back.pdf
.|- Project: HTMLS Viewer 14.1 update -

Channel Matching: @
Orientation and Alignment
Orientation {i} F3 Eh
Alignment “\, n\__‘ EEE [:

Offset X, 0.00 0.00 mm
CAD Overlay:
Click to select a CAD overlay Document. -

Use:

&
Rotate O to rotate the reference document.

Mirror F7 to mirror the reference document.

|
Invert|—hto invert the reference document.

‘- Tip: Use this when comparing a positive and negative version of the same document.

@ Note: The buttons indicate whether the rotation / mirroring / inverting of the reference
document is currently on or off.

Aligning Files
You will get Viewer tools to align files in the document select panel while:

« comparing two graphics/ CAD files.
« viewing a graphics file and a linked CAD Overlay. Read in: Aligning CAD overlay and Graphics on page
180.
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View Both - Side by Side

Current:

PE_linked_0_180_front.pdf

!- Project: HTMLS Viewer 14.1 update -

Compare to:

- PE_linked_0_90_back.pdf
.n Project: HTMLS Viewer 14.1 update -

Channel Matching: |i|
Orientation and Alignment
Orientation {i} F3 Eh
Alignment “\, n\__‘ EEE [:

Offset X,¥: 0.00 0.00 mm
CAD Overlay:
Click to select a CAD overlay Document. -

You can align the current and reference files during compare using:

« quto-align

« anchor points

- corners, margins (Trim-boxes) or offset values.
Auto-aligning Files while Comparing (Graphics)

Auto Align R aligns the currently visible view of the two compared images automatically.

—QV- Tip: Using this tool along with the zoom in function is a quick way to align the current and
S0 reference images in the Viewer.

You can also use this to align the CAD overlay on the graphics correctly.

1. Select the files to compare from the documents.
2. Click Actions > Compare in Viewer.
3. Select the Current and Reference documents in the Document Select on page 112.

The viewer starts the last used Compare mode ( except the View Reference Version or View
Current Version modes ) with those documents.
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Project: MIPE's hands-on  Document: -pdf (Version: 1) / pdf (Version: 1) User: skva (SKVA)

QA & Qe ¢ & F CArAl ik Y wE Y = % &2

~ Document Select

Current:

Project: MIPE's hands-on
_ Document: compareia.pdf -
Compare to:
Project: MIPE's hands-on
. Document: comparelb.pdf -

Channel Matching: [
~ Annotation List aYy e

Annotations are hidden because Side
by Side compare mode is active.

Show annotations for:
[ Curent| | geference

4,
Select your preferred Compare mode, for example, View both - side by side &0 view.

Zoom-in to a specific area and use Auto-align

Auto Align uses the currently visible view of the two compared images to attempt an automatic
alignment.

Note: The offset values are filled in automatically.

I

@5 Tip:
Using this tool repeatedly with one or more zoom-ins can be a very convenient and quick
way to align two images.

N

on Orientation Measure

Current)
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Using Anchor Points

1. Selectandload your documents to the Viewer.

2. Select the Current and Reference documents in the Document Select on page 112.

WebCenter

The viewer starts the last used Compare mode ( except the View Reference Version or View

Current Version modes ) with those documents.

Your document select panel will have Orientation and Alignment tools when you select two

documents to compare.

Select your preferred Compare mode, for example, View both - side by side

Click on the Anchor Point Alignment S tool.

] CT
“ view.

The Viewer will transform to the anchor point alignment mode. You can access the navigation and

orientation tools in the top panel. You can also use the Auto-align P function in combination

with the anchor points.

Project: SKVA_HTMLS  Documant: Eco_Speed_front-wer.pdf (Varsion: 1)/ Spead Label Blue (front). pdf (Version: 1)

Q Q& a|a O & f”A
Navigation Orientztion

Anchor Point Alignment

Select your anchor points in the current (left) and the reference (middle) documents.

Use your keyboard arrow keys to fine-tune. Click align.

co_Speed_front-war.pdf, Version: 1 - (Current) Speed Label Blue (front).pdf, Version: 1 - (Reference)

MAKE YOUR
WORK FLOW

TIME T0 MARKET T / [_TiME T0 Marker TR
L ——

User: ADMIN (ADMIN)

SCIE - |

Alignment result

#8042 X

TIME TO MARKET

MAKE YOUR
WORK FLOW

A

Note: The active anchor can be recognized by the crosshair icon.

5. Select your anchor pointin the reference document displayed in the middle.

« click to select a point.

« usethearrow keys to fine-tune your anchor points
« youcan also drag the selected point to another location.

Note: Use zoom tool to help you in finding the anchor point.

6. Check the result on the right pane. Click Align to confirm.

moving the reference .

Tip: If you click auto align after selecting the anchor points, it will start auto-aligning by
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The Viewer will return to its original state when you click Align/Cancel.
Aligning Graphic Files Using Corner, Trim box or Offset
You can use the Alignment tools to align two graphics files.
1 23

You can align the files to compare using the Choose corner for alignment of the reference “=+

a
option. To specify the corner point for alignment, click #44 and select your reference corner from
the alignment drop-down.

T|:||:| Left ,
Tu:up Center
T|:||:| Right
Center Left
EEECE‘I'ItE‘I'E‘d
Center Right
En:ul:tu:nrn Left
853 Bottom Center
En:ul:tu:nrn Right

2. =
Click on the Use margins (trim boxes) for alignment [ | option to align the images relative to the
trim-boxes of the compared documents. When this option is not on, the alignment will be relative to
the document boundaries.

Note: If the trim-box information is not included in the document XMP, the document
&= boundary will be used for aligning files.

When you do a specific corner alignment after clicking this option, the trim box alignment will be
remembered.
3. You can specify numbers in the Offset X and Y fields. This offset is added to the corner alignment.

Note:

If you are aligning two graphics files, the offset will be the distance between the current
and the reference according to the graphics coordinate system (positive horizontal is set to
the right and positive vertical is pointing downwards).

For CAD overlay and graphics, the offset is taken as the distance between the CAD
overlay and the graphics page using the CAD coordinate system (positive vertical pointing
downwards).

While aligning two CAD files, the offset is the distance between the reference and the
current document page (in that order) according to the CAD coordinate system.
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Aligning CAD files

« Toopen multiple CAD documents, select them and click Actions > Compare in Viewer.
The documents will open in the compare mode. Read details in: Compare Documents in the Viewer
on page 157

Use the Rotate Reference ' tool to rotate it with respect to the current document.
« Mirror Reference Image will flip your reference (from the centre of the view) with respect to the
current document.

« Use the anchor point alignment tool to align twoCAD files correctly.
a) . LN

Click on the Anchor Point Alignment tool.

The Viewer will transform to the anchor point alignment mode. You can access the navigation

and orientation tools in the top panel.

{ ' Note: The active anchor can be recognized by the crosshair icon.

b) Select the anchor points in the current and referencedocuments. Use the arrow keys to fine-
tune your anchor points. You can also drag the selected point to a new location.

c) Click Align.
« Offset X,Y fields allow you to enter precise offsets for accurate alignment.

{ ' Note:
]
If you are aligning two graphics files, the offset will be the distance between the current
and the reference according to the graphics coordinate system (positive horizontal is set to

the right and positive vertical is pointing downwards).

For CAD overlay and graphics, the offset is taken as the distance between the CAD
overlay and the graphics page using the CAD coordinate system (positive vertical pointing
downwards).

While aligning two CAD files, the offset is the distance between the reference and the
current document page (in that order)according to the CAD coordinate system.

Compare Modes

Show Current and Show Reference Modes

If you click the View Reference Version or View Current Version button, the tools update their
information accordingly. The annotations are also changed to the current document in view.

The Approval Details on page 117 will be updated as well. In the View Reference mode,you will still be
able to perform the approval actions of the current document.

View Both - Blinking
In this mode, you will see the two selected document pages rapidly one after the other.

« Allannotations will be hidden
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« Approval details will be unavailable

« If the channels are split in different views, in each view the documents will rapidly change.

« If measure tools are active, the information pop-up will be updated rapidly depending on the visible
page.

View Both on Top

You can view the documents to be compared on top of each other in this mode. You will not see the
difference view in this mode.

Difference Compare Mode (View both highlight differences)

In Difference Compare Mode, you can view a combination of the current and the reference channels in
the same window. When you select this mode, you will see an additional tool bar.

V) o b (WS [E

Selecting the Compare color space

You can use compare color space tools to judge the nature of the differences between the compared
documents.

« Compare: Channels - This is the default mode. Use this to compare Channels one by one. The
added and subtracted content is displayed in highlight colors.

« Compare: HSV - This mode compares the HSV color of the two documents and you can see the
relative differences in a graded color overlay. The common parts among the compared documents
are shown in a neutral gray color.

The overlay color will be a grade of the selected "Subtracted" color with the strength depending of
the magnitude of the difference. Use this to compare documents where the channels are not the
same. For example, a CMYK document and a Pantone spot color document.

« Compare: Automatic - In this setting, Channels will be used as compare color space if the
definition of all the visible channels is the same in the two compared documents. If this is not the
case, HSV compare will be used.

Change the difference threshold

You can change the precision of difference detection using the slider tool. You can also enter a
percentage [0-100% ] value. If the threshold is higher than 0 is set, you will see a message warning
about the hidden differences.

B Note:

Your difference threshold will be saved for your next compare session.

Change Difference highlight colors
Depending on your documents to compare, you may want to change the highlight colors. You can do
this by clicking on the color block tool and selecting your preferred colors.

By default,
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« the added channels and objects on common channels are displayed in blue to highlight the
differences. The left part of the color block button indicates this highlight color.

« thesubtracted channels and deleted objects on common channels are displayed in red. The right
part of the color block button indicates this.

You can:

« Change added highlight color
« Change subtracted highlight color

« Change both highlight colors

There is a button to reset the changed highlight colors back to red/blue.

Difference Compare Modes

You can select different compare modes for effective comparison of documents. These modes differ in
how they display the unchanged parts in the compared documents. Select from:

View both (default) %

This mode displays the unchanged image parts as it is in its normal colors and changes in its
highlight colors.

« Channels only present in the current version is indicated with a + after the channel name.

« Channels only present in the reference version is indicated with a - after the channel name.

. LI_I
View both - highlight difference
This mode hides the unchanged parts. Select this to view unchanged image parts with lightened
colors. This way, you can spot the differences in a colorful image.
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View both - show difference

The unchanged image parts are displayed in white. In this mode, you can see the differences in its
highlight colors and the rest of the image in white. This way, you can spot even small changes easily.

% %’\ b ey D
TR A
e "\\\

Note: View Both on Top and Difference Compare Mode are not possible when comparing
= SVG files.

Compare Modes for different file types

Compare Modes Graphics SVG 3D

Current Document Possible Possible Possible
Reference Document Possible Possible Possible
Blinking Possible Possible Possible
Side by Side Possible Possible Possible
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Compare Modes Graphics SVG 3D
View Both on Top Possible Not possible Not possible
Difference Compare Possible Not possible Not possible
Mode

Annotations in Compare Modes

By default, all annotations are hidden and you cannot make new annotations in compare modes.
However, in the annotation list, you can specify the Show annotations for: as either Current or
Reference. Select:

« Current to view and make annotations in the current document.

« Reference to view the annotations present in the reference document. You cannot draw new
annotations in the reference document.

Comparing 3D documents

You can compare the 3D view of two versions of the same document or reference to a 3D view of
another document. When a 3D file is selected as the Current version, the Document Selector Compare
To displays all the other files that have a 3D view to compare with.

Selecting one of the files as Reference Version will activate the side by side comparison of the 3D
views.

Following compare modes are available for 3D documents

« View Current Version

- View Reference Version

« View Both Blinking

« View Both Side by Side

When a Graphics file with 3D perspective is compared with :
« Another 3D Document

This can be another 3D file or a graphics file with a 3D perspective. Selecting one of the reference
versions in the difference selector activates the side by side comparison of the 3D views.

« Graphics file with a 3D perspective

If a graphics file with a 3D perspective is chosen as reference version, the default 2D compare mode
is used.

When in a 2D compare mode, clicking the 3D button enables the 3D version of that compare mode.

Whenin a 3D compare mode, clicking the 2D button enables the 2D version of that compare mode
and the Difference compare modes for 2D are available.

Lock Images to Compare

When you compare the 3D perspectives in the viewer, you can lock the view of both the Reference
Document or the Current version by enabling the Lock Movement tool.

One of the document is locked while you can rotate the other. The angle reset option synchronizes the
view of reference 3D object with respect to the current 3D object.
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Update View in Real Time

This option is enabled by default and you can view the current and the reference document aligned
with respect to the each other.

However, when the option is disabled, the viewer only synchronizes after the interaction has stopped.

Compare SVG Documents

You can compare two different SVG files or versions of the same file with each other or a SVG with a
graphic file. The supported compare modes are Blinking Mode and Side-by-Side.

{ = ] Note: The Channels Widget is hidden when SVG documents are opened.

4.1.23. External Comparison (QA) Tool in Viewer

WebCenter allows integration with third party external web QA (quality assurance) tools namely
InformalT and TVT for additional comparison features. The connectivity to the external tools can be
created by the Admin user in the Assisted QA tools menu option where the Name and URL of the tool
must be entered along with tool specific information.

How to Access the QA Comparison Button(s) in the Viewer

When the graphic documents are compared in WebCenter Viewer, additional button(s) are enabled if
any external tools are connected. On click of the button, the viewer is connected to the external QA tool
ina new tab and the comparison is performed.

On completion of the comparison session in the external tool, the reports and annotations are stored
back into the WebCenter.

Reports from the QA Tool
The report is automatically imported in the same WebCenter project as the compared artworks.

Reports names are same as the document along with a suffix string as defined by the Administrator
during the configuration of the connection to the QA Tool.

Annotations from the External Tool

After the report is generated of the compared documents, the annotations made are imported back to
the current document in WebCenter and the existing annotation in the document are overwritten.

{ = ] Note: Annotations can be viewed, when the external QA tool is accessed from the viewer.

4.1.24. Viewing Multi-Page Documents and Page Lists

The Viewer has a number of features that make working with Page List and Multi-page documents
intuitive:

« Reader Spread View

» Page List Widget
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When you open a Page List or Multi-page document, the Page List widget displays its pages as
thumbnails. You can switch the main view to a specific page by clicking on the corresponding page
thumbnail.

Special thumbnails are used for Blank and Empty (Non-available) and pages of a Page List. An empty
page cannot be selected as the active page.

Note: Blank and Empty page thumbnails are only available for Page Lists.

You can see the page name and folio of each page below its thumbnail. A yellow color bar below the
page thumbnail indicates the currently active page. The bar above the thumbnail contains the page
number (index) and icons to indicate the page's approval state. In addition to the icon, a color code
indicates the primary approval state.

Use the Viewer to compare, annotate, inspect and approve the pages.

4.1.25. Reader Spread View

172

il

The Reader Spread view allows you to see pairs of pages from a multi-page or page list in the
Viewer. This enables you to visualize the document matching the appearance of the final documentin
print.

Note: Reader Spread View is not available in compare mode.

il

4 3
You can turn this on or off by clicking on the button. You can use arrows to navigate

between reader spreads.

When one of the two pages is absent, the active page is displayed with an empty area next to it.

Remember: Although you can view two pages at the same time, there can only be one active
page. You can make a page active by clicking on its thumbnail.

The pairs will be displayed according to its binding:
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« Leftedge binding: The first page and the odd numbered pages are displayed on the right. The even
numbered pages will be on the left.

Page list &

« Right edge binding: the first page and the odd numbered pages are displayed on the left. The even
numbered pages are displayed on the right.

Page list +]

Read also Marking Pages in a Page List on page 177

4.1.26. Comparing Multi-Page / Page Lists Document Pages

1. Load the Multi-page / Page List documents into the Viewer by selecting them and clicking Actions >
View and Annotate or Actions > Compare in Viewer.

Special thumbnails are used for Blank and Empty (Non-available) and pages of a Page List. An
empty page cannot be selected as the active page.
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Note: Blank and Empty page thumbnails are only available for Page Lists.

2. Select specific pages in Current and Compare To document selectors.

The pages are grouped by document version. Use Hide all pages in the Current and Compare To
document selectors to have the display aggregated.

A dialog opens up where you can set your comparison mode.

3. Inthisdialog, define how the pages of the active document are mapped to the reference pages.
Click OK.

« Current page only : to map the current active page to the selected reference page. The other
pages will follow page number mapping.

« Current and following pages: to map the current active page to the selected reference page.
This mapping will be used for the next reference pages.

Note: If there are no following reference pages, the last one will be set as the Compare
To page.

« All pages: to map all pages of the two documents. The previous current pages will be mapped to
the respective reference pages.

E Note: If there are no previous reference pages, the first one will be set as the current
page.

Any changes in the active page will lead to a corresponding change in the reference page (as
defined in the dialog). If you have not defined any comparison mode, the page numbers will be
mapped.

4. You can use the Compare mode tools to compare the details of the pages.

4.1.27. Approval in Page Lists

You can set up approval cycle on individual pages of a Page List. However, for multi-page documents,
the approval cycle is only possible for the entire document. You will see the approval tools when the
loaded document is in an approval cycle.
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-\,TQ:- Tip: A color coded bar on the page thumbnails display the approval state of the document.

=
v

« Greybar: no approval cycle

« Blue bar: pending approval

« Green bar: approved or force approved
« Redbar: rejected or force rejected

In addition, a blue circle at the bottom of the thumbnails informs you that you need to approve
the document.

Approval Details on page 117 widget will display the approval information regarding the active page.
The widget updates the information when you view a different page of a Page List. When an approval
status is submitted, the approval status will be updated for all visible pages.

Read also Evaluate a Page List in the Viewer on page 175

4.1.28. Evaluate a Page List in the Viewer

1. Navigate to the Page List in a Document list, and click on its thumbnail image. The Viewer opens,
displaying the Page List in the Page List widget.

2. Inthe Viewer tool bar, click:

torejectit,

- to approve the document,
e
g

to comment on it,

* to force approve it (if you are a Project Manager),
" X toforce reject it (if you are a Project Manager).
3. Inthe pop-up that opens, choose to approve / reject / comment the :

Options Description

Current Page

Approved

Pages:

® Current Page
Marked Pages (No Marked Pages)
Selected Pages:
All Pages

Set Approval Condition

Select this option when you intend to approve
only the active page.

Marked Pages
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Options

Description

Approved

Pages:
Current Page

#) Marked Pages (4, 7)
Selected Pages:
&l Pages

Set Approval Condition

You can mark pages while evaluating to do
approval actions in bulk.

Selected Pages

You can approve / reject the selected pages in
one go by specifying them :

+ asapagerange

« orseparated by commas

#» Selected Pages:
14,16,17,18-21

All Remaining Pages

Approved
Pages:

Marked Pages (No Marked Pages)
Selected Pages:
# All Remaining Pages

Set Approval Condition

If you are clicking on the Approval tools from an
Approved /Rejected page, you will get an option
to approve / reject all the remaining pages.

a) Optionally:

if you are...

you can...

approving or force approving the page(s)

set a condition for your approval if the
approval cycle allows this (see Allow
Conditional Approval or Not on page 264):
select Set approval condition and type your
condition in the box.

rejecting or force rejecting the page(s)

type a reason for your rejection in the box.

commenting the page(s)

type your comment in the box.
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b) Enter your password if your WebCenter server requires it.
c) Click the Commit button.

4.1.29. Marking Pages in a Page List

When you need to approve pages of a page list, you can first open it in the Viewer to inspect. You can
then mark the pages ready to be approved, rejected or commented. This allows you to do bulk approval
actions on marked pages.

i = ] Note: You cannot mark pages in a multi-page document.

Select the page you want to mark and click on the Mark button (from the Page list ) tools to

mark the active page. For more options, right-click :
+ Mark

« Markall pages

« Clear marks on all pages

« You can also right-click on any of the page thumbnails in the Page list widget to get the following
options:

« Mark/ Clear Mark
- Markall pages
« Clear marks on all pages

.t
To clear the mark or marks, click on the * Clear Mark button For more options, right-click :

+ Clear Mark
« Markall pages
+ Clear marks on all pages

4.1.30. Viewing CAD with Graphics

You can view a graphics document with its CAD overlay for reviewing purposes.

When you open a normalized graphics document (PDF)in the viewer, WebCenter will check the meta-
data(XMP)for a linked ArtiosCAD (ARD) resource.

{ = Note: This link between graphics and CAD can be made in a desktop application like DeskPack
or PackEdge. Here the relative orientation and offset is determined and saved together with
the graphics file meta data (XMP).

If a Structure /CAD reference is found, you will see this in the document select panel with a link ==
icon. You can select this to view together with the graphics document. If the graphics file does not
have a XMP link, you can use the document references feature to link them.
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+ Document Select

Current:

barandbraille.pdf

T 3 Project: HTMLS Viewer 14.1 update

Compare to:

Click to select a difference Document page.

CAD Overlay:

Boxes002.ard
Project: HTMLS Viewer 14.1 update
=o barandbraille.pdf

Orientation {i} F3
Alignment:

Offset X, -31.9% 203.25 mm

Linking a CAD with Graphics using Document References

WebCenter

You can assign a Document Reference Attribute in your graphics file to refer to a CAD Overlay. To use
this feature, you need a few Attributes with specific names. These are created automatically during

installation or update of your WebCenter.

+ CAD OFFSET X(distance)

+ CAD OFFSET_Y (distance)

+ CAD ORIENTATION( integer).

+ CAD REFERENCE (document reference)
+ CAD PRINTABLE PART

+ CAD PRINTABLE PART SIDE

+ CAD FINISHING PROFILE

- Addthe CAD REFERENCE attribute to a new category or an existing category. You can name this

category according to your needs.

a) Configure adocument source for your CAD overlay files.

Read in: Adding Document Sources for a Document Reference Attribute.

Edit Category MIPE Linked CAD

Nan

MIPE Linked cAD

Current View: [Befault ] Add Creation View  Add Header View Add View

Alternating background
Show also Attribute types and Restricted Set types
Keep session alive (avoid that people get logged off due to time out)

Remove Grid Lavout
Attributes:

so|[+= =] [fE[E] 0] tmsert:[me] [ =] [=][=][E

CAD_REFERENCE

®  Edit Terminoloay

cell
[CAD_REFERENCE

Lab

<t: [CAD desian lit

age: [

tion of Changes

Bl

00 Initiator
00 Item Category

00 Item Number

« Assign this attribute category to a graphics file.

ViebCenter Atirbute ¥
Stle Adg style

Editable v

Add Rule

iple Values:|
ory: |CAD_ALIGNMENT_ATTRIBUTES
t n

Info Page:

Info HTML page (name +extension)
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Alternatively, configure document types in your Project/Template and assign your attribute
category containing CAD_REFERENCE as the default attribute category for graphics.

« Select orupload a CAD overlay file to the category of your graphics document.

Document: barandbraille.pdf
Mail link to Document: barandbraille.pdf (544.7k8) 2
Open in Acrobat Version: 1

Description:

Project:

View and Annotate

Mora actions...

Approval: Mo Approval Required

raphics Information | Document Information | Approval | Action History | Annotations | Projects | Attributes |
haracteristics | Discussions (0)
Show Attributes in Category MIPE Linked CAD change category
Print
CAD design list
Search
[ Boxes002.ard )

« Openthe Graphics file in the Viewer once the View files are prepared.
The Viewer will load the linked CAD reference in the CAD Overlay section of the Document Select

widget.

Document Select

Current:

- barandbraille.pdf
m ) Project: HTMLS Viewer 14.1 update -
EUIJ-
i

Compare to:

Click to select a difference Document page. -

CAD Overlay:
Boxes002.ard
Project: HTMLS Viewer 14.1 update -
=o barandbraille.pdf

Orientati A

Orientation u F3

Alignment: :\:

Offset XY -31.99 203.25 mm

If the CAD reference is stored via a Document Reference Attribute, the user can alter and save the
CAD QOverlay settings to the graphical document.

When a graphics document is opened with the CAD REFERENCE attribute, you can Save E the
alignment changes made in the viewer.

@ Note: You need the rights to change a document attribute to get the E option. The
administrator has to enable Document > Security Change properties option for you.

The Save g option is enabled when:
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« you change the alignment. For example, new offset values.
« youselect anew CAD overlay.

If you select another CAD file as the overlay, the previous file (with link icon) is deleted from the
document selector. You will see the new overlay in the selector with an active link.

The new orientation and offset will be saved to the CAD_REFERENCE attribute of the graphical file.

CAD Owerlay:
Boxes002.ard
Project: HTMLS Viewer 14.1 update -
= barandbraille.pdf

Orientation (i) Fd

Alignment: n\__‘ E @

Offset X,¥ -34.95 203.25 mm

To remove the CAD link from the graphics file, click Turn off CAD Overlay in the CAD Overlay
selector and Save.

Read also:

« Aligning CAD overlay and Graphics on page 180

« Viewing 3D in the HTML5 Collada Viewer on page 182

Aligning CAD overlay and Graphics

+ Toopen multiple documents(both Graphical and CAD), select them and click Actions > View and
Annotate.
You will see a graphics document as the current document.

If the active document has a linked overlay, the Viewer will display this as the linked CAD overlay in
the document selector.
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~ Document Select

Current:

PE_linked_0_0_back.pdf
[T Project: PIPR ViewerSamples -
L]

Compare to:

Click to select a difference Document page. |«

CAD Overlay:

Click to select a CAD overlay Document. -

basichox.ard

1 Project: PIPR ViewerSamples ﬁ;l

oo PE_linked_0_0_back.pdf

Custom Filter is Enabled -

0 of 0 threads shown + Y

WebCenter

Stueio Dusigner rottioe: 0
Struccwral Design racasan: 0°

TOP
TOP

Front

Front

BOTTOM

BOTTOM

« Select the corresponding CAD overlay from the CAD Overlay selector drop down. This drop down
will display all the available CAD files including the linked CAD files.
The Viewer will display the selected CAD file on top of the graphics file. The Orientation and
Alignment tools in this view allows you to position the overlay accurately on the graphics file.

Anchor Point alignment a for CAD overlay.

Note: The respective buttons indicate whether the rotation / mirroring / inverting of the
== reference document is currently on or off.

« Offset X,Y for CAD overlay

Use the Rotate CAD Overlay © tool to rotate the overlay to match the graphics correctly.

Mirror CAD Overlay F3 will flip your overlay with respect to the graphics document. This will show

you the opposite side of the CAD overlay. If the current view is the inside of a box, flipping will

display the outside view.

« Use the anchor point alignment tool to align the CAD overlay on graphics correctly.

a)

Click on the Anchor Point Alignment a tool.

The Viewer will transform to the anchor point alignment mode. You can access the navigation
and orientation tools in the top panel.
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Project: ViewerSamples  Document: FireWorx_COMPARE. pdf Version: 1 & User: ADMIN (ADMIN) B O & ? X
Q Q| a|a | @ (& A
Navigation Orientation

Anchor Point Alignment

Select your anchor points in the Graphics (left) and the CAD (middle) Documents. A, cancel @
Use your keyboard arrows to fine-tune. Click Align.

[m-nL

2
'

YT

Note: The active anchor can be recognized by the crosshair icon.

b) Select the anchor points in the Graphics and CAD documents. Use the arrow keys to fine-tune
your anchor points. You can also drag the selected point to a new location.

c) Click Align.
« Youcan change the values in the Offset X,Y fields to be precise.

Note:

If you are aligning two graphics files, the offset will be the distance between the current
and the reference according to the graphics coordinate system (positive horizontal is set to
the right and positive vertical is pointing downwards).

For CAD overlay and graphics, the offset is taken as the distance between the CAD
overlay and the graphics page using the CAD coordinate system (positive vertical pointing
downwards).

While aligning two CAD files, the offset is the distance between the reference and the
current document page (in that order) according to the CAD coordinate system.

« Save the alignment changes.

« Afteraligning the tools, you can generate a 30. You can also use the tools in the CAD on page 135
widget to further refine the display.

If you did not save the alignment changes before generating 3D, you will see a message:

Do you wish to change your CAD overlay alignment?

Click Save to generate 3D.

4.1.31. Viewing 3D in the HTML5 Collada Viewer

You can view 3D digital mockups in the HTML5 Collada Viewer.
This will help you to:
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In the HTMLS5 Collada 3D Viewer, you can view the following files:

Generating a 3D View from a Graphics file with CAD reference

Enhance artwork and shape approval with its 3D representation.
Communicate the final packaging in the most realistic form.
Use WebCenter as an online medium to share 3D mockups.

Collada

Aligned CAD and Graphics Viewing CAD with Graphics on page 177

CAD Viewing CAD Design files as 3D

Document Select

Current:

o barandbraille.pdf

" =3 Project: HTMLS Viewer 14.1 update
HUIJ-

- i

Compare to:

Click to select a difference Document page.

CAD Overlay:

Boxes002.ard
Project: HTMLS Viewer 14.1 update
=o barandbraille.pdf

Orientation {i} F3

Alignment ‘\: @

Offset XY -31.55 203.25 mm

WebCenter

Open a graphics file with a CAD reference. Align the CAD overlay correctly on the graphics file.

Read: Aligning CAD overlay and Graphics on page 180.

When you open a graphics file with a CAD reference in the Viewer, the document select panel will

show a @ button.

Note: The link between graphics and CAD can be made in a desktop application like
DeskPack or PackEdge or using document references. Aligning CAD overlay and Graphics on

page 180

Click the Open 3D View 2 button.

The Viewer will open the 3D View widget with a message.

Loading the 3D model...
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+ 3D View b4

a:‘ Loading the 3D model ...

The 3D View widget always shows the HTML5-version of the 3D viewer.

After the 3D generation, you can view the 3D mockups in this widget.

3D View i X

From within this widget, you can:

. L3}
Open the 3D Viewer = % in a new window

« close the 3D View widget.

After the 3D perspective is generated, the Open 3D View @ button is available in:

« thetop tool panel
« the CAD widget
« the Documents list and from all pages where the document operations area available.

| =

I«
['l'

()] basicbox.ard (2KE)

(]} t Boxes002.ard (28kB)

=
(] m FireWorx_window_clip2.pdf (100z.5KB)

C
e
]
[| I

m .
[ 1 i
| n‘l:“'ti barandbraille.pdf (s44.7k8) & '@ =]
@]
Qal

C
e
]
['L |

©
e
]
E@

« Togenerate a 3D Perspective from the Document Details page, go to Document Information > More
Actions. Choose 3D View(Collada).
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« Todelete a 3D Perspective, go to Document Details > Document Information > More Actions.
Choose Remove 3D View.

Opening Documents in the 3D Viewer

Once you have a generated a 3D perspective by opening it in the HTML5 3D Collada Viewer, you can
open this again from different pages in WebCenter.

You can also generate a 3D Perspective from the Document Details page. To do this, go to Document
Information > More Actions and choose the 3D View(Collada) option.

You will have the Open 3D View 9 button next to the normal document operations. You will have this
option for:

« Graphics Files with aligned CAD reference
« ArtiosCAD Design and Canvas files

« ArtiosCAD 3D files

To open a 3D view, click 9 from:

« The Task execution page:

Documents @  Bill Of Materials Tasks Discussions Characteristics ~ Attributes Project Information  Approva More...~
Folders ,‘ ,f' 'i' [ Compare in Viewer 4 Download # Delete Document(s) More...v
I Project Documents Documents Version Approval Uploaded Tasks
& caD 5
&=h o —_ - - Feb 12, 2016 at 5:08 PM
— : 1 = L} tup Approval Cy A ST
Il Icons used | Sample014.pdf (1MB) gaztae= LRSS AP G Keizer, Debbie (DEKE)
Il Inks used
A
I Text
« The My Work > My Approvals page:
Pages Waiting for Approval: 42, Total Number of Pages: 42
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« The Document search results:

E Note: For this option to be available, enable Search > Documents > Show Result Layout
Options > Document Operations > View. Read more in: Document Operations in Search.

(if View is an enabled Document Operation in the search Result Layout Options)- grid and list view
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Name: Juice - 6 Pack Bottle Box.pdf
Description:

Project: HTMLS Viewer 14.1 update
Actions: 2 Q%8 =

Annotations and the 3D Viewer Positions

WebCenter

S

The 3D Viewer can remember its view position when you create annotations in the Graphics document.

Note: The 3D view that will be remembered along with an annotation will be the view that is
currently on. For this feature to work, the 3D view widget has to be open in the Viewer.

« Tosave a camera position of the 3D viewer into an annotation:

a)

Open the 3D View widget by clicking 9 button on the Top Tool Panel.

b) Add your Annotation in the view port and click Save. The view position in the 3D view is now
linked and saved with the annotation

Note: You cannot add a 3D View position to replies or linked annotations.
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When a 3D view is saved to an annotation, use the @ iconin the Annotation List widget to delete or

update the 3D view:

a) Select the saved annotation in the Annotation List.
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b) Use the Update with current 3D view from the Actions List from the Annotation List widget
or the Annotation pop-up and save the annotation. You can also do this even when there is no
previous camera position saved in the annotation.

i = ] Note: The 3D widget should be open to update or save a new 3D view.

c) Use Delete Current 3D View from the Actions List to delete the stored 3D position and save.

Viewing Component Document in the Viewer

A component is considered “viewable” once it meets the following conditions:
- Contains one or more document reference attribute

« The attributes contain in total at least a document

Viewable components can be opened in the viewer. The documents attached to the component are
loaded dynamically and are visible in the document selector.

If the documents attached to the component are not viewable, then opening the component in viewer
throws an error.

Component Widget

The component widget displays the configured document references on the component and the
documents that it contains.

By clicking on a document in the tree structure, it becomes selected and behaves as if it would have
been selected in the document selector.

The component widget stays visible if the currently shown document is part of a component structure.

If the component has the CAD_REFERENCE attribute with at least one document, and the component
is the current selected page; then the 3D document present in the first row of that document reference
is shown in the viewport.

If the first document is not a 3D document, then the loading of the 3D documents fails in the viewport.

Combining 3D + graphics view

When the component is the active document then it shows the combination of all graphical files that
are linked to the same CAD_REFERENCE document as the component CAD_REFERENCE document. To
apply graphics to a 3D structure, see Use 3D file as 3D perspective

Following requirements must be met:

« Graphic files must be referenced from the component in a document reference attribute
« Graphic files must be linked to a structured 3D document with a specified printable part
« Both component and graphic document must point towards the same CAD_REFERENCE

This is useful to see multiple different graphical files being applied on the same 3D structure.

Viewing Assembly documents in the Viewer

Component documents can be opened in the viewer, if it has a document reference attribute
containing at least a single document. On opening a component document with reference, this widget
is populated and displays the attached documents.
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¥ Component

W CANS_COMPONENT
:..l

r GraphicReferences

Graphics_Can.pdf
Resources_Object0_Can_250ml-
print_areal_0

Graphics_Slesve.pdf
Resources_Object3_Object3-
sleeve_mat

v CAD REFERENCE

CANS_SIXPACK.zae

The component widget displays the configured document references and the documents that it
contains. If the component document has a document reference namely, CAD_REFERENCE attribute
containing a 3D viewable file then it displays that 3D model when the component becomes the current
selected document.

The component widget stays visible if the currently shown document is part of a component structure.
Assembly Documents in Component Widget

The Component Widget displays all the documents contained in the document references on the
component document attribute category.

When opening an Assembly document in the Component Widget, it has three sections namely:
« Structure : First document present in the CAD_REFERENCE attribute is shown and the graphic
document is referenced by the assembly (any document reference).

- Printable Parts: Printable parts associated with the structure document are listed and if any
graphical document is attached to the printable part, that document is shown along with the
printable part.

« Other Graphics Graphics documents in the component which are not associated to a printable part
are shown in other graphics section.
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Component

&Y
‘ Assembly for bottle_Orange i3

Set Angle Offset ®dcCH

46
-180° 0" 46"

Simulate View Preset
Angle 135
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¥ Struciure

. bottle_Orange._zae

+ Printable Parts

I Front Label
— Label Orange.ai
Iy Profile: Gloss Coated Paper

collar (Front)
collar

collar (Back)
collar_1

v Other Graphics

i =| Label Pear.ai

A graphical document is associated to a printable part if the document.

« Contains the attribute CAD_REFERENCE, in which it references the structure document with the
name of the printable part filled out in reference property CAD_PRINTABLE_PART and the graphic
document is referenced by the assembly (any document reference) or

« Isreferenced by the assembly’s GRAPHICS_REFERENCE attribute with the name of the printable
part filled out in Reference Property CAD_PRINTABLE_PART.

Assembly Properties

« Set Angle offset: To define an offset angle for the package to be in. On changing the value, the
angle is updated in the 3D view. Save the value if you wish it to be retained and on reloading the
offset angle isremembered. There are also options to
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« Get from view: change the angle offset based on how the model is turned in the 3D view or

+ Reset: Allows the offset to be changed to the original value and

« Save: Saves the value in the CAD_OFFSET_ANGLE attribute in the Assembly Document attribute
« Simulate View Preset

You change the values of the Angle and Elevation while creating packshots. When you change the
values of angle and elevation, the 3D viewer changes the camera to this position. You also have
additional options to

Note: Values changed are not saved

» Get From View: Update the fields with the angle that the viewer is currently in
+ Reset: Changes to the angle in which it initially opened
Editing Printable Part of the Structured Document

Printable Parts can be split in Front and Back side and can have different artworks on each side of the
Structure documents. If only one of the two sides is defined, the other side displays the back of the
selected side.

Click on the pencilicon on the printable part shown in the component widget and a pop up is visible.

You can attach or replace the graphics document for that printable part, as well as the Finishing
Profile.

Note: Documents are attached for the printable part from the defined sources in the
GRAPHICS_REFERENCE attribute of the attribute category of the assembly. Only Saved
Search and Current project document sources and only Use by Reference operation are
supported.

You can save the changes for it to take effect in the assembly document.

Also note that to edit a printable part, the assembly should have the GRAPHICS_REFERENCE attribute
with the following reference properties defined in the rendering configuration:

+ CAD_PRINTABLE_PART,

» CAD_PRINTABLE_PART_SIDE,
« CAD_PRINTABLE_PART_NAME,
«  CAD_FINISHING-PROFILE.

Also if the attribute Category view contains a "Viewer" view, this view should also contains this
attribute and reference properties.

View Graphics with 3D
You can view graphics with 3D files in the viewer. For this link the 3D file to a Graphics Document.

To link the 3D document to a graphics document, use the steps as given in Linking a CAD with Graphics
using document references.
« Ensure the graphics file has the CAD_REFERENCE (Document Reference) Attribute.

« Thedocumentis openedinthe viewer asa?2D document.

+  Whenthere are 3D files loaded in the Viewer, you can link a 3D file to the Graphic Document using
the Structure Document selector. Read more here Structure Document Selector on page 113
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Viewing Attributes

If the document in the Viewer has an Attribute Category with a Viewer specific View, you will see the
Attributes widget in the Viewer.

The administrators can create such Viewer specific views. Read in: Add Viewer Views

For example, you can create attribute category based checklists for different roles / groups. When a
user from that role or group views the documents with that category, this attribute checklist will be
visible in the viewer. Read more about this use case in: https://wiki.esko.com/pages/viewpage.action?
pageld=170047115.

As an another example, you can use this to view your document references in the Viewer. If you have
more than one CAD document references associated with your graphics file, you can create a Viewer
view for these attributes with specific source and rendering configurations. Your user will then be able
to change a reference from the Viewer and save this configuration.

i =l Note: Only the users with Project / Folder level Change Properties permissions can change
and save attributes from the attributes widget.

If your document has document references attributes, you can view them from the Attributes widget.
You can also do the document operations specified while configuring the document sources for the
reference.

i = Note: The administrators can create a Viewer view for the document reference attributes with
specific source and rendering configurations.

You can change a reference from the Viewer and save this configuration. This is only possible when you
haveChange Properties permissions.

Attributes

Icons
Add Icon(s)

vc €CE.gng .’_‘)
Y i
- %: Recycle?.png(X)

Video Support for files stored in MediaBeacon

Viewer supports video files from the Asset Management Connection, MediaBeacon. Video files can

be opened like any other document or image file in the project. You can select the video from the
document list in the Project Details tab and select View and Annotate. Videos files can be approved in
the workflow directly.

i =| Note: To set up MediaBeacon as the Asset Management connection, refer to Configure Asset
Management Connections
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Note: To import any file from the Asset Management, refer to Document Creation Settings

Viewing Videos

Opening Video in Viewer

You can open video files by either clicking on the document thumbnail in the document list or by
choosing View and Annotate for the selected video.

Video Toolbar

Toolbar for video viewer has specific video controls. Detailed description of the other tools can be read
at Top Tool Panel on page 95

Note: Viewer displays the tools which are relevant for videos.

Controls to View Video and Advanced Video Settings

Select Button Performs
Play or Pause Depending on the video state the button
*) or II toggles to Play/Pause

Mute / Unmute Mute or Unmute the volume in the video. Use
"‘ "} the slider to increase or decrease the volume.
or

Timeline Slider Helps to slide through the video and displays
the total length of the video at the end. You can

o:14 [ NN slide forward to watch the video ahead.
l 05 Settings Videos can be set to play in Auto Play which
LI plays on opening of the viewer, or you can
0.5x start the video manually on opening. Loop
~ Normal allows to play the video in loop until manual
intervention. Speed can be chosen as .25x, .5x,
2x P
5 Normal, 2x or 8x. Quality of the video display
. can be chosen if the video has multiple display
esolutions.
1920x1080 resolutions
" 450x360
Auto Play
Loop
_ View Full View / Toggles to either view full screen or exits from
P Exit Full View full screen
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Select Button Performs
{ =| Note: Alternatively use Esc key to exit
= full screen

Options in Viewer for Video files

Following are the widget options available for video files

- Approval Details widget functions the same way to document approval. Refer to Evaluate a

Document in the Viewer on page 154

« Info hasthe details of the document viewed. Refer to Info on page 121

« Help tolearn more about the viewer.

« Key Frames refer to Keyframes on page 193

- Annotation List refer to Annotation List on page 116

Keyframes

Keyframes widget displays the preview of different frames at regular intervals from the video in
sequential order. This helps to easily navigate and locate any frame in the video. You can choose any

frame displayed to jump to that point in the video.
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= ] Note: If you are viewing an annotation and select a key frame that is outside the range of the
annotation, the annotation is deselected. If the key frame is inside the range of the annotation,
the annotation remains selected .

Annotations for Video

Add Annotations in a Video

A note or comment can be added to the video file as an Annotation. To add an annotation in a video file,
use the Add Annotation from the toolbar. For detailed information on Annotations, refer to Annotating
in the Viewer on page 138.

In video files, adding an annotation pauses the video. The Start Time and End Time of the annotation
is taken as the current time in the video. This can be edited manually by modifying the time and saving
the annotation.

E b ] Note: Annotation List in videos also displays the start and end time of the Annotations.

Viewing Annotation

Annotations are displayed only when the current time in the video is within the specified start and end
time of the annotation. You can view all the annotation in the video file by selecting Annotation List.
Refer to Annotation List on page 116 for details.

Timeline Slider

The Timeline slider displays three indicators, representing the Start Time, Time within the Video and
the End Time.

You can also edit the Start Time and End time by selecting the Annotation in the Annotation List by
dragging the Start and End time indicators in the Timeline Slider.

Colored markers in the timeline slider show all the available annotations in the video. These markers
are visible, only when no annotation is selected.

If the start and end time of the selected video are different, then the video is played in loop. To
continue playing the video, close the annotation pop up.

E b ] Note: If the start and end time is same for an annotation, then the video is paused.

Unified Viewer

View 2D and 3D versions together

Viewer allows to view both the 2D and 3D perspectives in the center pane. You can use toggle buttons
to switch between 2D and 3D view. When you choose to view the 3D perspective in the center pane, 2D
perspective is displayed on the side panel and vice versa.

When 3D perspectives are opened in the viewer, all the other toolbar elements and other widgets are
collapsed in the viewer except for Document Selector and Approval Details.
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Using toggle buttons, you can simultaneously view both 2D and 3D in the center pane.

Limitations in the HTML5 Viewer

Following features are not available in the HTML5 Viewer yet:

« Advanced View features such as Seamless View or Advanced Flexo tools for screened data.
« Collaboration mode

See https://wiki.esko.com/display/KBA/KB90866114 % 3A+WebCenter+-+HTML5+Viewer+known
+limitations for a feature matrix.

aF 3 D ¥,
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About the HTML5 Viewer

The HTML5 Viewer is a fast and comprehensive viewing tool introduced in WebCenter 14.

From WebCenter 21.07 onwards, the HTML5 Viewer is the only supported WebCenter Viewer.

What does the HTML5 Viewer offer you?

« Speed: fast viewing for Graphics and CAD files. High speed 3D viewing (14.1and later).
« Compatibility: high speed performance on the new client browsers.

Browser Supported Version - Windows Supported Version-Mac 0S
0s

Microsoft Edge Latest -

Firefox 4.0 or higher 4.0 or higher

Chrome 5.0 or higher 5.0 or higher

Safari - 5.0 or higher

- Reliability: high accuracy in displaying your data.

» Detail: advanced zoom to see finest details, measuring exact distances. Fast zooming.

« Customizable widgets. You can even restrict access to certain features depending on the user
preferences.

« Keyboard shortcuts. To see all of them, press ?

« Easyaccess to help and knowledge base. Search in the Help widget or press F1to access help.

| ' Note: The HTML5 Viewer does not offer live collaboration or working together at the same
' time. You can use annotation threads for discussions.

Using 3D file as 3D perspective

You can use any 3D file as a 3D perspective of a graphics file in the WebCenter viewer. You can also
view both the graphics document and the 3D file next to each other.

To view the files in the viewer, ensure there is a document reference attribute called CAD_REFERENCE
in the graphics document. Follow the steps below to open a structure document.

You can use the structure document in the Structure document selector.

After selecting a 3D Document as 3D perspective, save the link using the save button next to the
Structure Document Selector.

{ . Note: Thisis only possible if the Document has the Document Reference Attribute

' CAD_REFERENCE, in which the link is stored.

If a printable part is selected and the alignment options are saved, then the 3D widget displays the 3D
shape along with the graphic file applied to the specified printable part.

{ ' Note: The printable part is saved in the document reference properties

' CAD_PRINTABLE_PART and CAD_PRINTABLE_PART_SIDE of the CAD_REFERENCE attribute
that points to the 3D file.
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- Viewer Workspace: Select any workspace from the dropdown or Create new Workspace by
selecting the option. Select the gear icon to open the Workspace Configuration pop-up window and
view the options available in workspace selected or to edit the configuration in the workspace.

You can choose to add or delete any tool or widget to the workspace or altogether delete the
workspace itself.

+ Unregistered User Viewer Workspace: A workspace is configured specifically for unregistered
users who access WebCenter Viewer, when they are shared with a document to view or to approve.
Other workspaces or tools/ widgets are not visible apart from the workspace configured by the
Admin User. Admin user can also create a new workspace specifically for this purpose.

- Annotation Color sets the color in which annotations will be displayed in the Viewer (you can set
Viewer Default or choose a color from the list).

« Annotate Approved Documents sets if and how the users are allowed to annotate documents that
are already approved.
« Select Enabled if you want the users to be allowed to annotate approved documents.

« Select Warn if Approved if you want to display a warning before allowing the users to annotate
approved documents.

« Select Read-Only if Approved if you don't want the users to be allowed to annotate approved
documents.

« Select Warn if Approved or Rejected if you want to display a warning before allowing the users
to annotate approved or rejected documents.

« Select Read-Only if Approved or Rejected if you do not want the users to be allowed to annotate
approved or rejected documents.

« Annotate Documents under Approval sets who can add annotations in the documents under
approval.

Note: A document version is considered under approval as soon as an approval cycle is
started

Choose from the following settings:

+ AllUsers: This is the default setting. All users with view access to a document can annotate that
document once the approval cycle has started.

« All Approvers and Approval Master: The Approvers and Approval master defined in the
document approval setup (all stages) for the current version can annotate during the approval
cycle.

- All Approvers: All approvers defined in the document approval setup (all stages) can annotate
the document while it is being approved.

« Pending Approvers and Approval Master: Only an approval master or approvers who can submit
an approval state (Approve or Reject) for the current version can annotate the document during
the approval cycle.

- Pending Approvers Only: Only approvers who can submit an approval state (Approve or Reject)
for the current version can annotate the document during the approval cycle.
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Specify the Viewing Quality as:

Best Performance (Default): In this mode, the Viewer uses less compression to transfer images.
These images are transferred faster but may contain small compression artifacts.

Best Quality: In this mode, the Viewer uses less compression to transfer images. It takes longer
to transfer these images. However, you can view them without compression artifacts.

Settings for Automated Artwork

Note: The below options are visible only when Automated Artwork license is enabled.

Task Type for Bulk Text Replace: Choose from the list of task types shown. The selected task
type is used in the Files marked for Edit widget when editing Artworks in the Viewer.

Text Replace Library: Choose from the list of Text Document Saved Searches shown. The
selected Saved Search is used in the Action List Widget. Read more about it here.

Note: This option requires Packaging Content Management License.

PCM Attribute for linking Text Statements: Choose from the list of document reference
attributes shown. The selected document reference attribute is used to attach text content
documents (such as .wcc) when saving a graphic file modified with Action Lists in the viewer.

Note: This option requires the Packaging Content Management License.

Log out user when inactive Select this option, to log out the users whose sessions are not active
for a period of time. Option is given to log in again and continue when the user returns to the viewer.

Stream video through WebCenter proxy Enable this option to open video files located in Asset
management system in the HTML5 viewer.

Show Discussions in Viewer Enable this option to view discussions widget in the viewer and view all
the discussion posts about the document viewed.

Note: Project Managers who can Force Approve or Force Reject is not considered an approver.
They can add annotations only if the setting is All Users.

4.1.32. Editing Artwork in Viewer

Text within an Artwork may have to be edited or modified sometimes or a single word may have to be
replaced in multiple artworks to suit the current marketing campaign. In such instances, depending on
an Artwork designer to perform the change may delay the flow of work and add to the cost.

You can use the WebCenter Viewer to modify the artwork on the go and instantly save the changes to
the artwork. This saves time, effort and dependency on the artwork designer and thus reducing the
time taken from the ideation to the product on shelf.

Note: Automated Artwork license is required for this functionality to be enabled in the Viewer.

To enable the edit mode for the document, Switch to Edit Mode in the Viewer.
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Two new widgets are available in the Edit mode namely,

« Action List Widget

« Files Marked for Edit

Action Widget

You can view the Al (Adobe lllustrator document) or PDF document in the edit mode in Web Center
Viewer.

Action widget allows you to create an action list, which performs text replacement actions in the
document. The actionlist can be saved to execute on other documents or to do a bulk operation.

Actions

Pages 1
i Replace = with "Minerals”

Search Area

All (Mediabox)

Search for

0K
|
Execute Clear Mew
Action Unda Rleda Actions HBction

Action lists can be created and saved within the same project as the document or in different projects.
Search and Replace Action is available. You can add a New Action or Execute Action or Clear Actions
List or Undo or Redo the previous operation.For each of the Action, edit or delete or reorder of the
actionis possible.

Steps to create a New Action

You can search for (live) text phrases and replace them with another text phrase. Follow the steps given
below to create a new Action list:
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Search Area: You can choose an area of the artwork where the text has to be searched for. You have
three optionsin the drop down namely

+ All: All the textboxes in the artwork are included.
» Trimbox: Only textboxes within the trimbox of the artwork are included.

« Custom: Textboxes within the specified region which is indicated by x, y and width and height
areincluded.

Note: Click the button to select an area on the artwork

Search For : Type the text which has to be searched for, in the artwork as specified in Search Area.
Replace With: Type in the text to replace the matches with.

Overflow options: Sometimes the replaced text may be longer or shorter than the current text.
When the replaced text is longer then choose the overflow options to specify how the extra text

is shown in the artwork. For example, when the text "fresh apple"is replaced with "Juice and
sumptuous apple".

Overflow can be dealt with

« Vertical Overflow: When the text is longer than the original text, the textbox can overflow to the
bottom, top or in both directions.

- Horizontal Overflow: When the text is longer than the original text the textbox can overflow to
the left or right or in both directions.

« Max Width: The maximum width of the textbox. Should be set in order to use the horizontal
overflow.

Overflow Scope

« Selected Paragraph: Applies Overflow options to the whole textbox

« Selected Line(s): Applies to the selected lines only and the rest of the textbox remains
unchanged.

» Selected Text Fragment: Applies to the selected fragments of text and the rest of the textbox
remains unchanged

Verify number of Replacements: Select this check box to verify the expected number of

replacements. When there are less or more replacements than expected, the action will fail.

Save : You can save the Action created with the above steps as a Document in the current Project

or you can specify the name of the document and by default it is saved in the root folder of the

Project. The action list is saved as a document with a .pal extension.

You can choose to execute the action directly from this widget by selecting Execute Action and

Save the document.

When you want to run the Action List for multiple documents use the Files marked for Edit Widget.
Switch back to view mode to navigate back to the original view.

Replace using text statements in Artwork

When a Text Content Search is configured in the General Preferences by the Admin user, the user can
only replace text with Text Statements. Click the button to select a Text Statement from the Saved
Search and select the correct translation of the text.
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A saved search of text statements can be configured for the replacing the text in the Edit Mode in the
Action List widget. Read how here.

Replace with

T

Invgeaey Triomm Tewt Conbbes Rikrany

When a saved search is chosen, then the text cannot be replaced manually. When pcm setting is
configured it is only possible to select text from a saved search
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You can select multiple statements in any of the languages available for the statement, of which you
can then select a single text statement as a replacement for the text on the artwork. Click on the
document to switch.

After the search and replace of the text statement is performed and the modified artwork is saved, the
selected Text Statement document can be linked using the Document Reference Attribute configured
in the General Preferences.

Edit text in Bulk
The Files Marked for Edit Widget makes it possible to make small text changes on multiple Documents.

You can choose an Action (.pal file) which is created and saved in the Actions Widget.
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» Files marked for Edit

energy.pal -

Select Documents. -

Project: SOBK_NDL Test
Version: 1

i 04_Green_Hanger_MP.pdf
L

03_Green_Hanger_MP.pdf
o

Project: SOBK_MDL Test
Version: 1

1FINAL_GET SET_BOTTLE_GR...
F'rl:uje-ct: SOBE_MNDL Test
‘l..fersin n2

ﬁ 01_Green_Hanger MPI@#$%"...

L

Project: SOBK_MNDL Test
Version: 2

Clear 4 of 4 selected

Select the Graphic files from your Project where you want to execute the Action list. Click submit
to execute the Action list (.pal file) on the selected files. A task is created in the project, where the
artwork and the action list are attached.
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5. Approving and Rejecting Documents

You can see documents waiting for your approval on the My Work page, under My Approvals.

| ' Note: If you cannot see My Approvals, go to My Work > Edit My Work Setup to add it to your My
' Work page.

You can approve, reject or comment a document:

« from the My Work page,

from the Viewer,

from the document details page (Approval tab).

| ' Note: Project Managers have more options when approving or rejecting documents. They can
' Force Approve or Force Reject a document. See Forcibly Accept or Reject Documents.

Approvals, rejections and comments are shown on the Action History page.

{ ' Note: If you need to setup an approval cycle to have other users approve or reject a document,

' see Defining Approval Settings on page 256.

5.1. Evaluate a Document in the Viewer

When you evaluate a graphic file or a page list (see Document Types on page 57 for information about
the supported file types), you can first open it in the Viewer to look at it in detail. You can then approve,
reject, or share a document for approving or viewing or add a stage or comment it directly from the
Viewer.

1. Click the document's thumbnail or the = button.
You can do this from:

« the My Work page (under My Approval if you have documents to approve or under Approvals to
Follow Up if you are an Approval Master),

» the Documents tab in the project,
« the header of the Document Details page.
+ theviewer

2. Inthe top toolbar, click:

o approve the document,

X I rejectit,
* ©@tocommentit,

Eto forward approval request
~ toforce approve it if you are a Project Manager

X to force reject it (if you are a Project Manager).

204



ESKO

WebCenter

Alternatively these options are also available in the Approval Details widget. This is available
only if the user has Change Approval permissions.

i

IE ] Note: You can view the status of the approval of the document in top tool bar.

3. Inthe pop-up that opens, do the following:

if you are...

you can...

approving or force approving the document

set a condition for your approval if the approval
cycle allows this (see Allow Conditional
Approval or Not on page 264): select Set
Approval Condition and type your condition in
the box.

rejecting or force rejecting the document

type areason for your rejection in the box.

commenting the document

type your comment in the box.

4. If the user has Change Approval permissions, then the user can access the Approval Setup in the

Approval details widget. Click ’fto open the Document Approval Setup pop-up window. User can

perform all actions as specified in

Defining Approval Settings on page 256

5. Itis possible to also Edit the approvers when the approval stage is in progress. When you click on
the Edit Document Approval Setup , you can add a new approver or replace an existing approver

based on the permission you have.
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Document Approval Setup

+ Approve X Reject 4 Forward () Comment More ~ Edit Approwers = Moro.__»

Slage 1
Role Assignee(s) or Group Members Type Slaws (version) Approval Date Las

Omne ol Role

A ADMIM (ADMINY User

Due Date Mar 10, 2027 D800

=291=-:e2

Approver Role Assignee(s) or Group Members Type Siatus (Version) Approval Date

@ s=thish, bala (DL5A_USTR) User

Due Date Mar 11, 2027 0800

Settings

You can read about it in detail.
6. Enteryour password, if your WebCenter server requires it.

In case, the approval cycle is completed and the document is in Approved state, then the user
cannot make any changes to the approval cycle from the viewer.

7. Click the Commit button.

A warning message is shown, if unsaved annotations are present, when you try to Approve / Reject
/Comment on a document.

Once you have approved or rejected the document, you may not change its approval status later (only a
Pending status allows future changes).

If you have entered an approval condition, a rejection reason or a comment, it will be shown in:

« the Approval tab of the Document Details page,
« the Action History tab of the Document Details page,

« the Approval Details panel in the Viewer.

To see all the documents you have recently evaluated, go to My Work > My Recently Submitted
Approvals.
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Note: If you cannot see My Recently Submitted Approvals, go to My Work and add it to your
“== My Work page.

5.2. Evaluate a Document in the Document Details Page

When you need to evaluate an office file (like Microsoft Word, Excel, PowerPoint etc.), you can first
download it and open it in the corresponding application, then evaluate it from the My Work or the
Document Details page.

To approve, reject or comment a document from the Document Details page:

1. Gotothe Approval tab.
2. Click:

-to approve the document,
» Reject
toreject it,

() Comment

to comment it,

+* Force Approve

to force approve it (if you are a Project Manager),

X Force Reject

to force reject it (if you are a Project Manager).
3. Inthe pop-up that opens, do the following:

if you are... you can...

approving or force approving the document set a condition for your approval if the approval
cycle allows this (see Allow Conditional
Approval or Not on page 264): select Set
Approval Condition and type your condition in

the box.
rejecting or force rejecting the document type a reason for your rejection in the box.
commenting the document type your comment in the box.

4. |tis possible to also Edit the approvers when the approval stage is in progress. When you click on
the Edit Document Approval Setup , you can add a new approver or replace an existing approver
based on the permission you have.
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Document Approval Setup

+ Approve X Reject 4 Forward () Comment More ~ Edit Approwvers

Slage 1

Role Assignee(s) or Group Members Type S1aws (Version) Approval Date

Omne ol Role
A ADMIM -:ADMIN} User
Due Date Mar 10, 2027 0800

=291=-:e2

Lasl

Approver Role Assignee(s) or Group Members Type Siatus (Version) Approval Date

@ s=thish, bala (DL5A_USTR) User

Due Date Mar 11, 2027 0800

Settings

You can read about it in detail.
5. Depending on your choice, click Commit Approval, Commit Rejection or Commit Comment.

Once you have approved or rejected the document, you may not change its approval status later (only a
Pending status allows future changes).

If you have entered an approval condition, a rejection reason or a comment, it will be shown in:

« the Approval tab of the Document Details page,
« the Action History tab of the Document Details page,

« the Approval Details panel in the Viewer.

To see all the documents you have recently evaluated, go to My Work > My Recently Submitted
Approvals.

Note: If you cannot see My Recently Submitted Approvals, go to My Work and add it to your
“== My Work page.
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5.3. Evaluate Multiple Documents at Once

If you have several documents to approve or reject, and you have made the same decision about all of
them (you want to either accept them all or reject them all), you can do this in one operation.

1.

2.

Go to your My Work page.
In the My Approvals section, select the documents to approve or reject.

[ l Tip: To select all the documents at once, select the check box at the top of the documents
list.

At the top of the document list, click:

) :| to approve the documents (you cannot use conditional approval on several documents at
once),

) mto reject them,
*  ©tocomment them.

B Note:

« Use the buttons at the top of the list and not the ones beside a document, or you will only
approve / reject / comment that document.

« If you are not Project Manager for some of the documents you selected, Forced Approve
and Forced Reject are not available.

If you are commenting the document, type your comment in the pop-up's box.

If you are rejecting the document, you can enter a rejection reason in the pop-up's box.

It is possible to also Edit the approvers when the approval stage is in progress. When you click on
the Edit Document Approval Setup , you can add a new approver or replace an existing approver
based on the permission you have.
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Document Approval Setup

+ Approve X Reject 4 Forward () Comment More ~ Edit Approwers = Moro.__»

Slage 1
Role Assignee(s) or Group Members Type Slaws (version) Approval Date Las

Omne ol Role
A ADMIM -:ADMIN} User

Due Date Mar 10, 2027 D800

=291=-:e2

Approver Role Assignee(s) or Group Members Type Siatus (Version) Approval Date

@ s=thish, bala (DL5A_USTR) User
Due Date Mar 11, 2021 0&:UU
Settings

You can read about it in detail.
6. Depending on your choice, click Commit Approval, Commit Rejection or Commit Comment.

The status of the approval action is displayed, listing any documents that could not be updated.

Note: You can also do this from within a project (in the Documents tab, select the project's
=== documents to approve or reject, then click Approve / Reject in the Actions menu).

5.4. Sharing Documents from Viewer

WebCenter Viewer now allows documents to be shared to users who are both Registered and

Unregistered users using Eﬁ Share Viewer Link option.

Registered users are those who are already present in the WebCenter and unregistered users are not
part of WebCenter and can be provided temporary access to view the shared document.
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When you click on Share Viewer Link option, a pop up window is opened. You can choose the users
whom you may want to share the document from the drop down.

If you wish to share the document to other users, you can type in their email id in the users field and the
option to Add Unregistered User is enabled.

Note: When a document is shared to an unregistered user, the email id is remembered and is
2= available in the drop down.

Share Viewer Link

User(s)
Garfield@gmail.com

v Unregistered Users

[*~] Add Unregistered User: Garfield@gmail.com

You can share the link to both registered and unregistered users at the same time. When you share,
an email is sent to the users with a link to the document and information about the Document name,
Version number and comment.

The validity of the link shared for unregistered users is based on the token authentication.
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6. Working with Page Lists

6.1. About Page Lists

What is a Page List document?

Page Lists are a special type of multi-page PDF documents in WebCenter that represent imposed
books or magazines. As such they are an important tool for commercial printers.

Page Lists PDFs are generated in Automation Engine from Fastimpose imposition files (* . imp), and
uploaded to WebCenter from the Automation Engine production server.

If you are not using a Automation Engine production server, you can also upload Page Lists using the
Upload feature in WebCenter. You cannot upload imposition files (* . imp).

Page List documents have two major advantages over other multi-page PDF files:
+ You can upload either the complete document, or specific pages only (for example, pages 6-12);

- individual pages can be approved or rejected in WebCenter (for example, you can approve pages 3,
5 and 7-16 of a 16-page Page List).

E b ] Note: A multi-page PDF file can only be approved or rejected as a whole.

Working with Page Lists

Page List documents are displayed as a single document in document lists. Click the Page List name
to view its pages and details in the dedicated Page List views.

[ ' ] Tip:
Only Fastimpose impositions are recognized as Page Lists in WebCenter. Multi-page files
uploaded from within WebCenter (except multi-page PDFs uploaded specifically as a page list),

or even other Automation Engine documents will never be treated as Page Lists. Instead, they
are considered regular multi-page PDF documents.

6.2. Page List Views

212

When you want to examine, approve or reject a Page List, you have the choice of a number of views in
which to do so:

Page List
Displays the pages in the imposition in a table.

For every page, the Folio, Sheet Name, Sheet Side (for page lists uploaded from Automation Engine),
Thumbnail, Page Version, List Version, and Uploaded Date are displayed.
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Finally, the approval status per page is listed, and pages that have annotations are marked with a post-

Page List Information = Document Information ~ Approval  Action History ~ Annotations  Projects  Attributes  References  Characteristics Discussions
Pagelist PageGallery Page Information  General nk Information  References
Approve Selected Pages Reject Selected Pages Force Approve Selected Pages Force Reject Selected Pages +/ Approve All Pages ¥ Reject All Pages More...~
Status  Index View Page Version List Version Uploaded Date Approve/Reject Annotation Upload New Version

v L E 2 2 May 11,2015 at 12:54 PM Upload New Version
X 2 H 2 2 May 11,2015 at 12:54 PM Upload Mew Version

) 3 E 2 2 May 11,2015 at 12:54 PM v X G Upload New Version

¢ 4 E 2 2 May 11,2015 at 12:54 PM v X G Upload New Version

¢ 5 ﬁ 2 2 May 11,2015 at 12:34 PM v X G Upload New Version

f/ [ 2 2 May 11,2015 at 12:54 PM Upload New Version
Page Gallery

Displays the pages in the imposition in a gallery view. This gives you a quick overview of the approval
status of the different pages:

X

¢ ¢ G ¢ ¢ G ¢ G

~_ X _ & _ X
4 HE ER HE -
1 2 6

3 4 5

7 g 9 10 11 12 13

Pages topped with a blue bar and C-' icon have not been approved or rejected yet;

Pages topped with a green bar and v icon have been approved;

Pages topped with a green bar and f icon have been approved with a condition;

Pages topped with ared bar and :X: icon have been rejected;

: ol

Pages topped with a green bar and == icon have been force approved;
Pages topped with ared bar and E icon have been force rejected.

Page List Information

Displays basic information about the Page List (number of pages, binding...). This information is
editable for documents that were uploaded using the WebCenter Upload feature.
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6.3. Notes on Page Lists and Approval Cycles

214

Page Properties
Index

Represents the sequential position of the page in the Page List.
Folio

Represents the “name” of the page as it is used in Fastimpose.
Page Version

Represents the version of the individual page in the Page List.

List Version

Represents the version of the complete Page List. The List Version is updated every time you upload a
new version of the imposition from Automation Engine.

Index versus Folio

For example, the page with Index 7 may have vii asits Folio, or the page with Index 1 may actually be
page 3 when the cover is not part of the imposition.

List Version versus Page Version

When new versions of a selection of pages are uploaded, the List Version number and the Page Version
number of the uploaded pages are incremented.

As aresult, in very asynchronous workflows (e.g. magazine printing), you can easily have 15 Page List
Versions.

Every update to the Page List increments this version number. However, most of these updates will
only affect certain pages: their Page Version will be incremented.

By the time you reach Page List Version 15, many pages will be at version 3 or higher, but some will still
be at Page version 3.

Empty and blank pages
Empty pages are ignored for approval.

For example, if you upload a 32-page PDF file as a Page List, but change the Number of pages to 64
afterwards, creating 32 empty pages at the end of the Page List. These 32 empty pages are ignored -
you cannot approve or reject them.

Blank pages require approval. WebCenter detects when PDF pages have been added to the imposition
that have no visible content. The blank pages need to be approved just like any other pages.

When is a Cycle Finished?
The approval cycle's status is changed to Finished when any one of the following conditions are met:

- all Approvers have either approved or rejected it,
« the Project Manager or an Admin has Forced Approved or Forced Rejected it.

Note that in this case, the final status is Forced Approvedor Forced Rejectedinstead of
Finished.
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A finished approval cycle may not be stopped or started without uploading a new version of the
document.

These status rules apply to each individual page in the Page List.

Only when all the pages in the Page List document have reached their Finished (or Forced) approval
status, will the Page List get the Finished status.

6.4. Approve or Reject a Page List

To approve the pages in a Page List, you can choose from a number of different methods.

6.4.1. Use the Viewer

1. Navigate to the Page List in a Document list, and click on its thumbnail image. The Viewer opens,
displaying the Page List.

2. Inthe Viewer tool bar, click:

- to approve the document,
nto rejectit,

tocomment oniit,
~ toforce approve it (if you are a Project Manager),

2 toforce reject it (if you are a Project Manager).
3. Inthe pop-up that opens:

Approved
Pages:

® Current Page
Marked Pages (No Marked Pages)
Selected Pages:
All Pages

Set Approval Condition

Commit Approval Cancel

a) Choose to approve / reject / comment either the Current Page, the Selected Pages or All

Pages.
b) Optionally:
if you are... you can...
approving or force approving the page(s) set a condition for your approval if the
approval cycle allows this (see Allow

215



ESKO

WebCenter

if you are... you can...

Conditional Approval or Not on page 264):
select Set approval condition and type your
condition in the box.

rejecting or force rejecting the page(s) type areason for your rejection in the box.

commenting the page(s) type your comment in the box.

c) Enteryour password if your WebCenter server requires it.
d) Click the Commit button.

6.4.2. Use the Page Gallery View

1. Navigate to the Page List in a Document list and click on its name.

The Document Details page appears.
2. Select Page Gallery from the menu.

3. Select the pages you want to approve or reject and then click Approve Selected Pages or Reject
Selected Pages.

You can also choose to Approve All Pages or Reject All Pages.
4. Inthe pop-up that opens:

+ Approve Selected Pages

| Approved

¥ Set Approval Condition

-

a) Optionally:

if you are... you can...

approving or force approving the page(s) set a condition for your approval if the
approval cycle allows this (see Allow
Conditional Approval or Not on page 264):
select Set Approval Condition and type your
condition in the box.

rejecting or force rejecting the page(s) type areason for your rejection in the box.

commenting the page(s) type your comment in the box.

b) Enter your password if your WebCenter server requires it.
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c) Click the Commit button.

6.4.3. Use the Page List View

1. Navigate to the Page List in a Document list and click on its name.

The Document Details page appears.

2. Select Page List from the menu.

3. Select the pages you want to approve or reject and then click Approve Selected Pages or Reject
Selected Pages.
You can also choose to Approve All Pages or Reject All Pages.

4. Inthe pop-up that opens:

a) Optionally:

if you are... you can...

approving or force approving the page(s) set a condition for your approval if the
approval cycle allows this (see Allow
Conditional Approval or Not on page 264):
select Set Approval Condition and type your
condition in the box.

rejecting or force rejecting the page(s) type areason for your rejection in the box.

commenting the page(s) type your comment in the box.

b) Enter your password if your WebCenter server requires it.
c) Click the Commit button.

6.5. Uploading and Updating Page Lists

6.5.1. Requirements for Page Lists

Page Lists are supported in WebCenter from version 7.1 onwards.

To publish an imposition from Automation Engine to WebCenter, use the Publish Imposition on
WebCenter ticket.

WebCenter and Automation Engine must be in the same LAN, or use a Tunnel and Approval client.

6.5.2. Upload an Imposition as a Page List from Automation Engine

Only Fastimpose impositions are recognized as Page Lists in WebCenter. Multi-page files uploaded
from within WebCenter (except multi-page PDFs uploaded specifically as a page list), or even other
Automation Engine documents will never be treated as Page Lists. Instead, they are considered regular
multi-page PDF documents.

Proceed as follows to upload an imposition file as a Page List from Automation Engine to WebCenter:
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1. Start the Automation Engine Pilot and log on to the production server.
2. Browse to the Fastimpose imposition file (* . imp) you want to upload, or create a new imposition in
the Pilot.

3. Right-click the imposition and select New Task > Publish Imposition on WebCenter.

If the Publish Imposition on WebCenter task does not appear in the context menu, choose More
Tickets and select the task in the Select Ticket dialog.

4. Modify the settings for the Publish Imposition on WebCenter ticket (the first ticket in the chain)if
needed.

5. Modify the settings for the Send Book to WebCenter ticket (the second ticket in the chain):
a) Onthe Destination tab, select the WebCenter Site from the list.

b) Enter the Project, Folder, Document and Project Template names. You can use SmartMarks to
populate these fields.

c) Enter your User Name and Password for the selected WebCenter site.
d) Click the Approval tab and enable Approval if required.

6. Click the Launch button to upload the imposition to WebCenter.

E b ] Note: This automatically adds the imposition to the Pilot's Pages view at the same time.

6.5.3. Upload an Imposition using the WebCenter Upload Feature

1. Either gotothe project/folder you want to upload the document into and click the

button, or just click the Upload menu from anywhere.

2. Onthe Upload page, select the Project and Folder you will upload the document into (if you
are already in the project/folder, those are filled in automatically, but you can still Change the
Destination).

3. Select Browse in the Source list and click the Browse... button to open a browser dialog and select
your file.

4, Select Page Listinthe Document Type list.

5. Type the index number of the first page in the file in the Index of First Page field.
For a new document, this will typically be 1, but it might not be, if you plan on adding additional
pages later, or if you are updating a selection of the pages in an existing Page List.

6. The document Name is automatically detected. You can still change it if needed.

7. Optionally, specify a Description for the document.

8. Click Upload.

The Page List is uploaded to WebCenter. You can still edit some properties of the Page List in the Page
Information view (such as the number of pages, the binding edge, etc.).

6.5.4. Update Pages in a Page List

You can update a specific page of range of pages in a Page List, either from Automation Engine or
through the Upload feature in WebCenter.
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To Update One or More Pages from the Pilot

1.

In the Automation Engine Pilot's Imposition Gallery, select the pages in the imposition that you
want to update.

Right-click one of the selected pages and re-launch the exact same Publish imposition on
WebCenter Chain ticket you used to upload the original Page List.

To Update Individual Pages from WebCenter

S

Navigate to the folder in which the original Page List resides.

Click the name of the Page List to open the Document Details page for the Page List.

Click Page List to open the Page List view.

Click the Upload New Version link in the row corresponding to the page you want to update.
Browse for the PDF document containing the new version of the page you want to update and click
Finish to upload the new page.

The Index for First Page field is already filled in, because you are only updating a single page (at the
listed index).

To Update Multiple Pages from WebCenter

I

Navigate to the folder in which the original Page List resides.

Click the name of the Page List to open the Document Details page for the Page List.

Click Page List to open the Page List view.

Click the More Actions... button and select Upload New Version.

Browse for the PDF document containing the new versions of the pages you want to update.
Provide the Index of First Page information: pages from the new PDF you are uploading will update
the existing pages in the Page List starting at the Index you specify.

For example, if you upload a four-page PDF document to a 16-page Page List, and enter 5 as Index
of First Page, WebCenter will update pages 5, 6, 7and 8 in the Page List with the newly uploaded
versions.

Click Finish.
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7. Working with 3D Files

With WebCenter, you can upload, view and approve 3D files. This is an option available with the
Advanced Approval module.

This is based on Esko’s Visualizer technology, and enables you to:

« Communicate the final packaging in all its realism to clients.
« Use WebCenter as an online medium to share 3D mockups.
« Enhance artwork and shape approval with its 3D representation.

7.1. About 3D Files

WebCenter works with Collada( . dae)and Zipped Collada (. zae) 3D files.

Colladais an interchange file format for interactive 3D applications. It is an open standard based on
XML, managed by the Khronos Group (a not-for-profit technology consortium). For more information,
go to http://www.khronos.org/collada/.

A Zipped Collada file is a zip file containing:

« aColladafile,
« amanifest.xml file with a specified format,
» optionally, other assets such as backgrounds.

E b ] Note: WebCenter supports having a preview embedded in the archive file and extracting this
automatically as a default thumbnail.

7.2. Creating and Exporting 3D Files

You can create Collada files from Studio Visualizer and / or ArtiosCAD.

7.2.1. In Visualizer
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Studio Visualizer can build 3D models based on the following structural design file formats:

« ArtiosCAD *.ard files;
- Studio Toolkit for Flexibles *.bag files for flexible packaging such as bags and wrappers;
« Score! *.vim files.

« Collada *.zae archives with arbitrary 3D shapes, with printable areas defined (if supplied by Esko
products). Collada archives created by non-Esko products can be used in Studio Visualizer but will
not have a printable area.

1. Openthe artwork in Illustrator, ArtPro or PackEdge.
2. Place and align the structural design file.
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3. Then choose Open in Visualizer from the File menu.
4. Set the Substrate material.
5. Edit your design as necessary:

« add processand/ or spot colors,
+ add special finishes,
- add an environment (background).
6. Export your 3D design to a Zipped Collada (. zae) file using the Export 3D file for Viewing option.

You can choose to Create a preview image file alongside the Collada file. This willbe a . jpeg
thumbnail image.

i =l Note: If your modelincludes graphics, saving to . zae and not . dae ensures you have
everything in one file (WebCenter doesn't support using multiple files for one 3D design).

See the Visualizer manual or online help for more information.

7.2.2. In ArtiosCAD

Since ArtiosCAD 7.6, any 3D file can be output to Collada. The output includes the graphics, floor
shading etc.

{ = ] Note: This might require additional licensing.

1. Create your model using the ArtiosCAD 3D functionality.
2. Wheniitisready, go to File > Outputs-3D > Collada to export it.

« Set the Graphics resolution.

« Toexport a thumbnail with the Collada file, choose either PNG or JPEG in the Include bitmaps as
option (you can select the Quality for JPEG).

« Save the file as a .ZAE file.

{ = Note: If your model includes graphics, saving to . zae and not a . dae ensures you have
everything in one file (WebCenter doesn't support using multiple files for one 3D design).

See the ArtiosCAD manual for more information.

7.3. Uploading 3D Files to WebCenter

Collada(.dae)and Zipped Collada( . zae)files can be uploaded to WebCenter using the normal upload
functionality available within WebCenter, via Automation Engine or through the WebCenter SDK.
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WebCenter automatically recognizes Collada files as the Collada document type.

7.3.1. Working with 2D and 3D Files

We advise using the same name for related 2D and 3D documents, and putting them in the same folder.

7.3.2. Creating a Thumbnail

By default, WebCenter shows the default Collada thumbnail for Collada files: e .

To add your own thumbnail:

« use the Create a preview image file alongside when exporting the Collada file from Vizualiser (see
Creating a 3D File in Visualizer).

« choose either PNG or JPEG in the Include bitmaps as option when exporting the Collada file from
ArtiosCAD (see Creating a 3D File in ArtiosCAD).

« upload your own thumbnail in WebCenter:

a) inthe Document Details, go to the Document Information tab,
b) click Thumbnail and upload your thumbnail image.

(f ’ Note: The best sizes for thumbnails in WebCenter are 100x100 and 200x200 pixels.

7.4. Viewing 3D Files

Hyper realistic 3D viewing experience is now available in WebCenter. You can view 3D in Unified Viewer.

- theJavaCollada Viewer
« the HTML5G Collada Viewer

« Click the thumbnail of a Collada file to open WebCenter's 3D Viewer. As a reqular user, you need to
have both View and Download rights to use the Collada Viewer.
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Project: DEKE_test_Viewer Document: 18 Pack.zae Version: 1 b 4

ESKO®

S THE LEADERIN GRAND PACKAGING KNOVATION
i ‘

(D Comment | ./ Force Approve X Force Reject €3

Note:

If your Collada file contains a background environment (. env file), you will see it in the
background.

WebCenter supports all the default Visualizer environments.

« The HTML5 3D Viewer launches much faster than the Java based Viewer and it works on mobile
devices. You can use your mouse or touch to perform actions. Read about HTML5 3D viewing in
Viewing 3D in the HTML5 Collada Viewer on page 182.

« Makes use of 3D capabilities that are built into modern browsers (WebGL) depending on your
browser.

« Supports the same lighting, print and finishing effects as Java version and the desktop Studio
application.

« ForCollada files that are written in Studio, the Viewer will show the lighting environment as
configured there. For other Collada files, it will use a neutral photo studio lighting (different from
the Java-based Viewer).

7.5. Using 3D file as 3D perspective

You can use any 3D file as a 3D perspective of a graphics file in the WebCenter viewer. You can also
view both the graphics document and the 3D file next to each other.
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To view the files in the viewer, ensure there is a document reference attribute called CAD_REFERENCE
in the graphics document. Follow the steps below to open a structure document.

You can use the structure document in the Structure document selector.

After selecting a 3D Document as 3D perspective, save the link using the save button next to the
Structure Document Selector.

{ =l Note: Thisisonly possible if the Document has the Document Reference Attribute
CAD_REFERENCE, in which the link is stored.

If a printable part is selected and the alignment options are saved, then the 3D widget displays the 3D
shape along with the graphic file applied to the specified printable part.

i =| Note: The printable part is saved in the document reference properties
CAD_PRINTABLE_PART and CAD_PRINTABLE_PART_SIDE of the CAD_REFERENCE attribute
that points to the 3D file.

7.6. Approving 3D Files

Collada files can be approved like any other document in WebCenter. You can approve, reject or
comment a Collada file from:

« your My Work page,

« the project's Documents tab,

« the document's Approval tab,

« the 3D Viewer (at the bottom left of the window).

7.7. Annotatingin 3D Files
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When the current document is a 3D file, the 2D annotations are created relative to the view port and
are shown in the annotation report. Adding an annotation is not possible during comparison of 3D
models or on 3D perspectives that are linked to graphic documents. When the annotation tool is active,
you

» Cannot move or rotate the 3D object. To rotate or move the 3D object, turn off the annotation tool.

« Addanannotation, the camera angle of the 3D model is linked to the 2D annotations. Selecting an
annotation, will result in the 3D model rotating to the same camera angle where the annotation was
added.

An annotation is only visible, when it is currently selected by the user from the widget.

You can read more on Annotations here Annotations and the 3D Viewer Positions on page 186
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8. Working with ArtiosCAD Documents

You can open your document in the ArtiosCAD application directly from the WebCenter server.

Note:
This is possible if:
1. the document is recognized as any of the following types :

« Design: . ARD and other structural design formats supported by ArtiosCAD

« Manufacturing: .MFG and other structural manufacturing formats supported by
ArtiosCAD

« J3D: .A3D

2. you have been granted rights to download the native ArtiosCAD files by the system
administrator.

3. you have been given the download permission to the project folder where the document
resides.

« From the Document Search Results page, you may see the Open in ArtiosCAD link even
when you do not have the download permission. When you attempt download, you will
receive an error message.

4. WebCenter Preferences > General Preferences > ArtiosCAD > Open ArtiosCAD documents is
set to either the ArtiosCAD Standard Edition or the ArtiosCAD Enterprise edition.

8.1. Canvas

The ArtiosCAD Canvas type document is a container for designing multi-part displays. These individual
parts in the Canvas may differ in the board format.

The parts of a Canvas can be saved as separate design files into WebCenter and then referred in a
document reference attribute with the name Canvas Parts.

Note: This document reference attribute is available in WebCenter by default. Read Canvas
related Attribute Categories

The Canvas document will also contain the meta-data about its parts.

Note:

« You cannot use the Canvas documents to run a Standard.

« Acanvas document cannot be used to create 3D view with aligned graphics. However, you
can view the 2D model with aligned graphics in the Viewer.

Canvas Information Tab
The Document Details > Canvas Information page has four sub-tabs:

« Geometry tab containing:
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+ Detailed design information

« Dimensional details

» Board and flute information,

+ Printitem details

+ Design preview

Parts tab displays the information regarding each part. The information displayed on this tab will
depend on whether these parts are managed by WebCenter or saved to WebCenter:

Canvas Information Document Information Approval Action History Annatations Projects
Geometry Parts 2D View 3D view (Collada) 3D Model (VEML)

Parts

Part Document Project

Part 1 PEMA_ACAD_CANVAST*OT . ARD PRMA_ACAD _Canvas_1

Part 2 PEMA_ACAD_CANVAST*OZ ARD PRMA_ACAD _Canvas_1

Fart 3 PEMA_ACAD_CANVASTI*03.ARD PRMA_ACAD _Canvas_1

Fart 4 FPEMA_ACAD_CANVAST*D4. ARD PRMA_ACAD _Canvas_1

« thePart name as defined in ArtiosCAD

- the Document file name (when not managed in WebCenter) or a WebCenter document name if it
is managed in WebCenter.

If the current user has the rights to view the document, it will be displayed as a hyperlink to the
referenced document's details.

If the document is not found, you will see a warning listing the possible causes.

- the Project name if the document is managed (separately saved to WebCenter). This will be
displayed as a hyperlink to the referenced project's details.

If the project is not found, a warning will be shown hinting at possible causes.
If the part is not managed in WebCenter, the Project field will be empty.
« the Version number for the parts managed in WebCenter.
The number will be “0” for the documents not managed in WebCenter.
« the Board name
« the Board Description - details of the board assigned to this specific part.
2D View tab shows a 2D view of the canvas file (default side)

3D View (Collada) tab shows the 3D view of the document with mouse controls.

Note: If 3D view cannot be created, then an error message will be generated.

3D Model (VRML) tab:

«  When you click on this tab, a VRML file (extension .wrl) will open in the browser generating a 3D
view.

Version

1

1

1

les

Boar
DECE
DECE
DECE

Q=20
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Note: The browser needs a plug-in for VRML format (e.g. Cortona) to generate the 3D
=== view of the document. If this is absent, the browser will download the VRML file.

Note: The Canvas documents should have folding angles to be able to render themin
2= 3D. You will see an error message if this information is missing.

~A Cortona
b

8.2. Opening Documents in ArtiosCAD Standard Edition /
Enterprise Edition

Set your My WebCenter > My Preferences > ArtiosCAD Preferences as either:

« ArtiosCAD Standard Edition to download an ArtiosCAD document from the WebCenter site and
openitinyour ArtiosCAD desktop application.

« ArtiosCAD Enterprise Edition to open the document in the installed ArtiosCAD Enterprise Edition

1. You may open your design / manufacturing /3D file you want to edit in ArtiosCAD desktop
application from:

« the document details page using the Openin ArtiosCAD button.
" the Project Details- Document Overview page, using the open ¢ button.
the Task Execution - Documents section page, using the open Ld button.

the Document Search Results page, using the open L0 button shown next to the document
name from the list view / grid view, or when you hover over the document in card view.
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2. Ifyour preference is set as ArtiosCAD Enterprise Edition, the system will launch the ArtiosCAD
Enterprise desktop application. To open documents in ArtiosCAD Enterprise edition, use the same
buttons as described. Also enter your login credentials for the WebCenter server.

The document will be loaded to the ArtiosCAD Enterprise workspace in manage document mode.
In this mode, you can publish the updated version to the same WebCenter project to which the
document belonged.
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9. Project Management in WebCenter

Users designated as Project Managers in their profile have a Projects | Manage link on their Projects
menu. In these projects, they have access to a number of additional features that allow them to
manage the projects.

Project Managers can:

Create projects, either blank or from a Template.

Invite members to the project and uninvite them.

Create project folders and add documents.

Set Characteristics and Attributes on the project and its documents.
Forcibly Accept or Reject documents requiring Approval.

Set the security on the project.

Manage Roles in their project.

Note: Only Project Managers who are members of the Admins group can save a project as a
Template. See the Administration Guide for more information.

Whenever a project is created, an event is logged in the audit trail and can be viewed in the
project history.

Basic information about the newly created project details like the Project Name, Project
Description, Project Manager, project was created from template are all mandatorily
recorded .

9.1. Creating Projects and Folders

Project Managers and Project Creator users can create new projects from a project template, or from
an existing project. Project Manager users also have an option to create from zero and they can create
new folders inside projects they manage.

Project Creators have to necessarily assign a project manager for the projects they create.

9.1.1. Create a Project from Zero

N

Login as a Project Manager or Project Creator.

In the Create or Projects menu, click Create Project.
Choose Start from a Blank Project in the Create list.
Fill in the new project's Details.

a) Enter the Name of the new project.

b) If you are a Project Manager user, by default you are the Project Manager of the project you
created. If you are a Project Creator, you can make another user or user group as the Project
Manager for this project by selecting the user name or group name from the Project Manager
list.
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c) To make the project active, leave the Status on Active.

Note:

If you are not sure that the project will be going forward (you need somebody else to
decide first), you can either:

« Make the project Non Active or On Hold,
- Make the project active (if you have the Task Management module), make the decider

a project member, and assign him/her a task to confirm/authorize the project as first
project task.

See Task Management in WebCenter on page 293 for more information about tasks.

d) If desired, specify a Customer for the project, and that customer's Location.

e) Touse a custom thumbnail, click Change beside the default Thumbnail.
Select Specify New Thumbnail and enter the complete path and filename in the associated field
or Browse for it. To use the default thumbnail, leave that choice selected.

f) If desired, enter a project description in the Description field.

g) To specify an optional due date, click the calendar at the end of the Due Date field and select
the desired due date. To set the due time, click the drop-down list to the right of the calendar
control.

5. To add Documents to the project, click Add Item in the Documents section and either:

+ Browse to the document to add,
« Copy a document from another project (select the project then the document to copy).

Tip: Use the “ icons to search for a project or document name.

You can then change the document's Name and add an optional Description.

6. Invite members to the project: select each member, role or group to invite in the Invite members
list

Note: You can Create and Invite New User to the project from the Invite Members drop
down list.

To remove a member, role or group, click the associated minus sign.
7. Click Create.

This brings you to the new project's details page.
Creating a project adds an event and this is stored in the Project History.
This event will add following information to the Project History:

« The Project/Template from which the new Project is created.
« The name.

« The Project Manager.

« The Salesperson (if there is any).

« The Customer (if there is any).

« The Location(if there is any).

- The description (if there is any).
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’ Note: When a project is created from a template or an existing project, then only the

changes (like deletion of attribute values or adding a new document) from the template
or existing project is logged in the events.

9.1.2. Create a Project from a Template

oo s

© ® N @

Login as a Project Manager or Project Creator.

In the Create or Projects menu, click Create Project.

Choose Use a Project Template in the Create list.

Select the Template from which you want to create the new project.

| @%| Tip: Toview the contents of a Template, click Show Details. This opens the Template in
another window. Explore the contents as desired and click Close Window to return to the
Create Project page.

’ ' Note: Depending on the template you choose, the fields you need to fill in may vary.

Fillin the new project's Details and if the project is created by a Project Creator user, then the
Project Manager's name has to be filled in mandatorily.

If desired, add Documents to the project.

Add Members to the project.

If the template has attributes defined, fill them in the Attributes section.
Click Create.

This brings you to the new project's details page.
Creating a project adds an event and this is stored in the Project History.
This event will add following information to the Project History:

« The Project/Template from which the new Project is created.
+ The name.

« The Project Manager.

« The Salesperson (if there is any).

« The Customer (if there is any).

« The Location(if there is any).

« The description (if there is any).

{ . Note: When a project is created from a template or an existing project, then only the
' changes (like deletion of attribute values or adding a new document) from the template
or existing project is logged in the events.
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Note:

The project is created with the same folder structure, documents, discussions,
characteristics, attributes, landing page, members, and security as in the template.

Any documents in the template are copied into the new project as new standalone documents,
even if they were linked documents in the template.

The list of Approval Users is copied if it is applicable; if there are conflicts, a warning appears
and you will have to configure new approval settings.

Fillin the Project Details

In the Details section of the Create Project page:

1.

Enter the Name of the new project.

If the option Use Automatic Naming is enabled, then the Name field is disabled.

When creating a project, you can choose another User/Group to be the Project Manager. Also, when
you copy from an existing project, you can also copy the Project Manager.

In such cases, you will not have visibility to the project once it is created.

To make the project active, leave the Status on Active.

Note:

If you are not sure that the project will be going forward (you need somebody else to decide
first), you can either:

« make the project Non Active or On Hold,
« (if you have the Task Management module) make the project active, make the decider

a project member, and assign him/her a task to confirm/authorize the project as first
project task.

See Task Management in WebCenter on page 293 for more information about tasks.

4. If desired, specify a Customer for the project, and that customer's Location.

To use a custom thumbnail, click Change beside the default Thumbnail.

Select Specify New Thumbnail and enter the complete path and filename in the associated field or
Browse for it. To use the default thumbnail, leave that choice selected.

6. If desired, enter a project description in the Description field.

7. To specify an optional due date, click the calendar at the end of the Due Date field and select the

desired due date. To set the due time, click the drop-down list to the right of the calendar control.

Add Documents to the Project

1.
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To add Documents to the project, click Add Item in the Documents section of the Create Project
page and either:

+ Browse to the document to add,
« Copy a document from another project (select the project then the document to copy).
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Tip: Usethe “ icons to search for a project or document name.

Create a document placeholder from a document template: select New in the Source list, select
the Document Template to use, and fill in any attributes that may be required.

Note: Thisis only available if your Admin has defined document templates.

See Document Templates in the Administration Guide for more information about document
templates, and Assigning Document Attributes on page 76 for more information about attributes.

2. You can then change the document's Name and add an optional Description.

Add Project Members

In the Members section of the Create Project page, you can either:

Invite members to the project: select each member or group to invite in the Invite members list.

To remove a member / group, click the associated minus sign.

If the template / project you are copying from contains roles: you can assign user groups or
individual users.

You can see roles the template / original project contains, and are available for assignment at
project creation time, in the Members section.

To assign arole to a user group:

Select that user group in the Group list.
2. Select whoin the group will be the User / Assignee.

Note: Leave the option Select User if you want any user of the group, or all of the
group users(depending on what was set when adding the role to the template /
original project) to be Approver / Task Assignee.

Note:

If you are using filtering (the role's name is the first word of the name of the group you
want to replace it with), you will only see the groups matching that filter in the Group list.

In the example below, the role is called Agency, and the list shows all groups starting
with Agency (followed by a space).

v Members
Role Group User / Assignee Invite Group

AGENCY | - Please select or start typing -

Please select or start typing..
Invite Mem AGENCY GHENT -
AGENCY GRONINGEN

AGENCY PRAGUE

Create Project

If no group matches the filter you will see the whole list of groups.

To assign arole to anindividual user:
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1. Leave —-Select Group—-in the Group list.
2. Select the individual user in the User / Assignee list.
3. Make sure Invite Group is deselected.

E b ] Note: You can Create and Invite New User to the project from the Invite Members drop
down list.

« Toassignarole toagroup with a specific user as assignee:

1. SelectaGroup in the Group list.
2. Select the individual user that you want to be the assignee in the User / Assignee list.
3. Make sure the Invite Group checkbox is enabled.
« Toassign several users and groups to the same role (this option may be enabled/disabled in the
parent project or template):
1. Select auser or group assignee you want to assign to the role.
2. Inthe Actions column, click the +icon to add another row for this role.
3. You can now assign the same role to multiple users and/or groups, using the + every time you
need to add a row and using - icon to remove a row.

You can also assign roles later if you don't have the user information ready.

Define Project Attributes

« If the template has attributes defined / you copied attributes from the existing project, you can still
edit them (if they are editable)in the Attributes section.

1 Attention: Certain attributes can be required. Those have a red asterisk (*). If the
template / project you copied from contains required attributes, you cannot create the new
project without filling them in.

For more information about attributes, see Assigning Document Attributes on page 76.

Uploading documents in project creation

9.1.3. Create a Project Based on Another Project
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1. LoginasaProject Manager or Project Creator.
2. In the Create or Projects menu, click Create Project.
3. Choose Copy setup from an Existing Project in the Create list.

E b ] Note: This option is not available for Project Creator users

4, Select the Project to copy from.

E b ] Note: You can only copy from projects you manage. If you are a project manager, you can
also copy a project from the project details More Actions... menu.

5. Inthe Copy setup from an Existing Project pop-up, select what you want to copy from the old

project into the new project (and deselect what you don't want to copy).
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Copy setup from an Existing Project

#| Copy Project Manager
# Copy Members
¥ Copy Approval Settings
# Copy Folders
Including Documents
Including Bill of Materials
# Copy Attributes
#| Copy Characteristica
# Copy Tasks | From Source Project ¥
#| Copy Security Settings
# Copy Motifications

# Copy Discussions

cocet |3

For Tasks, you can choose to copy the Tasks from the original Template or from another Template
by typing in the template name. The default setting is to copy Tasks from the Project that is being
copied.

Click OK.

Fill'in the new project's Details.

If desired, add Documents to the project.

Add Members to the project.

© ® N @

If the template has attributes defined, fill them in the Attributes section.
10. Click Create.

This brings you to the new project's details page.
Creating a project adds an event and this is stored in the Project History.
This event will add following information to the Project History:

« The Project/Template from which the new Project is created.
+ The name.

« The Project Manager.

« The Salesperson (if there is any).

« The Customer (if there is any).

« The Location (if there is any).

« The description (if there is any).
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’ Note: When a project is created from a template or an existing project, then only the

changes (like deletion of attribute values or adding a new document) from the template
or existing project is logged in the events.

9.1.4. Automatic Project Thumbnail Images from Documents

When a new graphics, ArtiosCAD or CHILI document is being uploaded to a Project or Template, the
user can have an option to check if the document image needs to be taken as the Project Thumbnail.

If this option is checked, the Project thumbnail will be set as the document image after checking and
registering.

You have to enable Make project thumbnail during the upload of documents to use this feature. You
can do so by setting up a document attribute with the exact name 'Make project thumbnail', using a
restricted set with values'yes' and 'no'(to create a checkbox).

{ ' Note:
]
When a document with the Make project thumbnail attribute set to “yes” is moved or linked or
copied to another project, that project’'s thumbnail will also be changed to the thumbnail of this

document.

Remember: This attribute has no effect when the document’s thumbnail is manually changed
to another thumbnail.

Notes on Thumbnail Images
When specifying a custom thumbnail, consider the following:
+  WebCenter automatically scales the thumbnail as needed to two sizes depending on where it is

used. The larger size is 100 x 100 pixels; the smaller, 50 x 50 pixels.

« The maximum file size of a thumbnail is 1 million bytes, whether it is custom or generated. This limit
is configurable; contact Professional Services for more information.

9.1.5. Create Folders in a Project
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You may only create one level of folders in a project under the Project Documents folder.

Login as a Project Manager or Project Creator.

Open the project you manage which will contain the new folder.

If it is not selected already, click Documents on the Details menu.
In the Folders column at left, click Add Folder in the Actions menu.
Enter the name of the new folder in the Folder Name field.

oo NN

Optionally, you can:
- Select Workflow Folder (Advanced) and select a workflow folder from the Configuration list.

This will turn the folder into to a Push Through Folder. A workflow folder automatically copies the
files uploaded into it to another folder (on the same or another server).
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Typically this other folder is a hot folder for a workflow application such as BackStage /
Automation Engine.

« Click Specify New Thumbnail to use a custom thumbnail for the folder. Enter the complete path
and filename in the associated field, or Browse for it.

To use the default thumbnail, leave that choice selected.

7. Click Create.

The folder is created. Project Manager can keep track of any changes made to the Project folders,
by enabling the notifications for Project Folder changed.

9.1.6. About Workflow Folders

What is a workflow folder?

When creating a folder the Project Manager can define it as a workflow folder, using a push-through
configuration defined by the Admin.

Any file that is uploaded into this folder will be automatically copied to a location defined in the
configuration. For this reason, workflow folders are sometimes also referred to as “push-through
folders”.

Workflow folders are particularly useful when that other location is a hot folder of a workflow system
such as Automation Engine, so that the file will automatically be processed by the workflow system.

Note: The Configuration for workflow folders needs to be defined by an Administrator.

Project Managers can then select one of the defined configurations when they create a new
folder.

Recognizing workflow folders

Workflow folders have a yellow icon with an arrow on it.

Folders IE, ﬁﬁ

[§ Project Documents
Il FRegular folder

13 Workflow folder

The files in a workflow folder have two extraicons:

The first B8 shows whether the copy of the file was successful or not.

The second ™ 'is a button to copy the file again to the location defined in the configuration.

System History Logs

All Push Thorough Configuration related events like
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« Push Through Configuration created
« Push Through Configuration deleted and
« Push Through Configuration changed

are recorded and stored in System History. Read this page on how to access the records.

9.1.7. Project Creation from a Dashboard

Dashboards are more interactive in order to edit the data which can then be saved or have forms where
input can be added. Project creation has been incorporated to enable easier collection of information
with specific action driven pages in Dashboards.

Admin users can set the Dashboard function to Creation Form in the Project context. Then an option is
available to add a Save and Cancel button.

€) This Dashboard now behaves as a Form. Do you want Add Buttons X

to add a Save and Cancel Button?

You can create customized Projects from an existing Project or a Template which are available in the
dropdown. When no Project or Template is selected, a blank project is created.

Save and Cancel buttons can be formatted with various configuration parameters available for the
blocks.

Creating a Project using a Button Block

You can configure a Button block so that clicking the button opens a Dashboard. The Dashboard can be
further configured to open a project creation form as shown in the image below.

Column Column

Configuration
List Layout . Label
List Layout My Butten (i3]

Icon

K icon-WCR_WF-Select

Kk My Butten
Link to
Dazhboard -
Dashboard
lefrProjectCreation -
List Layout Open in
Column Layout Papup -
Column Celumn
List Layout | . m Popup Width
Freject Manager Example Project .

M coomnlo Funmela ey abE Y

To use the Button with a Project Creation dashboard, follow the steps below.

Create a Dashboard with Project as Context.

Set the Dashboard Function to Creation Form.

Choose the Project or Template that you wish to create the Project from.

You can optionally choose to navigate to the new Project when it is created or open in the same
browser window.

SN
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5. Choose your Styling, Padding, Background color options for the Creation form.

You can add the Document Sources from which documents can be added tp the project created.

7. Now create another Dashboard with any context that you need and add a Button Block. In the
configuration of the block, link it to the dashboard created earlier.

8. Save the Dashboard.

o

Creating a Project using a Menu Layout

Similarly in the Menu Layout, you can create a Dashboard as stated above. Select the Button block in
the Menu Layout (with Bottom or Top or Left option).

Below screenshot shows project created from Dashboard.

Create Project in Menu Layout using a
Project Creation Dashboard Label

Column Column Create A Project from Doshboard &

Q) create Project using Link to lean

© iconWCR_ACAD -

| [ rmjecl from Dashboard
r Link to

£~ Dashboard in Browser tab Dashboard -
Dashboard
ﬁ Dashboard in pop up
BLsacreale project - r
K Dashboard in Menu Layout Open in
Mew browser tab -

w Menu Layout Placehalder

9.1.8. Synchronize the Project with a Workflow Job
If the Admin has defined a workflow connection, you can create projects that automatically create a
workflow job (see "Configure Workflow Connections"in the Administration Guide for more information).

The workflow jobs created will be automatically synchronized to the linked WebCenter projects when
certain events occur (as defined by the Admin).

However, if the Admin has enabled this possibility, you can also synchronize the workflow job to the
linked project (that you manage) whenever you need to.

To do this, click the synchronization q}' icon in the project header.

9.1.9. Create a Project from Automation Engine

With the Create WebCenter Project Automation Engine task, you can create an Automation Engine
Job and a corresponding project in WebCenter at the same time.

You can also retrieve information from WebCenter (Project Template, Customer Company...) and
associate it with the project you are creating, directly from Automation Engine.

This avoids double entries and duplication errors, and can be triggered from an MIS system for even
more automatization.

In this task:
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1. Select your WebCenter Site (it must be defined in the Configure tool).
2. Inthe Site Logon area, fill in your WebCenter User Name and Password.

You can choose to type in your password (which is then Encrypted) or to Use SmartNames that
resolve into your password.

Note: The user you enter here must be a Project Manager in WebCenter to be able to create
projects.

3. Enter the Project Name and Project Description to give the new project.

Tip: Aninteresting choice for the project name is the SmartName [JobName]. By selecting
the job name as SmartName for the project you can map the jobs in Automation Engine to
the projects in WebCenter.

4. In Project Manager Username, enter the user name of the WebCenter Project Manager that will
manage the newly created project.

Note:

« This user must already exist in WebCenter.

« This can be the same user as the one you logged on with, or a different one.

« Theuseryoulogged on with must have at least as much visibility in WebCenter as the
Project Manager you enter here.

5.
Click the Refresh \LI buttons.

6. The Project Template, Customer Company and Customer Location fields should now contain a list
of the WebCenter Project Templates / Customer Companies / Customer Locations visible to that
Project Manager.

Choose the Project Template, Customer Company and Customer Location of your choice.
7. Click Launch.

9.2. Editing Projects

Project Managers can:

« edit the project's general information in the Project Details > Project Information page,

« add specific information to the project, like characteristics and attributes,

« update the links to documents in the Project,
» change the Project status.
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Note: Only Administrators can save Projects as a template, so that other Projects can be
created based on it. See the Administration Guide for more information.

9.2.1. Add a Salesperson

9.2.2.

Project Managers can associate a Salesperson with the project. This can be any user in the system, but
has no specific rights in the project.

On the Project Details page, click Project Information.
Click Salesperson.

Select a salesperson and click Finish.

Click Save.

N s

Note: The salesperson does not gain access to the project unless he/she is invited as a
user, Project Manager or is part of the Admins group.

It is possible to search for all projects associated with a certain salesperson across WebCenter.

Note: Project Creator user can be set to a Salesperson after the project was created. This
is possible only if the Admin user has enabled Project Creator becomes Salesperson after
Project Creationoption in the Project Creation page.

View Project Source

Projects can be created in multiple ways, like from project template or from another project or a blank
project. When the projects are created from a template or from another project, some of the project
properties like the Documents, Tasks, Attributes, Characteristics, Discussions, Notifications,
Members can be copied to the new project.

In such cases, especially Tasks can be copied either from the project template or from the project
source.

Project Source is the existing project, which is used to create a new project.

Project Template will remain same for the existing project and any newly created project from the
existing project.

Project Template and Project Source information of a project is useful for the Project Managers and
Admin users to understand the origin of the tasks or documents or attributes.

Example

There are two projects and one template created. The name of the template is T1, the names of the
projects are P1and P2. The projects are created in following order:

« Pliscreated fromT1
« P2iscreated from P1

Following table shows the resulting values of the Project Template / Project source field
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Project / Template Project Source Project Template
T None None

P1 T T1

P2 T1 P1

Whenever a project is created using an existing project, the new project created has the same
Project Template as that of the existing project.

To view the Project Source of any project :

Navigate to Project Details page, click Project Information tab.

Specify Project Characteristics

N N

5.

Login as a Project Manager or Project Creator.
Open the Project whose Characteristics you want to specify.
Click Characteristics.

Select the checkboxes of the desired Characteristics. The selected Characteristics will appear
in the list of Characteristics. Click the + plus sign next to a Characteristic to see its children
Characteristics.

Click Change. The selected Characteristics will be associated with the Project.

To remove Characteristics from a Project, do the same as described above, but deselect the
checkboxes of the Characteristics to remove them from the list.

Specify Project Attributes

1.

oos oo

Loginasauser who is a Project Manager, or as a user who has the Change Properties permission
on the root level of the Project.

Open the Project whose Attributes you want to specify.

Click Attributes.

Choose the Attribute Category and click Change.

Set the values for the Attributes as desired and click Change.

The Attributes are assigned to the Project.

About Exporting and Importing Attributes

To make working with other systems easier, you can export and import project Attributes by using JOF
(Job Definition Format) files.

You can export the Attributes, modify them in another system, and then import their changed values
back into WebCenter.
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E b ] Note: You cannot add more Attributes to a project this way; this only lets you change the
values for existing Attributes.

Important:

If you want to import Attributes that are not generated by another WebCenter system, you
should generate a sample JDF file for the people using the other system to use as a reference,
so that they format their JOF file correctly.

The important lines are the ones similar to <eg:SmartName Name="Attribute Name”
Value="Value”/>; there must be a Value tag for each Name tagqg.

| Note: Option to Import from or Export to JDF buttons are enabled only when Allow

importing from/exporting to JDFis enabled in the WebCenter Security Preferences by
the Administrator users.

9.2.6. Export Project Attributes

WebCenter automatically names the exported file <Project name> attrs.jdf.

E b ] Note: Any periodsin the project name will be converted to underscores.

1. Loginas aProject Manager or Project Creator.
2. Openthe project with the attributes to export.
3. Click Attributes.
4. Click Export.

5. Click Save, browse to the desired location, and click Save.

9.2.7. Import Project Attributes

1. LoginasaProject Manager or Project Creator.

2. Navigate to the project with the attributes to import.
3. Click Attributes.
4,

In the Import from JDF file field, enter the path and name of the file, or click Browse and select the
JDF file.

5. Click Import.

The values for existing attributes are updated if necessary.
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. Note: If there are either too few or too many attributes defined in the file as compared to
== the project, WebCenter will mention it in a status message.

Update a Project

If you have a document that is linked in many Projects, and upload a new version into only one Project,
the links in other Projects continue to reference the prior version.

1. Open the Project to update.
2. Click Update on the Project Actions menu.
3. Alldocumentsin the Project are updated.

Alist is shown of the updated document(s), the containing Project, the old version number, and the
new version number.

Tip: To update more than one Project at once, get a list of the Projects, select them, and click
=0 Update Project(s)in the Actions menu.

Project Statuses

The Project Status feature allows you to review the current project standing. This feature can be
accessed by an Admin user or a member of the Admin group, Project Managers and an User.

An administrator can add statuses in WebCenter. This works similar to task statuses (whereas the
statuses are not shared). A status has a name, anicon and a type. The types are Non-active, Active,
Archived and Completed. The WebCenter has the functionality to limit the actions possible in not-
active and completed projects. It is most typical to add active statuses, for example: Briefing, Design,
Prepress, Printing. An administrator can limit the statuses for a project and this can be done for every
project individually.

The project status is displayed in the project header (and in available other locations such as search):

Note: This can be set as read only. Read more atPrevent direct changes to Project Status

Project: Lumi+ Purple

‘ umm Manager: Keizer, Debbie (DEKE)
s+ Upload Multiple Documents Customer:
Due On:
i Mail link to Modified: Jul 1, 2016
More...» Description:

The Project Manager can perform following:

« Setthe Project Status.
« View Project Status.
« Search Project Status and Filter projects based on Project Status.
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An administrator can limit the statuses for a project and this can be done for every project separately.
Go to a project or a template as an administrator and click on the Configure tab. By using Add Project
Statuses and Remove Project statuses (select with the check boxes and take remove from the action
drop down), you can get a specific set of statuses.

An Administrator can link milestones to project statuses to see the timeline of projects in a calendar
view by setting up a date/time attribute for project statuses. Each active status can have a date/time
attribute linked and the same date/time attribute can be used multiple times with different offsets.
The linked date indicates the intended end of the project phase, but will not trigger an automatic
project status change. The actual date will depend on the related attribute value in the project context.

The administrator can decide the sequence of the statuses. This sequence is purely used for sorting.
When the projects are sorted based on Project Status, this is the sequence used. The sequence is
system wide.

Apart from showing the Project Status in many project overview pages(and also in the search results),
the project statuses can be used in the Workflows. For example: To decide different operations or
assignees depending on the current project status.

Note: By using the Set Project Status node in Workflow, you can set the status for the current
“=% project.

In the following example, let us consider five statuses allowed for this project. The Project Statuses
are set as 01- Briefing, 02 - Concept, 03 - Artwork, 04 - Prepress and 05 - Closure. The WebCenter
has many more statuses, but only these statuses are allowed for this project. The statuses are in this
sequence in the entire system.

. Note: You can only decide per project whether you can have these statuses, but you cannot
“=% change the sequence of the statuses per project.

Project: Lumi+ Purple

t Upload Manager: Keizer, Debbie (DEKE)
Customer:
it Upluad Multiple Documents
Due On:
& Mail link to Modified: Jul 1,2016
More...» Description:
Documents Bill Of Materials Tasks Discussions Characteristics  Attributes Project Information Approval Motifications Configure More...~
Workflow Connection Document Templates ~ Project Creation ~ Document Types  Document Creation  Project Statuses
== Add Project Statuses
Name Active Color Icon
01 - Briefing (Complete) Active [ Esko Green Concept > Artwork > Prepress > Closure )
02 - Concept (In Progress) Active . Esko Green Briefing Concept > Artwork > Prepress > Closure >
03 - Artwork (In Progress) Active . Esko Green Briefing Concept Artwork > Prapress > Closura )
04 - Prepress (In Progress) Active . Esko Green Briefing Concept. Artwork
05 - Closure (In Progress) Active . Esko Green Briefing Concept Artwork Prepress m

A new Project Status type has been introduced called Archived. You can set this status based on the
stage of the project. Archive Project status is visible to users based on the setting specified by the
Administrator in the Security Preference.
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Read more on Project status as Archived here.

On archiving the Project, the project is excluded in the Project list and is not shown in the My Projects
or Project | Manage menu items. The Project as well as the Tasks and Documents within the project
does not show up in Search Results or in My Work page.

Trying to access the Project with an URL from a notification for an archived project gives a permission
denied message.

Change the Project Status

A project can have different statuses. For example:
« Active

« Non Active

« Completed

+ Archived

In additional to the standard statuses, custom statuses may have been defined by the system
administrator. A project or template can have its own specific set of available project statuses. Every
project requires at least one active status.

The project manager can set the project status from the project details header, or in the Status list on
the Project Information page.

When searching, you can search for all projects, or projects that have a specific status like Active,
Archived, Not Active, or Completed. It is also possible to search for All Active, All Not Active or All
Completed projects or All Archived, and this type of search would include different (custom) statuses
of the same type.

Displaying a Project Status

The Project Status can be viewed by an Administrator, Project Manager and a Project Member.
The status of a WebCenter project is displayed in following ways:

« The statusis displayedin the project header of each page of the project.

- The statusis displayed in the columns of the project overview pages (Project | am Invited to,
Favorite Projects and Projects | Manage).

« The statusis displayed in project search results if this column is requested to appear in the search
result.

If aniconis available, the Project Status is displayed as an icon with its status name. If noicon is
available, the project status is displayed as a name only. If the option hide thumbnails is active, only
the status name is shown. The icon is displayed in true size.

Customizing a Project Status

An Administrator can set allowed statuses for Templates or for Projects. By doing this an Administrator
can limit the number of Project Statuses to be used for a specific project. When adding a new project
status to the system, this status will be also added to all projects and templates. When a project is
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created from a template or from another project, it inherits the allowed statuses from its source. This
happens only once and does not happen when the template changes later.

1. LogintoWebCenter as an Admin user.

2. Click the Admin > Project Management and select Projects or Templates.

3. Click the required Project or Template link from the list.

4. Click the Configure > Project Statuses. This displays a table with the current allowed statuses for
this Template or Project.

5. Select the required Project Status from the list and then click the Add Project Statuses link.

i = ] Note: By default a blank Project will get the list of all statuses as allowed statuses.

6. Click the Save button to make changes.

{ =l Note: The Project Status cannot be re-ordered here, the order is inherited from the system
order.

You can remove allowed statuses for a template or project by selecting the status and select Remove
from the Actions menu.

Set a Project Status using the User Interface

An Administrator or a Project Manager can set the Project Status for the current project using
WebCenter Ul. A Project Status is changed by selecting a new project status from the status drop
down list in the header of the project pages. The drop down only contains the allowed statuses.

MNon-active |

Completed

Validation

Set a Project Status when creating a Project

An Administrator or a Program Manger can set the Project Status while creating a new Project. When
creating a new project through the WebCenter User Interface, there will be a drop-down allowing to set
the project’s initial status. The drop-down will default to the first Active status.
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@ Note: The Completed statuses are not shown because you cannot create a Projectin a

=== completed status. In case the Project is created from a Template (or a copy of another Project)
it may be possible that the Project Status field is hidden. If so, the newly created Project will
get the first Active status.

9.2.13. Searching based on a Project Status

You can search for projects based on their Project Status. Choose Search from the menu bar and
select Project or Tasks and Approvals. On the (advanced) Project Search page and the Task Search
page, the list box will contain the list of all the Project Statuses.

In addition to all individual project statuses, the list also contains the following:

- Show All(default): show all projects (or tasks of all projects).
« Show All Active: show only projects or tasks of projects with an active status.
« Show All Not Active: show only projects or tasks of projects with a non-active status.

«  Show All Completed.

Project Mame

Description

Project Status | Show All I
Created Show All Active v
Show All Not Active
Show All Completed
Modified Non-active A
Active
Due Cancept Art (at risk) v

Customer/Location
Salesperson
Project Manager
Manager's Location
Add Role

Attributes...

248

Briefing (at risk)
Briefing (on track)
Cancept Art (on track)
Lancement

PAO Contrile

Erreur Contrile

En attente Lancement
PAQ Contrdle OK
PitStop oK

PitStop Avertissement
Pitstop Erreur

En cours de traitement
Naouvelle Soumission
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You can also search on Project Status Started, Project Status Due,Project Status Completed, Project
Status Duration, and Project Status Time Left in the Project Search page.

9.2.14. Filtering based on Project Status

In Favorite Projects, Projects | Manage, and in Projects | am Invited to, you can filter on all Project
Statuses individually. You can also use the filters to look for a combination of statuses: Show All, Show
All Active, Show All Not Active, Show All Completed.

9.2.15. Document creation settings in a project

In a project, go to the Configure > Document Creation to view the template from which the document
upload configuration is taken.

To change this, select the template from the drop down list. You will see a list of templates with a
custom document creation configuration. This will update the project document creation settings with
the selected template's settings.

Documents Bill of Materials Tasks Discussions Characteristics ~ Attributes Project Information ~ Approval  Notifications = Configure | More...~
Workflow Connection Document Templates Project Creation  Document Types Document Creation Project Statuses

Default

® Anocther Template's Document Creation Setup
Display_LUMIH+ v Click to see details

The dropdown lists only the Templates with a custom Document Creation Configuration

9.3. Managing Project Members and Permissions

Project Managers are responsible for managing who gets access to their Projects: they can add
members to a Project, remove members from a Project, and set their permissions.

9.3.1. Roles

Roles are created at a global level which the Project Managers (or the selected Project Managers) can
use in individual projects and templates. You can invite these Roles just like Users and Groups.

Roles are effective after real members (Groups or/and Users) are assigned to each of the Roles. A
project Role assignee will be treated like a standard project member. Once you assign the Role to a
project, these take over the role’s security setup, approval setup and task assignments.

Multiple assignments of Roles are possible. For example, if you have a "Designer” Role, you can invite
this Role to all the Projects that require a designer either after creating a Project or via the Project
Template with assigned Roles.
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{ =1 Note: You need administrator rights to create Roles. The visibility of the Roles can also be
determined by the administrators.

Read more about Roles in the WebCenter Administration Guide in Roles.

Role Assignments in a Project

The Project Manager and all the Members of a project can view all existing Role assignmentsina
project in the Project Members page.

{ =|| Note: You can filter on the Users, Roles and Groups in the Members tab. Alternatively you can
2= search using the Role name in the field.

Members
¥ 2t Groups v Roles ! Users Company m
4 Add Members 27 Manage Roles Q
Members in Project Role Assignment
Users
Firo, Pieter-Jan (PJPR PRINTER Change Permissions
Roles
AGENCY Change Permissions
DESIGNER Change Permissions
PRINTER Change Permissions
£ Groups
2 AGENCY GHENT AGENCY Cha

2 DESIGNER GENT DESIGNER [ Assignee: Keizer, Debbie (DEKE) | Change Permissicns
Role members are displayed in the list as regular members under the Roles project member type
section.

You can see the Roles assigned to the Users and Groups in the Role Assignment column for user and
group project members.

{ =l Note: When assigning users to a Role, the drop down also shows the deactivated users that

=== you can reactivate while assigning the role. Admin users can activate any users whereas
Project Manager and other users with Create User rights can only activate the users they
created.

If a User is specified from the Group for a particular Role, this information is displayed next to the Role
reference in the Role Assignment column as [ Assignee: USERNAME].

Managing Roles in a Project

If a project has at least one role among its members its Project Manager can access the Manage Roles
page to define role assignment within the project.

1. LoginasauserwhoisaProject Manager.

2. Openthe project for which you want to manage the roles.

3. Click the Members tab. A list of the current members is displayed.

4. Click Manage Roles link in the column header.
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Manage Roles

Change | | Cancel

For each Role, first select the Group to be assigned or leave it on 'Select Group® to specify a User Assignee (use the second list for that). Use Invite Group checkbox to
specify a Group User Member Assignee when assiging to a Group.

Role Group User / Assignee Invite Group | Actions

_REQUESTOR |Please select or start typing... - Jensen, Kim (KSJ1) - -‘_;) -_-i—)
AGENCY Please select or start typing... - skva (SKVA) - -‘_;) -i—)
AGENT Please select or start typing... - Beckner, Brieann (BIBE) - -&) -j-)
APM Please select or start typing... - Please select or start typing - =@
APPROVER(S) |Please select or start typing... - Please select or start typing... v =@

Change | | Cancel

Removing a Role Assignment

Each Role assignment is represented as a separate project member on the Members page. It can be
deleted from the project by uninviting it as in the case of removing a project member.

You can also remove the existing role assignments from the Manage Roles page.

Removing a Role from a Project

You can remove a Role from a project in the same way as removing a User or Group. By deleting the
entry for the User or Group with the Role combination, you can remove the Roles

(f Note: When you have Roles assigned to Users or Groups, you have to delete the assignments
(assigned reqular members) before being able to uninvite the Roles from the project.

1. Login as a Project Manger.
2. Open the Project from which you want to remove Roles.
3. Click Members.

A list of the current members is shown. If desired, use the filter to refine the list.

4, Select the Roles which need to be uninvited from the Project. Select the User or Group entries
assigned to these Roles to unassign them from this role, if the Roles are already assigned.

5. Click Remove from the Actions in the header.

6. Click OK to confirm the removal. The selected Role(s) and its assignments will be removed from the
Project.

Using Roles in Approval Setup

You can use Project Roles in approval directly as an Approval master and/or as an Approver.When
adding a Role to an Approval setup as an approver the user doing so has to choose between two
options for the Type:

« One of Role: Only one of the role assignees needs to approve on behalf of the Role. This is the
default setting.

Tip:

It is possible to change Role assignments after starting the Approval cycle if you select One
of Role option. Use One of Role if there is only one role assignee.
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« All of role - One per Group: All of the User and Group Role assignees will replace the Role as
Approvers. When you choose this, for each Group, its representative Role assignee will become the
approver on behalf of the whole group.

« Allof Role: When you select this, all the User and Group role assignees will replace the role as
Approvers. In this case all the members of the Role-Groups will become the approvers.

Project Approval Setup

Approval setup has changed since last Save

m Revert Clear
Due Date No Due Date v
Approval Master Me v
E-mail Notifications Mo Notifications v
Convert to Staged Approval
- Add Approver — v
@ Approver Type

® DESIGNER All of Rale - One per Group v

« Allow conditional Approval

When one User rejects

Stop Approval cycle after every approver decided v

Require review state on all annotations

No A

{ =w| Note: You cannot start an Approval cycle with unassigned Roles in the project. When the
approval cycle starts, all the Role-approvers are replaced as their assignees and the Roles will
no longer be visible in the Approval Setup.

If a Role is set as the Approval master, all the Role-assignees(Users and members of the Group)
become the real Approval masters.

Changing Role Assignments
From WebCenter 14 onwards, you can easily change Role assignments within a Project.

1. Go to Project > Members. Click on Manage Roles to get to the Role Management page. You can see
the list of Roles associated with the Project. You may also access this page from Project Creation

page.
In the Manage Roles page, you can see the existing Role assignments. You can change or remove
the existing Role assignments from here.

2. Youcan:
« adda Group to the Role
- create a new assignment for the existing Roles. Use the User/Assignee dropdown to choose

another User as the new Role assignee.

+ add/delete members from the same Role. Use the + and - controls respectively.
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When an existing Role Assignment is changed, all the Role dependent Task and Approval
assignments will get transferred to the new Assignee. This transfer of assignments only happens if
the current Assignee loses access to the Project by getting unassigned from the Role.

In situations where a User or a Group is only invited to the Project via a Role Assignment, a Role
reassignment will result in that user's /group's removal from the project. Approval and Task related
dependencies are checked to prevent leaving the Project workflow in an inconsistent or blocked
state.

Delegating Roles

Go to the Manage Roles page. If you have been given permissions to assign Members of a Role or to
change Role assignments, it will be displayed.

If you do not have the permissions to manage any roles, a message will indicate this.

Add Members to a Project

Users and Groups need to be added to a project before they can access and use it.

1.

2.
3.

Login as a Project Manager or Project Creator.
Open the project to which you want to invite members.
Click Members.

Alist of the current members is shown.

4. Click Add Members in the column header.

Add Project Members window is opened, where you can select and add new member to the project
from the New Project Members drop down.

Select the role for the newly added user from the Assign to Role and click Continue.

{ ' Note: You can Create and Invite New User to the project from the New Project Members

tab from the drop down.

Set the project permissions as desired. These permissions apply to all members being added in this
step. Then click Finish.

A successful status message appears along with a list of suggested subsequent tasks.
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Note:

If the project already has any number of roles among its members a drop-down list containing
these roles is displayed at the top of the ‘New Member Selection’ step of the ‘Add Member to
Project’ wizard.

By selecting a project role while specifying users/groups to be invited to the project the
project manager can at the same time assign the desired new members to the selected roles.

The Set Project Security for New Members step fills up the security matrix with the original
setup of the selected role.

Take into account that you cannot assign a role to another role in a project - any role objects
selected from the list of the desired new project members will be disregarded (they won't even
be invited to the project)if a role assignment’ is specified using the appropriate drop-down list
while picking up new project members.

By introducing roles than can be assigned to multiple user or group members it is now possible
to have a same user or group member invited into the project via different role assignments
(i.e. Joe Designer can be invited into a project both as assigned to DESIGNERS role and
independently without any role assignment). Every such combination of a member and its
assignment is considered (and presented) as a separate project member.

9.3.3. Remove Project Members

Note: You may only remove Project members who are not Approvers in an active Approval
Cycle.

Login as a Project Manager or Project Creator.
Open the Project from which you want to remove members.
Click Members.

Alist of the current members is shown. If desired, use the filter to refine the list.

Select the users, groups and roles to uninvite from the Project. In case you want to unassign a user
or group from a role, select the specific entry for this combination.

Click Remove in the actions menu.
Click OK to confirm the removal.

The member(s)are removed from the Project.

Note: Project Manager can enable the Remove Project Members notifications to ensure an
event is saved in project history and also to notify involved people or other members of the
project.

9.3.4. User, Group and Role Permissions in a Project

When a user is invited to a project several times(as an individual user through the Add Members
function, as part of a Group and/or as part of a Role), his/her permissions on the project are calculated
as follows:
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As a general rule, all permissions are added so that the user has the most permissions. For
example:

1. Theuserisinvited to the project with the View and Download permissions.
2. Heisadded to aRole that has the Add permission on this project.
3. Thenthe user will have the View, Download and Add permissions on this project.

Exception 1: when a user is already invited directly (as an individual user) to a project, re-inviting
him/her through a Group doesn't change his/her permissions.

Exception 2: when a user is only invited to a project through a Role or Group, you can change his/
her permissions when re-inviting him/her as an individual user. This allows you to either restrict
permissions for a specific user, or give him/her more access.

E ] Note:

In this case, when inviting the user individually, his/her existing Group or Role permissions
for the project will be suggested, and you will see a warning explaining that changing the
user's permissions at that point may interfere with his/her ability to perform project tasks.

For example if the user has a "Designer"role, and you remove her Add permission, she won't
be able to upload designs to the project!

9.4. ArtiosCAD Default Projects

You may see WebCenter projects with names starting with ACadDefaults .

Do not modify these projects as they are automatically created by ArtiosCAD (and Cad-X) to store
defaults.

They are named with the following patterns:

ACadDefaults <version> <language-code> Shared, where <version> can be for
example 12.0 and <language code>en.

These projects are created when you run the ArtiosCAD Defaults Installer. ArtiosCAD users should
have View and Download rights on these projects.

Do not delete these projects as this would take away some CAD functionality!

However, if you want to install new defaults, or in case the defaults installation was interrupted,
you will have to delete the corresponding ACadDefaults_ project before reinstalling the defaults
(which will create anew ACadDefaults_project automatically in WebCenter).

ACadDefaults <version> <language-code> <login name>, Where<login name>is
the login name of an ArtiosCAD Enterprise (and WebCenter) user.

These projects are created when a WebCenter user logs into ArtiosCAD and defines defaults to
work with. ArtiosCAD will update them automatically if that user changes his/her preferences (in
ArtiosCAD).
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9.5. Defining Approval Settings

Document, Folder and Project Approval Settings

You can define approval settings at the document, folder or project level. You can also define approval
settings on a number of documents in a folder or project.

(f Note: Defining approval settings for a project (or folder) does not mean the project (or folder)
itself is being approved. Rather, it means that users adding documents to the project can use
these pre-defined settings to save time and reduce the chance for error.

When you want to setup an approval cycle for a document, you can:

« define document-level approval settings, that will only be used for that document (Setup Approval
or Setup Staged Approval),

« load the enclosing folder's approval settings, if the document is in a folder that has approval
settings defined (Load Folder Approval Setup),

- load the project's approval settings, if it has approval settings defined (Load Project Approval
Setup),

« use the default approval settings for that document (Start Default Approval Cycle). Those are:
the enclosing folder's approval settings (if the document is in a folder with approval settings), or
otherwise the project's approval settings (if they are defined).

Exceptions

« URL documents may not have approval cycles.
« Anapproval cycle may not be started on documents in Templates.
« Anapproval cycle may not be started on linked documents.

Permissions Needed

« You need the Change Approval permission to create or edit an approval setup.
« You need the Start / Stop Approval permission to start or stop approval cycles. This is the same as
the Lock / Update permission.

The project manager and the administrator can always define / edit the approval settings (at the
project, folder and document level).

For more information about permissions, see Project and Document Security on page 281.

9.5.1. Simple Approval and Staged Approval

256

What is Simple Approval?

When a user or a number of users need to approve your document(s)in no particular order, you can use
simple approval.

All approvers are notified at the same time and get the same due date (if a due date is defined).

What is Staged Approval?

When your document(s) need(s) to be approved by several people or groups of people, in a sequential
order, you can use staged approval.
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The staged approval cycle works with approval stages, and each stage only starts when the previous
stage is completed.

This allows you to be as close as possible to your company's real life approval process, while taking
advantage of WebCenter's automating and tracking capabilities.

For example, if a document needs to be approved by the marketing, finance, and legal departments,
you can use three approval stages.

« Inthefirst stage one or several people from the marketing department can be asked to approve the
document.

« Inthe second stage the finance department can approve or reject the document,
« Inthe final stage the document is sent to the legal department for approval.

9.5.2. Setting Up an Approval Cycle

WebCenter enables you to define a number of approval settings like who can approve the document?,
when ( due date)? and what happens if the document is rejected? and so on to match your real-life
business process as closely as possible.

i = ] Note:

You need the Change Approval permission to create or edit an approval setup.

To get to the simple approval setup page (for a project, a folder or a document):

1. Gotothe Approval tab:

For... click...
aproject ... the project page's Approval tab.
£
If your project has(sub)folders, go to the project page's
Documents tab first, and click the top-level folder at
left (called Project Documents).
This ensures you have selected the project, and not one
of its (sub)folders.
afolder ... the folder you want to define approval settings for on the
project page's Documents tab.
Then click the Approval tab.
adocument ... the Document Details page's Approval tab.
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For... click...

i = ] Note:
You can also get to the Approval tab by:
« clicking Setup document approval right after

uploading the document to the project,

« clicking the Setup Approval Cycle link
corresponding to the document on the project's
Documents tab.

several documents ... Actions > Setup Approval Cycle after selecting the
documents in the project or folder.

i =| Note: This will start the approval setup from zero, even
if some of the documents selected already have an
approval setup.

2. Click Setup Approval.
You will see the Approval Setup page where you can configure a simple or staged approval.

3. Define Settings such as the due date, approval policy for the new version, approval master and
notifications.

Click on the ﬂ' Show Stage Configuration Details to set up conditional approval, document
rejection policy and annotation review requirements.

To set up a staged approval, you need to add an approval stage and specify stage specific
configuration and approvers.

5. Add Approvers on page 267
6. Save.

i = ] Note:

« You canonly set up an approval cycle for a project/folder/document that does not already
have a started approval cycle.

Add an Approval Stage

Your approval cycle already has one approval stage by default.

1. Define Settings such as the due date, approval policy for the new version, approval master and
notifications.

2. Click Add Stage. Give the stage a name. The names are set by default as Stage 1, Stage 2, etc.

Users with change approval permissions, can change the stage name by changing the text in the
edit field.

Click on the ﬁ' Show Stage Configuration Details and:

a) Decide to Allow conditional approval or not (see Allow Conditional Approval or Not on page
264).
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b)

c) Define what to do when one user rejects the document (see Define How to Handle Document
Rejection).

d) Define annotation review requirements.

4. Add approvers to the stage (see Add Approvers on page 267).

6.
7.

Click Add Stage to add another stage.

E b ] Note: This adds a stage after the last stage. To add a stage before the current stage, click
Insert Stage above the current stage instead.

Repeat steps 2 to 4 for each stage.

If necessary, you can drag a stage up or down to reorganize your stages.

To remove a stage, click the minus button in front of it.

9.5.3. Approval Cycle Settings

WebCenter allows you to define a number of approval settings (who is the master approver? when?
what happens when a new version is uploaded? who should be notified? etc.)

To define these, use the Settings section in the Approval Setup page.

Set the Approval Due Date

For a simple approval, you can set a single due date, which is the same for all approvers. Choose how to
define the Due Date in Settings:

Choose No Due Date if you do not need a due date for your approval cycle.

E b ] Note: Approval cycles tend to take longer when they don't have a due date.

Choose Fixed Due Dates if you want to give a fixed due date to your approval cycle.

Choose a due date from the calendar, or type it using the one of the following formats: 2 May,
2010,5/2/20100r5/2, 2010.

Then choose a due hour from the list.

When there are multiple stages involved, then the Due Date Calculation can be done in multiple
ways. Read more about Due Date Calculation on page 262 here.

Choose Lead Time to define how much time the approval cycle should take (as a maximum).

Define the Lead Time in Days and / or Hours. It is added to the date the cycle starts, to define the
cycle's due date. For example if the cycle starts on May 2nd and has a 2 days lead time, it is due to be
completed on May 4th.

A Attention: WebCenter only takes week days into account. So if you start the cycle on a
Friday with a 3 day lead time, it will be due the next Wednesday and not the next Monday. By
default, Saturday and Sunday is considered as weekend. However, it is possible to switch
the weekend days to Friday and Saturday. The due date calculation will ensure that the due
date will always be on a weekday.
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« Choose Lead Time with Final Due Date to give your approvers a lead time and give a final due date
for the approval cycle.

If the document has to be re-uploaded and re-approved, it will be given the same lead time again.
The final version of the document has to be approved by the final due date.Link your Approval Due
Date to a Date/ Time Attribute on page 260

Link your Approval Due Date to a Date/ Time Attribute

WebCenter enables you to define Project (or Document) Statuses using Attributes (Date-Time
attribute). You can link your approval due dates to these Project or Document Milestones, if you have
the milestones specified.

If your Project's Attribute Category contains Date/Time Attributes, you can choose your approval due
dates based on them. You can use these Attributes in Project/Folder/Document approvals. The setting
also allows you to specify an offset value along with the attribute value. For example. “Final Approval
Date” - 2 days.

Date/ time Attributes can be used as the final approval date or as stage approval dates. If you change
the attribute value, the linked approval due dates are updated including that of any ongoing approval
cycles. A due date change will trigger a notification to the approvers, based on Notifications chosen.

1. Inthe settings section, choose the Due Date as either of the following options:

+ No Due Date
« Fixed Due Date
+ Lead Times
« Lead Time with Final Due Date
2. If you select Fixed Due Date, you can specify the Due Date for each approval stage separately. You
can specify:

- aSpecific Date. In this option, you can select a date from the calendar.

« oraDatein Project. This option lists the Date/Time Attributes, from which you can select. You
can specify an offset period in days and/ or hours. The offset is added or subtracted from the
Attribute value.

» Specific Date

w Date in Project

Offset | ofu | = 0 days 0 hours

JEPE Milestone Approval Finished

JEFE Milestone Artwork Created Date
Attribut
JEPE Milestone Artwork Released butes
Jun 29, 2017 at 15:00 -
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When you save, your approval due date is calculated using the date value given in the attribute and
the specified offset. See the example below:

Stage [
(® Approver Type
® Penninck (JEPE) User
% | adds ) L | Jul 28,2017 at 15:00 (JEPE Milestone =

Approval Finished = 3 1

Due Date can also be calculated for all the stages at once if Specific Due Date is chosen. Read
moreDue Date Calculation on page 262

3. If you selected Lead Time with Final Due Date, you can select the Date /Time attribute +/- Offset in
the Final Due Date drop down. The options are exactly the same as above.

.Note:

If you change your Approval Due Dates, the Milestones do not get updated.

« The Due Date calculations use only working days.

- if you change the attribute value after the completion of the stage, it has no impact on the
Due Date of the completed stage.
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Due Date Calculation

You can calculate the due dates for the different stages using the Due Date
Calculation option. Any calculation done on this page is applicable for all the stages.

Due Date Calculation

Calculate New Due Dates

Give Each Stage |6 Days |0 Hours
Shift Due Dates with |4 Days |0 Hours

Shift Due Dates to have Latest on

Feb 07,2018 17:00 - ®

Shift Due Dates to have First on

17:00 - ®

# Distribute Due Dates Evenly

From 17:00 - ©
To 17:00 - ®

- Give Each Stage___ Days and __ Hours: Specify the exact number of days and hours for each stage
in the approval cycle

- Shift Due Date with __Days and __ Hours: Shift the due dates specified as fixed or as a Date/ Time
attribute to the given number of days and hours

- Shift Due Dates to have Latest on: You can shift the due dates specified as fixed or as a Date/ Time
attribute to not exceed the number of days and hours

- Shift Due Date to have First on: You can shift the due dates specified as fixed or as a Date/ Time
attribute to have first on the number of days and hours

« Distribute Due Dates Evenly You can distribute the Due dates equally amongst all the stages by
choosing this option

Define How to Handle a New Document Version

When a document's approval cycle is started, and someone uploads a new version of that document,
the approval cycle may stop or restarted based on the option chosen in the workflow. You can define
what happens to the new version of the document.

« Inthe When a new version is uploaded setting, choose either:

- Approval Restarts from Beginning to restart the approval cycle from zero. People who already
approved / rejected the document will have to evaluate it again.

- Approval Restarts from Current Stage to keep the approval stages already completed (typically
approved)and restart the current stage. Approvers who already approved / rejected the
document in the current stage will have to evaluate it again.
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« Approval Continues to keep all the approval actions already done. Only approvers who rejected
the document earlier will reevaluate to check whether the reason for their rejection was
corrected.

Set the Approval Master
In the Approval Setup > Settings section:
« Choose the Approval Master. This can be:

« Me(the person currently editing the approval setup),

- the Project Manager,

« the document Uploader,

- any project member with View access to the document (users, groups and roles).

The approval master is the person who gets the approval follow-up under Approvals to Follow Up on
his My Work or in Dashboard pages.

Notifications are received by Approval master as an information only.

Approval Master can now Force Approve or Force Reject Approval stages. This is a configurable
option in Security Preferences. Admin users can configure the Force Approve and Force Reject to
be allowed by either

« Administrator, Project Manager and Approval Master or
« only Approval Master or
« Project Manager and Administrators

Set Up Approval Notifications

Notifications are email messages sent to users involved in an approval cycle when certain approval
events occur, like for example User Rejected Document, or Approval Cycle Finished and so on. You
can define the notifications that can be received and when in the Approval Setup > Settings section.

Note: The system administrator must configure WebCenter to send e-mail for notifications to
work. Regardless of the e-mail configuration, the My Approvals section on the My Work page
shows items waiting for approval.

1. Choose the type of E-mail Notifications to use:

- No Notifications if you do no't want to notify any user of the progress of the approval cycle,

- Default Notifications if you want to use the project's or the folder's notifications (if the
document is in a folder with notifications defined, they will be used, otherwise the project's
notifications will be used),

« Custom Notifications if you want to select who to notify (only for this document).
2. If you have chosen Custom Notifications, define who to notify for each approval event:
+ the Project Manager,

- the Involved People (the people who are involved in a particular event, for example when an
approval comment is posted, the Involved People are the document approvers).

Tip: Click on Involved People to see a list of involved people for each event.

+ the Project Members.
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Manager Loozoe Members

Notification People

Approval Stage started

Approval, Rejection or Approval Comment posted
Document rejected

Ongoing Approval Due Date changed

Approval Stage finished

Approval Cycle finished

Approval stopped

Approval Setup changed

N

©| Tip: You can use the top check boxes to notify the Project Manager, the Involved People or
“= the Project Members of all approval events.

9.5.4. Approval Stage Configuration Details

You can access this by selecting the ﬁ icon on the approval stage header. This configuration is
required when your

«  Document(s) need(s)to be approved by several people or groups of people, in a sequential order,
you can use staged approval

« The staged approval cycle works with approval stages, and each stage only starts when the
previous stage is finished

Allow Conditional Approval or Not

Use conditional approval to allow your approvers to give their approval on a certain condition (for
example, if a barcode in the document is corrected).

The conditions (like the comments and the reasons for rejection) will be shown in:

- the Approval tab of the Document Details page,
« the Action History tab of the Document Details page,

« the Document History in the Viewer.

« Decide to allow conditional approval or not.
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Note: This option is hidden if the administrators have turned off the Admin > Preferences
> Security Allow Conditional Approval option in Approval setup option.

{ =

{ = ] Note:

When working with an Automation Engine workflow, documents you approve conditionally in
WebCenter will go through the Approved with a Condition output of the Publish on Web task in
your Automation Engine workflow.

o
Wait for Action
[Checkpoint)

Use a Wait for Action (Checkpoint) task for those documents, so the Automation Engine
operator can fix them manually.

Allow Forward Approval Link

The option to Allow Forward Approval Link is enabled in Approval setup based on the system settings
by the Administrator users in the System Settings.

When the option is enabled, then either an Administrator user or Project Manager or any other user
with Change Approval permissions can then use this option to allow the approval to be forwarded as a
link.

This option is not visible if the Administrator has not enabled the option.

It is also possible that an Approver may want to forward the approval as an email link to other users. It
can either be a Registered user of WebCenter or an unregistered user. The approver who forwards, can
then choose to either be part of the approval cycle or not after forwarding.

Keep or Revoke Forward Approvals

Keep Forward Approvals

When Allow Forward Approval Link is selected for a stage, then the option to Keep Forwarded
Approval is available. The forwarded approvals for the current stage are retained when a new version
of the document is uploaded. If the forwarded users have already submitted their approval status, it is
also added to the new version based on the settings.

Revoke Forward Approvals

Any approval forwarded can be revoked by either the Administrator or the Project Manager(s) or the
user who forwarded the approval.
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Inherit Previously Submitted Approvals

You can inherit the approvals done at a particular stage, if the same stage is restarted. The option is
available in the traditional approval as well as in the workflow driven approval. When an Approval Stage
is started, a check is made to know

« |fthere are any already submitted Approvals on this document and
« Inherit Previously Submitted Approvals option is enabled.

Inheritance of the Approvals are done only if the previous approval state is either Approved or
Approved with Comments. Approvals in previous stages with status such as Rejected, Forced
Approved, Force Rejected or Force Approved with comments are not inherited.

Inheritance of an approval is done, irrespective of whether the user is still an Approver. We consider all
document versions except the deleted versions, when checking for approval statuses.

Note:

1. Notifications are not sent for inheritance of approvals but approvals are tracked in the
Documents Action history.

2. Approvals with conditions are considered as reqular approvals, when they are inherited.

3. Version number of the document from where the approval is inherited is also mentioned in
the Approval set up.

Define How to Handle Document Rejection
« Define what to do when one user rejects the document:

« Choose Stop approval cycle immediately if you don't want to bother the rest of the approvers
with a document that will have to be corrected and re-approved anyway.

Note:
That document version gets rejected as final approval status.

The approval request is removed from the to-do list of the approvers who haven't
evaluated the document yet.

« Choose Stop approval cycle after every Approver decided, if you want to collect as many
opinions as possible before creating a new version (to increase the chances that the next
version will be approved).

Note: That document version only gets the rejected status after all approvers have
decided. The approvers of the next stage(s) don't get an approval request for that
version of the document.

« Choose Continue approval cycle anyway if you want to use the current stage as a review
stage (the approvers are just expected to give their opinion on the document, but do not

have a veto power)and to only start the real approval in a later stage.
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Require Review State on all Annotations

In the approval Setup, you can set up a mandatory review on all annotations using the Require review
state on all annotations before approving or rejecting option.

This forces all approvers to review annotations before submitting an approval status.

Note: This only applies to viewable documents.

« Select No if you want all approvers to submit their Approval Status without the condition of
reviewing the annotations. This is the default setting.

« Select Any Viewer when you want to enforce that all annotations should be reviewed by at least one
person before submitting the Approval status.
A warning message will appear when the Approver tries to submit the Approval status for the
document containing unreviewed annotations.

« Select Current Reviewer when the Approver needs to review all annotations before submitting an
Approval status.
A warning message will appear when the Approver tries to submit the Approval status for the
document containing annotations he did not review.

Note:

« Thereview status None will not be accepted as a valid review state.

« This settingisrelevant while submitting an Approval Status from the Viewer and the
other WebCenter pages.

9.5.5. Add Approvers

You can add any member of the project as an Approver. You can also add user groups or roles Invited in
the Current Project as approvers.

Documents SEved seanch Bill Of Materials EKE Discussions Charactenstics Aftributes Approval Mare,., =

Project | porgl

w Invited in Current Project
Mo matches faund
w Not invited in Current Project Q

@ A No matches found Type

No ap B Create and Invite New User

F -

+ Add Stage

Settings
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« Toadda project member as an approver, select him / her in the Add Approver drop-down. Repeat
for every user you want to add as approver.

- Toaddaroleasanapprover, selectitin the Add Approver drop-down. After adding the Role, edit
the Type. Select from:

« One of Role if you want only one of the role assignees to approve on behalf of the role. This is the
default setting.

Tip:

It is possible to change Role assignments after starting the Approval cycle if you select
One of Role option. Use One of Role if there is only one role assignee.

Note:

Make sure that the Role is assigned to at least one user/group before starting the
approval cycle.

« All of Role - One per Group if you want all users and one (any) member per group assigned to the
role to approve the document.

« All of Role if you want all users and all members of groups assigned to the role to approve the
document.

All current assignees of a Role can see the approvals for their Role in their My Work > My
Approvals section.
« Toaddagroup asanapprover, select it in the Add Approver drop-down. After adding the group,
select either:

« One of Group if you want one (any) member of the group to be able to approve it for the whole
group. (The document will get the approved status once one group member approves it.)

A typical example would be a legal review, which is completed as soon as one member of the
legal department has approved the document.

- All of Group if you want all members of the group to approve the document. (The document will
get the approved status once all group members approve it.)

A typical example would be a management review, which is only completed after all members of
the management team have approved the document.

All the users of a particular group are listed individually in this drop-down. It is possible to select
one or members of the group by clicking on the listed members'name.

Note: When adding a group as All of Group, the users who are group members when the
approval cycle is started become approvers. If you later add or remove users from the
group, the list of approvers is not updated.

« Toaddanon-member as anapprover, select him/ her in the Add Approver drop-down. This will
open the Invite Project Member dialog.

a) If there are Roles as members of the Project(with view rights to the folder or document where
the approval is being set up), it is mandatory to assign the user to a role. Select the Role in the
Assign to a Role field.

« ToaddaUserwhois not present in the system, click Create and Invite New User option from the

Add Approver drop-down. It is possible to set up a default approval user template(in preferences)

to apply to the newly created user.
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Note:

« You need User Creation rights to be able to create and invite users.

« You can set up a default Approval User Template to automatically apply the User
Preferences and User Profile > Authentication settings. Read more in: User Creation on
page 50

Read step by step instructions in: Create and Invite a User from the Approval Page on page
269

To remove an approver or a group, use the x sign in front of it.

Create and Invite a User from the Approval Page

Project Managers can create and invite users in the context of an approval page. This allows you(as a
Project Manager)to add an external reviewer to the Approval cycle. If the user is not in the system, you
can add a new user and invite him or her from the approval page. It is possible to create and add users
from any approval page(document's, project's or folder's).

Note: These users will be created as Regular Users. The only exception is when an
Administrator user creates a user using an Admin User as the Approval User Template.

If you have used up all your Regular User licenses, you will not be able to Create and Invite User
from the approval page. Read about Named User License model in Licensing and Users.

« Click Add Approver > Create and Invite New User.

User Info in the Create and Invite New User wizard appears.
- Typethe user's e-mail address. The fields (Username, First Name and Last Name will be filled in
automatically from the e-mail address. You can change these fields, if necessary.

+ Username isfilled with the part before @ of the e-mail address.
« First Name is taken as the part before the last dot.
- Last name is filled with all characters after the last dot (or all the characters before @ if no dots
are present).
« Optionally, assign to a Company and Location. Note that this can be very important to filter the
content and users the new user will be able to see.
« |fyouwant the usertologin with alink sent from the approval page, follow the process below:
a) Setup a Token based single sign-on instance and keep it active.
b) Specify a User as Approval User Template. Also remember to allow link authentication in the
user profile.

To allow a User to authenticate via a link, configure Token Authentication and allow this type of
authentication in the User profile page.

Note: You need to disable all the other types of authentication to make the link
authentication active.

Whenever the token-authenticated user receives a notification with a link, the link contains a
token to authenticate without user credentials. This permits the users added to the approval
cycle tologin using the approval links from the notification mails.
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« |f your default approval user template has no Token Authentication setup or you have not defined
a user as the template, you need to specify and confirm a password in the Create and Invite User
wizard.

« If there are Roles as members of the Project(with view rights to the folder or document where the
approval is being set up), it is mandatory to assign the user to a role. Select the Role in the Assign to
aRole field.

« Click Create and Invite User.

A new user is created and invited to the Project. You will be able to see this user in the Approvers list as
well as in the Users list.

« If you enabled link authentication, the user will log on to the system using a link from the
notification e-mail. The user will be able to see and approve the document/folder or project.
« Ifyou specified a password, the user would need to know the password to be able to log in.

9.5.7. Add a Deactivated Approver

It is possible to invite deactivated users to the approvers list.

« Toaddanon-member as an approver, select him/ her in the Add Approver drop-down.

This will open the Invite Project Member dialog. The dialog will warn you that you are activating the
user with this action.

- If there are Roles as members of the Project(with view rights to the folder or document where the
approval is being set up), it is mandatory to assign the user to a role. Select the Role in the Assign to
aRole field.

« Click Invite to confirm that the member should be activated and invited.

Notes

«  Youwon't be able to invite a user who has been deactivated within the past 24 hours. The users
automatically deactivated or created as deactivated users do not have this waiting period of 24
hours.

- Tore-activate a Project member who is in the Project Members list, click on the name (in the Add
Approvers dialog) and in the prompted dialog, click Activate.

9.5.8. Save the Approval Cycle

«  Whenyou are finished with the setup, click Save.

{ ' Note: If you were setting up an approval cycle for several documents and some of them

already had a started approval cycle, the approval setup will fail for these documents. You
will see a list of failed documents on the Multiple Document Approval Setup - Info page.
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From the same page, you can also:

- Revert the approval settings to the last saved version (when editing an existing approval
cycle). See also Editing Approval Settings on page 271.

- Clear the approval settings (so the project, folder or document has no approval cycle).

For a document, this also clears all settings inherited from the project or folder.

- Start the Approval Cycle (see also Start or Stop the Approval Cycle on page 271).

9.5.9. Start or Stop the Approval Cycle

{ =1 Note:

You need the Start / Stop Approval permission to start or stop approval cycles. This is the
same as the Lock / Update permission.

» You can start the approval cycle from:

- the document list on the project page (in the Approval column),

« the document details page's header,

» the Approval tab of the document details page,

- the upload page (click Start Approval Cycle right after uploading your document),

- your workflow system (select the Start Approval Cycle option before sending your document to
WebCenter).

« You can stop the approval cycle from:

« the header of the document details page,
» the Approval tab of the document details page.
9.5.10. Editing Approval Settings

Permissions Needed

You need the Change Approval permission to create or edit an approval setup.

{ = Note: When editing a folder or a project's approval settings, the new settings affects only the
=% documents added to the project / folder after the settings are changed.

Started and Stopped Cycles

You can edit the approval cycles while they are started. To edit an approval cycle that is already started,
you must first stop it. You can do this from:

« the header of the document details page,
« the Approval tab of the document details page.
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Editing a Simple Approval Cycle

After stopping a simple approval cycle that was already started, you can only edit the approvers (you
can add or remove approvers, even if they have already approved or rejected the document).

You cannot change anything else (due date, conditional approval...).

Editing a Staged Approval Cycle

After stopping a staged approval cycle that was already started, what you can edit depends on the
stages'status. If a stageis:

« completed: you cannot edit any information or remove the stage.

- pending: you can only add or remove approvers (even if they have already approved or rejected the
document). You cannot change other information like due date, conditional approval or remove the
stage.

- not started yet: You can remove the stage, or add extra stages or change any other information.

{ = ] Note: You cannot change the Approval Master.

You can now add or replace or remove an approver(s) when the stage is still in progress. Read more
about it here.

Editing the Approval Cycle for Next Version

You can also choose to leave the current approval cycle as it is, and only edit the approval setup for the
next version of the document. To do this, click Edit Approval Setup for Next Version in the document
details page's Approval tab.

{ =l Note: If an approval cycle is finished, you cannot edit it. In this case, you can only edit the
== approval setup for the next version of the document.

Role Selection while approving

In an approval cycle, a user is sometimes part of multiple roles, who are required to approve the
document. While approving or rejecting the document, the Approver can choose the approval for each
of the role he / she is part of.

For example, User A is part of Legal Asia, Legal Australia and also Legal South East Asia. When the
user approves the document, the user can choose the role for which the approval is made.

Project History and action history pages tracks the approvals with the detail of user roles or groups
specifically mentioned.
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{ = Note: User can still approve on behalf of all the roles by choosing the option Default (All). This
option is not available if reasons for rejections are enabled, as the reasons can depend on the
roles of the Approver.

9.5.12. Following Up on Approvals

If you are an Approval Master, you will see the approval cycles you are responsible for under Approvals
to Follow Up on your My Work page. This section shows a summary of each document's approval cycle,
with all the necessary details (Approval Status, Document Version, Due Date...).

i = Note: If you cannot see the Approvals to Follow Up section, go to My Work > Edit My Work
Setup to add it to your My Work page.

In this section, you can:
« Filter the documents:

« by status(Pending, Rejected, Approved or Approved with Comments),

+ by date (Finished within last 14 days, last 7 days or last day).
» Sort the documents list (by Approval Status, Document Name, Due Date...).
« View the documents.
« Gettoadocument's details page.

9.5.13. When is an Approval Cycle Finished?

The approval cycle's status is changed to Finished when either:

- allapprovers have approved or rejected it,

- the Project Manager or an admin has Forced Approved or Forced Rejected it (see Forcibly Accept or
Reject Documents on page 273).
Note that in this case, the final status is Forced Approved or Forced Rejected instead of Finished.

A finished approval cycle may not be stopped or started without uploading a new version of the
document.

9.6. Forcibly Accept or Reject Documents

Project Managers have two special approval status settings available: Forced Approved and Forced
Rejected (unless this is disallowed by the Administrator).

Using either force approval or force reject finishes the approval cycle so that other approval users may
not approve or reject the document.
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9.7. Delegation

Delegations allows the users you nominate to view, edit, approve, comment, discuss and even reject
documents on your behalf. Similar to having an assistant, another WebCenter user(s) chosen by you,
can respond to all your pending tasks, approvals in your absence for a period of time specified by you.
The delegation can be set up by any user based on permissions granted by the administrator.

Terminology used

« Delegate: A person to whom the work is delegated.

« Delegator: A person who is delegating his work to someone else.

« Active Delegation: Period during which the delegate can take up the work of the delegator.

« Start Date: Date on which the delegation becomes active.

« End Date: Date on which the delegation expires. When an end date is not specified, the delegation
will be permanently active until it is removed.

9.7.1. My Delegated work

Any user in WebCenter can delegate his or her actions to be performed by other users.

When you have active delegations assigned, you can view them when you log in to WebCenter. Work
delegated to you by other users are displayed as pop-up in the first screen. In case you have more
than one delegator, you can view the work delegated by each of the active delegator along with their
comments.

i =, ] Note: To get this as the log in screen, enable the option Show this information when logging
in

Log-in as a Delegate

You can either choose to continue your work or can log in as a delegate and complete the work
assigned to your delegator. To perform the delegated work, choose Act as (Delegator). Then you are
logged in as the delegator in WebCenter and My Work page of the delegator is visible. You can now
perform all actions as the delegator.

You can also note that the avatar in the navigation pane is that of the delegator and there is a banner
indicating that You are logged in as delegate of (User Name of the Delegator).

Return to your own account

Choose Return to my account link in the banner or from the drop down option in the avatar to return
back to your WebCenter account.

9.7.2. Execute Work as a Delegate
Viewing as a Delegate

When you log in on behalf of the delegator, you can view and perform all the work assigned to the
delegator, on top of that your menu will be updated to the menu of the delegator.
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As a delegate, following actions can be performed
« Approvals

« Task Actions as a Delegate on page 275

« Document actions as a Delegate on page 275

« HTML5 viewer actions as a Delegate on page 275
« Text Actions as a Delegate on page 275

« Discussion actions as a Delegate on page 275

Approvals as a Delegate

Approving, rejecting or adding comments as a delegate is done similar to normal approvals. If the
delegator has rights to change or start the approval cycle, then delegate will also have the same rights
when logged in as delegator.

Note: When you are acting as a delegate, enter your own password to approve or reject any
documents.

Task Actions as a Delegate

Whenever the delegate logs in as the delegator, he/she will have the same rights as the delegator. This
means that if the delegator is allowed to create new tasks, the delegate will be able to perform that
action.

Document actions as a Delegate

When you are logged in as the delegator, the same permissions as the delegator are given. The
document actions performed by the delegate clearly indicate the owner/ uploader. Delegator is the
owner of the document which is uploaded by the delegate, while logged in as the delegator. Similarly
when a delegate locks the documents, the delegator can unlock the documents.

HTMLS5 viewer actions as a Delegate

While access the WebCenter to perform actions for your delegator, delegate can access the HTML
viewer to view, annotate and approve the documents.

Text Actions as a Delegate

The delegate can login as the delegator to approve, reject, comment or edit content of a Text Content
language element and perform other Text Content operations based on the PCM permission model.

Discussion actions as a Delegate

In discussions too, delegate has all the access as the Delegator and can execute all actions the
delegator can perform.

The actions done by the delegate are visible on the following places:

Action by Delegate Displayed as

Creating a new Discussion Delegator is set as the Owner

Post a New Message author name of the message indicates that it is
posted by the delegate who was logged in as the
delegator.
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Action by Delegate

Displayed as

Unread messages

For the delegate: when logged for the first
time, messages not yet read by the delegator
are displayed. The unread messages reflect the
messages that are not yet read by the delegate
since the last login.

For the delegator, the unread messages are
shown as his previous log in.

Watch/ Unwatch a Discussion

Any updates to Watchlist like adding a discussion
to a watchlist or removal done by the delegate are
applied to the delegator. When the Delegator logs
in again will have the same Watchlist as updated
by the delegate.

Online status

« Delegate: Shown as logged in(If part of the
participant list)

« Delegator: Shown as offline

Quotes in Discussion

When a user quotes a message posted by a
delegate, the author of the quoted message
indicates that it was originally posted by the
delegate himself.

Mention

When the delegator is mentioned in any
discussion, the delegate will be notified, if the
notification forwarding for the delegate is turned

on.
{ = Note: You cannot mention a delegate
“= if the useris not already a part of the
discussion.

Tracking of Delegate Actions

Actions

Tracked in

Approval

» Project History: "As Delegate of "column
« Document Actions History: "As Delegate of" column

« Approval Setup: In the "Last Submitted by" column in approval
setup and the User column in the comments pop-up, contains a
string with following format: "Delegate as Delegator

Create New Tasks

Project History and Task Details pages

Complete a Task

Project History and Task Execution pages

Check an item in the checklist
of atask

Task Execution and Task Details pages

All other events

Project History

Document Upload

Document Action History
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Actions

Tracked in

« Uploaderis the Delegate ( actual uploader)
« Owner of the document is the Delegator

Document Lock

Document Action History

» Delegate can lock the document which can later be unlocked by
the delegator.

Document Annotations
including creating new
annotations, Removal
of annotations, reply to
annotations

Document action history

« Whenanew annotation is added to the document, the author of
the annotation is the delegate.

9.7.3. Add Delegate

You can delegate your work to a specific user or users. Follow the steps below to add delegates.

1. Toadd one or more delegates, go to My WebCenter > My Delegates.

2. Select auser from the drop-down and click Add Delegate.

To inform your colleague about the delegation, enable the Notify new/modified delegates option.

3. Ifthisis atemporary delegation until your return to work, specify a Start Date and an End Date.
There is also a comment field to leave your notes.

If you leave the End Date empty, the colleague can act as your permanent delegate.

My WebCenter > My Delegates page lists all your delegates and the respective time periods for which

the delegations remain active.

E b ] Note: You can modify the delegation fields or delete a delegate from My WebCenter > My

Delegates page.

9.7.4. Modify or Delete Delegate

You can delegate your work to a specific user or users and modify it at a later date. To modify the
existing delegation, follow the steps below.

1. Navigate to My WebCenter > My Delegates

2. You can modify the existing delegates by changing the start date and end date. You can also change
the notifications by checking the box to send.

3. Select Save to confirm the changes.
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To delete a delegation, select the icon in the row for the respective user.

9.7.5. Delegation Notifications

Notifications for Delegator

During the delegation period, some notifications can be received by the delegator and the delegate
based on the options chosen in the My Delegates page.

- Toreceive notification when you have delegated your work to another user, select Receive email
notifications during delegation period. This will ensure you receive all email notifications during
the delegation period.

Notifications for Delegate

« 0On Assignment of the Delegation, select the option Notify new/modified delegatesto send
notifications email to the delegate when added or modified.

» Toreceive notifications during the delegation Period, choose the option Forward my notifications.

9.8. Search on Project Duration

Duration Reporting for a project

You can search for projects based on the Start date, Due date, Completed date, Duration and Time Left
of the project. You can save the searches and add it to the dashboard to have an instant view of the
progress of all the current projects.

Field Name What it means

Started The start date of a project is the first time the project was set in an active
status.

Completed The last date the project was set in a completed status

Due The due date is shown in the project details.

Duration The time between the start date and the completed date. Only active statuses
are considered to calculate the duration of the project.
When the project is not completed, the duration is the time between the start
date and the current date/time.

Time Left This is the time between the actual completion date and the Due Date. When

there is no due date, the time left is not shown as it is not relevant.

When the project isin progress, the Time Left is the time between the due date
and the current date. When the current date/time is still before the due date,
the project is not overdue.

In this case, the time left is a positive number, indicating that there is still time
remaining before we reach the due date.
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Field Name

What it means

When the current time is after the due date, the project is overdue. In this case,
the time left is a negative number, indicating how much the project is overdue.

How to find Project Status Duration

You can also find the Duration metrics on the time spent in a given stage of the project. Projects
statuses can reoccur multiple times and you can compute the duration of time in each of the given

status.

Project Status Started
(®) Prepress Creation Started

() Prepress Approval Started

Project Status Duration
@ Prepress Creation Duration

(®) Prepress Approval Duration

Select Project Statuses that you want to search on

-

this week - o

this week - L

You can filter each selected Project Statuses based on the duration criteria

»= =| 2 days o 6

= ¥ <= 7 days o) 7

Field Name

What it means

Project Status Started | T start date of a project Status is the first time the project was set in the

selected status.

Project Status The completed date of a project Status is the last time the project was in
Completed the chosen status before it was changed to a new status.
Project Status The project status duration is the time that the project spent in the selected
Duration status. It is the sum total of all the time the project was in a particular
status. When the project went into the selected status multiple times, the
duration is the accumulated time the project spent in the selected status.
In this field, you can filter on the duration in days of the selected status.
Project Status Time It is the time the project was in the Project Status. When there is no due
left date, the time left is not shown as it is not relevant.

When the project is still ongoing, the Time Left is the time between the
current date with the Project Status Due. When the current time is before
the Project Status Due, the project is not overdue yet.

When the current date is after the Project Status Due, the project is
overdue. In this case, the time left is a negative number, indicating how
many days the project status is overdue.

For example: Let us assume that
Day 1:Jan 0100:00 till Jan 02 00:00 => Project was in StatusA.
Day 2: Jan 02 00:00 till Jan 03 00:00 => Project was in StatusB.
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Day 3: Jan 03 00:00 till Jan 04 00:00 => Project was in StatusA.

Project Status Started of StatusA is Jan 0100:00 (first time project was in StatusA)
Project Status Completed of StatusA is Jan 04 00:00 (last time project was in StatusA)
Duration of StatusA is 2 days and Status B is 1day
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Project and Document Security

Project Managers secure projects by setting permissions for users and groups on a project as a whole,
and on folders within the project. They can set and change permissions at any time.

Permission types
The permissions for folders and documents are:

« View: This permission allows viewing the project and the list of files and folders in the top level. All
users and groups invited to a project get the View permission automatically at the project level.
At the folder level, View allows a user to see that the folder exists. View permission is required
for a project or document to be listed in the Search results. It takes precedence over all other
permissions; if a user does not have View permission, nothing else is possible.

« Add: This permission allows adding a new document to a project or folder by using Add, Copy, Copy
as Link, or Move.

« Change Properties: This permission allows changing database information about a document
or project. Project Managers have implicit permission to change the database information about
projects they manage.

« Delete: This permission allows the removal of a document from a project or folder. This permission
is also needed to Move a document out of a project. Only Project Managers or members of the
Admins group may delete a project.

« Download: This permission allows downloading a project or document from the database to a user’s
computer. This is also required to open documents other than an Esko ArtiosCAD 2D or 3D view, or
those viewable in the WebCenter Viewer.

« Lock/update: This permission allows the locking of documents and the subsequent uploading of
new versions.

« Start/Stop Approval: This permission allows starting and stopping approval cycles.
» Change Approval: This permission allows the user to change the approval setup.
« Change Task: This permission is only available for WebCenter

setupsincluding task management. It allows users to create and change tasks. You can only set this
permission at the project level, not at folder level.

- Change BOM: This permission allows the user to change the Bill of Materials (Administrators and
the Project Manager can always change the Bill of Materials). You can only set this permission at the
project level, not at folder level. See Who Can Edit the Bill of Materials? in the Administration Guide
for more information.

How permissions are inherited

Documents that are not in a sub-folder inherit project permissions. By default, folder permissions are
inherited from the project, but they may be overridden by the Project Manager as desired.

If auserisinvited to a project, and is also a member of an invited group, then group permissions for
that user are ignored, and only the individual permissions for that user are considered.

If auseris notinvited to a project, but is a member of a group that is invited to the project, the group
permissions are used.

If the user belongs to more than one group that is invited to the project, the permissions are combined
and the user gets the most permissive security setting available.
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Permissions and groups: an example

For example, user USER1is a member of GROUP1, GROUP2, and GROUP3. PROJECT1has GROUP1and
GROUP2 as invited members, and GROUP3 is not invited. GROUP1 has Change Properties granted
and GROUP2 has it denied, and it is not set for GROUP3 because GROUP3 is not an invited member.
USERT1is able to modify database information about PROJECT1 because it is granted through
GROUP1.

Project Managers and Admin group members
Members of the Admins group have full permission to access everything.

Project Managers have full permission within the projects they manage.

10.1. Set Security on a Project

1. Loginas aProject Manager or Project Creator.
2. QOpen the project.

(f ’ Note: The project should have folders created and members invited already.

3. Click the Security tab.

Documents Bill Of Materials Tasks Discussions Characteristics Attributes Project Information Approval Notifications Members Security Configure

Project  Folders  Users Groups Roles

Permissions for Project Lumi+ Purple

Lock/Update

Start/Stop Approval Change Approval Change Task Change BOM

Full Permission View Add Change Properties Delete Download

Piro, Pieter-Jan (PJPR) as PRINTER

2¢ AGENCY GHENT as AGENCY

2 DESIGNER GENT as DESIGNER

4. To set/edit the project permissions: choose Project from the menu and check or uncheck the
desired permissions for specific users, user groups or roles.

When you first enter a project’s security menu, this menu is selected by default. Project level
security controls access to the project and whether the contents of the project documents folder
are visible and searchable. A checked item indicates a granted permission; no check indicates a
denied permission.

(7, l Note: View is automatically granted upon invitation to a project. View permission to the
root of a project cannot be denied for an invited project member.

[l Tip: To grant or deny all permissions, check or clear the Full Permission checkbox. The
changes are effective immediately.
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Set folder level permissions:
a) Click Folders.
b) Select the folder to change from the Permissions for folder list.

c) Checkthe checkbox in a column to grant it to the user, group or role in that row; clear the
checkbox to deny it. To revert to default project permissions, click Reset.

Tip: To grant or deny all permissions, check or clear the Full Permission checkbox. The
changes are effective immediately.

Set the user specific permissions:
a) Choose Users.
b) Select the user whose permissions are to be modified in the Permissions for user list.

c) For Project and folder permissions, check the checkbox in a column to grant it to the user or
group in that row; clear the checkbox to deny it. To revert to default Project permissions, click
Reset.

Tip: To grant or deny all permissions, check or clear the Full Permission checkbox. The
changes are effective immediately.

Set group level permissions:
a) Choose Groups.
b) Select the group whose permissions are to be modified in the Permissions for group list.

c) For Project and folder permissions, check the checkbox in a column to grant it to the user or
group in that row; clear the checkbox to deny it. To revert to default Project permissions, click
Reset.

Tip: To grant or deny all permissions, check or clear the Full Permission checkbox. The
changes are effective immediately.

Set role level permissions:
a) Choose Roles.
b) Select the role of which you want to modify the permissions in the Permission for role list.

c) The changes you make in this section define what the default permssions to be used when you
assign a user or group to this specific role. Any changes made here will not affect users and/or
groups that have already been assigned to the role.
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11. Reassign a Project to Another Project
Manager

284

Projects may be reassigned to other Project Managers as long as the current Project Manager is not an
Approver in ongoing Approval Cycles in that Project.

Login as a Project Manager or Project Creator.
Open the project.
Click General Information.

oo s

Click Manager. WebCenter performs a dependencies check for the current Project Manager being
an Approver on ongoing Approval Cycles. If it finds any, click OK, stop the Approval Cycle(s), and
retry changing the Project Manager.

5. Assuming there are no dependencies, filter or click Go to generate a list of Project Managers.

This list can also include user groups.

6. Click the name of the new Project Manager or group and click Finish. The new Project Manager's
name will appear on the General Project Information page.

To reassign more than one Project to another Project Manager, generate a list of projects either
by searching or by using an item on the main Projects menu, and then click Change Manager in the
Actions menu. Filter or click Go! to show the list of Project Managers, select the desired Project
Manager, and click Finish.

Admins can change Project Managers for more than one project at a time using the Projects menu in
Project Management on the Admin menu.

While they can select projects with different Project Managers, they may only assign all the projects to
one Project Manager.
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12. Create a User

Attention:

As a Project Manager, you can only create other users if the Admin granted you the User Can
Create User privilege.

For more information about this privilege, see "Create a User" in the Administration Guide.

In the Create menu, click Create User.

Step 1: User Info in the Create New User wizard appears.
Type the basic user information into the appropriate fields (Username, First Name, Last Name...).

Note: Required fields are indicated with an asterisk *.

Provide the user's initial Password and confirm it.

Enable the option Require the user to change the password at first login to force the user to
choose a new password when they first log on to the system.

Do you want this user to see custom menus instead of the default WebCenter menus?

Custom menus allow you for example to simplify the user interface, so the users only see the menus
they need to use. For more information, see "Menus Preferences” in the Administration Guide.

« If yes, choose the menu to assign to the user in User Menu.
+ If no, leave Default in User Menu.

Click Continue.

6. In Step 2: Assign to a Company, optionally select a company to which you want to assign the user.

7.

Note that this can be very important to filter the content and users the new user will be able to see.
Click Finish.

Your user is created.
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13. Editing Users and their Preferences

13.1. Edit a User

4,

In the My WebCenter menu, click My Users.

This shows all the users you have created.
On the My Users page, filter the list of users if desired, and click the username of the user to edit.

The Profile page appears.

Make the required changes:
To edit the user’s... You should...
user info edit the fields on the Profile page.
menu select a different User Menu.

E s ] Note: Users linked to a company will
always see the menu assigned to the
company, even if they have a different
menu assigned to them individually.

company or location 1. Click the Company/Location link on the
Profile page.
2. Selectanew company and click Finish.

Click Save to confirm.

13.2. Change the Password for a User
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1.

ooroaN

In the My WebCenter menu, click My Users.

This shows all the users you have created.

On the My Users page, filter the list of users if desired, and click the username of the user to edit.
Click Password to show the Password page.

Type a new Password and confirm it.

Click Change to save the changes.
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13.3. Set the Preferences for a User

1.

In the My WebCenter menu, click My Users.

This shows all the users you have created.
On the My Users page, filter the list of users if desired, and click the username of the user to edit.
Click Preferences to show the Preferences page.

Configure the Preferences as needed. For more information on the settings and options, see
General Preferences in the Administration Guide.

Click Save to confirm.

13.4. Copy Preferences to Users

Use this to quickly copy previously defined preferences to one or several users.

1.

In the My WebCenter menu, click My Users.

This shows all the users you have created.

Select the user(s) whose preferences you want to change and select Apply Preferences in the
Actions menu.

In the Apply Preferences popup, select the preferences to change, and deselect the preferences to
keep.

Other Preferences are the user preferences not mentioned above (for example: show thumbnails or
not, search results layout, etc.).

Select who you want to copy the preferences from: in Take Preferences From, select another of
your users, or select Default to use the default settings for the preferences you selected.

Click OK.

287



ESKO

14.

14.1.

WebCenter

Discussions in WebCenter

You can start a discussion in WebCenter, in a Project, Task or at a Document level. It facilitates
members of the project to have conversations, which improves collaboration and faster decision
making.

You can view the conversations in the Project or Task or at the Document level in the Discussions
Tab. Discussions can be with all the members or private conversations with few or one member of the
project.

You can view and respond to discussions on My Work and Search Results dashboard pages if enabled.
You can also view and respond to discussion pertaining to the document in the HTML Viewer.

Start a New Discussion

288

New Discussions can be created in Projects, Documents or in Tasks that has discussions enabled. Any
user can create new discussions.

« To Start New Discussion in a Project:

a) Navigate to Project Details > Discussions Tab. You can view the Discussions for Project,
Document and Task in separate sub tabs.
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Documents Bill Of Materials Tasks Discussions @ | Characteristics  Attributes  More...~
Discussions Y 4 | test1 @ Project: BLSA proj123 C O ETFn
All | Project | Document | Task Discussion was started by _PC, BLSA (BLSA_PC)

@ (BLSA) Jul 10,2018 at 10:45
This is a test message after making read only

This Discussion is read-only.

Hi
e Project: BLSA_pr..

test1®  Jul 10,2018
e Project: B...

BLSA: Thi..

B I U & S x X A"~ = T T«

[Type a Message

b) In the Discussions panel, click + to Start New Discussion. A message panel is opened in which
you can enter a relevant subject.

c) Addthe members to the Discussion by selecting from the drop down list in the Visible To. By
default, the discussions are visible to all members in the project including the Project Manager.
Refer to point 4 in the note below.

d) Write arelevant Subject line and type the message in the message panel and Post the message.

« Tostartanewdiscussion in a Task:

a) Ensure that the Task Type chosen for the task is enabled to have Discussions.

b) Navigate to Project Details > Task .

c) Click Discussions > Start a new discussion.

d) Addthe members required for the Discussion by selecting from the drop down list in the Visible
To. Refer to point 4 in the note below.

e) Type the message in the message box and Post the message. Now this message is visible in the
Discussions.

« Tostartanew discussion on Documents:
a) Navigate to Project Details > Documents
b) Click Discussions > Start a new discussion.

c) Addthe members required for the Discussion from the drop down list in the Visible To. By
default, everyone allowed to view this document is part of the discussion on the document.
Refer to point 4 in the note below.
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d) Type the message in the message panel and Post the message. Now the discussion is visible in
the document to all the users who have permission to view the document.

Discussions on document can have members from other projects, if the document is part of
other projects.

E ] Note:

1. Discussions can be deleted only by the Admin User or the Project Manager or the
Discussion Owner.

2. Project Manger can view all the private discussions in the Project or in the Documents or
in tasks within the project.

3. Any discussion can be made read-only either while creation or any time during the
discussion by the owner of the discussion or the Project Manager or the Admin user.

4. When a new Discussion is created, it is possible to have the default participant as the
Discussion creator which can later be edited to add the required members. This feature
is enabled based on the Admin User's choice in the Preference page. You can enable
notifications when a new member is added or deleted in a discussion.

14.2. Post a Message in Discussion

Any user who is part of the discussion can post a message.

1. Go to the Discussions tab in Project.
2. Select the Discussion, where you want to add a message.
3. Enterthe text in the Message box and click Post.

When hovering on any message, you can get an option to quote the post and to mark the message
as unread. Discussion owners, Project Managers and Admin Users will get an option to delete the
messages.

[ ( ] Tip: Depending on the setting for Notifications in the Project, notifications are sent when:

« Discussion Started

» Discussion Deleted

« Discussion Message added
« Discussion Message deleted

Discussion editor is equipped to handle texts from languages which are written from right to left.
Enable the right to left or left to right buttons to change the direction of text.

B I U & § XX, A~ = = & » Tk

Change text direction to the right
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14.3. Viewing Messages in Discussions tab

The Discussions tab label displays the numbers of Discussions and on hovering over the label you can
view the number of discussions in Project, Documents and Tasks.

Note: When there are unread messages, the badge has a different color.

Discussions Characteristics Attribut
#§F5D) Froject Discussion(s)
Y - &P Document Discussion(s)
Task Discussioni(s)
Task

In the Discussions tab, you can view discussions filtered and displayed in four tabs on the left for All,
Project, Document and Task respectively. The Discussion with the most recent message is displayed
in the message box.

Discussions Y <+

All Project Document Task

Menu Options in the Discussions Tab

Use To
Y Filter the discussions based on what you are watching, or marked as
unread or discussions started by you. You can choose one or more or

none of the options to filter.

Note: You can also filter out using Show Only options. You

&= can filter out discussions based on what is being watched
or unread or direct discussions or discussion started by the
user or as a direct participant.
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Use To
=+ Add a new Discussion
® Watch All Watch all Discussions or reverse it.

¥ Unwatch A

w7 Mark All as Read

O Mark All as Unread

Mark all the Discussions as read or reverse it.

Print the discussion which is currently visible.

-
® Watch the current discussion. The discussion subject also displays
thisicon to indicate the discussion is being watched.
View Participants in the current discussion in a sub tab with their
2t online status.

Note: You can filter to view only direct Discussions.

Special characters in the Discussions

Use To

@ Mention a User, Group or Role in a message. The User, Group or Role
will get a notification of the mention in the message.

# Link to the Project or Document name mentioned

Discussions during Delegation

Users sometimes delegate their work to other users and in such circumstances the delegate can also
be part of discussions for the delegator. Read more about delegation here. Discussions Read-only

Admin Users, Project Managers of the Project where the discussion is in and the owners of the
Discussion can make the discussion read-only. In read-only mode, a normal user cannot add a new
messages or quote any message. The owner of the discussion also cannot add or edit the users in the
discussion nor delete the individual messages.
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15. Task Management in WebCenter

Task management adds a complete time perspective to your Projects. WebCenter facilitates
timeliness by adding extensive notifications on the tasks. The task searching and overview pages
facilitate follow-up, finding critical and overdue tasks and creating reports.

Task Management allows adding tasks to WebCenter Projects and assigning these tasks to Project
members.

Tasks have due dates, start dates and estimated dates. Tasks also have a specification and a checklist.
In addition, you can link documents with tasks and organize a discussion forum around a task. Finally,
tasks have statuses.

Note:

Task Management is an optional feature of WebCenter. If you did not purchase the Task
Management license, you won't be able to create tasks or task types and these features won't
appear in your user interface.

15.1. What You Can Do with Task Management

Atask is work (or part of the work) that you assign to a project member with a specific due date. A
task has a name, a description, a status, due date, estimated date, starting date, a specification, a
checklist and a discussion forum. Use tasks to:

- assign human tasks to project members, groups or roles:

The assignees or group of assignees will get a notification by e-mail and via their To Do list. You can
describe the task via the task description (free text), the task specification (structured data) or via
the checklist.

You canrestrict the task type to a dedicated Main Assignee.
- create task sequences:

You can connect the tasks in a way to launch the next task automatically on completion of the
preceding task. Alternatively, you may set a delay to start the task automatically. This feature allows
you to build automated workflows that flow from one project member to another.

You can also set the Project Status to be completed when the tasks are completed.
- monitor critical tasks:

Use the Gantt chart to view the tasks in their time line. You can monitor the status of the critical
tasks according the project delivery time line.

- project definition:

Define what parts constitute a project. These parts can be human tasks but can often also be
physical components to deliver, for example all the parts of a complex box. Each part can have

a different due date. You can use the specification to define length, width, depth or any other
parameter. You can upload the digital files representing this component to the task representing
this physical delivery.
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- Create a project plan according to a project plan template. This allows making a plan with multiple
steps that are shifted in time. You can re-use timings from a previous project to create estimates
from where you can start refining.

« Keep track of quotes or projects in an initial state.

« Organize your own To Do list.

15.2. Basic Concepts of Task Management

294

Task

Atask is a piece of work you assign to a project member to be done before a certain due date. A
task has a name, a description, a status, due date, estimated date, starting date, a specification, a
checklist and a discussion forum.

Only the name and due date are needed, the rest can be omitted if they are not interesting or needed.
Tasks have a task type.

Atask livesin a project. A project can have multiple tasks but a task cannot be in more than one
project at the same time.

Task Type

Task types are templates for tasks. Task types are global for the WebCenter system. Each task follows
the task type from which it was created.

The task type contains:

. Estimated duration of the task.
o List of statuses for the task.

« Specifications. This is a set of parameters you want the task creator or assignee to enter into the
system (they can be required, in which case the task will not be completed if they are not filled in).

« Checklist. This is a set of items you want to assignee to check off before completing the task.
Optionally, the system can enforce this.

« Documents. Thisis a set of parameters that defines whether you can add or even have to add a
document.

» Discussions. You can allow to start a discussion in your task.

«  Workflow. In this section you can create a complete workflow using different task types and other
nodes.

Specification

A parameter for a task. Specifications work much in the same way as attributes. The list of
specifications is determined by the task type.

Due Date

The date and time by when a task must be completed. Due dates are visible in all task overviews. Due
dates are mentioned clearly in the notifications sent to the person to whom the task is assigned.

If the task is not completed on the due date/time, the assignee will get a reminder. Tasks going
overdue are flagged in red in the task overviews and search results.

Estimated Date
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The estimated date is a date and time filled in by the task assignee. It gives the best current
estimation of when the task will be finished.

Estimated dates are allowed to fall before or after the due date, but when they fall after the due
date, they will appear in red in the task overviews. Changing the estimated date will normally send a
notification to the Project Manager or task owner.

Started date
The date and time when the task changed status from Created to In Progress.

Assigned To

Tasks are assigned to project members. You can assign a task to one project member only (one user or
one role or group). You can also assign any task to yourself, which provides a way of notifying the other
project members that you will take responsibility for this task.

Tasks can change assignees during their life cycle, in this way handing over the task or responsibility
from one person to another.

Allowed Assignee

You can restrict the tasks to have a pre-configured Allowed Assignee. This feature allows you to
restrict the tasks to a group or arole specified in the Project / Template as the only allowed assignee.

« You can specify a group or role as the allowed assignee of a task type. This allows you to restrict
the task assignment to a member of this particular group / role for all tasks derived from it.

- Alternatively, you can enable this feature in the task type and leave it unassigned (default to task
assignee). This allows you or the user to specify a particular group or role in the task.

E b ] Note: This feature is restricted to administrator users.

Auto-delete

A task type can be configured with an option to automatically delete the task when it is completed
successfully. This option comes in handy when you want to keep the task overview page clean.

This is especially useful in the case of tasks specified in Rules. It is best to delete the Rule related
tasks automatically once they are executed.

E b ] Note: The project history will keep a log of all the tasks that were created, started and
completed successfully. History will capture the task details at the time of task creation.

15.3. Getting Started with Tasks

15.3.1. Create a Simple Task

The system comes with only one task type built in: Simple Task. This is a task with no document, no
specification, no checklist, and no estimated duration.

Use the Simple Task type to experiment with creating tasks before figuring out how to make task
types. Listed below is a procedure for getting started.
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1. Opena project(or create one)and click Tasks.

{ . Note: If you don't have a Tasks tab, you probably do not have the Task Management license.

If thisis a fresh project, an empty list of tasks appears.
2. Click Create New Task.

3. Onthe Create New Task page, select the Task Type. Since this is the first time you are using tasks,
select Simple Task from the Task Type list.

4. Assign the task to a project member or user group using the Assigned to list. For this first task,
select yourself.

{ . Note: If you assign a task to a user group in WebCenter, all members of this group will see

" the task show up in their My Work pages, and they will all receive notification e-mails (if
set up by your site Administrator). Any member in the group can then take on the task and
complete it.

5. Enter a Name and Description for the task. Fill in other fields as desired.
6. Click Create.

You have created a simple task.

15.3.2. Use the Task List, Task Search and My Work Page

» Click Tasks to get an overview of the tasks in your Project.

« Create some additional tasks with different due dates and assignees. You'll see a list of tasks
building up and you can start experimenting with the sorting options in the overview.

» Tryatasksearch: click Search in the top menu, click Tasks and enter your search criteria.
«  Now go to your My Work page. You'll see all tasks assigned to you under My Tasks.

You'll see the status and the due date. Due dates in the next 3 days will appear in orange and due
dates in the past will appearin red.

Completed tasks are shown under My Recently Handled Tasks.

| ' Note: If you cannot see My Tasks or My Recently Handled Tasks, go to My Work > Edit My
Work Setup to add them to your My Work page.

15.4. Task Types

Use a Task Type to:

« Setupatemplate for alarge number of tasks.
« Enforce structured specifications for tasks.

« Enforce a checklist for tasks.

« Add extra task statuses.

| . Note: Task types can only be created by Project Managers with the User Can Create Task Type
' permission, or by Admins.
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The task types are also used in creating workflows in WebCenter. Read more in Workflows on page
346.

A Task Type can be either Manual or a Task Type with a Workflow. Both types can be added to a
workflow from the canvas.

The manual tasks require human intervention and they can be used as either individual tasks or as
workflow nodes.

Read also Task Types on page 424

15.4.1. Create a Task Type

Creating a task type demands some initial planning, certainly if you want to use specifications.

Attention: All specifications you want to put in a task type must first be defined by an
Administrator.

To create a task type, do the following:

1. Click Task Types in the main menu bar. You will get an overview of the existing task types.

Note: If you cannot see Task Types in the main menu bar, you either do not have the User
Can Create Task Type permission set on your user profile, or you do not have the task
management license.

2. Click Add Task Type. This brings you to a wizard.
3. Enter aName, an optional Description, Estimated Duration and Due Date Link. Click Create.

The Estimated Duration is used to calculate defaults for dates. We advise to only use the Estimated
Duration for tasks that really have a typical duration (overnight shipping, die creation...).

Due Date Link is an option to select a Date/Time Attribute, which can be set as the task due date.
You can also choose an offset value (plus or minus, in days and hours) to the attribute as due date.
The due date will always be in weekdays. Changing the attribute value in the project will change the
task due date.

Note: By default, Saturday and Sunday is considered as weekend. However, it is possible to
switch the weekend days to Friday and Saturday. The due date calculation will ensure that
the due date will always be on a weekday. To enable this in your WebCenter system, contact
an Esko Representative.

Enable Allow Changing Task Due Date Link to allow users(with Change Task Permission only) to
change the attribute link in the tasks derived from this task type or can provide a fixed date/time as
task due date.

4. Optionally add Specifications and determine whether they are required.

Note: If a specification is required, tasks of this type cannot be put In Progress before all
required specifications are filled out.

« If the Admin enabled Attribute is also a task specification when creating some attributes,
they will be in the specifications list. If desired, those can be used both as an attribute in your
projects, and as a specification for tasks.
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You can then select Automatically update project attributes from task specifications so
that when the task assignee updates the specifications' values and completes the task, the
corresponding attributes'values are updated in the project.

« You can also select Assign roles from task specifications, if you want to use tasks created from
this task type to allow non-project managers to select users or groups (for example to invite
people, to assign tasks or approvals to users / groups).

See Example: Assign a Role using a Task on page 344 for more information.

Note:
You can also:

« Add Statuses to a newly created Task Type,
« Change settings related to task documents,
« Change settings related to task discussions.

« Add Custom Document Sources to the Tasks

Now that you have created a new task type, itis a good idea to try to create a task based on your new
task type.

Go inside a project, click Tasks > Create New Task, and follow the wizard.

Save As Task Type

New Task Types from existing Task Types

You can utilize the existing Task Type by the option Save Copy As in the Task Type details page. You
can copy all the details of the existing task type and save it with a new name.

Note: Users with permission to create task type can use this option.

System History Logs

All Task Type related events like

« Task Type General Info changed

- Task Type Specification changed

« Task Type Checklist changed

« Task Type Status changed

« Task Type Document changed

« Task Type Document Creation changed
« Task Type Document Rendering changed
« Task Type Discussion changed

» Task Type Workflow changed

« Task Type created

« Task Type deleted

are recorded and stored in System History. Read this page on how to access the records.
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1. Click Task Types on the main menu bar. You'll get an overview of the existing task types.

2. Click the name of the task type. You'll see an overview with the following tabs:

General Info
Specifications
Checklist

Status

Documents
Document Creation
Discussions

Workflow

3. Consult the following table to consider the impact of your changes to any existing tasks derived
from the task type:

If you change the task type's...

Then...

Name

Existing tasks derived from the type will display the new
task type name.

Icon

Each task type can have anicon. Thisiconis usedin the
Workflow canvas/gallery and is also used in the task list in
Projects. Click the Select Icon button to select arequired
icon. You can also use filtering on the icon name. The files
with extensions jpg/jpeg, png, gif, bmp.

Dashboard

Specify a Dashboard that can be used in

« ToDo Feed, or Selection Details blocks in Dashboards
for a visual representation of the Task and /or

« Toviewin Focus Layout for Task Search results.

Restrict Task to an Allowed
Assignee option

In the General Info tab, you can enable the setting to
restrict task assignees to a particular role or group.

After enabling this option, you can:
« select an Allowed Assignee role or group.
« set Default to Task Assignee in the Allowed Assignee

field. Read more in: Restricting a Task to Project Roles
or Groups on page 314
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If you change the task type's...

Then...

Require Password to complete Task

Enable this option in the task type, to get password
confirmation for the task completion. Tasks completed
with password re-entered, are specifically mentioned in
the project history.

{ ' Note: Password requirement can be setup only

' for manual tasks.

When this option is enabled, you can further specify

« Prompt for Password where only password is to be
provided

« Prompt for User name and Password where both User
name and password ha to be provided

« Prompt for username and password once, afterwards
only prompt for passwordwhere user name to be given
once and thereafter only the password to be provided

Perform full validation of Document
Attributes on User Task completion

Enable this optionin the task type, to ensure that all the
mandatory values required in the task are all validated on
completion of the task.

If all values are not found in either the task specification
or in task document then an error message is given.

Automatically delete Task when
successfully completed

This option, if enabled, automatically deletes the tasks
when they are completed successfully. This option comes
in handy when you want to keep the task overview page
clean.

This is especially useful in the case of tasks specified in
Rules where you do not want all the tasks in the Project's
tasks page.

{ . Note: The project history will keep a log of

' all the tasks that were started and completed
successfully.

Estimated Duration

Existing tasks will not be changed in any way.

Specification

Existing tasks derived from this type will be updated as
follows:

» If you add a specification, all tasks of this type will get
an extra specification.

« If you make an extra specification required, all tasks
not yet In Progress will enforce this specification.
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If you change the task type's... Then...

Nothing will happen to tasks that are already In
Progress, or Completed, or any other state beyond
Created.

« Ifyou delete a specification, it will be removed from
tasks not yet in progress. Information in there will be
lost. All other tasks will be kept intact.

« Read morein: Synchronizing Specifications with
Project Attributes on page 305

checklist items If you...

+ Add checklist items: existing tasks derived from
this type and not yet completed will also get the new
checklist items. Completed tasks are not affected.

+ Delete checklist items: they will be deleted from all
non-completed tasks. Information in these tasks will
be lost.

status If you...

« Addastatus: itis added to all non-completed tasks.

(f Note: Tasks will not change status as aresult
of this.

« Ifyou delete a status: it will not be applied to any
created tasks.

Document Creation Tasks created from this task type are presented with the
customized document upload options. Read the details
about this option in Document Creation Settings.

Each Task Type can have anicon. The Icon gallery stores icons for Task Types, Project Statuses and
WebCenter statuses.

You can add your own icons to this library as jpg/jpeg, png, gif or bmp images. The Project Statuses,
Task Statuses and Task Types can load icons from the icon gallery.

Icons between 15 and 30 pixels high and between 15 and 130 pixels wide appears without scaling.

The gallery allows filtering of icons by its name.

301



ESKO

WebCenter

Icon Gallery

Total: 416 Filter | green|
s Approve-1_green.png

Approve-2_green.png

<

Approve-3_green.png
Approve-4_green.png
CAD-2_green.png

’% CAD-Design_green.png
CAD-approve_green.png
1 CAD1_greenpng

Canralad arean nnn

Delete Cancel m

15.4.3. Task Specifications
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Specifications work like Attributes and together in a Task Specification page, they act like an Attribute
Category. They are used for specifying tasks.

Note: Specifications can be made by an Administrator or Project Managers with Create Task
& Type permission.

System History Logs
All Specifications related events like

. Specifications created
. Specifications deleted
- Specifications changed

are recorded and stored in System History. Read this page on how to access the records.

Create a New Task Specification
1. Go to Task Types > Specifications.

A list of specifications opens (this list can be empty if this is the first time you use specifications).

2. If your specification will be a restricted set (a drop-down list of items to select from), you need to
create this restricted set first. Click Restricted sets to do this.

Note: The restricted sets are shared with the Attributes' restricted sets.

3. Click New Specification on the top right.
4. Enterinformationin the fields as appropriate:
In the field .. FillIn the ..

Name

name of the attribute
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In the field ..

Fill In the ..

(for example,Billable).

Description

description of the attribute contents (for example, Indicates whether work
on this project should be billed by finance).

Type

the type of the attribute. You can select from the drop down.

Document References are attribute-links pointing to different document
sources. When you select this option, you will have more options. Read
more in Create a Document Reference Attribute.

Floats are numbers containing a decimal point(e.g. 3.1415) and integers are
whole numbers(e.q. 42).

Rich Text attribute type allows you in entering long and/or rich text. You
can:

« add set of least 16 different colors.

« setthe text bold and italic.

« use bullet and numbered lists.

« Heading up to four levels and also add tables.

In the Preview you will see the Rich Text editor. Click the Show Rich Text
Controls link to view the broad pallet of text options. The Project Managers
with change properties rights can add content from a document to the Rich
text editor window. Here, the text (also Chinese, special characters), font
types, bullet types, color, tables and headings are preserved.

Values

choose either:

« Prompted if you want to allow the user to enter any value.

« Calculated if you want to use an ArtiosCAD formula to calculate the
attribute value (enter the ArtiosCAD formula in the field).

i =w| Note: You should set Calculated attributes to read-only as
their values are automatically updated from ArtiosCAD and
should not be changed by WebCenter users. To set the value of
the calculated attributes during upload, ensure that you have a
default attribute category with the calculated attributes for the
ArtiosCAD documents.

« Restricted Set to limit the possible values.

i = ] Note:

« Tochoose aRestricted Set, it must be created before defining the
attribute (see Create a Restricted Set).

« Make sure that the Type of the Restricted Set is the same as the
attribute type.
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In the field .. Fill In the ..

the value.

+ For Document Reference attributes, you will have only Prompted as

If you are creating a document reference specification:

Options

Description

Values

will be set to Prompted by default.

Versions and Revisions

Use this field to point to the exact version

of the document you need as the document
reference link. This is especially useful when
you want to point to an approved version. By
default, it points to the latest version, but you
can set this to:

» Latest Version: When you select this, the
document reference link will be updated to
the latest version of the document.

| . Note: When you update the

referred document, the document
link will point to the latest
version regardless of the Change
Properties permissions in the
Project > Security tab.

« Selected Version: Use this setting if your
document reference link should point to
a certain version always. In this case, the
document reference will not be updated
to point to the latest version when a new
version of the reference document is
uploaded.

« Selected Revision: When you choose this,
the document reference will always point to
the latest version of the selected revision.

| . Note: When you update the

referred document, the link will
source the latest version of the
selected revision regardless of the
Change Properties permissions in
the Security tab.

Reference Category

To apply a reference category to the document
reference, select from the drop down listing all
the attribute categories.
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Options Description

{ . Note: Rich text attributes and

document reference attributes
cannot be used as reference
attributes.

You can use a reference category (which is an
attribute category) to assign certain attributes
to the document reference link. This is very
useful when the property is not linked to the
product or the component specifically. You can
use reference categories to specify properties
of the reference links.

Edit or Delete Specifications

- Toedit a specification, click Task Types > Specifications. Click the name of the specification and
edit it as desired.

« Todelete a specification, click Task Types > Specifications. Select the specifications you want to
delete and click Delete in the Actions menu.

Synchronizing Specifications with Project Attributes

You can use Task Specifications to ask project members to supply values for Project's attributes or to
assign Roles.

You can Synchronize Project attributes with Task specifications when the tasks are completed.

]
« While the task is running, project attributes and task specifications can be different. This
is indicated by the ! warning.

{ ' Note:

You can also assign a role using task specifications.
1. Enable Synchronize Project Attributes and Task Specifications option to:

+ automate the process of filling the Project Attributes if they are empty
or to copy the values from Project Attributes to the Task specifications

{ ' Note:
]
- This function works without the user having the necessary Change Properties right
at the Project level. This allows you to give a user temporary permission to change the

Project Attributes.

» If the project attribute is blank, task specifications set in the previous sessions will be
saved.

« The Specification values in the Task Execution Page will be filled with the Project Attribute
values when the Specifications are empty and when the Task Specification is read-only.
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«  When the task is completed, the changed Specification Values will be copied to Project
Attributes

« When a Task is saved without completing it, the new Specification value will be remembered,
but not Project Attribute Value will not be updated.

. Note: A warning sign will indicate that the Attribute values differ from the Specification
=== value. You can choose to change the Attribute value to the new Specification value.

2. Optionally, enable Update empty values. This option is only available when the Synchronize Project
Attributes and Task Specifications option is on.

This will result in clearing of the Project Attribute values if the corresponding Task Specifications
were left empty when the Task is completed.

Task Forms (Task Execution View)

You can fully customize your Task Execution Form (just like Project Creation Form in WebCenter. This
way you can have a uniform customized look for a Task Execution Page. To configure a custom form,
you can combine Specifications with Task Properties in a dedicated Task Execution View.

1. Gotothe Task Type's Specifications page and Add Task Execution View.

General Info Specifications Checklist Status Documents Document Creation Document Rendering More.. =

Current View: Task Execution ¥ Delete View

Synchronize Project Attributes and Task Specifications ) Edit Terminclogy €
Assign Roles from Task Specifications
# Alternating background
# Show also Attribute types and Restricted Set types
Keep session alive (avoid that people get logged off due to time out)
# Use Alternative Rendering (Gives more control over column width)
Other Properties =

Remove Grid Layout

2| 5= [=em] [+5]) vone||-2- || —
o T =
[Status]

|assigned to] I [oue]

[checklist] Add 30 Motes
[Documents]

[ButtonRow]

3 & (4 »

Your Specification page will load all the default Task Properties in the default order.

2. Use <<toremove Properties (just like Specifications). It is also possible to remove these properties

from the form, add them again or place them between the Task Specifications. You can customize
these properties just like Specifications. See Grid Layout.

Keep the following in mind when customizing Properties:
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» You can show and hide fields or sections based on attribute values
« You cannot specify them as Read-Only or Required
« You can customize the label or image including their position (left or top).
« You can add Style to these Properties
+ You can define the Column Span for them.
When the Task Execution view is defined in the Task Type's Specification, this view (with custom Task

Properties) will be loaded on the Task Execution Page. When this view is loaded the whole page will
look like one continuous form.

Assignedto | Me -z Due  Jun23,2016 a1 430 FM

Checklist Hame Completed by Completion date Add 3D Notes

[

Note: Use caution when configuring a Task form:

» If you remove the ButtonRow from the view, you will not be able to save the Task.
- If certain sections are not enabled, but are configured in the Task Execution View, they will
not be shown in the Task Execution View

Edit Terminology

It is possible to change the terminology used in Task Execution page so that it talks about "Designs"
instead of "Documents", or "Attributes” instead of "Specifications", for example...

Attention: Your custom terms will not be automatically translated, and will show as you enter
them for all languages in which you run WebCenter.

You can achieve this by customizing the terminology in the Specification page of the Task Type. To edit
the terms:

1. Click Edit Terminology in the Specifications page

Edit Terminology

Change terms in all Task Execution Page Forms for this Task Type
Default Term New Term
Specifications | attributes
Task Discussion
Task Documents | pesigns

Checklist ltems
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2. Specify the new terms next to the default terms.
3. Click OK.

Document Reference Task Specification

You can use a Document Reference Attributes as Specifications to refer to a document that is located
within another project or a document library. You can add documents to tasks this way as references
instead of copying them into tasks.

When you create such a task specification, select the specification type as document reference.

{ ' Note: You can use your document reference attributes as task specifications if you have
' checked Attribute is also a task specification.

Read more in:

« Document References
« Create a Document Reference Attribute
« Edit a Document Reference Attribute

« Copy Document References

15.4.4. Edit Checklist

Checklists can be added to a task type. Checklist items can be things you want the operator to check
off before marking the task as completed. Another typical usage is to list subtasks.

Checklist items have no due dates but the system does track the day and user that checked off the
checklist item, in this way enforcing responsibility.
1. Navigate to Checklist tab in Edit Task Type.

« If you select Finish task if all steps from checklist are completed, it may not be possible to
complete a task of this type without having checked off all the checklist items.
« You can also decide that Only a task assignee can check off checklist items.

2. Choose Add checklistitems to open Add Check Items text box. Enter items and Finish to save.

{ . Note: You can create an empty checklist (with no checklist item) but in this case do not
' select Finish task if all steps from checklist are completed, as otherwise tasks of this type
can never be completed!

15.4.5. Add Task Statuses

308

Tasks have three statuses by default: Created, In Progress and Completed.

Adding more statuses improves the accuracy of task progress. This comes in addition to the estimated
date.

The task statusis reported in all task overviews. Task statuses can have high-quality icons. This allows
making these overviews much more visual.
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E b ] Note: Only Administrators can create task statuses but the task type owner can select task
statuses from the list.

Task statuses have a sequence and this sequence is automatically adopted by the task type.

« Tocreate new task statuses, as an Administrator:

a) Click Task Types > Statuses > Add Status.
b) Type names of extra statuses and browse for an icon.

If you don't add an icon, the name of your status will be displayed in the status column (so avoid
long names or use icons). Icons can be jpg/jpeq, png, gif, bmp file type. They are put without
any scaling in the task column so you should be careful not to use large icons. Good sizes are
between 15 and 30 pixels high and between 15 and 130 pixels wide.

Using wide icons allows showing progress very visually as in the example below:

c) Click  Finish.
« Toadd task statuses to a Task Type, as a user with the User Can Create Task Type privilege:

a) Onthe Task Types page, click your Task Type.
b) Go to the Status tab and click Add Status.
c) Select the status you want to add and click Finish.

15.4.6. Document Sources in Task Type
Use the Document Creation tab to setup the document creation settings. You can configure custom
document upload options (in Tasks) this way.
» Default
The default document creation options will be:
- Browse
- Copy

« New(when atemplate library is configured)

E b ] Note: New document creation is only possible if a Document Template library is linked
in this template.Read more in: Create Document Templates.

« Custom

When you select this, you will see a list of customizable options:

Source Where the document will be sourced from.

Label The link description. You can create a custom label, suchas Upload a graphic
file.
« Standard
« Simple
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- Translated

Details Additional information such as:
« Allowed Extensions
« Document Template Selector
Here you can select the already specified document templates. Read
also:Document Templates
Operation The operation depends upon the Source button. For example, if you have chosen
Project+Folder, the operations would be Copy, Move or Link the document
Sections The configured upload source is made available in these sections. By default, all

the options will be available and enabled. You can deselect the sections to disable
some of the locations.

« the Project Creation Documents
- the Project Creation Bill of Materials
- Bill of Materials

« Upload (Copy or Create Multiple Documents)

E b ] Note: You can also drag and drop multiple files onto an Upload button.

Target Folder

The destination folder

When a task is created from this kind of a task type, you get custom upload options in the task
execution page.

E ] Note:

If the task type does not have a document creation setup, the setup defined by the task’s
project is used as the upload options.

15.4.7. Define Task Documents Settings
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Use the documents settings to define the relationship the tasks created from this task type will have
with documents.

1.

task type.

Select Allow attached documents if you want to be able to attach documents to the tasks of this

Selecting this makes the other settings available. You can also customize document upload options
in the Document Creation tab. Read more in Create a Task Type on page 297

If the goal of the task is to produce one or more document, you can choose to Only allow task to

complete if it has one or more attached documents.

If the document(s) need(s) to be approved, you can also choose to:
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« Complete task automatically when all documents are approved,

« Only allow task to complete when all attached documents are approved.

You can also select Start approval cycle on attached documents to start an approval cycle
automatically when documents are uploaded to the task.

This uses the approval settings defined for the project the task is in(or the folder the document is
uploaded into, if it has approval settings defined).

Note: If neither the folder nor the project has approval settings defined, the approval cycle
will not be started automatically.

You can also choose to automatically Assign Attribute Category to uploaded documents. Select
the attribute category to use in the drop-down menu.

Note: If the task has specifications that are also attributes, you can use this to assign
those specifications / attributes to the task documents as well.

/. Attention: When linking documents that already have an attribute category to the task, the
existing attribute category will not be replaced by the one you select here.

If you want the documents to be uploaded to a predefined folder, you can enter the name of that
folder in the text field.

Note: This default folder will only be used if there is a folder in the project with that name.

If:

- the specifications used in the task are also attributes,
- those attributes are assigned to the document(s) attached to the task,

Select Automatically update attached documents attributes from task specifications to update
the values of the document(s) attributes with the values that the task assignee fills in for the task
specifications.

Note: The update happens once the taskis completed.

Click Save.

15.4.8. Define Task Discussions Settings

To allow project members to start discussions on all task created from the particular task type

1.

Select Allow discussions. By default, this option is not selected.

2. Onselection, Discussion Context drop down list is displayed. You can choose one of the following

options:

+ Current Task : This is the default option enabled. The discussions in the task are created and
visible in the current task.

» Parent Workflow: If the task is part of a workflow, the discussions in the task are created on the
parent workflow. The discussions are visible in all tasks of the parent workflow with this setting.
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The discussions are visible in the parent workflow task if the task type of the workflow has the
setting set to “current task” or if the workflow task has no parent.

+ Root Workflow: If the task is part of a workflow the discussions in the task are created on
the top level workflow task of the task. The discussions are visible in all tasks in the workflow
that have this setting, and all first level child tasks of the root workflow that have the Parent
Workflow Discussion Context.

+ Project: The discussions created in the task are Project Discussions. All Project Discussion are
shown in the task.
3. Choose the requisite option.

4. Select Show Discussions of Documents linked to the Task to view the discussion of documents
linked to the task.

5. Click Save.

15.4.9. Delete a Task Type

1. Click Task Types on the main menu.
2. Select the task type(s)to delete.
3. Click Delete in the Actions menu.

i = ] Note: You can only delete task types that are not used in a task.

15.4.10. Copy a Task Type

You can copy an existing Task Type. To do that
1. Click onthe Task Type. From the Task type's details page, click Save as Copy

2. Specify aunique name.
The following details are copied:
« Basic settings of the task type:

+ Description

- Estimated duration(days + hours)
+ Restrict Assignees

« Automatically delete option

« Document settings, including the name of the default document category

« Discussion settings

» Checklist items + settings

« Specifications including the layout and the order
« Restricted Sets used in Specifications.

«  Workflow

» Task Status List, including the name of the icons.

{ = ] Note: Theicons are not copied.
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« The Document upload configuration setup

«  Document Rendering setup

15.5. Working with Tasks

15.5.1. Create a Task

1. Click the Tasks tab in your project.

’ ' Note: If you don't have a Tasks tab, you probably do not have the Task Management license.

=4
2. Click Create New Task.
3. Onthe Create New Task page, select the Task Type.

To know how to create custom task types, see Task Types on page 296.
4. Choose a Status among the statuses available for that task type.

5. Assign the task to a project member or user group using the Assigned to list.

{ ' Note: If you assign a task to a user group in WebCenter, all members of this group will see
' the task show up in their My Work pages, and they will all receive notification e-mails (if
set up by your site Administrator). Any member in the group can then take on the task and
complete it.

6. Enter a Name and Description for the task.

7. If this task needs to start after another (already created) task, you can Add predecessor(s): hover
over Add predecessor(s) and select another one of the project's tasks as predecessor.

Repeat to add other predecessors if necessary.

{ . Note: See Sequential Tasks on page 323 for more information on tasks' links with their
predecessors.

You can also choose to Automatically link documents from predecessor tasks when task is
started.

8. Define when the task is due: you can use a Lead Time or a Due Date.
Use Lead Time if you know how long the task will take, but haven't calculated a precise due date for

it (for example for a task in the middle of a project). This calculates the Due Date automatically by
adding the Lead Time to the current date.

{ . Note: The Lead Time only takes working days into account.

The Estimated field will be mostly used by the task assignee to indicate when he/she expect(s) to
have finished the task.
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Note: By default, Saturday and Sunday is considered as weekend. However, it is possible to
switch the weekend days to Friday and Saturday. The due date calculation will ensure that
the due date will always be on a weekday. To enable this in your WebCenter system, contact
an Esko Representative.

9. Define when to Start the task:

+ Choose Manually if you want the assignee to decide when to start the task him/herself.

« Choose Automatically at ... (due date minus lead time) to have the task start automatically a
certain number of days (the Lead Time) before the due date. This makes sure that the task is
automatically started when there is still enough time to finish it.

« Choose Automatically after predecessors complete if the task has predecessors, and you want
it to be started as soon as they are finished.

« Choose Automatically after predecessors complete and after ... (due date minus lead time) to
have the task start automatically a certain number of days (the Lead Time) before the due date,
but only after the predecessors are finished.

- Choose Automatically after project creation if you want the task or workflow to be started right
after project creation from a template containing this task.

Note: If you are making the task start automatically, you can still give the assignee the
option to start it manually (select Assignee can start task manually).

10. If this task is crucial to the project, you can decide to have its completion change the project's
status (for example mark it as Completed).

Select Completion of this task changes project status to and choose your desired project status.

11. Click Create. When the task is created, alog is created in the project history with the Assigned to,
Lead time, Due Date, Estimated Date, Description.

15.5.2. Edit a Task

Note: You need the Change Task permission to be able to edit a project's tasks.

1. Inthe project's Tasks tab, click the Edit link next to a task to go to the Task Information page.
2. Edit the task as desired and click Change.

Note: You can also edit the tasks assigned to you from the task execution page (see Working
on Tasks Assigned to You on page 318) by clicking the Edit Task Details link (if you have the
Change Task permission).

15.5.3. Restricting a Task to Project Roles or Groups

1. Create a Task Type.

2. Inthe Edit Task Type page, enable the option Restrict Task to an Allowed Assignee (Group or Role)
in the General Information tab.

» After enabling this option, you can either select an Allowed Assignee role or group in the task
type or leave it as Default to Task Assignee.
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Save the Task type.

Click Create New Task in the Tasks tab in your project.

Select the Task Type you created.

Choose a Status among the statuses available for that task type.

N oo oo

Select an Allowed Assignee (a group or a role). This will restrict the task to that specific group or
role.

8. Inthe Assigned To field, you can specify:

« the Allowed Assignee role or group. This field will list all the project members.
« the members of the Allowed Assignee role or group.

Warning: If you specify an Allowed Assignee in the task type and select a different role /
group / project member in the Assigned To field, you will get an error while saving.

9. Click Create .
Your task is now restricted to the Allowed Assignee.

To change the Allowed Assignee, go to Edit Task > Task Information and select another role or group.

{ ' Note: You need to be an admin user to be able to change the Allowed Assignee of the task.

{ . Note: If the Allowed Assignee role or group is specified in the Task Type, you cannot change it

' in the Edit Task page.

15.5.4. Reschedule a Set of Tasks

Often, an entire set of tasks must change its due date. Some possible reasons are:

« The projectis delayed.
« The project needs to speed up.
« Asetof tasks needs to happen earlier or later in the project.

« The entire set of tasks was copied from a template or another project and it needs to be shifted as a
whole to be realistic for the current project.

{ . Note: You cannot change the due date of completed tasks.

To reschedule your project's due dates:

1. Open the project and select Tasks.
2. Click the Schedule Tasks link.

You can see all due dates and lead times of the existing tasks but also their Estimated Finish Date.
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Make estimated dates the new dates Show Task list (days only) v
@ # TaskName Assigned to Depends on Status Old Lead Time Old Due Date  (E3imated)  (Estimated) o\ oy 130 New Start Date New Due Date
Start Date  Finish Date
1 TL_Router Date sm_Task 1 ADMIN (ADMIN) 4 odays Jan 13,2015 Jan13,2015 Jan 13,2015
w o [-Routeratiribute comparison 1 O odays Jan 13,2015 May 25 2016 May 25, 2016 days May 31,2016 May 31,2016
sm_change project attribute_1 y ) ’ v «
@ 3 TL Router Date sm_Task2 2 O odays Jan 13,2015 May 25 2016 May 25,2016 days May 31,2016 May 31,2016
@ 4 SI‘;RT“'G'“‘”“(ECmpa”m” 3 O odays Jan 13,2015 May 25 2016 May 25, 2016 days May 31,2016 May 31,2016
¥ 5 TI_Router sm_Upload files_1 O odays Jan 14,2015 May 25,2016 May 25, 2016 days May 31,2016 May 31,2016
Preject due date:
Fast operations on the selection
Shift due dates with | 0 days
Try
Shift due dates to have the May 31,2016
latest ending on
Try
shift due dates to have the May 25, 2016 ﬂ
first one starting on
Try
Re-distribute due dates to  May 25,2016
start on
<
and end on
¥ Try

m Reset Cancel

This can differ from the due date because certain tasks are already overdue, or because due dates
were chosen without taking the predecessor tasks' due dates into account.

You can view the lead times in days only or in days and hours. When choosing days and hours, you
will be able to refine the scheduling to the hour a task should start or finish.

3. To change the due dates, you can either:
- Manually change the Lead Time of certain tasks (enter the New Lead Time and press Enter).

WebCenter then calculates a New Start Date (if the task isn't started yet) and a New Due Date (all
the dependent tasks are moved accordingly).

For example if your project is late, you can shorten some tasks'lead times to make sure it still
ends at the planned date.

i = ] Note:
« The Lead Time only takes working days into account.
« Thefieldsin yellow show the tasks on the critical path. Those are the tasks that
directly influence the project's end date (the last task and its predecessors).

To make the project end sooner, you can shorten the lead times of the tasks in the
critical path (in yellow).

- Click Make estimated dates the new dates: this takes the Estimated Start Date and Estimated
Finish Date as New Start Date and a New Due Date.

Use this for example if your project is late and you want to update your planning accordingly.

« Shift due dates with a certain number of days (select the tasks to change, enter a number of
days and click Try).

i = ] Note: Selecting a task automatically selects its dependent tasks too.
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You can use this if your project is late, or you can enter a negative number to speed the project
up.

- Shift due dates to have the latest ending on a certain date (select the tasks to change, enter
the due date of the last task and click Try). This will calculate how many days the latest task
needs to shift (to later or to earlier) and apply the same shift to all others.

- Shift due dates to have the first one starting on a certain date (select the tasks to change,
enter the start date of the first task and click Try). This will look how much the task with the first
starting date shifts and apply the same shift to the due dates of all tasks.

This would be typical for a set of tasks of which just one is started. This starting date allows
calculating the rest of the track.

Note: You cannot move tasks to before Today.

- Re-distribute due dates to start on a certain date and end on a certain date (select the tasks to
change, enter the new start and end dates and click Try). This will compress the selected tasks'
lead times to fit within the given dates.

By default, the starting date is today, and the end date is the project due date.

Tip: You can also use this to do backward planning by only giving an end date and
disabling the start date checkbox, or forward planning by only giving a start date and
disabling the end date checkbox.

4. If you are not satisfied with the changes, you can click Reset to go back to the original dates. You
can then Try to change the dates using a different method.

When you are satisfied with the changes, click Save. This will send an e-mail notification to the task
assignees (if this is configured).

You can also click Cancel to return to the task list without saving your changes.

You can also see your tasks in a Gantt Chart. You can display them by Day, Week or Month, and you can
choose to view the Original, Estimated or New dates.

¥ Show/Hide Gantt Chart

5/6 - 11/6/2011 12/6 - 18/6/2011 19/6 - 25/6/2011 26/6 - 2/7/2011 3/7 - 9/7/2011 10/7 - 16/7/2011
Task Name Lead Time Start Date Due Date 5 6 7 B 51011121314 151617 18192021 222324252627282930 1 2 3 4 5 6 7 8 9 10111213141516
Get translated text 14 days Jun 15, 2011 Jul 5, 2011

Berg, Brune
Design artwork 10 days Jun 6, 2011 Jun 20, 2011 Agency, Design
Review the design 10 days Jun 20, 2011 Jul 4, 2011 LT-I _.IKn:i er, Debble
Implement Corrections 5 days Jul 4, 2011 Jul 11, 2011 B Agency, Design
5 Make versions for different markets 2 days Jul 11, 2011 Jul 13, 2011 Berg, Brune

Powered by jsGantt Format: @ Day ) Week ) Month
View dates: O Original O Estimated @ New

B o e A

Note: You can also shift due dates from the project's Tasks page: select the desired tasks and
click Change Due Date in the actions menu.

15.5.5. Task Discussions

You can start a discussion on a task by clicking Edit Task Details then Discussions.
Task discussions work in the same way as document discussions.

Read more on how to enable Task Discussion Enabling Discussions in Task Type
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15.6. Working on Tasks Assigned to You

To work on a task assigned to you, you can either:

« click the link to the task in the notification email you received,
« click the task name in the My Tasks section of your My Work page,
« inthe project details page, click the Tasks tab then the name of the task.

This opens the task execution page.

Task: Design New Chocolate Ice Cream Packaging Project: Chocofun Project Details

Return Complete Task

Status Created

Assigned to <Nobody= - 2
Due  Jul1,2016at12:00 PM
Estimated \EC]

w Task Documents & Upload Multiple Documents

4+ Upload + Link

» Discussion -

Return Complete Task

15.6.1. Start a Task

« Onthe task execution page, click the Start Task button.

This sets the task status to In Progress.

15.6.2. Upload Documents to the Task

On the task execution page:

1. Inthe Task Documents section, click one of the options in the Task Documents section. You can
either:

« Upload a document saved on your computer or network (use Upload / Browse),
« Linkadocument already existing in the project to the task (use Link),
« Create adocument placeholder from a document template (use New).
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{ =l Note: Thisis only available if the project has been created from a project/template
=== containing document templates.

This is similar to the general upload document page. For more details, see Uploading a Document via
Upload on page 59.

2. Choose the project Folder in which to upload the document.
3. Click Change.

You can also Upload Multiple Documents (see Copy / Create Multiple Documents on page 63 for more
information).

15.6.3. Download a List of Documents from the Task

To download documents from the task execution page:

Select the documents to download and click Download in the Actions menu.

- Ifyou selected a single document (that you have download rights for), it will be downloaded
directly.

» Ifyou selected several documents, you will get a ZIP archive containing all the documents you
selected and for which you have download rights.

{7] Note:

« Ifyou don't have download rights for any selected document, you will see an error
message.

« Ifyouselected CAD files as part of a multi-document download, they will be
downloaded in the native perspective.

15.6.4. Change the Task Status

When you are working on a task, you may want to change its status to reflect the task progression
(especially if the task was created from a task type with many precise statuses).

On the task execution page:

1.
2.

Choose the Status to give the task.
If the task contains a Checklist, mark some checklist items as done if necessary.

3. Click Change.

15.6.5. Complete a Task

Once you have completed a task, do the following to mark it as Completed in WebCenter.

On the task execution page:

1.
2.

If the task contains a Checklist, mark the checklist items as done.
If the task contains Specifications, fill them in as needed.
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3. If the task type allows Discussions, you can add a comment if you wish.

Click Start a New Discussion if there is no discussion yet, or Reply if there is one, enter your
Message.

4. Click the Complete Task button.

This sets the task status to Completed.

15.7. Overview of My Group's Tasks

My Group's Tasks lets the Group Manager quickly view the tasks assigned to their group or group
members. It also allows to assign, re-assign, or distribute the tasks among the group members.

If a group memberisill or not available, the Group Manager can re-assign the task to an other group
member. A Group Manager can also monitor the progress on a selected Group or Group Member. Using
the filter options, the Group Manager can have a quick overview of the workload.

15.7.1. Group Task Manager

Every department has a Department Manager. In WebCenter Department Manager are referrred to as
Group Manager. A group can have any number of Group Managers including 0. Group Manager is always
part of a group.

A Group Manager likes to view the tasks assigned to a selected group or group members, which will
assist himin distributing the tasks and also get a quick view on the current status of a task.

The My Group's Tasks feature allows Group Managers to:

« View task assignments for a selected group and the workload overview.
« View tasks assigned to a group member and the workload overview.

« Re-assign any task assigned to a group member.

« Review the task overview filtering on status and due date.

15.7.2. Using My Group's Tasks

320

To access My Group's Tasks feature, log in as Group Manager. Click My WebCenter > My Group's Tasks
to view the Group Tasks for Group page.

Viewing Task Assignments
You can view the tasks assigned to a selected group and also for a group member within the group.

1. The task list for assigned group appears.

i =| Note: If a Group Manager manages or is assigned to multiple groups, WebCenter displays
the list of managed groups. You can only view the tasks for one group at a time.

2. Inthe Tasks assigned to drop-down list box, select the group or group member for whom you want
view the task assigned.
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3. Atasklist assigned to the selected group or group member appears. Also in the list are:

«  Task Name
+ Project Name
« Assignedto

« Status
« LeadTime
«  Due Date

+ Created Date

« Started Date

« Estimated Date
« Task Documents

Viewing a Workload Overview

During editing/re-assigning, the Group Manager can have an overview of number of tasks assigned and
how many are overdue. The Task Count is the number of assignments assigned to a group member. The
Task Count displayed is based on the filtering criteria and tasks with past due-date always appears.
The non-active projects do not appear and are not counted.

1. Thetask list for assigned group appears.

Note: If a Group Manager manages or is assigned to multiple groups, WebCenter displays
== the list of managed groups. You can only view the tasks for one group at a time.

2. The workload overview appears for the selected group.

Search Tasks Sortby | Due Date A Status All but Completed

Members Task Count

Before1{1 overdue)

DEKE_DEPENDENCIES
2 - After: [1(1 overdue)

Before:0(0 overdug)

ArtiosCAD, ArtiosCAD (ARTIOSCAD)
ArtostA osLATHA e After: 0(0 overdug)

Before:0(0 overdug)

deke_user2 (DEKE_USERZ
e —oeene After: 0(0 overdue)

Before: NG 1(61 overdue)

il, pm (IL_LPM)
il, prm {IL_| After: S (67 overdue)

- Behbie (DEKE} Before: NG 35 (138 overdue)
Keizer, Debbie (DEKE H :
er, Lebbie ! After: 1 35138 overdue)

Before:0(0 overdue)

prma (PRMA_USERZ)
a | Ao / After 0(0 overdue)

If the task is past the due date, it appearsinred.

Reassigning a Task

A Group Manager can re-assign a task to a group or a group member. A task can be re-assigned only to
a group member within the same Group. In addition to this when the task is reassigned, the WebCenter
Ul displays the previous assignee in Previous column.

1. Note: Ensure tologin as Group Manager.
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1. Thetask list for assigned group appears.

{ ' Note: If a Group Manager manages or is assigned to multiple groups, WebCenter displays

the list of managed groups. You can only view the tasks for one group at a time.

2. Select the new assignee in the Assigned to drop-down list box. This list contains group and group
members name.

3. WebCenter shows changed tasks with a yellow background indicating the change.

{ . Note: Even if ataskis not initially assigned to a group, the Group Manager has all the rights

to re-assign the task to a group member.

4. Click Save to commit the changes.

Filtering Based on Task Status and Due Date

A Group Manager manages multiple tasks at a time and this might lead to delay. Using the Search
Tasks Status, one can see tasks in a more specific status.

For example, you can filter the tasks which are in Completed or In Progress status. By filtering the
task, a Group Manager need not re-assign completed tasks or tasks which cannot start because a
predecessor is not complete.

Similarly the tasks can also be filtered by Due Date. This gives a Group Manager a quick view of the task
for the required time line. Using this information Group Manager can view what is due this week or this
month to make the required planning.

1. { . Note: Ensure to login as Group Manager.

1. Thetask list for assigned group appears.

{ . Note: If a Group Manager manages multiple groups, WebCenter displays the list of

managed groups. You can only view the tasks for one group at a time.

2. Inthe Search Tasks Status drop-down list, select the desired task status.
3. InDue Date, select the required due date and then click Go.

{ ' Note: To set the Due Date filtering, setting a task status filter is not necessary. The Due

Date changes to completion date, if the task status is filtered to completed.

The following are the default due dates settings available:

« All

« Today

+ Next 3 days

+ Next week

+  Next 2 weeks

» Next month

+  Next3months

» Overdue

«  Week overdue, all the tasks which are overdue for less than five days.
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Filtering Based on Column

By clicking a column header, the Group Manager can view tasks for a selected group in ascending or
descending order.

For example, if Due Date is selected then the tasks for the selected group appears with the earliest
due date. Similarly if Due Date is clicked again, then the tasks for the selected group appears with the
latest due date.

1. Loginas Group Manager.
2. Thetask list for assigned group appears.

i =u| Note: If a Group Manager manages multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

3. Click a column header, for example Due Date, to sort on this column.
The sorting is indicated by an arrow. For example, if Due Date is selected then it would appear as:

Due Date

Jan 29, 2013

Sequential Tasks

What is a sequential task?

Tasks can be made dependent on each other. You can define predecessors for a task, which
automatically chains tasks to each other.

For example, if you create a “Review the final design proposal” task for a member, and then add a
second task called “Implement design corrections” that has the “Review” task as a predecessor, you can
make sure that the “Implement design corrections” task starts automatically when the “Review” task
has been completed.

Starting tasks: options
Tasks can be set to start:

« Manually (the member changes the task status manually).
- Automatically, depending on the due date and lead time (in working days).
« Automatically, depending on the completion of the predecessor task(s).

i = ] Note:

If the Due Date is different from the Due Date of the predecessor plus the Lead time (i.e.
the earliest the task can be finished), the Reset Start Date button will appear. Clicking this
button will set the Due Date to the Due Date of the predecessor plus the Lead Time.

This option is only available if the task is in Created status, and if the Start Task is set to
Automatically after predecessors complete.

« Acombination of the above options.
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Also, task completion can change the project status.

Linking Documents to Tasks

15.9.1.

15.9.2.

324

One of the strengths of Task management is the ability to link documents to tasks.

Documents always sit in a folder in a project. The link to Tasks is optional and comes on top of the
positioning inside a folder.

{ =| Note: If a default folder was defined in the Task Type setup, new files will automatically be
uploaded to that default folder. The user can still change the folder manually in the upload
dialog.

You can also attach a document table to your Task Type. This gives you multiple referenced documents
in the Tasks. You can use the Document Rendering on page 325 tab to attach multiple documents (for
example, a copy sheet)to a Task Type's tasks.

Why Link Documents to Tasks?

Linking a document to a task gives purpose to the document. Without task management, the purpose
of the documentsin a project is implicit. You typically figure out what they represent through their
name, through their Attributes, or through the name of the folder they are in.

Most documents linked to a task are one of the following:

» Theresult of the task. Creation type tasks end normally with a digital asset resulting from the
creative work. Good examples are ArtiosCAD .ARD files, or PDF files etc.

« The"current state” of the task. When the task is not yet completed, you can already show what you
have by linking the current version of the document to the task.

« Aspecification as a separate file. Although tasks can have structured specifications, it is possible
that you want a complete document to specify the task. You can then upload that document and link
it to the task.

» Theinput for a task. Creation of graphics for packaging demands a definition of the cutting shape.
Soyou can link the .ARD file to the graphics creation task or upload it to the task.

« Collateral information.

l” © Tip: Documents can be linked to multiple tasks. A typical example is where the same
document is the result of a first task and the input for a second task.

Documents Tab

In this tab, you can configure how documents are handled in a Task Type. See the options below:
« Allow Attached Documents: Enable this option to allow attached documents.

« Show link to Multiple Upload: This option is to streamline handling of tasks that do not require any
documents. It is common when a task is used to fill specified values (specifications)and/or fulfill
defined checklist only.
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Upload Multiple Documents : Disable this to hide the button from the task execution page.

| " Note:

Only allow task to complete if it has one or more attached documents: When this is checked, you

have the extra options:

« Complete task automatically when all documents are approved

« Only allow task to complete when all attached documents are approved

Start approval cycle on attached documents

Assign Attribute Category to uploaded documents

Automatically update attributes for attached documents from task specifications

Set default folder for uploaded documents

15.9.3. Link a Document to a Task

There are multiple ways of linking a document to a task:

From the documents overview, select the document(s) and click Link to task(s) in the Actions
menu. This allows you to quickly associate multiple documents with multiple tasks

Within the task details, click the Documents tab and then click Link document(s) in the grey bar.

Select the document(s)to link.

You can directly upload a new document to a task. In the task details, click Documents and then
click Upload Document. This will give you the well-known upload dialog, but you will immediately
create alink to this task.

15.9.4. Find Documents Linked to a Task

In the task, click Documents. This shows what documents are linked to this task and it also shows

their version, description and approval state.

In the tasks overview, there is a Task Documents column showing the names of the documents
linked to this task. Clicking a document name brings you to the document.

In the documents overview, there is a Tasks column. Clicking a task name brings you to the task.

15.9.5. Document Rendering

You can create Custom document rendering options in a Task Type's Document Rendering tab.

There are two options in this page.

Default (this is selected by default). See the example of a Default Rendering:
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w Task Documents | 44 Upload Multiple Documents

+ upload + Link

HEE Thumbnall Mame

« Custom

1 Mormal Permission.wec

1=

4=

1=

Version

Gn this page, you can configure the rendering options of Documents Table for the Task Exscution Page of this Task Type.

Default
® Cusiom
Hide Header
Type
] Expand Attributes (+) ¥
] Document Property
Document Name
o Document Actions
o Document Froperty
o Document Froperty
o Delete Button
) Replace Button
o Duplicate Button
Add Column

Details Label
View | PCM Collate
Use Creation View for new Documents.

Thumbnail . 50 v pr | Thumbnail

Show Document Source
Show Document Description

Show Folder

(O

Show Document Template

Open 2D View
Wiew

Open in ArtiosGAD DocRefColLabel Docum

000

Download
Add Action

Version
Version
@ Allow uploading a new version

Approval Status v Approval Status

Revert to default configuration

To create a customized document table in the Task Type:

Visibility

Editable

Read Only

Read Only

Read Only

Read Only

Read Only

Read Only

Read Only

Read Only

I

I

WebCenter

Approval Status

Width

v | auto

auto

auto

« Enable Allow Attached Documents in the Documents tab. This option is disabled by default.
« Select Custom in the Task Type > Document Rendering tab to configure the document table.

The options available are exactly the same as Document Reference Rendering. Read details about
the options in the document references section.

« Configure your table options.

You can attach a copy sheet in a task type this way. This allows you to send a copy sheet to edit,
translate or approve in a task (therefore automate it in workflows). If you are attaching a copy sheet,
also configure options for Text Documents.

Note:

You can configure Master Text and Translation Text widgets to appear in the Text document

table.

Read more in:Creating a Copy Sheet on page 336

«  Remember to Save. Only then it takes effect.
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Documents section of all tasks created from this Task Type (old and new) are affected by the changes
saved on this page. See an example of a Task Document Rendering (Artwork with its copy sheet) below.

Task: Collate Project: PCM New Template 00008 Project Details

Description  Validate the text statements

Status Completed -
Completed by % Martinez, Teresa (TEMA)
Previous Assignee  §3 PCM_CONTENT MANAGER

Due  Jun 16, 2016 at 3:40 PM

Completed  Jun 16, 2016 at 243 PM

¥ Task Documents

EE Thumbnail Name

Version Approval Status
= .I" i GET SET_MULTIVITS_CARTON_2.a 1
= ) Q 1
Marketing:
+ New <+ From Library
Instance (G51) Englizh - United States * Spanish - Spain (Traditional) * Version
| | GET It NOW! Q "/ iConsiguelo shoral ®
- =
ERAND KAME 1 Siged Sigred 3 A L
oft © ®
| | \/ OME-A-DAY 56 TABLETS = o] \/ UNO-A-D14 56 comprimidos - ®
o 9 NSTRUCTIONS INSTRUCCIONES Adultos: Tomar 3 - - -
Lsans Sigred b ; b sl 5510 una tableta cada dia. No = -
INSTRUCTIO. U A dults: Take only ane tablet (0] off exceda la dosis recomendada. Este (0]
every dav Nn not exceed the s ; 2 ; T
[ | v | O-A-DAY o v 10-A-DAY ®
USAGE 1 s " 3 L L
INSTRUCTIO o ® 9""‘ ®

Create an Advanced Table Rendering

Adding an advanced table of document references allows you to customize the way your document will
be shown to users when they are applied (For example, in a template).

It also allows you to configure advanced features such as making an attribute of the document
required or read only.

Note: The document reference attributes will inherit the style specified in the attribute
== category. This style is further expanded to the individual document's attributes as well.

« Click Use Grid Layout in the Edit Category page. Add your document reference attributes.

Reference Mo Reference Category selected
Category:
Version Mode: Latest Version
Document Components_Default ‘¥
Source(s): Edit Configuration

¥
Rendering: Components_Default

Edit Render Configuration

« Select the Rendering as Table in the grid layout.

In the Edit Render Configuration dialog, you can set up the advanced rendering.
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i = ] Note: You can create custom tables for your different views.

« Enable Hide Header if you do not want a header row in the document references table. The labels
will be displayed in line for each document.

« Enable Allow Bulk Operations when any action performed on the document reference is also
cascaded to all the references which are made to that particular document reference. Actions
performed on the document reference could be to

» Remove a Referenced document which removes all the document references in the tree
structure
+ Replace and Undo
« Gettingdocument to Local and Undo action
« Upload a new version and/or edit a text statement
« Update to the latest version
« Enable Limit Bulk Operations to Document References with matching Operations configured,
when you want to perform bulk operations on document rows which are filtered based on document
sources and actions configured for them. Read more about bulk operations.

User is informed about the number of rows the bulk operation will be really performed (after
filtering) in the specific bulk operation modal dialog.

. EIE. Name color2 (prop) City Project D
- /\.‘: Report test.pdf [ | A DocRef project
Adobe

= - Name color2 (prop) City Project

+ - X
mpp.txt [pitch black | [Landon |ﬂ DocRef project ¥

« Enable Open Links in new Tab , to open any link in the document reference in a new tab.
« Click Add Column to add more columns to the table.

The rows in the Edit Render Configuration pop-up correspond to your document reference
columns.
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Edit Render Configuration

Name: DocRef3_Default

Hide Header
¥ Open Links in new Tab
#| Allow Bulk Operations

Limit Bulk Operations to Document References with matching Operations configured

Type

Reference Property
Up/Down

Document Property

Document Name

Document Actions

Document Property

Local/Remote Project

Replace Button

Delete Button

4

-

Details Label
INSTANCE_SEQUENCE - INSTAMCE_SEQUENCE
Thumbnail « 50 v px Thumbnail

« Show Document Source
# Show Document Description

Na
@ Show Folder ame
# Show Document Template

Open 3D View - ©

View - B9

Open in ArtiosCAD v ©

Download ~ B

Add Action

Version -
¥ Allow uploading a new version Version

¥ Allow updating to |atest version

Copy Text Content Status

Add Column Revert to default configuration

Visibility
Editable
Read Only

Read Only

Read Only

Read Only

Read Only

Editable

Read Only

Read Only

WebCenter

Width

auto

auto

auto

auto

auto

auto

auto

auto

auto

Collapse

Select Type as Document Name which is a mandatory field. In the Details section, you can disable:

« Show Document Source

« Show Document Description
« Show Folder
« Show Document Template

Your rendering will have a hyperlink to the document depending on the user permissions. These
options are additional details added to the document and can be viewed only when a new document

is added.

box sprint2.ard

The name will not be a hyperlink for users without document view permissions.

Depending on how your document properties should be rendered, configure the table columns. You

can create custom Labels for your selections. The properties will be displayed as read-only.
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Choose Document
PropertyDetails as...

The result in the rendering table will be...

Description
VersionRevision
VersionAuthor
Project
ApprovalStatus
ApprovalStage
ModifiedDate

Thumbnail

£ ™

« Create custom
labels

« Specify the pixels
for your thumbnail.

« Checkthe box
Allow uploading a
new Version button

The selected document properties will appear in the table
header with the custom label. For example:

« thecurrent Approval Stage of the document. The user can
click to access the approval pop-up.

« Clickable thumbnail of the document with the default (50x50)
or specified pixels.

estado de  etapa de

Version - .
aprobacion aprobacion

1 (3 (8 Stage2

1 (%) WV Etapa 3

* Upload New Version # if you have the rights to upload will be
available in theVersion column.

« You can configure document actions in the table rendering of the document references.

The actions will appear next to the documents listed in the table only when it is relevant.

® =+ |Document Actions

r | Open 3D View v %) |£-.|:ti|:|n5
View v |%)
Open in ArtiosCAD ¥ %)
Download r EJ
L E__J

Upload Mew Version

I Add Achion ]

Choose Document Actions as...

The result in the rendering table will be...
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View
Openin 3D
Openin ArtiosCAD

Download

A 3D 9 button will be available only when there
is an existing 3D perspective.

« Openin ArtiosCAD option will be available
for CAD files. Clicking on it will open the CAD
document as set up in the preferences

Re
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Choose Document Actions as... The result in the rendering table will be...
« Upload New Version « Download option will be available when the user

has download permission.
« Update to Latest Version
- Upload New Version: This is available when the
user has the rights to upload new version.

@ Note: The Upload New Version *

" button can also be placed in the Version
column by checking the Allow uploading
a new version check box.

- Update to Latest Version: Allows user to update
to the latest version

Note:

« If you change the attribute values during the upload of a new version, these are only
applied on the new version of the document. The previous version will have the old
attribute values.

- Ifadocument versionis linked in multiple projects, all linked projects will get the new
document version.

« If the configured columns do not fit in the table, the table will assign each column its
minimum width and show a horizontal scroll bar.

« Configure how your Document attributes should be displayed. Select the relevant attribute from
the drop down as a specific column (with a custom Label) in your table.

| Components ¥ |

Component Code "
Component Mame

Component Number

Concepts

Configuration

Connectarealsqg ft,sq m)
Construction of Pack Efficient?
Consumer Insight

Contact Name

Specify the Visibility of the The result in the rendering table will be...

attribute as...
- Editable if you want the « The selected document attributes will be displayed in the
users (with the right table header and its values in the respective columns.

permissions)to be able to

edit this attribute.
Width * Length
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Specify the Visibility of the The result in the rendering table will be...
attribute as...

« Required if you want to
make it mandatory for users
(with the right permissions) « The users can type in the values for the editable attributes.
to fill in this attribute.

Weight Date

« Read Only if you don't want
any user to be able to edit
this attribute.

1g | [May 25, 2015 |=]| 13:30 v

Note: You can configure the Visibility also at the
attribute level. If your settings differ, the most
restrictive setting will be applied.

Tip: Click add column and select another attribute to have more attributes listed in your
table.

Tip:

You can configure a project's document reference attributes to be non-editable and still
allow the user to edit the attributes of the documents referenced.

Your user can do this from the project's attribute category tab.

Tip:

Optionally, you can setup the Project > Notifications > Project Attribute/Category change
to receive notifications about document references.

Reference category changes will be notified according to the Project > Notifications >
Document Attribute/Category change settings.

Configure Expand Attributes + / Collapse Attributes — button for your document references.
This allows you to expand or collapse the document attributes of your references.

Tip: You can configure different expand attributes settings for different views. Specify the
view name here.

Note:

The check box Use Creation View for new Documents is switched on by default. As a result,
you will get the creation view whenever you use Upload/ Browse, Copy or New regardless

of the view you are creating the rendering for. If this option is disabled, you will see the
specific view or the default view.

When you save the view will change to the specified or default view depending on the
configuration.
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« read-only

- editable

Note: The user needs
Change properties right to

edit attribute values.

Click + to expand the document attributes (which
may also be document references):

~ @5 Tip: Keep this editable, if your users have to
= edit the document reference's attributes.

When the document attributes are expanded, you can

use '~ to collapse them.

= Thumbnail Name

= ‘ BOXCO 00001.ard
Customer Box Brands
Description CAD Number
[Blue box for Bax&Ca. | [t |
Display Style Length
@

« Select the relevant reference properties and specify if you want it to be Read-only / Editable /

Required / Hidden.

Reference properties are attributes (reference category )of the document reference link. You can
select one of them from the attribute drop down in the Details cell.

I Reference Property

¥ | | DEKE_Ingredient Quantity (fcat) ¥ |

I Reference Property

¥ | | DEKE_Ingredient Unit v |

Note: Reference Property field is only available when a reference category is specified for
the document reference.

- Editable if you want the users (with
the right permissions) to be able to
edit this attribute.

« Required if you want to make it
mandatory for users (with the right
permissions)to fill in this attribute.

The reference attributes will be displayed in the table
header and its values in the respective columns.

The users can type in the values for the editable
attributes.
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Specify the Visibility of the reference  The result in the rendering table will be...
category attribute as...

« Read Only if you do not want any
user to be able to edit this attribute.

Hidden if you want to specify a « No visible reference attributes in the table
Reference Property, but do not want to
show it in the table. « The values (of the reference attributes)are retained

- . - when you duplicate or replace a document reference.
Note: This option is specific to

Reference Properties.

Note:

Choose Collapse check box when you choose Document Property, Reference Property,
Reference Property Filter, Document Attribute, Project Property, Project Attribute,
Master Text, Translation Text, Text Language Flags fields for Type, to expand or collapse
the column while rendering in the table.

+ = Pphoto Ingredient Quantity

« You can allow the users to move a referenced document into the current project. To set this up,
create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.
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-+ Upload < Link -+ Search -+ Search
[=] Location = Thumbnail Name Version
opy All References into Current Project
S Refer Reference M Allergen statement Q s 1 =

0002 _TextDoc_00000814_PCM.wce

Reference Best before date
123Best before date.wecc

Reference M Dosage instructions
123Dosage instructions.wcc

NCarrotl1.pdf Q & 1t (]

000000002_Mutritional Facts_C.wce

You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.

[=] Location = Th

z.5 Copy to Current Project

sl
“1
-
"

<908

----------- I e WA 8
= L= = LB QIm. ¥ve-n-10o50

The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

« anewname and description
- document template
« target folder

If the setting is Read-only, the user will see indicating remote project.

When you are creating a Copy Sheet using Text Document References, you can configure text
related data to the table. Read more in: Create a Table Rendering for Text Documents on page 338
To configure the rendering with Project related parameters, choose from
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+ Project Property
« Project Attribute

Read more details in: Project Properties in Advanced Table Rendering
« Optionally, add:
a) aNumbering column.
b) Up/ Down arrows to let the users change the sequence.
c) Duplicate button which allows the user to duplicate a reference along with its properties. Read
more in: Duplicate a Document Reference.
d) Replace button which allows the user to replace a document reference. Read more: Replace a
Document Reference.
e) aDelete Button to let the users delete the document references from the table.
f) Row Selector to let the users select single or multiple documents. Using this, user can select
multiple documents from the document table and perform document actions on them.
« Save the configuration by clicking OK. To revert from this configuration, click Revert to WebCenter
Default Configuration.
. Save the Attribute Category.

If the logged in user does not have permissions to view the document, the document table will have
(based on the configuration):

1. Document name with !. The user will see a warning message.
Editable reference properties displayed in the specified columns
Up /Down arrows

Delete button

Numbering ("#")

LIPS

Note: If the settings are not editable, the document table will have the document name and its
sequence number.

Creating a Copy Sheet

Copy sheet is aterm used to describe all the content that is attached to a particular artwork or printed
item. A copy sheet containing aggregated content helps you to:

- validate the copy sheet templates for consistency, accuracy and compliance with the established
content management process.

« review, proof-read and approve copy sheet in one place.

You can create a copy sheet using Text Content Document References in an Attribute Category. This
gives the option to attach this copy sheet to your Projects or artwork documents.

The copy sheet categories allow you to:

« track the content on an artwork.
« easily reuse existing approved content
» configure separate permissions and approval system for each text document.
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-ff‘f- Tip:

o By configuring Document Rendering for Text documents, you can attach copy sheets to Task

S.

When you configure Workflows with manual tasks for editing or approving, the users can work

on the copy sheet directly from their task.

An Attribute Category based copy sheet offers the following advantages:

« thelanguages. To view a particular translation corresponding to a master, just select that language

in the filter drop down.
« thelnstance Sequence. See more in: Dynamic Content documentation

« theoptionto replace a text document with another
« thebutton to duplicate a document with the same reference attributes

« advanced document reference options

You can Edit, Start Approval, Approve and Reject actions from the copy sheet depending on your
content permission.

. Note: The text document references are used when you import Dynamic Content into
=== WebCenter. Read about this here.

See the example screen shot below. The configuration explained here is only an example. You can
configure your document references according to your needs.

Tip: You can configure the copy sheet with different Attribute Views to provide custom
views to your users. For example, a content collator and Translation Language Editors can
have different custom views of the same text document reference category.

n‘ /
[

On deletion of a language, the * iconis again displayed to enable adding back the
language. You can configure the corresponding attribute category to display the languages
one by oneinatable.

_@ Note: You can also add the languages by clicking on the e displayed in the text statement.

Tt

o Mew b Mattng Contert Library

. Text Widgets
£ Engileh - ntwenationst

Ham

[
B

Trammiaton Text: Freneh - Frame . Taxt Langusges

Language Flags

i re] L=} +*
W bt cogy 5 ¥ r' OE ® o 1] L1 =

: o
7 o =] s i *

.4 o ¥ @5 i msn=us
=
DAL e o AL .

" st co0r 5- u p.-r-.'_'re . o ML=
a @
N FECHCLE [=] TELER L ]

| ® e s 5 . .m—..-.« o ol MIENI=ID
@

A B 5 s oo ne o: [ ®; LIEELImT

| Pt i - - ,.__ o c' * NELI=T
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Automatically add/remove languages in the Documents Table

Adding any of the available languages is possible based on permissions on all the local text content
documents in the table, but for the remote documents (sitting in another project). Auto Addition of
Languages can be enabled in the PCM Deployment and Configuration.

When a new language is added in a Master/Translation language attribute, the language is
automatically added into all the local text content documents. For the new text content documentsin
the local project, the missing languages are added and extra languages available in the text content are
removed.

Similarly, when a language is removed from a language attribute, it automatically removes the
languages which are added recently but not yet saved.

Create a Table Rendering for Text Documents

You can configure a Text statement as document references and add them to a Project or Document
Attribute category. The configuration and rendering are similar for Task Specifications.

For each Copy Sheet (Product Content Sheet), which has Text Content documents as reference, you
can make different configurations to show text related data using advance table rendering option."

1. Create a Table Rendering.
2. Inthe Edit Rendering Configuration pop-up:

Configure The result in the rendering table will be...

Master Text or Translation Text Master Text Statement or the Translation Text is shown in a text
widget along with its content in the edit field and all related text
content actions.

E b ] Note: The Visibility should be specified as Editable
if you want your users to edit the text. One or
more columns can be configured for the Master or
Translations of the Master Text.

Master and Translation languages will either appearin a
drop down or you can choose Show Side by Side view.

You can also restrict the languages that will appear
in the drop down, by mentioning the languages ( pipe
separated) specifically in the details tab.

Text Language Flags The language drop downs for Master and Translation Text
columns.

E b ] Note: The master and translation
languages are populated from the project
attributes MASTER_TEXT_LANGUAGE and
TRANSLATION_TEXT_LANGUAGE respectively.
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—QV- Tip:

You can specify a default language code for Text statements. The selected language will be

the default in the document reference table. If default language is not specified, the first

language from the language drop down is selected as the default. WebCenter also supports
right to left languages like Arabic and Hebrew for text content.

3. Specify the width for Master Text and Translation Text.By default, the width of every column is set
to Auto. However, you can configure the width for the Document Name, Master Text, Translation
Text and the Translation Languages.

To change the width of the columns, specify pixels or a percentage (of the width of the
table). If the label of the column is too big for the width specified, the column width will be
bigger to accommodate this.

Edit Render Configuration

Name: PCM Text Reference_Default

O Hide Header
Open Links in new Tab
O Allow Bulk Operations

Limit Bulk Operations to Document References with matching Operations configured

Type

Document Property

jocument Name

Replace Button

Reference Property

Reference Property

Translation Text

Master Text

Delete Button

-

Details
Thumbnail » 50 v px
Show Document Source
[0 Show Document Description
[ Show Folder
O Show Document Template
Compact Rendering
ARTWORK_VARIABLE v

INSTANCE_SEQUENCE -

O Show Side by Side

DisplayOptions & & © @

O show Side by Side

DisplayOptions | & & © @

Add Column Revert to default configuration

Label

Thumbnai

Mamea

ARTWORK_VARIABLE

Instance Seq.

Translation Text

Master Text

Visibility

Read Only

Read Only

Read Only

Editable

Editable

Editable

Editable

Read Only

Width

auto

100px

auto

auto

T5px

600px

G00px

auto

Collapse
(]

1. You can also enable the Display Options in the Edit Render Configurations. You have four icons
buttons and are active by default.

Status Button Show status column in default manner like basic view page when active. When
the button is inactive it shows status in the form of a colored strip based on the status of the
content. Green for approved, red for rejected, blue for pending approval and grey for draft.

Inheritance Button Shows the inheritance icon when active.
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«  Comments Button Shows the comments icon button when active.

« Approval Info Button Shows the approval info button when active.

WebCenter

While Rendering of Master and Translation Language, if all the button options are disabled and
there is no message to show then more options "Ellipsis” button will also not be visible.

4. Configure the display of Text Language Flags. You can configure the Display as Show only Flags or

340

Show Flags and Languages.
These flags will be based on the Project Language Attributes.

» Inthe copy sheet view, all the newly created text documents will have the current Project's
Language attributes as flags. You can read about how to customize flags for languages here.

« Allthe sourced content (referenced from other Projects) will have the flags based on the source
Project's language attributes. To add the current project's languages, select them from the

available flags.You can add or delete flags in this view.

You can allow the users to move a referenced document into the current project. To set this up,
create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the

header and selecting the option Copy All References into Current Project.

= Upload = Link = Search = Search

] [=] Location = Thumbnail Mame

opy All References into Current Project

Reference M Allergen statement
0002_TextDoc_00000874_PCM.wcc

2., Reference

Reference Best before date

% Reference 123Best before date.wcc

Reference M Dosage instructions

% Reference 123Dosage instructions.wecc

2., Reference NCarrot11.pdf
=
EI=
% - 000000002_Mutritional Facts_C.wce
—

You can move any of the referenced document to the local by clicking on the Referenced field of the

required document and selecting the option Copy to Current Project.

|4

|4

|4

[4m

|4m

Version

8(F)
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Location Tht

£ Copy to Current Project

The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

« anewname and description
« document template
« target folder

If the setting is Read-only, the user will see E'E' e indicating remote project.

6. Ifyou are configuring Local / Remote button to allow copying of documents, ensure that you have
enabled or disabled Retain text document status.

When this option is turned off, if you copy to Local, the approval status of the Text Document is
reset to Draft.

If Retain text document status option is turned on when you copy the document, the document's
approval statusisretained as it is.

7. Define adequate permissions to view and edit Text Statements.
Whether or not your user can edit or perform approval actions on a Text Element is determined by
the following settings and permissions:

« Visibility should be specified as Editable.

- If your Text Document Reference is a child of another document (for example an artwork), the
Expand Attributes (+) column of the Parent document should be configured as Editable.

« The user should have appropriate Content Permissions. Read more in: Managing Text
Permissions on page 465.
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|"’fTip:

Check these Project level permissions (Project Details > Security) to troubleshoot editing
problems:

- Change Properties

« Start/Stop Approval
- Upload new version
« Change Task

» Download

+ View

- Add

Note: The Text widgets, related languages and statuses are rendered only for Text Document

' References.

15.10. Setting Up Task Notifications

The biggest aim of Task Management is to make tasks happen at the right time. As with most
production processes, packaging production is a complex process with both sequential and parallel
operations.

The critical path is the set of dependent operations defining the total duration of the Project. At each
moment, only one task is on the critical path and any delay on that task delays the entire Project. Often,
people performing critical tasks are not even aware of the critical nature of their work.

Therefore, it is very important that people get correctly notified of what they are supposed to do and
that they get notified again if they cause delay to the Project.

Currently, WebCenter does not calculate critical paths; it leaves it to the Project manager to set good
due dates and it notifies people assigned to a task.

WebCenter also automatically sends overdue notifications to Project managers and assigned Project
members whenever a task is overdue. Overdue means that the task passes its due date without being
completed.

This information assumes that the e-mail environment is already set up. Please refer to the WebCenter
Installation Guide for detailed instructions.

15.10.1. Set Up Notifications for Tasks

Task management notifications are set up on the same pages as all other notifications.
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The Admin sets system-wide default notifications for all projects at once (see "Notifications
Preferences"in the Administrator Guide), but you can change those defaults for the projects you
manage.

- To set project-specific task notifications, click the Notifications tab in your project. Following
Notifications can be set up for task related events.

« Taskcreated

« Task Assignment changed
« Task Due Date changed

« Task Predecessor changed
« Task Specification changed
« Task Information changed
- Task Document(s) changed
« Task Checklist changed

» Task Status changed

» Task started

« Taskcompleted

« Task deleted

« Workflow canceled

For example, you can send notifications to the Involved People. For task management notifications,
the involved people are typically the task creator and the task assignee.

l © Tip: Onthe notification setting page, click Involved People for more information about the
“=2 involved people for each kind of notification.

15.11. Tasks, Templates and Copying Tasks

«  When saving a project to a Template, you also save its tasks to this Template. When creating a new
project from this Template, you'll automatically have these tasks in your new project.

- You can also create a project as a(partial) copy of an existing project. After clicking Create New
Project, click Copy setup from an Existing Project (see Create a Project Based on Another Project
on page 234). There you have the option to copy the tasks.

« Athird way to quickly create a task from existing tasks is to create a task as a copy of another task.

15.11.1. Copy a Task from Another Task

{ = ] Note: You can only copy from other tasks in the same project.

1. Gointo the task details of the task you want to copy and click Copy Task on the right of the screen.
2. Choose if you want to:

- Copy Specifications,
+ Copy Documents.

... into the new task.
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Enter the new task's Name and an optional Description.
Change the due date as desired.

Assign it to the project member of your choice.

Click Finish.

15.12. Example: Assign a Role using a Task

Use this to allow non-Project Managers to invite people, assign tasks or approvals to users or groups
via a task.

For example, use this if you want Marketing Managers or customers to invite an agency without getting
to project management details.

You will need your Administrator's help for this(steps 1to 3).

1.

As an Administrator, create a Restricted Set containing the people or groups that will be used to
assign the role in the task.

+ Use the Text Type.

» Forgroups, use the exact group names.

« Forusers, use thisformat: Lastname, Firstname (username).Make sure thisis spelled
correctly, especially the (username)!
See the Administration Guide for details.

Create a Specification (from the Task Types > Specifications menu) with the same name as the
role and add the Restricted Set you just created.

Create a Task Type that allows assigning roles with your restricted set values.

E b ] Note: You can do this part yourself if you have the User Can Create Task Type permission.
Itis possible to assign multiple users/groups to the same role in case you use the option
Allow Multiple Values for your specification.

In the Select available specifications screen of the Create New Task Type wizard:

a) Select Assign roles from task specifications.
b) Add the Specification you just created.
As a Project Manager, create a task from the task type your Administrator created.

Assign it to the person who needs to take the decision (who to assign the role to).

For example, assign it to the Marketing Manager to have him / her choose a design agency for this
project.

When you run the project, the assignee will get the task on his / her My Work page and will assign
the role with the appropriate user or group.

15.13. Task Reporting

WebCenter has a number of areas where you can see progress of tasks and sets of tasks.
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The most obvious one is the tasks overview within the project. Here you can rapidly see how the

project is doing and which tasks are in trouble.

You can also create reports that encompass multiple projects. The way to do this is through the task

searching combined with saved Global Searches.

A typical task search for a follow-up report

Search for Tasks

Fill in one or more fields. Prefer less fields? Try Keyword Search.

Use Advanced Search Characters

Search Panel Design

Task Name

Task Description

Task Type Name

Task Type Description

Task Status

Start Date

Due Date

Completed

Estimated Date

Modified

Created by

Assigned to

Assignee’s Location

Specifications

Task Documents

Enable SmartMames

Mot Completed

this month

2 7

View(List)

Search Results Options

Column

Order .

1 i

Clear this Form
Save this Search

Show Result Layout
Options

The search pictured here shows all tasks in projects | have access to that need some follow-up.

Completed tasks are excluded and also tasks in non-active projects are not interesting. Tasks with due

dates far in the future or along time ago are also excluded.

The result will show a set of tasks with their due dates. Those overdue will be shown in red and you can

rapidly click-through to these tasks and take action.

15.13.1. Step into Workflow

View a Sub Workflow from the Workflow Node

Workflow nodes are sometimes linked to a sub workflow. Viewing a sub workflow from the workflow
is simple. Right-click the node and the sub workflow opens up. With the browser backward or forward

buttons, navigate in and out of the sub workflow.
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15.14. Workflows

15.14.1. What is a Workflow

A Workflow associated with a task enables you to automate actions and events in WebCenter, reducing
the number of human interventions during the project. Use these workflows to execute complex
business processes in an automated way. You can create smart workflows by using SmartNames,
subworkflows, routing and integration steps.

You can use Workflows in:

» task creation and assignment

« approvals

« communication to and from Automation Engine
« project creation

« setting the project status

« content management: translation

It uses attributes to decide what happens next (for example, who needs to approve a document,
perform a task or manage a project). This reduces the number of templates required and also makes it
possible to run many tasks in parallel.
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Note:
~ Toenable the workflow feature you need the following license module (depending on the

License model):

» the WebCenter Task Management Advanced module in the Named User License model|

« the WebCenter Lifecycle Management module in the Concurrent User License model

15.14.2. Workflow Basics

Workflow is attached to a Task Type

The workflows are attached to the Task types. Task types are templates for tasks which can be added
into projects.

You can create:

« Manual Task types where human intervention is necessary. Read more in Task Types on page 296.

«  Workflow Task types where you attach a workflow to perform the automated action sequence.

Workflow Editor
WebCenter has HTML 5 based Editor for workflow.

Workflow Step / Node
A step ina workflow is a Task which is configured to:

« performanaction on aninput file to produce an output file.
« manage files such as selecting or copying a document using an Auto Task

- decide the flow (Router) of the workflow or decide about other administrative decisions in the
workflow such as wait for action check points.

The actual workflow operations take place in these steps which are sequentially connected to each
other via “tubes”.

2o
SetDocumeni

Aftribute -
Approvec

p L & = =

.- t © <\ Do %) —

Develop Arwor BIBE Review Tast chuter0 °
.

SetDocumeni
Attribute -
Rejectec

Completed

3
Start Approva
Cyele

« ATransitionis the line that connects each step in the workflow. It is a graphical representation of
communication of output file or data being sent as the input for the next step.
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« Bydefault, each node / step has an OK and an Error Output Pins. If the task ends in the OK state, the
output file will be sent to the following step. If it fails, the step connected with the Error output pin
will follow.

Note: You can have more output pins depending on the possible outcomes.

«  Workflow constructs can do administrative actions on the workflow, such as in the case of Router.

Documents in the Workflow
There are a few ways to attach input documents to a workflow.

« You can upload them to the project where the Workflow task is added to. In this case, these are
inputs for the Start node.
« You can use a Select Document node to pick up documents.

- You can have manual Tasks (conventional in the workflow. For example, when a designer creates
and uploads an artwork.

Workflow Tokens

Documents and operations processed by the workflow are represented by tokens @ traveling through
it. The number indicates the number of tokens. The position of a token indicates what is currently
happening (which node is being executed). A red token @ indicates an error.

Using a Router node, you can split a token (and its documents) into multiple tokens based on certain
parameters which will follow their own path through the workflow network. After certain workflow
tasks, you can use a Data collector to aggregate these into a single token again. Read more in: Data
Splitter and Data Collector on page 434.

« You canview the Token information while a workflow is in progress. The route that the Token has
taken is highlighted.

« Openin Viewer is enabled when you right click some of these tokens

«  You can Retry (in case of error) or Relaunch (in case the workflow is stopped or cancelled) a
workflow when you right click on a token.

Workflow Feedback in Project Details

You can view a workflow's feedback from Project > Tasks page. To open the workflow feedback page
either:

* hover over the task name and click the Workflow = icon.

Tip: You can use the Edit button to edit the Task Information.

or click the Show Active Nodesﬂi and Expand the mini Feedback view.

PCM Create Artwork Flow_1 (Curre. &
|_] 'n Progress Expand

B.
o

< 1of1 >
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SmartNames

Certain parameters of the workflow nodes are SmartName enabled. This is a variable that will be
resolved only when the node is executed. When the value is resolved (for example, an attribute value is

found), this will be used as the value during the execution of the node. Click the SmartName *[1button
inan input field to use this feature.

15.14.3. Building Workflows

Create a Workflow from a Task Type

Creating and Starting a Workflow
To create a Workflow, you need to:

1. Create a new Task Type or use an existing Task Type.

Note: Task types can only be created by Project Managers with the User Can Create Task
Type permission, or by Admins.

2. Inthat Task Type, open the workflow tab and create a Workflow by combining workflow nodes.

To start the workflow, make the task status active, such as in progress.

The Workflow Editor

To open the Workflow Editor, go to Task Types in the menu and:

Hover over the Task Type Workflow HI where you want to create a Workflow and click the Task

Typeicon. You can also create Workflows from the D Manual Tasks directly from the list.

« Orclick the required Task Type. Go to the Workflow tab to access the editor.

The workflow editor appears as below. By default, it contains a Start node and a Completed node. A
node or step represents an individual operation performed in the sequence of a workflow.
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General Info | Specifications | Checklist | Status | Documents | Document Creation | Document Rendering | Cescussions | Workflow
Workflow o
a a a |k + " &' = IS TR LA S Al a M
Zoom Undo/Redo Remoe workflow Wi Q

bt
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@. SAS_zzz - Copy Diglines
@. SAS_zzz - Create SKU Project

Select

Select Children (Document Refer:
Select Document
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v

Compleed

81 Document Aftribute

81 Froject Atnioute

21 Froject Status

Bl Wiorkflow Specificabon
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(MM etinatn M
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1 The workflow canvas in the edit mode. By default, this only contains a Start
node and a Completed node.
After the workflow has processed its files, you will see this canvas in the
feedback mode. In this mode, you can monitor your workflow or examine a
finished workflow.

2 The Workflow editor tool bar. Use it to:
+ Zoomin, Zoom out or Zoom to fit
- Maximize the canvas in your browser window (and minimize it again),
+ Delete the selected items

3 « Use the filter to select certain workflow node types (seeWorkflow Nodes on

page 355 ). Using this you can choose to display All or only:
» Auto Tasks

« Statuses
« Task Types

« Use the search field to search on node names. The search field accepts
wildcards.
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4 The Task pane shows all the Auto Tasks, Statuses and workflow constructs
that you can use in a workflow. Drag and drop them onto the canvas. You can
easily find tasks by using the filter and the search field.

Read more in: The Workflow Tools on page 351

The Workflow Tools

Table: Zoom Tools

Use this Tool or Shortcut...

To...

@ tool or CTRL + Plus(+) or F5

Zoom In on the Workflow Canvas

a CTRL + Minus(-) or F6

{ = Note: Scroll the mouse up or down to
Zoom in and out on the canvas.

Zoom Out on the Workflow Canvas

@ or CTRL + Zero (0) or F9

Fit the Workflow on the Canvas

Table: Navigation Tools

Use this Tool or Shortcut...

To...

N‘ Pointer

Select an areain the Canvas (including the Nodes
init)and copy, cut or move those Nodes and
Transitions marked by the selection.

@ Pan or Space

Pan the whole Canvas and to move all the Nodes
and Transitions within by using the click-drag-
release action.

Table: Other Tools

Use this Tool or Shortcut...

To...

" orCTRL+Z

Undo your actions on the Canvas

- or CTRL +Y or CTRL + Shift+Z

Redo your actions

il
B o Delete or Backspace

To remove a Node. Select the Node or Transition
and click Remove.

To remove a Transition, select the arrow-head
and drag it away.

{ = Note: You cannot delete the Start
=% Node.
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Use this Tool or Shortcut... To...
Context Menu Right-Click to access the The Context Menu
tools
[l Tip: Use CTRL +click or click and drag to select multiple steps.
Table: Workflow Tools and View Tool
Use this Tool or Shortcut... To...
- Save all changes made to the Workflow
= orcTRL+S 9
o Import Workflow from an XML file. The import will
overwrite the current workflow.
I"'_|+ Export Workflow tand save it as an XML file on your

computer. It can be used later to Import the workflow to
the same or another system

Click Clear Workflow to clear an existing workflow from a

fod
Clear Workflow Task Type. This will make it a Manual Task Type.

T The priority of a workflow can be set and is used in the
: queuing strategy of the workflow engine. Choose one of
T High the priority
A Norma
m L. « Low: to execute with lower priority than usual.
Workflow Priority

« Normal: the default priority

+ High: to execute with higher priority than usual.

L X, To View the Workflow in Full Screen or Minimize the
e wor canvas in your browser window.
[ l Tip: Use Esc to exit full screen.

Node Gallery

It contains all Task Types and Workflow Constructs required to build a workflow. Select using the below
filter options:

The Filters... and what they mean

All Nodes from all categories

Auto Tasks Tasks executed without human intervention

Statuses Task status for the current workflow task type

Task Types Manual, Auto Tasks and Workflow Task Types

Workflow Constructs Building blocks for the workflow used for Routing and Token
management. Read more in: Workflow Constructs on page 434
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Right-click anywhere on the Canvas or on a Node and access the context-sensitive menu.

Context Menu Actions on a Workflow Node/Canvas

& Femove Mode(s)
® Copy Nodes
3 Cut Modes

% Add Sticky Note
# Edit Parameters

o Configure Outputs
B Open Mode Help

See the details and keyboard shortcuts below:

To...

Select this from the Context Menu.. Or use these Shortcut Keys..

Remove Nodes

Copy Nodes

Cut Nodes

Paste Nodes

Add Sticky Notes on the
Canvas

Edit Parameters of a
Node

Configure Outputs of a
Node

Open Help on Canvas and
Tools

Open a specific Help page
about a Node

Remove Nodes(s) Delete Backspace

CTRL +C (Windows)or CMD +C
(Mac)

CTRL + X (Windows) or CMD + X
(Mac)

CTRL + V(Windows) CMD +V
(Mac). Paste Nodes can be done
only by shortcut keys.

Copy Nodes

Cut Nodes

Add Sticky Note Read more.

Select anode, right-click and select
Edit Parameters

Select anode, right-click and select
Configure Outputs

Click Open Editor Help to view
workflow editor help page.

Right-click on a Node and select
Node Help to get help on a specific
Node.

Click Open Node Help to view details
of working with each Node type.

To create a Sticky Note:

« Select Add Sticky Note from the Context Menu.
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« Click the body or the Edit Sticky Note icon in the top-left corner to edit the sticky note

Type your text and Save using the Save Sticky Note | To edit a Note, just click onit.

*  To Remove Sticky Note, use 1.
- Toresize the Sticky Note, drag the resize icon at the bottom-right of the Sticky Note
» Tomove the Note, click and drag to anywhere in the Canvas.

15.14.4. Create a Workflow

You can create a workflow from the Workflow Editor of any Task Type.

1. Click on the Task Types from the top menu items.
2. Toopenthe editor:

Hover over the Task Type Workflow h&" where you want to create a Workflow and click the Task
Type icon.
+ Orclick therequired Task Type. Go to the Workflow tab to access the editor.

You will get a blank canvas containing only the Start and Completed nodes.
3. Dragand drop your chosen nodes from the workflow nodes list onto the canvas.

You can add nodes to create a workflow. There are four types of nodes:

« Auto Tasks on page 360

« Manual Task Types

« Workflow Constructs on page 434
« Statuseson page 449

See Workflow Auto Tasks and Constructs on page 356 for more information about nodes.

[ ( ] Tip:
- Tofind a node quickly, you can either use the filter or the search field on top of the
workflow nodes list.

- Todelete anode, right-click and select Delete.

4. |f desired, click your node names to rename them.

5. Connect your nodes with one another.

To do this, click a node’s green pin and drag it onto the next node. This links the two nodes with a
green transition or tube.
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'ta ;

Select Document Add to Bill of
Materials

Note:

« You can connect a node’s output to several other nodes.
. Toremove a connecting tube, dragits arrow head to a blank area on the canvas.

A Warning:

It is not possible to self-reference a node. Self-referencing happens when the error pinis
connected again to the input pin of the same node. This will result in an error when you start
the workflow.

General Info  Specifications  Checklist  Status Documents Document Creation ~ Document Rendering Discussions =~ Workflow

Q@ a a k I 5 & =& = G- e
Zoom Mavigation Undo/Redo  Remaove Workflow View

WorkflowEditor Tiools Eilter

Artwork Approval

Drupa Approve in Viewer

Drupa Draft and Approve in
: o) ® Viewer
S O ) (9]
i (]
Ml Transition; *Ee Me o
stat  tube Create Project Select Document Startr\ppéovlal g
- 0 yele
connecting;
two,Nodes

JORE-Assign Approvers
LABO Approval Task

PCM Approve Master
PCM Draft and Approve
Master

PCM Draft and Approve
Master form

POL - Customer Review and
Approve Quote

©lelele] Jlelelele b

6. Double-click each node and fill in its parameters in the Edit Parameters pop-up.
7. Whenyou are done, click the Save button to save your workflow.

15.14.5. Workflow Nodes
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Workflow Auto Tasks and Constructs
Nodes Description
Add to Bill of Materials Adds the incoming document(s) to the current project's Bill
of materials.
Assign Document Attribute Category Allows you to assign an Attribute Category to your
documents in a workflow step.
Add or Replace Approvers Allows you to add or replace existing approvesin an
approval stage
Completed The workflow completes when all operations for a workflow
have finished.
Copy/Move Document Copies and moves the incoming document(s) to the given
project/folder and optionally renames it.
Create Project Creates or updates projects from your workflow. It can also

iterate the project creation to create multiple projects at
once. For example, using a multivalued attribute.

Note: This node is only available if you have the
WebCenter Advanced license.

Copy Document Attributes Values Copies all non-empty document attribute values including
document references from a source document to one or
many target documents.

Create Graphics Placeholders

Create Color Cert Job Outputs a CCJ file and a mediastrip

Color Preflight

Delete Document Deletes the document when it is no longer required in
WebCenter

Delete View Files Deletes the view files of specified document

Delete Older Versions Deletes older or unused versions of the document

Execute JavasScript

Export Chili to PDF on page 378

Export to GS1Format on page 377 Exports your text content along with its Element Type
tagging.

Export to XLIFF Format Exports your Text statements to be translated into a XLIFF
file.

Finish Approval Cycle
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Description

Get Dependent Colors

Syncs the dependent standards belonging to the master
colors based on the conditions and shows these colors in
the input document attributes in WebCenter.

Import XLIFF Content

Imports your translated Text statements in XLIFF format.

Import Dynamic Content

Extracts the Dynamic Content from your artwork(s) as Text
Content Documents. You can configure this node to import
these Text Documents with a link to specific document
reference attributes and document templates.

Import Dynamic Table on page 388

Extracts the Tables from your artwork(s) as Table Content
Documents. You can configure this node to import these
Documents with a link to specific document reference
attributes and table document templates.

Import Dynamic Graphic on page 382

Extracts images or symbols from an incoming artwork
document and are added to the artwork file as document
references.

Import Dynamic Barcode on page 383

Extracts Dynamic Barcodes from an incoming artwork
document. For each Dynamic Barcode, a new document
is created and these Barcode documents are added as
Document References in the Artwork.

Invite Members to Project

Invite a User / Group / Role to a Project in the workflow by
the users who can create Task Types.

Merge Text Content

Merge incoming text content documents with matching text
content documents into the library project configured

Run Report

Generate a report for the incoming document(s)/ Current
project/other reports

Reuse Text Content

Reuse the text content documents that are referenced in
the incoming artwork document by matching and replacing
them with the library documents or updating the text
content document with SmartText that refers to library
documents.

Remove Member

Remove User(s)/ Group(s)/ Role(s) from a project, who have
no approvals or task assigned to them

Replace Member

Add and delete members in the project in Work flow
execution

Restore from Esko Cloud

Restores the document from Esko cloud to Webcenter
location

Select Document

Selects a document based on the folder, project name and
name of the document.

Select Children (Document Reference)

Selects the document references associated with an
incoming document.

357



ESKO

358

WebCenter

Nodes

Description

Select Parent (Document Reference)

Selects the master documents of the incoming document
references.

Send Notification

You can send automatic notifications to Project Manager,
Sales Person, Workflow Master, Groups, Users, Roles. Here
Workflow Master is the assignee of the workflow task.

See Send Notification for more information.

Set Document Attribute

Sets the value of one or more document attribute(s)
automatically.

Set Project Attribute Sets the value of one or more project attribute(s)
automatically.
Set Project Status Automatically changes the status of the current project.

Set Workflow Specification

Automatically sets the value of one or more specification(s)
for the current workflow.

Set Workflow Status Automatically sets the status of the current workflow to a
new status.
Start Approval Cycle Starts an approval cycle on a document and waits for its

approval status.

Start Approval Stage on page 406

This node starts an approval stage in a workflow and build a
staged approval.

Finish Approval Cycle on page 408

This node finishes the approval cycle of the incoming
documents and send e-mail notifications.

Submit Workflow

Launches an Automation Engine workflow that is
configured in WebCenter.

Sync Workflow

Synchronizes the project with the configured workflow
taken from the project/template setup.

Table Content Preview Report

Generate report of the preview of Table Content

Update Text Document

Specify or Update Text Document properties

Update Table Content

Specify or Update Table Document properties

Upload to Asset Management System

Uploads the document to Esko cloud location or the Asset
management location specified

Wait for view files

Wait for view files in the work flow when it is not available

Wait

Workflow waits/pauses for a specified amount of time
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Description

Data Splitter and Data Collector

If you have two or more documents with two different tasks
assigned to each of them, then use the Data Splitter node.
This node will put each document separately on this tube
after which these follow their own path.

Once the tasks are completed the Data Collector will wait
until both tasks are completed and then proceed to next
node.

See Workflow Example on page 449 for more information.

Error Handler

Use this to collect failed tokens when other nodes go
into failure (make sure the other nodes' error dots are not
connected to anything).

Fork and Join on page 436

The Fork step automatically tags

« every file running through it
« andallthe files that those files are related to in the next
steps

The Join step then groups all the files with the same tag and
outputs it together.

Mark and Select The Mark node marks the documents arriving to the node
with a named tag. For example, main design, original data or
admin data.

Later, the Select node can pick up the same documents
based on this named tag and then route it through the
outgoing tube.

Router Use the Router to build a rule list to meet a result, these
rules are evaluated from top to down. The rules can be
based on:

« Project Properties

« Project Status

« Project Attribute

« Document Name

«  Document Attribute

«  Workflow Specification

See Workflow Example on page 449 for more information.
Stop Use the Stop node to stop the workflow before being

completed. When a workflow token arrives at this step, it
stops the workflow.
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Auto Tasks

An Auto Task is a step in the node which does not demand human intervention. Auto tasks are
automatically executed using predefined parameters (the attribute values or SmartNames).

Add or Replace Approvers

You can now add or replace approver(s) like users or groups or roles to a specified approval stage while
itisin progress using the Add or Replace Approves node.
Add or Replace Approvers

Stage Name []

Replace existing Approvers in the Stage

(®) Approver Type
No Approvers selected yet Add Approvers from the drop-down list

8 -

Fillin the following in the node to add or replace :

Stage Name: Select the Approval Stage where the approvers are to be added. The stage can either be
ongoing or yet to start or stopped.

Replace approvers option: This option allows the approvers in the stage to be replaced by the
approvers specified in the workflow node.

Approver : Choose the type of approvers from the drop down like Users, Groups or Roles.

Note: Ensure that the approvers added have view rights on the document.

When there are no approvers selected by the workflow and the option to replace is selected, then all
approvers are removed from the stage and an error is generated in the workflow.

When the approvers are replaced while they have already submitted their approval, their approval
status is not taken into account when calculating the final approval status. This is similar when the
approval is stopped, approvers are removed and the cycle is started again.

Note: After adding or replacing the approval users, the todo list and document history is
=% updated. Search is also updated with the new information.
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An email notification to the newly added approvers is sent out if the notification event Approval Cycle/
Stage started is selected.

Add to Bill of Materials
Use this node to add documents to the current Project's Bill of Materials automatically.

Parameters

Count: Set the documents' Count in the Bill of Materials.

l" ] Tip: You can use a SmartName (for example a document or project attribute) to set the count.

Apply InDesign Content

You can use this node to update the InDesign template with referenced contents (text statements,
structured contents, images). It creates a new version of the InDesign template with updated reference
content. There are three types of automation scripts that can be applied to the template:

+ Pre-Import Script: This script runs before the content (Text, Tables, Images, etc.)is imported.
« CONTENT_TRANSFORM: Thisis an XSL transformation that can be used to define formatting
exceptions on your content.

« Post-Import Script: This script runs after the content (Text, Tables, Images, etc.)is imported.

When the execution is successful, it will reset the references of the “LINKED_ASSETS" attribute of the
template with all the linked images.

An option to set language parameters is available in the node. You can specify the locale index and
choose any one of the available masters and the translation language. You can also select the Include
Empty Elements checkbox and it is used to include the text/table elements based on content empty
or not. To scale up the InDesign server as per business requirements, it is possible to provide multiple
InDesign server instances in the appconfig.xml as in the example below.

<indesign_servers_url=
<indesign_server_url value="http://HOST:PORT"/>
<indesign_server_url value="http://HOST:PORT"/>

</indesign_servers_url=
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Apply Content in InDesign

Include Empty Elements

Locale Index Language
1 --- Select Language --- - []
2 --- Select Language --- ~ [1]

Copy/Move Document

Use this node to copy or move one or more document(s) to a new location.

Parameters

Double click a Copy/Move Document node to set up these parameters in its dialog box.

« Copy: select thisif you want to copy a document to a new location, while keeping it in the original
location. You can choose to:

362

Link the new document to the original document,
Create a New version if the document already exists in the new location.
New revision if Document already exists: enable this to raise the revision while copying or

updating. This will raise the revision letter (and create a new version) if the document already
exists.

{ ' Note:
]
The option is visible only if your Admin > Preferences > General > Allow increment
Document Revision when uploading a new Document Version is on.

Copy Viewer Annotations: use this option to copy annotations of a document to a new one.

Update Document References to remove a current document and add a new document to the
document reference. A new version/revision of a document is now created in the target project
and added in the document reference attribute.

Copy Local Referenced Structured Content Documents: to copy the document and its
structure. This means that documents that are referenced via the SC_LREFERENCE document
reference attribute are copied along to the target project.

{ | Note: Only documents that sit in the source project of the file that is originally copied

' (i.e. are’local to the source project) are copied. Document references within the original
structure are recreated in the copied structure. Document references that point from
the original structure to outside of the original structure, will still be pointing to the
same places in the copied structure. Document references that are external to the
original structure and pointing to the original structure will not point to copied structure.
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+ Keep Text Content Element Status to retain each Text Content element approval status when
the document is copied as new version. (by default each element approval status is moved to
draft state).

@ Note: You can retain the language content approval status only when the Packaging
&= Content Management Licence is enabled.

@ Note: You can choose to either copy the comments or can be cleared based on the
&= option chosen by the Admin user in the preference settings for Packaging Content
Management. You can read more on the option at Copy comments from a text document

« Move: select this if you want to move a document to a new location (removing it from the original
location).

Project Name: Enter the name of the Project into which you want to copy/move the document.
Folder: Enter the name of the Project's folder into which you want to copy/move the document.

Name: Enter the name to give the document in the new location if desired.

Tip: You can use SmartNames for the Project Name, Folder and Name parameters.

These Copy/Move action have below results:

»  When Moving, all document versions move along, including all the related features like approval,
history, attributes...

«  When Copying, only the latest version is copied along with its view data, attribute... and the
Approvals reset.

« Foreachdocument, aline is added to the Project History stating that the document is deleted/
moved from the source project and added to the target project.

Note: The node fails if the target project/folder does not exist.

Copy Document Attribute Values

You can use Copy Document Attribute Values node to copy all non-empty document attribute values
including document references from a source document to one or many target documents.

g | | Q= B
/ ﬂJ o --hh‘-'-"a%__?_
ﬁ =< Seled Document i _
™ e N O—— . | —————— )
Start > :_ o " ﬁ I::_J— g e e v
L *; -] - Drata Calector Copy Documant Completed
Sele:t Docurment Mark Aftributes
3 .

Set up the Parameters as below:

« General
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In the Source Document tag drop down, choose the source document. This tag is to identify the
source document from where document attribute values need to be copied from.

Select Only select tagged source Document from the incoming Documents field to look up the
source document from the incoming documents instead of selecting all documents with the given
source document tag in the workflow. This allows bulk tagging of documents earlier in the workflow,
but when a set of documents reaches this node, the only Source Document that is selected from
the list of tagged documents is the one that is part of the documents of the incoming token.

« Document Reference

You can use this tab to copy all the document references and other attribute values to the matching
attributes. When the same reference attributes are not available in the target document, then
document references are copied in the reference attribute chosen in Copy all unmatched
Document Reference to.

From 18.0.1 WebCenter, select Only copy if Reference Properties match target Document
Attributes option to decide whether the document references are to be filtered based on reference
properties or not.

When document references are copied from a source document, existing document references in the
target documents are removed. Basic attribute’s values are copied when matching attribute is found.

Create Packshots

From the Workflow Configuration Tab of a Task Type a user can add a Create Packshots node. This
node allows the creation of Packshots in the Esko Cloud Environment. The node requires a a Packshot
Job Document as input.

A user can configure the following fields in the node:

« The Asset Management Connection that should be used. Only Asset Management Connections of
type Esko Cloud Packshot will be available for selection. For the configuration, please check this

page

« AFolderinwhich the resulting packshots should be stored. If no Folder is specified, the Project’s
root folder will be used.

When the node is activated, a Packshot Job will be started. If the Job is executed successfully, the
Packshots will be stored in the location specified in the workflow node. If a Document with the same
name as the Packshot output already exists, it will be saved as a new version. The node will then go
down the success path and the Job will be deleted from the Cloud. The success pin will contain the IDs
of the Packshot Documents which were created. If the Job fails, it will go to the error pin with more
information on what went wrong.

Note: If the Packshot module is not enabled in WebCenter, then this Node type is not be
available in the workflow Editor.

Create Project

Creates or updates projects from your workflow. It can also iterate the project creation to create
multiple projects at once. For example, using a multivalued attribute.

Note: This node is only available if you have the WebCenter Advanced license.

Using this node, you can:

« create or update projects either in the current WebCenter or another WebCenter.
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« create Child Projects in a Program.

« copy the existing project documents to the new project.
« iterate over an attribute to create multiple projects.

» specify project attributes.

o P (o] O [T © > (T3 © =
L] o = e

Start Select BOM Data Splitter Create Project Completed
Flaceholders

Project Tab
Parameters for creating the project (all smart name enabled):

« Project Name is the name of the new project. If not specified, auto-naming is checked in the
template or in theadmin > general > preferences settings.

= Note:

If the field is left empty without auto-naming in the Project Template, you will receive an
error message :

One or more mandatory parameters were not specified

- Update Project if it already exists, otherwise create a new Project: Check this option to update a
project with the specified name if it already exists.

If it is not checked, a new project will be created. If a project with the specified name already exists,
it will result in an error. For copying documents, there is an option to be copied as new versions.
Project Name Suffix is required when you are using auto-naming with a Suffix field as Edit.

« Add as Child Project of the Current Project: Check this box to create Child Projects in a Program.
Use this to create Projects as part of a Program. This option is turned off by default.

« Template: The project template on which the new project should be based on. If left empty, a blank
project will be created.

« Project Description: The description of the new project.

« Project Status: The initial status of the new project. This list follows the order of the project
statuses as defined in WebCenter and by default, the Active status is selected automatically. You
can also select Blank as an option.

When a new project is created, the first active status is assigned whereas while updating existing
project, the project status is left unchanged. You can configure SmartNames to indicate this initial
status to make it context relevant.

» Customer/Company: The legal name of the company/customer. By default, it will be the customer/
company of the current project.

« Location: The customer/company location. By default, it will be the location of the current project.

« Project Due Date: The due date of the new project. By default, it will be the due date of the current
project.
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« Project Manager: The project manager of the new project. By default, the node takes the current
project manager.

+ Use SmartNames to choose a Group, Role, User as the Project Manager of the new Project
and an attribute (document / project / task) to automate the setup of the node. You may also
manually specify these parameters.

«  When a SmartName for Project Manager is not resolved (for example, you choose an attribute
(with Group or User as value) and it cannot be resolved because you forgot to add the
attribute to the project's attribute category), an error

Project manager not found.
is shown.

« Ifyou choose arole to assign the Project Manager, the current project is checked for the
assignment of that role. A unique User or Group should be assigned to that role. If more than
one group / user is assigned to then, you will receive a warning.

« Ifyou assign a Group, at least one of the group members should be a Project Manager.
« If youassign a User, the user should be a Project Manager.

« Ifyou choose an attribute to assign the Project Manager, the attribute should resolve to the
user name of a user or the name of a group.

Documents Tab

In this tab, you can set options to copy the incoming documents to the project or projects being
created.
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Create Project W
Project Documents terate Project Attributes WebCenter
Copy/Move/No Copy or Move
Copy incoming Documents
® Move incoming Documents
Target Folder Products []

Mame

Do not copy or move incoming Documents

« Copy Documents (default): lets you copy the documents to the new project.
» Folder Name: specify the target folder in this field. If you leave it empty, it will take the root
folder as the target folder.

« Copy incoming documents as Link: enable this to copy the documents as links in the new
project.

. Note: If you are creating projects in a remote WebCenter, you cannot copy the
=% documents as links.

- Copy incoming documents as new version if they already exist: check this to copy the
documents as new versions.

- Raise revision if Document already exists: enable this to raise the revision while copying or
updating. This will raise the revision letter (and create a new version) if the document already
exists.

Note:

The option is visible only if your Admin > Preferences > General > Allow increment
Document Revision when uploading a new Document Version is on.

- Copy Viewer Annotations: use this option to copy viewer annotations of documents while
copying.
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Note: This will not work if you are copying to a remote WebCenter.

«  Move Documents: choose this to move the documents to the newly created Project. You can
specify a folder for this document.

Note: It does not work for remote WebCenter projects.

« Do Not Copy Documents: choose this option if you do not want to copy the documents to the new
project.
Iterate Tab

You can create multiple projects at once using the options in this tab. The default option is Do not
Iterate.

To create multiple projects over an attribute, choose Iterate over Attribute.

Iteration/Mo Iteration

Attribute: |[Flavor (Project]] [1

Do Not Iterate

You can select this attribute via a SmartName or by manually typing in the attribute. Based on the
resolved value of this attribute, this node will create multiple projects. For example,

« If the SmartNames resolves to a multi-value (text) attribute indicating languages, the created
projects will be language variants. You will get the same result when you type in the attribute values.

For example, if youtypein Dutch | French | English, theiterator value will be “Dutch”,
“French”and "English". As a result of running the task in a Project, you can expect three new
Projects corresponding to each language.

Note: While iterating project creation, you can send only the related attributes to the
created projects by specifyingthem iterator value as the attribute in the Project
Attributes tab.

«  When multiple documents with a multi-value document attribute (for example, Dutch | Spanish
| English asthe Iterator)arrive at this step:

« Incasethere are two values for the attribute (e.g. Dutch and English), this document will be
attached to both the Dutch and English projects.
+ If the documents' attribute value is left empty, they will not be added to any of the projects
created.
« The documents without the specified attribute will be attached to all the created projects.
- If the SmartName resolves to an integer or if you type an integer (for example, you type 3), the
projects will be created based on these numbers.

For example, if the value resolves to 3, the iterator value will be 1, 2 and 3. You will get three new
projects when the task is finished.
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Note:

If the attribute is missing in the Project, you will get an error.

Attribute not found

Important:

« Do not aim to create more than a hundred projects using the Create Project Node . You will
be warned if you do so.

Maximum number of projects that can be created at once exceeded.

Tip: You can use the Iterator Value SmartName from the Iteration category in the other node
parameters such as the Project Name or description.

Project Attributes Tab
For setting project attributes of the new projects, click on the +. Add the

- project attribute and the corresponding value. Enter this value via a SmartName or by manually
typingin.

Note: The attribute values are set regardless the Attribute Category of the new project.

Note: If the SmartNames are not resolved, it will not fail project creation. However, the
attribute value will not be set in the new project.

« You may also assign roles via attributes.

WebCenter Tab
In this tab, define the WebCenter on which you want the new project :

« Current WebCenter(default): Use this to create the new projects on the WebCenter where the
workflow is running.

» Other WebCenter: Use this to create the new projects on a remote WebCenter. For this to work,
the parameters specified in the node (for example, the Project Manager) should be present on the
remote WebCenter.

+  WebCenter URL: The URL of the remote WebCenter.
«  WebCenter User Name: The user name used to log in to the remote WebCenter

«  WebCenter Password: The password used to log in to the remote WebCenter for the specified
user name.

Note: If a user exports a task type containing a node with this option, this field will be
blank in the generated XML.

Note: You may copy the documents remotely, but you cannot add them as links.

For every project created, you will find a log in the Project History.
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Create Graphics Placeholders

You can use this node to create graphics placeholders to represent print area information available in

the Collada document, referenced in the input document attribute called CAD_REFERENCE. Any user

with Task Type creating rights can use this node to create graphics placeholders. Placeholders can be
replaced with actual printable parts later.

These graphics placeholders are created to represent print areas available in the Collada document.
Name of these graphic placeholders will be created with print area id and the side of the print area, like
for example "printareal_front”.

Based on the node configuration, each print area is extracted once for the printable side front or twice
for the printable side front and back.

{ = ] Note: When the input document is a component document, then the Thumbnail is updated.

o e (| (e— - =) B o —
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Start Select Document Create Graphics Completed
Placeholders

Parameters

- Template Project: This is a smart name input field to get project name(s) where document
template is available.

« Document Template: This is to get document name available in the mentioned Template project.
This document is copied for creating placeholders documents for each print area available in
Collada document. Template document is having hard coded document type of an attribute
called CAD_REFERENCE. This attribute will reference Collada document from where print area
information is extracted. Two hard coded reference properties namely CAD_PRINTABLE_PART and
CAD_PRINTABLE_PART_SIDE are expected to be in the CAD_REFERENCE attribute to hold the print
area id and value of front/back.

« Target Folder: Name of the folder where new graphic placeholder documents are created.

« Target Reference Attribute: Select any one document reference attribute from the drop down to
attach graphic placeholder documents as reference in the incoming document. Selected document
reference attribute is expected to have one reference property called CAD_PRINTABLE_PART, to
hold the name of the print area.

- Extract printable part for front and back: An option is provided to decide whether printable parts
are expected for printable side front and back both or only for printable side front. Placeholder
for back side is only created if the print area information contains printable part for back and this
optionis enabled.

Create ColorCert Job

ColorCert is a software application which helps you to get accurate, consistent precise colors and print
the specifications from pre-press to production process control.

In this workflow node, information that is available in WebCenter as e.qg.
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« Projects, Colors selected from alibrary and assets within WebCenter

» Scorecard rules and profiles (ColorCert profiles, ICC profiles, CGATS profiles) that are stored as
regular documents in WebCenter

Note: The documents are tagged with the Mark node in the work flow and then referred to
by the mark name. For Example, specify the ColorCert rule document, mark it and select the
tagin the ColorCert Rule parameter

are all called to create a CCJ (Color Cert Job) and a media Strip (PDF file). Along with these, a CCJZ file
for debugging purposes is also uploaded back to the current project.

The workflow requires the following parameters in the respective tabs:

1. Job Details: Job Name, Job number, customer, business unit, brand, variety, UPC and Product
Order Number.

2. Output: Artwork Target, Orientation values like surface or reverse, Screen Count, Screen Type like
Ipi or LCM, Lot Size, Supply As either Roll or Pallet, or Sample, Printer and Separator.

Note: All the parameters are SmartNames and maps to parameters with the same name in
the ColoCert job or the Job Details and Output tabs.

3. ColorCert Assets: ColorCert Rule which uses the tag for marking the ColorCert Rule document and
Substrate file for the ColorCert job.

4. Color : Specify the following with the tag used for identifying them
» Profile: Either ColorCert profile, ICC profile, CGATS profile.

+ Enable Autoload: If checked, substrate, primary or builds/overprints are automatically
loaded from the profile. In that case it is also possible to explicitly specify colors that should
be removed. This should be a pipe-separated list of the color names.

«  The Remove Colors field is SmartName enabled.

« Primary Colors: Colors that are specifically tagged are picked in this parameter.

« Enable Custom Curves: If checked, you can specify the Dot Gain Method and the following
nominal and target dot gain values: Minimum Dot, Highlight, MidTone and Shadow. Those
values will be applied to all primary colors that are not loaded from the profile. If the nominal
value is not specified, the value will be defaulted from the rule.

+ Valid values for the dot gain method are: Default, Relative Colorimetric, Murray Davies,
ColorCert Relative Colorimetric and SCTV.

« Minimum Dot nominal value should be higher than 0 but lower than or equal to 10.

« Highlight nominal value should be higher than 10 but lower than or equal to 34.

« MidTone nominal value should be higher than 34 but lower than or equal to 65.

+ Shadow nominal value should be higher than 65 but lower than or equal to 99.

Example: A Shadow Value of 1.3 and a Shadow Nominal of 75 would give a dot area target of
76.3.

+ Spot Colors: Colors that are specifically tagged are picked in this parameter.

Note: Either a profile or colors need to be selected for a ColorCert job to be created.

5. Mediastrip: SmartName enabled fields including

» Patch Width: for the width of the mediastrip
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» Patch Height: for the height of the mediastrip

« Strip Type: Type of the strip, either can be ScanSingleRow, ScanTwoRow, ScaninkByInk
6. Configuration

« Cloud Connection Dropdown where we show the available Cloud Color connections

+ Folder The folder in the WebCenter project where the document is uploaded to. When the folder
does not exist, it is created. When the document already exists in the folder, the workflow will
create a new version of this document. If the document exists already and the folder specified is
different than the folder of the existing document, the workflow generates an error.

- Document Name (CCJ, PDF) This is the name of the resulting CCJ and PDF file. When the
document name is not unique in the project, WebCenter will take the document with the given
name and will create a new version of the document. In this case, the folder name is ignored.

The resulting CCJ file contains the colors specified by the primary and spot color tag. Color that are
in the profile, but not in the list of primary or spot colors are not included in the CCJ file.

If a color that is not connected to the Cloud (ESKO COLORS or PantoneLIVE)is used as input, the color
details (spectral data) must be available in the associated ICC profile. If not, the resulting documents
are directed to the warning output pin.

Color Preflight

The Color preflight workflow node validates the colors referenced in the actual document against the
specifications provided and generates the preflight results in the workflow.

Preflight Results are stored as attribute value(s) of the document(s) which may include preflight
status, preflight report or both. Preflight results could indicate whether all the expected colors are
found or not and if any unexpected colors are found.

In this node, following information has to be provided in four tabs.

Color Preflight

Specificatior Document Colors gnore Preflight Result
Color Specification []
Palette []
Specification
Palette Color Please select or start typing... -

1. Color Specification
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- Color Specification: Specify the attribute(s) that has specification details for the color.

- Palette specification: Select the Attribute / task specification that holds the direct color
specifications in the palette(s).

Note: Either the Color Specification(s) or the Palette Specification(s) is required for
preflight.

« Palette Color Specify the attribute that has the color(s) information in the incoming
document(s).

For each incoming document, the workflow fetches the referenced color information, and
compares it against the specification(s) provided.

Note: Colors having the attributes with matching condition specified in the Ignore tab
will be ignored from the actual color list.

Document Colors: Select the Document Reference attribute, that holds the colors list in the
incoming document.

Ignore: Specify the values for attributes that you may want to ignore from the actual colors from
the incoming document(s).

You can add multiple conditions in this tab, and even if any one condition specified in this tab is
true, the colorisignored from the preflight check. To ignore, select the attribute for which you want
to validate either by Matches condition or Contains condition for a given Value.

Preflight Result: Select Preflight Status Attribute or Preflight Result Attribute or both in the
respective drop-downs.

Preflight Status Attribute: Ensure the selected attribute is available in the attribute category of
the incoming document to set the Preflight Status. Resultant values possible for this attribute are:

« Additional Colors when the incoming document has some additional colors than specified.

« Missing Colors when the incoming document has some missing colors from the specified
colors.

- Both Additional and Missing Colors when the incoming document has both additional and
missing colors.
« Matched Colors when the incoming document has exactly same colors as the specifications.

Preflight Result Attribute: Ensure the selected attributes is available in the attribute category of
the incoming document to set the preflight result provided in the rich text editor field.

Preflight Result Field is to provide data to be set in thePreflight Result Attribute selected.
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{ = Note: There are four new SmartName introduced, that can be used to fill in the details for
the preflight result:

- Additional Colors: To resolve to the names of colors that are available in the incoming
document but not in the specifications.

- Ignored Colors: To resolves to the names of colors that are ignored from the document
colors for preflight check.

« Matched Colors: To resolve to the names of colors that are available in both incoming
document and specifications.

« Missing Colors: To resolve to the names of colors that are available in the specifications
but not in the incoming document.

Delete Document

This node allows you to remove documents from WebCenter whenever it is no longer required in all the
projects it is present( in case of linked documents).

There is an option to Force Delete Documents used in Document References. When this option is
selected,the node deletes the documents that are used as a document reference in a Project or a
Document or in a Task and the document is then removed from the document reference(s) attribute
value too.

Delete Document

Force Delete Documents used in Document References

i = Note: Documents cannot be deleted, when it is locked or pending for approval actions or is
part of an inactive projects.

After deletion, the Document is no longer available in WebCenter. Historic information about the
document can be found in the Project History.

Delete View Files

This workflow node allows you to delete the view files of the incoming documents. Using this node, you
can clear out the view files for all versions of the Documents.

{ = ] Note: View Files of Page List documents are not deleted.
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Delete Older Versions
This node enables you to delete old/unused versions of a Document from WebCenter.

In this node, the older versions of the input Documents are removed, and the remaining Versions have
their version numbers reordered.

Delete Older Versions

Delete Old Revisions

When enabling the Delete Old Revisions option, only the latest revision is kept. If the option is turned
off, the latest version of each revision will be kept.

The document version is only removed when

Itis not linked in any project where it is the most recent document
It is not used as a value for any document reference attribute

Itis not used in any cart or task

It is not the last version of a revision

It does not contain final approval information.

oor N

Note: Document versions will not be deleted when the security settings of WebCenter do not permit
users to remove Documents with Approval actions.

Execute JavaScript

Use Execute JavaScript step to write and execute JavaScript code in a workflow. To access the
JavaScript editor, double-click the node.

You can use the WebCenter JavaScript APl by using the API object. For example, APl.getProject()
returns a project object representing the current Project.

Use CTRL+Space to enable auto-completion in the node. You will get pop-up with all possible options
related to the typed syntax.

If you type APT and enter CTRL+Space, a popup will list all possible methods of API(in this case
‘getProject’).

If youtype API.getProject (). andenter CTRL+Space, you will see a list of all possible
functions of a project.
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B Note:

« Theauto completion does not list options if you nest multiple functions:
for example, if you type in API.getProject () .getChildProjects ()
[0] .setName (API.getProject () .) ; and enter CTRL+Space you will not get a list of
options.

» By default, a script can be of maximum 100.000 characters.

The screenshot displays a case where the workflow calculates if a Parent Project (Program)is
at Risk. In this case, it updates the Parent Project's status to "At Risk" if more than 50 percent
of the Child Projects are at risk.

Execute JavaScript X
1 wvar project = API.getProject();

2
3 wvar children = project.getChildProjects();
a
5

var count = @;
6~ for(var 1 = @; i < children.length; i++) {

7 var child = children[i];
A8 var status = child.getStatusiame();
9~ if (status == "At Risk™) {
10 count++;
11 }
a7 |]
13

14  var percentage = (count/children.length)*160.0;
15 = if (percentage > 58) i

16 project.setStatusByName( At Risk");

a7 |

_ine 17, Column 2 — 17 Lines, 373/100.000 Characters

This workflow step executes JavaScript in a sandboxed environment which allows you to execute the
java classes of WebCenter APl exclusively.

(f ’ Note: There is alimit of the stack depth (by default, 10,000) to avoid infinite recursions and
there is also an instruction count limit (by default, 1,000,000) to avoid infinite loops. The
maximum script size is also enforced during execution.

Any JavaScript error puts the token on the error pin with an appropriate error message.

Detailed list of Java Script API's that can be used with this work flow node are available in WebCenter
JavaScript APl document.

Allow calling external APl from JavaScript

It is possible to call external API Connections(reference to external api connections
documentation) from a JavaScript node. Use the methods API.doExternalAPICall(...) and
API|.doExternal APICallWithBody(...) to make calls to external systems.
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Export to XLIFF Format

Use this node to export your Text statements to be translated in a translation software that uses XLIFF
content (e.g. Trados or SDL). After translating, you can import them back.

Parameters

« XLIFF File Name: Specify the name for your target document.

« Target Folder: Specify the folder where the exported XLIFF file should be placed.

Note: By default, the document is exported to the root folder of the current project. If an
XLIFF file (of the specific name) already exists, then exported document will be uploaded
to the same folder as a new version. If there are no content to be added for export to XLIFF,
then instead of generating an empty file, output is sent to No Files pin.

« Source Language: Specify the master language of the text content.

« Target Language

Note: You can use SmartNames to set these parameters.

« Export statements only if Master Language is signed off: Check this to specify that the exported
XLIFF should only contain statements if their master is approved.

- Export statements only if target language is already added to document: Option to not add
statements without the target language. This is unchecked by default.

- Export Statements only if Target language is not signed off

This step creates an XLIFF file from the incoming text document (.wcc)and uploads it to the current
Project.

Notes

« Ifthe source textisinrich text format, then the exported XLIFF file will have rich text identifiers.

« If agraphicsfile arrives at the node, it will search for Text Document References. If there are
referenced text documents, an XLIFF file is generated.

« Comments added in the text content document will be exported to XLIFF file.

Export to GS1Format

You can export all of the text content, table content, symbols, images, Barcode attached to an artwork
to XML in GS1format in a workflow.

For example, when a designer creates an artwork in Adobe Illustrator with placeholders for dynamic
content, they are tagged with appropriate GS1Element Types(Content Types). Artwork is then
imported into WebCenter and Dynamic Content is then processed and approved in WebCenter. You
can then use this node to generate the GS1 XML file with the updated information. This node will add
the output file to the current Project. You can send this GST XML file back to the designer to place the
content on the artwork.

Update and configure the following information in the work flow node to export to GS1format:

« GS1File name: Specify the name for your exported document. It is possible to use SmartNames to
generate file names. If the file name is not specified, file name will be generated automatically.
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« Folder: In this field, specify the folder where the exported GS1 file should be placed.

« Choose Include Empty Content in GS1to view all the elements in the table document else only
elements with content are exported.

Note:

Default folder location is the root folder of the current project. If a GS1document (of the
specific name) already exists, then exported document will be uploaded to the same folder
as anew version.

The node will create a GS1 XML document for the specified languages with Language index mapping.
You can add a row for each locale mapping to include the languages in the artwork.

« Locale Index: Specify the sequence number referencing the locale index to the language. Locale
Index represents the GS11ocaleSequence tag.

« Language: Select the language corresponding to the Locale Index from the drop-down. The drop-
down will list all the master and translation languages listed in the system.

Export Chili to PDF

You can use this workflow node to export Chili documents to PDF format. By default, the exported PDF
files are routed to the current project and the root folder with the incoming Chili file name. You can also
specify the target location of the exported PDF document including the Target Project, Target Folder
and the Document Name.

Specifications
« Target Project: Specify the location where the exported PDF documents are to be placed
- Target Folder: Specify the folder in the Target Project where exported document are to be placed.

« Document Name: Specify the new PDF document's name. If left blank, the document name will be
same as the incoming document’s name with the extension .pdf.

» PDF Export Setting: Specify the PDF Export Settings name as defined in the CHILI Server. The pdf
document is created using the configuration defined in the XML of the export settings.

Note:

If there is an existing file in the target location with the same file name as the exported pdf,
then the node will fail. Alternatively, you can choose the option New Version if Document
already exists.

Export InDesign to PDF

You can use this node to generate a PDF from an InDesign document. This workflow node provides the
option to select target project, target folder, document name, and PDF preset settings. You also have
the option to upload a new version of the document if the document already exists. You can choose

to generate a PDF output after applying the referenced contents to the incoming InDesign document
without updating the incoming document.

Note: To know more about scalability, or the behavior of applying content, please refer to the
section Apply Content in InDesign.
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Export InDesign to PDF X
Target Project [Project Name] []
Target Folder [root] []
Document [ ]
Name
PDF Preset [ ]

_J New version if Document already exists

! Apply Content

0 coco [

Export Structured Content

DITA documents stored in WebCenter may be required to be sent to other stakeholders like translation
agencies or media houses. When a document is required to be shared with external stakeholders it is
important that it is available in commonly used formats.

This workflow node converts the DITAMAPS (a collection of DITA files referenced) or the DITA topicto a
flattened zip file along with the related topic references.

To ensure the document is selected use a Select workflow node and specify the following information
in this workflow node:

« Document Name: Name of the document in the output zip file

« Target Folder: Location where the output zip file is uploaded

Ensure all the topic references mentioned in the ditamap are present in the project. To include the
language attribute, specify that attribute value in the input document itself.
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Export Structured Content

Document []
Name
Target Folder [root] []

Note: This workflow node also supports exporting PCM text statements residing in DITA
“= topics, which are placed within the <div> tags.

Adding Attributes to DITA on Export

On export the value of any <othermeta> elements on a DITA Map will be refreshed with the
corresponding attribute value for that other metadata element in the project

Get Dependent Colors

In the ESKO Cloud and/or in Pantone LIVE, there are master/dependent relationship that exists
between the colors. Given a master color and conditions, there can be a dependent color linked to the
master color. This workflow node syncs the dependent standards belonging to the master colors based
on the conditions and shows these colors in the input document attributes in WebCenter.
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Get Dependent Colors %
nput | Output  Configuration

Master #COLOR -
Colors

Ink Type [#COLOR INK TYPE (Project)] []

Printing [#COLOR PRINTING TECHNIQUE (Project| [ ]
Technique

Substrate [#COLOR SUBSTRATE (Project)] []
Type

Finishing [#COLOR FINISHING (Project)] []

0 =N

Input The inputs to the node are the document(s) that contain the master colors. Specify the following
information in this tab.

« Master Colors: Specify an attribute of the document that contains the master colors.
« Ink Type Specify a Smartname that represents an ink type.

« Printing Technique Specify a Smartname that represents a printing technique.

« Substrate Specify a Smartname that represents a substrate

« Finishing Specify a Smartname that represents the finishing profile and it is relevant for Pantone
Live colors only.

In the Output tab, specify the document reference attributes that you want to be updated for

« Dependent ColorsThis is a mandatory field. The dependent colors to the master colors specified is
added to the attribute.

« Missing Dependent Colors The masters colors for which no corresponding dependent colors are
found are added here

Specify the Cloud Connection that has been configured to the ESKO cloud for the Color Service in the
Configuration tab.
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Import Dynamic Graphic

When this node is executed, images or symbols are extracted from an incoming artwork file along with
expected number of occurrences from either Al files ( pdf) or Chili files and are added to the artwork as
document references.

Parameters

Symbol Tab

Symbol Library: Field for providing the Project name(s) where all the Symbols are located. You can
either specify multiple project names with a'l" between them or provide SmartName which resolve
to multiple project names. Read more on this is How WebCenter finds previously used images on
page 383

PlaceHolder Document Template: When matching symbols are not found in the Symbol Library, this
graphic document is copied into the current project as a placeholder which can be replaced with
actual symbol later.

Upload Folder: Folder where the placeholder graphic documents are copied into.

Document Reference Attribute: You can choose the Document Reference Attribute of the Artwork
file that has to be used to link the Symbols.

Find Previously Used Symbols: If this option is selected, the node will find if an existing symbol in
WebCenter matches before creating a new document. In case the matching symbol was not found,
the node will create a new document.

Note: This optionis applicable only if the GS1XML created in the system has been added to
Artwork file through Dynamic Content.

Image Tab

Image Library: Field for providing the Project name where all the Images are located. You can either
specify multiple project names with a'[' between them or provide SmartName which resolve to
multiple project names.

PlaceHolder Document Template: When matching images are not found in the Image Library, this
graphic document is copied into the current project as a placeholder which can be replaced with
actual image later.

Upload Folder: Folder where the placeholder image documents are copied into.

Document Reference Attribute: You can choose the Document Reference Attribute of the Artwork
file that has to be used to link the images.

Find Previously Used Images: When this option is selected, the node will find if an existing image in
WebCenter matches with the reference property specified from the artwork before creating a new
document. In case the matching image was not found, the node will create a new document. Read
more on this is How WebCenter finds previously used images on page 383

Note: This optionis applicable only if the GS1 XML created in the system has been added to
Artwork file through Dynamic Content.

Import of Chili Documents

When the incoming document is a Chili file, then only the Chili variables with the data type as image are
imported and stored in the ARTWORK_VARIABLE.

382

Note: Symbols are also considered as images in the Chili File.




ESKO

WebCenter

How WebCenter finds previously used images

When an artwork is imported into WebCenter, all its contents are also imported along with its meta
data( XML)

Now when the images are imported and if the option Find previously used Images is enabled,
before creating a new document, search is made on the value in the reference property
EXTERNAL_IMAGE_PATH to find if any documents exist with the same name or matching image path.

If no matching document is found, then a placeholder document is copied into the project and its
attribute values are set accordingly.

Similarly when symbols are imported and if the option Find the previously used Symbol is enabled,
before creating a new document search is made on the value in the reference property SYMBOL_NAME
to find if any documents exist with the same SYMBOL_NAME. If no matching document is found, then a
placeholder document is copied into the project and its attribute values are set accordingly.

Import Dynamic Barcode

When the node is executed, Dynamic Barcodes along with the expected number of occurrences are
extracted from an incoming artwork file. For each Dynamic Barcode, a new document is created and
these Barcode documents are added as Document References in the Artwork.

Parameters:

- Document Template Project: Field for providing Project name(s) where the Barcode Document
Template is present. You can either specify multiple project names with a"|" between them or
provide SmartName which resolve to multiple project names.

« Document Template: Template used for creating a new document that stores the Barcode
information.

+ Upload Folder: Folder where the new Barcode documents are created.

« Document Reference Attribute: You can choose the Document Reference Attribute of Artwork file
that has to be used to link the Barcode document.

- Find previously used Barcode: If this option is selected, the node will find if an existing Barcode in
WebCenter matches before creating a new document. In case the matching Barcode was not found
in the System, the node will create a new document.

Note: This optionisapplicable only if the GS1XML created in the system has been added to
Artwork file through Dynamic Content.

Import XLIFF Content

In a translation workflow involves third party solutions (e.g. Trados or SDL), you will get your translated
content as XLIFF documents (.xIf or .xliff). You can use the Import XLIFF step in your workflow to
import the translated statements into the WebCenter Text Document (.wcc).

If a particular language is missing in the Text Content document, this step will add that language.

This step will update the document only if the statement is in Draft or Pending Sign off or Signed off
rejected state.

Parameters
« Approve Translation: If you enable this all imported content will be Signed off.

If this option is turned off, the imported text will be in the Ready for approval state.
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« Create Translation: If you check this option, a new translation statement will be created even if the
language does not exist in the document.

If this option is turned off, the languages should exist in the document before the XLIFF content is
imported. Otherwise, the imported content will not be added to the document.

Note:
« If the statement is in Signed off state, it will not be updated with the XLIFF content.
« This step may update the Text Document partially, if there are reasons for the other

statements (parts) to fail. For example, if there are three languages, it is possible that only
one language statement is updated.

« Rich Text Support: If source and target languages contents are rich text format, then the
same rich text identifiers are added into translation content in the imported text content
file.

«  When the import of the XLIFF document is failed, the error pin is updated with the reason
for the failure.

« Any new comments given during translation is imported.

Warning: This step will update the language statement in WebCenter regardless of the User
Permissions.

Import Dynamic Text

The Import Dynamic Text node extracts the Dynamic Content from your artwork(s) as Text Content
Documents from either your Al files or Chili files. For Al files, the expected number of occurrences of
each text statement is also imported. You can configure this node to import the text documents with a
link to specific Document Reference Attributes and Document Templates.

Note:

1. You need a Copy Sheet Attribute Category with Text document references as a pre-
requisite to configure this node.

2. If theinputis a Chili document, then read this for detailed explanation Import Dynamic
Content from Chili file using Import Dynamic Text node on page 388

Parameters- Configuration tab

« Specify the Upload Folder to store the extracted documents.

- Select the Document Template Project at the top of this tab. Enter the name of the Project(s)
where you have configured your Text content specific templates. It can either be SmartName that
resolves to multiple project names or pipe separated values.

« Specify the Element Type. You can create a dedicated row per Element Type / Content Type. Click
+to add a row. Read also: Configure Element Types as a List.

Tip: Select All Element Types to import content that has no specified Element Type.

+ Select the Document Reference Attribute for each row (per Element Type). Select the appropriate
document reference from the drop-down listing all document references.

These document references keep the link between the artwork and its Text Content active while
allowing you to process them separately.
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« specify the corresponding Document Template. You can configure document templates for each of
the Element Types in this SmartName enabled field.

Read also: Creating a New Text Document

Import Dynamic Content - Sans Add.Prod.Var.Info 4
Configuration Language Mapping Existing Text Content
Upload Folder [root]

Document PCM Text Templates
Template Project

Add Imperted Text Content Documents to Output

| Add Translation Languages to Text Content Documents

Document Reference Document Template
Attribute

Element Type

Active ingredien...
Active ingredien...
Allergen statem...

Assembly instru...

Brand name

Consumer guara...
Consumption co...

Contact informa...

Content claim
Copyright trade...

Cross sell

Narlaratinn ~con

i

PCM Technical ...
PCM Technical ...
PCM Legal Doc...
PCM Marketing ...
PCM Marketing ...
PCM Legal Doc...
PCM Marketing ...
PCM Marketing ...
PCM Marketing ...
PCM Legal Doc...
PCM Legal Doc...

PrbA L anal Dine

Parameters- Language Mapping tab
You can map the Locale ID of the Dynamic Content to the corresponding language in WebCenter.

Active ingredi
Active ingredi
Allergen state
Assembly imstr
Brand name.wcc
Consumer guara
Consumption co
Contact inform
Content claim.
Copyright trad

Cross sell.wcc

S N ——

« Language Index: When you create the first row, this field will have the value 1 by default. When you
create more rows, they will be numbered serially.

« Language: Select the language from a list of languages. Or use a SmartName to dynamically assign
the languages.

Note:

1. By default, animported statement is imported as Translated language if it does not exist
as a Master Language in the Project's language attribute.

2. If you do not specify language mapping for the imported Dynamic Content, the node will
try to find the language in the Lists (Master and Translation languages).
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Parameters-Existing Text Content tab.

You can specify the reuse policy for matching Text Content Documents in this tab. Check Reuse
existing Text Content Documents to match the incoming text with the existing documents.

Note:

« When you enable this option, the matched Text Documents will be copied to the current
Project if it exists in another Project.

- Ifthereisa100 percent match with regard to the content and languages, the existing Text
Documents will not be updated.

« Iftheincoming document is a Chili file, then the content of this tab is ignored while
importing.

If left unchecked, the import will create new documents.

The following settings allow you to handle partial mismatches with regard to content or languages.

If there is a partial text match (with same list of languages), choose from:

« Replace text and Reset the Status to Draft: The content will be updated and the document status
will become Draft.

« Replace text and Retain the Status: The content will be updated retaining the current status.

» lgnore Change: In this scenario, the changes are ignored and the existing documents will not be
updated in anyway.

If document is an Invariant, it will be reset to false.

If there is a language mismatch, then you have the option to:

« Addlanguage and Reset the Status to Draft If document is available in different project, make
a copy of document to current project, add language and content and reset the status of full
document.

« AddLanguage and Retain the Status If document is available in the same project, then add new
language and content, and reset the status of full document.

» lgnore Change: ignore the incoming language.

Example
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In the example, when an artwork with Dynamic Content arrives at a Packaging Content Management
workflow, the following steps happen:

1. The workflow assigns a Document Attribute Category to the artwork (parent). This 'copy sheet'
category contains the document reference attributes to which the text content will be imported.

Note: If this step is not in the workflow, the Import Dynamic Content will use the Project's
= attribute as the default.

The category contains the Document Reference Attributes for:

« technical text statements,
« legal statements and
« marketing statements

to serve as the copy sheet template.

2. The Import Dynamic Content step maps the various Element Types to appropriate document
reference attributes as configured.
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3. The Select Children nodes select the text documents (technical, legal and marketing) separately.
These documents can be processed as separate text documents while keeping the link between
them and the artwork alive.

Import Dynamic Content from Chili file using Import Dynamic Text node

Import Dynamic Text node handles incoming Chili document in the same way as other artwork files
except it ignores any configuration in the Existing Text Contents tab.

WebCenter supports the following Chili data types for text content documents

« String, short text, long text, formatted text, unformatted, number for text content documents.

When imported, the imported Chili file is considered as GS1complaint, if the Instance Sequence and
Locale are already defined in the Chili Variable name.

You can see examples of how Chili variables are handled by the workflow node in the table below.

Before Import After Import to WebCenter

Chili G51 Derived DocTemplat Final ARTWORK DocName |
Variable Complia ElemT N T ElementTyp VARIABLE Instance |Locale |autonaming
Name nt Var ype ZEINEE not enabled)
MARKETING_ [ WMARKETING_CO|BRAND_NAM [MARKETING_ 4 1 MARKETING _C
COPY PY E COPY OPY.wee
MARKETING_ MARKETING_CO MARKETING_ MARKETING_C
copy 1 |"° PY VARINT | copy 1 T [opywe
MARKETING_ MARKETING_CO MARKETING_ _ MARKETING_C
CoPY 1415 |'®° PY RECIPE COPY 4 ®  |oPYwee

A L A [
UNKNOWN_V [ UNKNOWN_vAR |BRAND_NAR Toe o nane] UTRNOWR_Y ; ] UNKNOWN_VA
AR E AR R.WEE
UMKNOWN_Y ) UINKNOWN_Y LINKNOWN_WA
AR No UNKNOWN_VAR | vARIANT VARIAMT AR 1 1 1 R wee
UNKNOWN_V UNKMOWN_V UNKNOWN_VA
ARI2 L3 No UNKNOWN_VAR|RECIPE RECIPE AR.IZ 2 3 .
UNENOWN_Y " Mot LINEMNOWN_Y UNKNOWMN_VA
AR Mo UNKNOWN_VAR] 0 o e AR 1 1 iy

Tip: Chili variables should be GS1compliant so that node can process the data correctly.

Import Dynamic Table

The Import Dynamic Table node extracts the Tables from your artwork(s) as Table Content

Documents. You can configure this node to import these Documents with a link to specific document
reference attributes and table document templates.

Note: You need an Attribute Category with Table document references as a pre-requisite to
configure this node.

If there are multiple artworks coming into the documents, the node will iterate and extract tables from

all of them.

Parameters- Configuration tab

« Specify the Upload Folder to store the extracted documents.
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Select the Document Reference Attribute for the table. Select the appropriate document
reference from the drop-down listing all document references.

Add Imported Table Documents to Output . Check this if you want the document sent to the output
pin.

Reuse existing Table Documents. The document version specified in the document reference will
be reused to store the data instead of creating a new Table Document. If there are no matching
tables in the system,new document will be created.

Document Template Tab

Specify the corresponding Document Template. Select the Table Template (either simple or Smart)
that corresponds to the incoming Table.

Select the Document Template Project at the top of this tab. Enter the name of the Project(s)
where you have configured your table templates. You can either specify multiple project names with
a'l'between them or provide SmartName which resolve to multiple project names. Read more in:
Creating a Simple Table on page 493

Add all Document Template elements Check this to import all statements present in the document
template.

Set values from Document Template. Check this to take values from the Document Template for all
matching statements. If there are no matching statements, the incoming values will be used in the
table document.

Parameters- Language Mapping tab

You can map the Locale ID of the Dynamic Table to the corresponding language in WebCenter.

Language Index: When you create the first row, this field will have the value 1 by default. When you
create more rows, they will be numbered serially.

Language: Select the language from a list of languages. Or use a SmartName to dynamically assign
the languages.

Gl

Note: By default, an imported table is imported as Translated language if it does not exist
as a Master Language in the Project's language attribute.

For new Table documents created from this node, the master language table will be added
in the Draft state, even if that language is not available on the artwork.

b ] Note: If you do not specify language mapping for the imported Dynamic Content, the node will
try to find the language in the Lists(Master and Translation languages).

-Read also: Import Dynamic Text on page 384.

It will import the Text Content
from Artwork
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In the example, when an artwork with Dynamic Content arrives at a Packaging Content Management
workflow, the following steps happen:

1. The workflow assigns a Document attribute category to the artwork (parent). This 'copy sheet'
category contains the Document reference attributes to which the text and table content will be
imported.

Note: If this stepis notin the workflow, the Import node will use the Project's attribute
as the default.

The category contains the Document reference attributes for:

« text statements,
« and nutrition facts table

to serve as the copy sheet template.

2. The Import Dynamic Text on page 384 step maps the various Element Types to appropriate
document reference attributes as configured.

3. The Import Dynamic Table extracts the table matching it to the document reference and the
table document template.

After the extraction of the content, the workflow processes the content based on the requirements.
You can, as in the example, update the incoming table and text using the workflow.

Import Structured Content

You may sometimes require to create a working copy of the DITA files and its related assets
(referenced graphics, other DITA documents or PCM statements) to edit the content without impacting
the original documents that are stored in the library projects. This workflow node creates a zipped
document in WebCenter representing structured content, comprising of a set of dita, ditamap and
graphic documents which are referenced by one another and upload it to a local project in WebCenter.

You have to specify the following information to configure the workforce node.
- Library Project(s): (mandatory)Fill in a list of project names or by default is filled in with the current
Project SmartName.

« Folder: the folder in the current project where the documents are uploaded to.

« Statements Folder: the folder in the current project, where the PCM Statements created during
import based on <div outputclass="PCM:.../> elements not matched with already existing PCM
Statements in the system are saved to.

« Package Language: default en. When dita/ditamaps do not have the xml:lang attribute set, the
default language is set to the Package Language

« Master Language. During the import process, the assets are looked up in the library by its ID. When
the asset in the master language is found, we link the imported asset to the asset of the master
language.

Output pins

« Reused files: the files that were already existing in the folder defined are found in reused file in the
output pin.
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+ New Files: the files that are uploaded newly like the graphic files, resolved dita(map) files, , dita files
where all the referenced documents are found in the new files output pin.

- Files with missing References: this output pin contains ditalmap) files which contain referenced
documents that were not found in the system (and which were also not provided in the zip file)

« Error: when no document was provided to the node.

Handling dita/ditamaps

When handling dita/ditamaps, WebCenter will first read the properties from the file. For dita files,
these are attributes of the node ‘topic’/'task’. For ditamap files, these are attributes of the node ‘map’.

When there are attributes that map on these properties, the value of the DITA property is stored in the
WebCenter document attribute. Following properties are treated in Webcenter:

Topicmeta\othermeta: all these elements will be checked and the attribute name and content is
loaded. When both are set; we store the values in WebCenter as attributes on the document where the
name maps to the webcenter attribute and the content is the value of this attribute.

Topicmeta\prodinfo\prodname when available, the content of this node is saved in the attribute
SC_PRODUCT_NAME

the property 'ID’and the 'xml:lang: when importing the document, webcenter checks whether a
document in the library exists with this ID (stored in the attribute SC_ID) and this language (stored in
the attribute SC_LANGUAGE) and if a document with corresponding values exist, it will link the assets
to the existing document, rather than creating a new document. The existing document will be re-used
and will be put on the output pin “Existing Files” - see below for description of the output pin.

When checking whether a document exists, we only check the projects that are specified in the
workflow Library Project(s) parameter.

The ID is a mandatory parameter, ‘xml:lang’ is optional and when not set, WebCenter takes the value of
the workflow parameter Package Language.

The referenced document versions are stored in the document reference attribute 'SC_REFERENCE' of
the ditamap where the sequence number is stored in the property 'SC_REFERENCE_INDEX'.

For feedback reasons, the document names as found in the HREF attribute of the dita map are stored
inthe SC_MAP_HREF attribute. It can be that for a ditamap, not all referenced topics/ditamaps are
found in the system. If this is the case, the missing reference document names are stored in the
attribute 'SC_MAP_MISSING_HREF".

Other stored values are SC_TYPE (DITA or DITAMAP) for lookup reasons and SC_TOPIC_TYPE (TOPIC or
TASK).

PCM Statements
PCM statements contained in the imported topics in a form of:

<div outputclass="PCM:ELEMENT_TYPE:[ name of the element type]-{ID:[ document version ID of this
PCM Statement J}I-LANGUAGE:[language code J> <p>[ PCM statement content ]</p> </div>

are recognized and processed as follows. Note that the ID of the PCM Statement is optional. Any other
parameter inside outputclass property is ignored for the purpose of import.

« Ifthe optional ID parameter is specified, the system checks whether a document with such ID
exists. If so PCM <div> in the imported Dita document is replaced by: <div outputclass="PCM:
[specified ID of the PCM Statement]'/>

« If the PCM Statement is not identified during the first step, current project and project(s)
configured as a Library Projects (see the parameters of this WF node above) are searched for PCM
Statements with the same Element Type, Language and content. If such a PCM Statement is found,

391



ESKO

392

WebCenter

the PCM <div> in the imported Dita document is replaced by: <div outputclass="PCM:[doc. version
ID of the found PCM Statement]'/>

« Ifthereis no existing PCM statement found, a new Rich Text PCM Statement is created from the
[PCM statement content] and saved as a PCM Statement document (*.wcc) to the current project to
“Statements Folder”(see the parameters of this WF node above). The same text content in different
languages is not recognized and a new independent PCM Statement with corresponding language
is created for each of them. The PCM <div> in the imported Dita document is replaced by: <div
outputclass="PCM:[doc. version ID of the created PCM Statement]/>

Invite Members to Project

This workflow node can be used to invite a User / Group / Role to a Project in the work flow itself by the
users who can create Task Types.

You can specify any active member to be invited to a project based on the Group or Role or even
specify a single user in the Members tab. This can also be done using Smart names. When you select
a Group, you can further select a member as Group Assignee. All the permissions are inherited based
on the Role selected to the added member. If no Role is assigned to the user, default( only view)
permission is available.

Invite Members to Project

Invite MName Role Assignment (Permissions) Group Assignee
User = | sogk =[] | 2020 roLE = []
Group - || ARD_TEST1 =[] = [1  am0
Rele  « | APPROVAL MASTER » | [] | approvER = []
User = 1L UsER: - [] =[]

In the Iteration tab when iteration is on, each of the member rows are evaluated for each value of the
attribute and then the members are added to the project.

You also have an option to choose Do not iterate, which is the default option.

Merge Text Content

This node is used to merge incoming text content documents with matching text content documents
in the configured Library project. For every incoming text content document, a library document
should match the content for each of the languages in both documents.

This workflow node has the following configurable fields:
Text Content Library(s): Enter project names or a SmartName that resolves into multiple projects.
Ignore Case while matching: Select this field to match only the content, ignoring the case.

Ignore white space while matching: Select this field to ensure that leading and trailing spaces are
ignored.

Cancel
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Approve Content: Enable this field to approve the merged content. When the master language of the
merged content is not already approved, then the newly added language will not be approved.

Ingnore Translation Languages: Enable this field to only check on the master language when merging
text content. It will allow to update translations in case only the master language is matching.

Library Upload Folder - Specify the folder, where the copied document should be placed in the Library
project.

Ok

Dﬁ:} T ) EXT {:E
ﬁ J*| o :., Mew Version UEInam

Full matched file

Start Select Document Merge Text ™ e\ added tg Libaae
Content =
Documents ‘ Duplicate fi
Target . s
& Error
Run Report

Use this node to generate a report for the incoming document(s)/ Current project/other reports
according to the setup in the node.

Details Tab
You can Create Report for

« Incoming Documents: Choose this option to generate a report for the incoming documents into
this node. If there are no incoming documents, the node will fail.

« One Report for All Documents option generates a single report for all the incoming documents.
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Paramete
Create Report fo - Run REDDI’T
® Incoming Documnents
One Report for All Documents Details CAramETers
Current Project Parameter Parameter Value
Name
Other b [ ]
Report Template Please select Report - [] [ ]
Target Report [ ] [ ]
Hame J
:
Target Project [Project Name] [] |
Target Folder [root) []

Current Project: Choose this option to generate report for the current project.

Other: Choose this option to generate any other report.

You can choose the Report Template, Target Report Name and Target Project and Target folder or
add a smart names for these fields.

Note: It is mandatory to mention the Report Name.

Parameters tab

You can specify the parameters that are required for the report to be generated in this tab. If no
parameters are provided, default parameters configured in the Report setup page is considered.

« Parameter Name: Should be same as the name configured in Jasper Report. When the
parameter name does not match with the report parameter name, the node skips that
parameter altogether.

Note: The name seen on the Report Setup Page is a label and is not same as the field in
&= the Jasper Report.

« Parameter Value: Define the value for the parameter set and it is a SmartName field.

In case there are wtc(table content) document references in the attribute category where you are
creating a report, and if the report template is PDF then the Table Content Preview is merged into
the report or else the Preview PDF report will be generated seperately.

Now choose the Report Template, Report Name, Project and the specific folder in which the report is
directed.

Note: You canread more about the set up of report parameters here.
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Reuse Text Content Node

This node helps you to reuse the text content documents that are referenced in the incoming artwork
document. This is done by matching and replacing them with the library documents or the text content
document is updated with SmartText that refers to library documents.

Reuse Text Content Documents

Text Content Library(s)

Ignore Case While Matching
Ignore Rich Text Differences
Ignaore White Space

Match Element Type
If matching Document foun
® Create Smart References for Library Document

Delimiters wnl, 111
Exarmple: Pipe separated string - \tl,l.|ll

O Replace with Library Document

cance' “

Text Content Library(s): Specify project names or smart name that resolves into projects.

Every text content document referenced in the artwork are searched in the mentioned Text Content
Library Project and if matching document is found, then based on the node configuration

If the input Text document is inheriting content from another language, then the inherit content
settings is respected while updating the text with Smart Content.

Ignore Case While Matching: When enabled, content matching ignores cases. By default, this option is
selected.

Ignore Rich Text Differences: Select this checbox to ignore the richtext formatting differences. When
unselected, the text content will be reused only if the rich text formatting visually matches. By default,
this field is checked.

Ignore White Space: Select this option to ignore the leading and trailing spaces. By default, this field is
selected.

Match Element Type: When enabled, it matches element type of text statement. By default it is
checked.

Create Smart References for Library Document : Text content document is updated with Smart
References to reuse the library document and all language content is also updated with smart
reference(s)and are also resolved automatically.

Delimiters: You can specify the delimiters that allows the workflow to split the available text and
search in the configured library. This field is a free text field, but the input is expected in certain format
to avoid any wrong match/splitting of string.
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Replace with Library Document: Referenced text content document in the incoming artwork is
replaced with the matching document from the Text Content Library specified.

Remove Member

This workflow node allows you to remove User(s)/ Group(s)/ Role(s) from a project, who have no
approvals or task assigned to them. You can also remove the user(s) or group(s) assigned to a specific

role.

Members tab

In this tab, you can choose multiple member rows for removing at the same time.

Remove Members from Project

Members terate

Remove MName Role
User - || MoaM ~ [] -
Group  ~ | ARTWORK_DESIGNER « | [ ] | BLSA_TEST -
Role - | apProvAL MASTER - [ ] -
Role M. « ~ []  cDE suppLIER -
User * || JAMI_ADMIN ~ | [] | Aomn Fm1 -

Cancel

You can specify to Remove from the project, either

« anUser

« oraGroup where an user is specified
+ aRolecompletely

« member(s)of the Role

[]
[]
[]
[]
[]

Name and the Role fields in this tab are SmartName enabled, and resolves values in the workflow.

Iterate tab

You can choose a Project/Document attribute or task specification via a smart name and Iterate Over

Attribute.

When iteration is on, each of the member rows are evaluated for each value of the attribute and then

the members are removed accordingly.

Note: When the attribute value is empty or cannot be resolved in the workflow, the node fails

to remove the member(s).

You also have an option to choose Do not iterate, which is the default option.
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Replace Member

Many a times members are added to the project for a specific purpose like approval and later are
removed, while new members may have to be added for other purposes. To automate the adding and
deleting of members at certain juncture in the project, you can use the Replace Members workflow
node.

Current members of the role within a project can be dynamically replaced with new members using
Replace Members Workflow node. You can specify the member or groups or member of a group to
replace a member or a group or a member of a group already existing within the project. The node has
to be specified with the following details in the Members tab and Iterator tab.

Members tab: You can add as many rows that may be need, to replace the existing members in the
current project. You can delete the row if required. A member row requires the following fields :

Replace Members in Project

nbers terate

Role Current Member Replace by Group Assignee
[No Role] ~ [1 | user + || MIKAEUS ~  [] | user v || maA - [1] ~ []
[No Role] ~ []1 Group ~ || venDom ~ []  Greup ~ | aSk DRAWING VIEWER~ [ ] | cabx ~ [1]
[No Role] ~ [] Group ~ || TRADE SAMPLE MaRs - [ ] | User > | s0BK - [] ~|[1]
[Any Role] ~ [] | User > || KvBA ~ | [] | User ~ || ROBA - [ ~ []
[Any Role] ~ | []  Group ~ | PURCHASER GROUP ~ | [] | Group - || TRamsLATION AGENCY~ | [ ] | USER_DUTCH - BELGI~ | [ ]
[Any Role] ~ []  Group ~ | GROUP C ~ | [1 | user ~ || Gaza ~ [1 ~ [1

« Role: You can specify the role which has to be replaced from the drop down of available roles in the
project or with smart name(s). You have an option to choose a member as a part of Any Role to be
replaced or a direct member (No Role ) in the project to be replaced.

+ Current Member: You can specify the current member type (user/group)in the two optional fields
where a drop down is used and a smartname dropdown is used to specify the current member who
is to be replaced from the project.

« Replace by : You can choose a new member type as either a user or a group from the drop down and
you can also further use a smartname to specify the new member or choose from the drop down.

Group Assignee: You can optionally specify a member of the group as a smart name or choose from
the dropdown. The user selected in this field will become group assignee. The user should be part of
the selected group.

{ = ] Note: This option is enabled only when groups are chosen to replace.

Iterator tab: You can specify whether there are Iterations or No iteration. When the iteration is on, the
member rows are evaluated for each Iterator Value. You can

« Iterate Over an Attribute You can choose a Project or Document Attribute orTask Specification
with a smart name.

+ Do not iterate (default option)
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E s ] Note:
1. If the current member configured in the row is not a member in the role/Project, then the
replacement of member is not performed.

2. The Tasks and Approvals assigned to the current member is reassigned to the first member
replaced.

Restore from Esko Cloud

Sometimes you might want to retrieve an archived document from Esko Cloud back to Web Center
filestore. It is possible to restore the Document using the Restore from Esko cloud. This means that
the Document will be downloaded from the Esko Cloud and saved in the WebCenter Filestore.

In this work flow node, you need to specify a working Esko Cloud Archiving Asset Management
connection and the node should receive document(s) that are archived in Esko cloud.

E ) ] Note: Ensure to choose the right Asset Management connection for Cloud Archiving, in which
the document is archived.

There is an additional option to retain the archived file in the Esko cloud or not. When the Remove
Document from Esko Cloud after Restore option is chosen (by default), the Document is removed from
the Esko Cloud and it is no longer archived ( as per the document status).

Save Document Colors in Attribute
Color Trace solution supports Color Ink Books/ Pantone Standards from the ESKO Cloud.

Save Document Colors in Attribute work flow node extracts the color information from the incoming
artwork document ( ROMD properties) and saves it as attribute values in the corresponding document
in WebCenter's #COLOR Library Project.
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Save Document Colors in Attribute
Jutput | Color Specification

Document #FCOLOR L
Attribute
If th

~elmr doas neyt
L R L L ¥

(1]
m
[}
s |

i

T
m

® Create Color

Project | MISSING COLORS LIBRARY []

Folder [root] [ ]

Fail if Color does not exist

Ignore Color if it does not exist

To extract the information from the incoming artwork, you need to define the following

« Document Attribute in which the values are stored

« On matching the incoming file with the existing document in WebCenter, the work flow node
progresses step by step in an orderly fashion.

« Firstly, checks if a color with the matching name exists in the specification. The attribute value
for #COLOR Name is found, when they are matched. If no match is found, then it is checked in
the preferred books.

« |fthe preferred book is not mentioned or not matched in the preferred book, the #COLOR
LIBRARY is searched for the color name.

« While searching in the #COLOR LIBRARY, a search is made to match the attribute "#COLOR
NAME" and “#COLOR BOOK". If not found, then only #COLOR Name is searched for and it is
updated only if only one matching color is found. If more than one color is matched, the node is
failed.

« When the option Create if not exists is selected, then a new color document is created in the
Project > Folder where the following attributes are specified as the cloud color.

« #COLOR NAME: Name of the color
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« #COLOR BOOK: Name of the book where the color is present
« #COLORRGB: RGB value of the color

» #COLOR ORIGIN: Missing Color

If the #COLOR NAME exists in the project, then then same is linked to the document. Also note, that
the newly created color has a thumbnail indication that it is not a cloud color.

Select Children (Document Reference)

Using this node, you can select the documents that are referenced in the input document as a
document reference attribute value. Read more in: Document References.

This node collects the documents referenced in each of the input documents and sends them as the
output documents. Based on the settings, this task may output the incoming parent documents as
well.

In the following example, the node selects the artwork document referenced in a design file.

@ (| > PR @ | |
o
Yo-Yoghurt_final.pdf

Start Select Artwork Completed

document

Double-click the node in the canvas to fill in the following options:

Parameters

Attribute: | Variants =

Project: [1
Fail if no Documents found.

[ Add Input Documents to Output

« Attribute: drop down listing all the document reference attributes defined in the system.

. Note: When you select the option Any Document Reference from the drop down, all
2= document reference children of the incoming documents are selected and added to the set
of output documents.

400



ESKO

WebCenter

Parameters

Attribute:  |Variants -

DEKE_DocRef PMG IPG only

DEKE_DocRef PMG anly

DEKE_DocRef Selected Revision

DEKE_DocRef Selected Yersion

DEKE_DocRef Single

DEKE_DocRef View: Creation

DEKE_DocRef View: Default -

13

Project:

[.m

|ﬂ' |

+ Project name: use SmartNames or type in the name of the project where the referred document
is located. This is handy when you want to filter the multi-valued document references located in
several projects.

This field is optional and by default empty.

« Fail if no Documents found: check this when you want the workflow to stop if there are no
document references for the attribute you selected.

This option is turned on by default.

- Add Input Documents to Output: check this to send the incoming documents (the documents
containing the document references) also to the output pin in addition to the selected document
references.

This option is turned off by default.

Select Document

Use the Select Document node to choose a document to be processed by the rest of the workflow.
When a workflow is started with a human task requiring documents, the Select Document node can be
used to provide documents.

Parameters

Project Name: The name of the Project containing the document to select (by default, this is the
project in which the workflow is launched).

You can select either:
- Documents in the project: then define the following:
« Name: The name of the document to select.

« Folder: The project folder containing the document to select. By default, this is the root folder.

Tip: You can use SmartNames for the Project Name, Folder and Name parameters.

« From Project Document Reference

In 18.0.1 WebCenter release onwards, the documents that are referenced by the selected Project
Document Reference in the specified project are put on the output pin. You can scroll the drop
down list to select the document references.

«  From Task Document Reference
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The documents that are referenced by the selected Task Document Reference in the currently
executed workflow task are selected. You can either select the Task Document Reference from the
drop down or select Any Document Reference. When Any Document Reference option is selected,
all documents that are referenced in the task’s specification are selected in the node.

+ Documents in the Bill of Materials. When this option is selected, all the document(s)(versions) that
are in the Bill of Materials of the project specified in the Project Name field, are selected and put on
the green output pin as one token.

There is also an option to Fail if no document found. This option stops the workflow with a failed
state, if there are no documents in the defined Project location/Bill of Materials.

Select Parent (Document Reference)

Using this node, you can select the parent documents where the input documents are being
referenced as the attribute value. Read more in: Document References.

This node collects the master documents of the input documents (document reference values)and
sends them as the output documents.

In the example below, the document Christmas Bottle.zae hasanARD file asadocument
reference value for the attribute Die Line.

To select the parent when your input document is the CAD008 . ard, specify the attribute( Die
Line)in the node. The node will select Christmas Bottle.zae.

= 5 Christmas Bottle.zae

Name Value

Die Line
E1E] Thumbnail Document Version

% -
‘ CADOOS.ard 1 %)

Double-click the node in the canvas to fill in the following options:

Parameters

Attribute: | ACAD - trays -

Project: [1

Fail if no Documents found.

[] Add Input Documents to Output

oK |[ Cancel ]

« Attribute: drop down listing all the document reference attributes defined in the system. Select
the attribute name where the input document is the referenced document.
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Note: When you select the option Any Document Reference from the drop down, all parent
2= document referencing the incoming documents are selected and added to the unique set of
output documents.

Parameters

Attribute:  |Variants v
DEKE_DocRef PMG IPG anly -
DEKE_DaocRef PMG anly )|
DBG_bowef SearcnActons ]
DEKE_DocRef Selected Revision |
DEKE_DocRef_Selected Version

DEKE_DocRef_Single

DEKE_DocRef_View: Creation

DEKE_DocRef_View: Default -

Project:

®

« Project name: use SmartNames or type in the name of the project where the parent or master
document is located. When the project name is specified, only the parent documents that are in
this project are selected.

This field is optional and by default empty.
« Fail if no Documents found: check this when you want the workflow to stop if the parent
documents are not found.

This optionis turned on by default.
« Add Input Documents to Output: check this to send the incoming document references also to the
output pin.

This option is turned off by default.

Send Notification

You can send automatic workflow notifications using the Send Notifications node. These notifications
are sent as an e-mail with a configurable subject and body. You can customize this according to your
needs.

Parameters

In the To field, type the e-mail addresses of the receivers or select them using SmartName [] .The
following SmartNames are supported:

« Project Manager

« Sales Person

«  Workflow Master (the project member who is assigned the whole workflow as a task in the project)
« Groups

« Users

+ Roles(the e-mail will be sent to the current holders of this role in the project)

-ff‘f- Tip: Use ; as a separator between the receivers.

>
ey

In the Subject field, type the subject of the e-mail. The subject can be configured using SmartNames.
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In the Message field, type the body of the e-mail. You can use the buttons and options at the top of the
field to format your message. The e-mail body will automatically contain a link to the first document
coming into the node even if the node gets multiple documents.

. Tip:
]

the Project name or a User name).

« Inthe Links section, You can find a SmartName to generate a Temporary Document Preview
or a Temporary Document Download link in the e-mail. The preview link SmartName is
only available if the admin has enabled Allow large Document preview (approval e-mail
notifications) and for download link Allow Project Members with Download permission to
e-mail a link for non-authenticated download of a Document.

Select some text and click ﬁ to create a hyperlink.

Set Document Attribute

Use this node to automatically add document attributes and their values to the documents processed
by the node.

1 Attention: Your documents should have the attribute category (containing the attributes you
add) already assigned, otherwise the workflow will fail.

Parameters

Click + to add one of the attributes of the document's attribute category. If this is not the attribute you
wanted, click it and select another attribute.

Then double click in the Value column to enter the corresponding attribute value. You can use
SmartNames.

To remove an attribute, select it and click -.

Set Project Attribute

Use this node to automatically add project attributes and their values to the current project.

1 Attention: Your project should have the attribute category(containing the attributes you add)
already assigned, otherwise the workflow will fail.

Parameters

Click + to add one of the attributes of the project's attribute category. If this is not the attribute you
wanted, click it and select another attribute.

Then double click in the Value column to enter the corresponding attribute value. You can use
SmartNames.

To remove an attribute, select it and click -.
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Set Project Status

Use this node to automatically set the status of the current project.

Parameters

Choose the project status in the Status list (it contains all project statuses configured in your
WebCenter system). You can also use SmartNames to configure a status parameter.

Set Workflow Specification

Use this node to automatically set the value of one or more specifications of the workflow you are
running.

Attention: The specifications you want to use should already be added to the workflow task,
before starting the workflow.

Parameters

Click + to add one of the workflow specifications to the list. If this is not the specification you wanted,
click it and select another of the workflow's specifications.

Then double click in the Value column to enter the corresponding specification value. You can use
SmartNames.

To remove a specification, select it and click -.

Set Workflow Status

Use this node to automatically set the status of your workflow (this must be an active status).

Parameters

Choose the workflow status in the Status list (it contains all active workflow statuses configured in
your WebCenter system). You can also configure SmartNames to set the status parameter.

Start Approval Cycle

Use this node to start an approval cycle on any incoming document, and wait until the approval cycle is
finished.

Parameters
Choose to either:

« Use the default approval setup: This is the default approval setup of the incoming document. If no
approval setup exists for it, the default approval setup of the folder containing the document, or
failing that, of the project containing the document, is used.

« Use the approval setup of another document. In this case, enter the Project Name of the project
containing that document, and the Document Name.

You can use SmartName for both the Project Name and Document Name.
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Note:

- Ifthereis no active approval setup in your project or you chose to use a document that has
no approval setup, this node will fail.

» If the approval was already started, it won't change. The node will wait until the document
got approved or rejected.
« Ifthe document was already approved or rejected this node will fail.

Start Approval Stage

Use this node to start an approval stage in a workflow and build a staged approval. You can set up an
approval stage in the workflow similar to a stage in the Approval Setup page in Projects.

You may have multiple stages of approval required within the same approval cycle. In such cases, you
can set up stages within the approval cycle to approve a document from different stakeholders.

Parameters

Stage Setup

The stage starts when the incoming document is received for the stage. The document is sent to the
appropriate output pin based on the outcomes defined for the stage.

Note: If a document version is deleted while the node is waiting, the document is sent to the
error pin with the message Document version is deleted.

Approval stage has to be defined with the required information like:
. Stage Name

Provide a name to the approval stage. This is a mandatory field.
« Approver

Roles for a particular approval stage have to be assigned before the stage begins or else the
workflow will fail. Smart names can also be selected for this field. This field supports all possible
user options like User, All of Role, All of Role - One of Group, One of Role, One of Group, All of Group
and you can also have multiple SmartName fields and also multi- values for this field.

« Allow Conditional Approval Tick the check box if conditional approval has to be allowed. Read more
about it here

+ Allow Forward Approval Link Tick the check box to allow forwarding the document for approval.
Read more about it here.

+ Inherit Previously Submitted Approvals Tick this check box to inherit the approvals. To know more,
read about it here

+ Keep Forwarded Approvals Tick the check box to retain the forwarded approvals when a new
version is uploaded. Read more about it here.

+ When one User Rejects Specify how document rejection should be handled. To know more on this
option read here

« Require review state on all annotations Specify how the review on annotations has to be handled
by approvers. To know more, read here

Due Date

Specify the due date for the approval stage. To know how to set up, read here
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Approval Settings
Specify the setting for approval in this tab

«  When a new version is uploaded You can read how to set up here
- Approval Master You can read on how to set up here
- Email Notifications You can read on how to set up Email Notifications here

When a New Version is uploaded

When a document's approval cycle is started, and a new version of the document is uploaded, then
the approval cycle is automatically stopped. You can define what happens when the approval cycle
restarts.

In the When a new version is uploaded setting, choose either:

When a new version is Approval Restarts from Current Stage -

uploaded | Approval Restarts from Current Stage

Approval Continues

Go to New Version Pin

« Approval Restarts from Current Stage to keep the approval stages already completed (typically
approved)and restart the current stage. People who already approved / rejected the document in
the current stage will have to evaluate it again.

- Approval Continues to keep all the approval actions already done. Only people who have rejected
the document will see it again (to check whether the reason for their rejection was corrected).

« Go to New Version Pin redirects the uploaded new version of the document to the New Version
Uploaded output pin if the approval has already started. When no rule is specified, then the
approval of the document is in Waiting for workflow status.

The approval rule will be initialized, when the workflow starts an approval stage. Depending on the
stage that is started next, the inheritance of Stages/ Approvals is determined as follows:

« A new stage that was never executed before: All stages are inherited, except for the stage that
triggered the Go to New Version Pin.

« A previous stage: All stages are inherited up to the one that needs to be started.

« Same Stage: All previous stages are inherited.

.Note:

It is not possible for a document to go through two New Version Uploaded output pinsin a
row. This is to prevent endless loops in the workflow. Go to New Version Pin setting in the
second stage will be overruled. In such a case, the stage is restarted.

« Thenew version can also be uploaded, when the approval is in a waiting for workflow state
where approval is required, but the workflow is pending completion of a manual task.

«  When the document was already in a waiting for workflow status and a new version is
uploaded, the new version of the document will also be in waiting for workflow status and
when entering an approval stage node, the new version uploaded setting gets executed in
this node.
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Finish Approval Cycle

Use this node to finish the approval cycle of the incoming documents and send e-mail notifications.

Since there could be many stages in an Approval cycle, a workflow step is designed to determine the
completion of the approval cycle. The output pin of this node denotes the final approval status of the
document.

E-mail notifications:

« No Notifications: No e-mail notifications will be sent when the Approval Cycle is completed.

. Default Notifications:

E-mail notifications are sent according to the notifications setup defined in the Document Approval
Setup, Folder Approval Setup, Project Notification Setup and System Notifications setup, each time
falling back to the next level if that level is set to default.

- Custom Notifications: Choice to send an e-mail notifications to the Project Manager, Involved
People and/or Project Members when the approval cycle is completed.

Documents with similar approval statuses are directed to the same output pin.

For example, two documents arriving in one token with final approval status as Approved would be
shown in the Approved output pin. The error output pinis split per document to view the error for each
document.

The final approval status of the document shown in the output pinis

« Approved: If the final status of the incoming document is approved
« Approved with conditions: If the final status of the incoming document is approved with condition
« Rejected: If the final status of the incoming document is rejected.

« New Version Uploaded: When a new version of the document is uploaded after all the approval
stages are completed then the document is directed to this pin.

« Error: For example, when there is no incoming document.

Submit Workflow

Use this node to launch a workflow in Automation Engine from WebCenter.
During execution this node will:

« connect to Automation Engine using the specified Workflow Connection.

« launch the workflow in the specified Automation Engine Job / Container

The incoming documents will be processed according to the Send incoming Documents option
setting. If there are documents to be sent, they will be copied to the specified Job or container and will
be added to the start node of the workflow in Automation Engine.

When the workflow is finished in Automation Engine, the WebCenter node will continue over the green
output pin. During execution, the workflow feedback shows that it is running on Automation Engine.

Note: Your Administrator must have configured a Workflow Connection of the type Project/
Workflow (JDF) for this to work. See Configure Workflow Connections in the Administration
Guide.
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Parameters Tab

Submit Workflow

Workflow | Please select or start typing
Connection

Workflow []
Name

Workflow | nermal [ ]
Priority

Workflow Connection:

Select the JMF type workflow connection (configured by your Administrator) from the drop down. Read
in: Configure Workflow Connections

Workflow Name:

Enter the name of the Automation Engine workflow to launch. You can use SmartNames.

1 Attention: The Workflow Name is case sensitive.

Workflow Priority:

This parameter allows you to launch a workflow with a Normal, Low and High Priority. The default
optionis Normal. The value is represented as sw.priority.low, sw.priority.normal or sw.priority.high if
you are using SmartNames.

Send incoming Documents (by default):

Check this to send the incoming documents to Automation Engine (e.g. because of an earlier submit or
a sync operation).

Select the check box Also send previous version with Document name suffix to send the previous
version of the file as well.

{ = Note: Specify the mandatory suffix when enabling this option. The previous version is
submitted only when a suffix is specified. For example, if the name of the file name is file.pdf
and the suffix is _PVS, the previous version will be submitted as file_PVS.pdf.

Choose if you want to launch the Automation Engine workflow on the files in:
« an Automation Engine Job; in this case, enter the Orderid and the Sub-orderid of that job.

« an Automation Engine Container (only if you use Automation Engine 12.1or newer); in this
case, enter the path to the container in the Folder field, in the format file://aeserver/
containername.

You can use SmartNames in all of these fields.

Workflow Parameters Tab

To map your WebCenter Project Attributes to the Workflow parameters in Automation Engine, specify
them in this tab.

409



ESKO

410

WebCenter

Note: Thisis only supported if you use Automation Engine 12.1 or newer. Read also Add
Documents from Automation Engine

Submit Workflow

Parameter Value

L]

You have the following options that you can enable:

- Add Project Properties to add the WebCenter project properties as Automation Engine workflow
parameters.

« Add Document Properties to add the project properties as parameters.

« Add All Project Attributes to add all the project attributes. They will be available as
project.attributename in Automation Engine.

« Add All Document Attributes to add all the document attributes. They will be available as
document.attributename in Automation Engine.

- Add All Task Specifications to add specifications.

- Define Custom List to type in the specific Parameter Name and specify their values manually in the
resulting columns below.

+ Intheleft column, specify the workflow parameter name. It will show up as that workflow
parameter name in Automation Engine.

Note: This list will overwrite the previously added values (For example, add all project
attributes as "project.attributename”).

« You can typein atext value or use SmartNames to specify the workflow parameter in the right
column.

Note:

The default behavior is to send no parameters unless specified. However, if you had enabled
the Map attributes to Workflow Parameters in a previous version, all the above options except
the Define Custom List are sent by default.

Manually force the node to an output pin

Any user with Change Task rights can force a node to an output pin. To force the node to the output
pin, right click on the token of a running workflow node and choose either

1. Force to Completed pin: This will put the token on the green completed pin.
2. Force to Error pin: This will put the token on the red error pin.

When one of the option is chosen, a confirmation window appears and the action is logged in the
project history.
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This feature is useful, when the feedback from Automation Engine is not received, and you want to
let the WebCenter workflow continue after some manual correcting actions are done.

Sync Workflow

Use this node to sync the current WebCenter project with the Automation Engine job configured in
your Workflow Connection. This syncs the WebCenter project data with the Automation Engine job
parameters.

This node uses the synchronization settings from the project/template setup by default. However, you
can setup alternative synchronization settings in the Sync Settings tab.

sync Workflow

To change the project settings:
« Enable Override Project Settings and configure the following settings:

. Toassociate the workflow with a different workflow connection, select Override Workflow
Connection and Select new Workflow Connection from the drop-down.

Note: This drop-down lists all the connections listed on the Project > Configure >
Workflow Connection page.

« Foroverriding the copy document settings, enable Copy Documents when Synchronizing and
select the specific setting:

« Only Documents in Folders: Select this to specify one or more folders in this editable field.
Use ; asthe separator. Only the documents in the specified folders will be synchronized.

Note:

« If one of the specified folders does not exist in the project, the node will skip the
workflow synchronization.

« To specify the root, leave the field empty or as “[root]".
« You may also specify the folders using wildcards. For example, 2* will match the
folders A, ABC,and Amadeus.

« Only Approved Documents: Use this setting to synchronise only the approved documents.

« Only Documents matching: Type in the names of the specific documents that you want to
synchronise. This field accepts wild cards.
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Note: If Copy Documents when Synchronizing option is not checked, no documents
are synchronized.

Specify the WebCenter Project Attributes that should be synchronized as Job Parametersin
Automation Engine. Configure the settings in the Job Parameters tab:

« Push All(default): All the Project Attributes from the project attribute category are pushed as Job
Parameters.

« Push None for not pushing any Project Attributes to Automation Engine

« Push Custom List: When you select this, you see two columns and two buttons:

- Select from All Project Attributes to add one or more attributes listed in the column. The >>Add
All (Filtered) Attributes adds all attributes listed in the column.

. Select from Selected Project Attributes to remove one or more attributes listed in the column.
The << Remove All (Filtered) Attributes removes all attributes listed in the column.

Sync Workflow

Push Al
Push None
® Push Custom List

All Project Attributes Selected Project Attributes

«
»

e [

Note: The Sync Workflow node will push only the attributes that are assigned to the
WebCenter project in which the workflow is executed. If the attributes specified in this node
are not assigned to the Project, these will not be pushed.

Executing the node results in the project being synchronized with Automation Engine as per
the settings from the node and the Project in which the workflow runs. The workflow will wait
until the synchronization is finished and show an error in case this fails.

A Warning: When you push a custom list of attributes to Automation Engine as job parameters,
you may lose some of the existing job parameters. This happens if you are using the old JDF
policy on Automation Engine. Read about the JDF policy in: http://help.esko.com/docs/en-us/
suite-general/14/otherdocs/AE_Job_Parameter_Policy.pdf

Manually force the node to an output pin

Any user with Change Task rights can force a node to an output pin. To force the node to the output
pin, right click on the token of a running workflow node and choose either

1. Force to Completed pin: This will put the token on the green completed pin.
2. Force to Error pin: This will put the token on the red error pin.
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When one of the option is chosen, a confirmation window appears and the action is logged in the
project history.

This feature is useful, when the feedback from Automation Engine is not received, and you want to
let the WebCenter workflow continue after some manual correcting actions are done.

Sync Chili Variables
You can use this node to sync the attributes with the CHILI document.

When the node is executed for incoming CHILI documents, only those CHILI variables with data
type Text and Image are processed. The Rich Text formatting of the content will be applied to CHILI
variables if they have the required style mapping.

:1), —— T —— -’1'\ Q) — — - :T:
o ENE .

Get Set.chp Get Set.chp

t Set.c Far Dt b
Start Select Documetr Syne CHIL m ZEt aEt.Chp

Ensure that the referenced text content documents in the incoming chili document contains the
attribute ARTWORK_VARIABLE or the CHILI variables in the incoming document is in the format

<element type> L<x> I<y>

where x and y are integers.

Basic Attributes are also synced if CHILI Variable name matches exactly with the Attribute Name. For
Images, the variable name of CHILI image file should match with ARTWORK_VARIABLE present in the
attribute category.

A new document version and a new thumbnail of the CHILI file is created after the workflow is
successfully completed.

Table Content Preview Report
This node allows you to generate a pdf report of the Table content document selected in the workflow.

The report is generated based on the preview of the document which is saved in the selected target
folder specified in the node. You can also select the Generate separate report per language option to
generate language specific reports.

When multiple Table Content Documents are received by this node, then separate reports are
generated for each input document.
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Table Content Preview Report

Target Folder Folder2 []

#| Generate separate report per language
Locale Mapping

Use Table Content locale mapping

* Use custom locale mapping

Locale Language
1 Englizh - United States []

2 Englizh - International = []

Report generated is named as <name of input document>_report.pdf. If the report is already
present, then new version of the report is created.

And when the report is generated for specified languages, then it is named as < name of input
document>_report_<language code>pdf.

By default, Use Table Content locale mapping is selected, and the locale mapping is done as per the
incoming table content document for which report is generated. You can choose to change the order
of language mapping in the incoming table document by selecting Use custom locale mapping and
choose the languages for each locale number for which report has to be generated.

Transform Structured Content

You can transform the chosen DITAMAP file to a Word, PDF or an HTML file and upload it to a specified
folder in the project.

You can specify different output formats for the documents dependent on the Structured Content
Plugin folder.The plugin configuration allows different transformation types, for e.g MS word, PDF,
HTML5 etc.
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Transform Structured Content o4
Output Format Please select an output format - [ ]
Document [ ]
Name
Target Folder [root] [ ]

€

cocet [

This workflow node requires following information to transform the DITA file:

Output Format: Choose an output format from the dropdown list. This is a mandatory field which
reflects the folders available in the “sc_plugin_dir” location.

Output Format can now be configured to reduce the size of the resultant MS Word file by limiting
the size of the images within the document.

To reduce the file size of MS Word exports, a Template Engineer can add the
image_resize_longest_edge_pixels parameter to the output template creating the MS word file.
If this parameter is present and has a value greater than 50, then any image which has a longest
edge greater than the configured value will be resized. The resized image will have the same
aspect ratio as the original image. This resize only impacts the image which is placed in the MS
Word document and not the actual image in WebCenter.

The Transform Structured Content Task Type is used to perform the transformation of a ditamap
to MS Word.

If for some reason the image cannot be resized, then the full-size image can be used and a
warning pin is set on the workflow step for each file which could not be reduced.

{ = Note: The output template in which the user would like to limit the size of images
needs to have the property image_resize_longest_edge_pixels added to it with a positive
integer value greater than 50. It is recommended to use value between 500-800 to
maintain ~72dpi on a legal sized document. A Transform Structured Content Task
pointing to the configured output template needs to be run.

Document Name: Specify the name of the output document, which is usually the same as input
document. If a document already exists in any folder of the project, then it will upload new version
of the document.

Target Folder: Specify the target folder name. By default, the upload folder name is the [root] that
uploads the output document into the root folder of the current project.

{7

Note: This workflow node also supports transforming PCM text statements residing in DITA
topics, which are part of this particular DITAMAP.

To add output formats and configure the transformation type, copy one of the pre-defined plugin
folders. You can also customize the output styling.
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All these different plugin folders should be kept in alocation which is specified in the appconfig.xml as
in the example below.

<sc_plugin dir value="C:\Esko\Artios\WebCenter\SCPlugins">
<!--local storage for available Structured Content output plugins-->
</sc_plugin dir>

Update Text Document
This workflow step allows you to specify or update Text Document properties such as:

« Text Content
« Role Mapping
« Languages

« Approval
Update Text Document X
Text Content Role Mapping Languages Approva
¥ Set Permission
Content Permission Language Role
. G Zi=-- o B T o= ADD LANGUAGE ~ || French - Fiw | [ ] | kzkuRroLE « | []
k| & ) o
ADD LANGUAGE ~ | [aLL oTHER~ | [ ] | kTkuRole « | [ ]
Select Document Update Text
Document =
o coce [
Text Content

In this tab, specify the properties in the Text Content Field and the corresponding values in the
SmartName supported Value field.

You can specify or update the following properties and their values in this tab:

Update Text Document »
Text Content Role Mapping Languages Approva
Field Value
Approval Setup - One of Role + []
Inherit Content .. » || English - United States * | []
’ Invariant - Falze - [ ]

o oo I
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Allow Only Single Smart Text: Specify this as True if the Document should allow only single
SmartText.

Note: When 'Allow Only Single Smart Text'is set to True, the content of the document will
be cleared automatically.

the Approval Setup:

+ Default: Only one member has to approve. For example, if the Approver permission is assigned
to two Roles, only one member (from any Role) has to approve.

- One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member
or user from that Role can approve.

« All of Role - One per Group : At least one member from each Role-Group has to approve. If there
is anindividual User, then he or she has to approve as well.

Auto Suggestion: If specified as True, the Document will suggest matching text when the user

starts typing.

Note: This will work only when Saved Search is enabled.

the Element Type of the Text Document. You can select from the list of text content element types
supported in the system.

Note: The Element Type drop down is configured as a List. Read more in: Text Content
Element Types

Inherit Content From :
You can choose to inherit content one of the options below:

- Default: Will inherit the content from the language that is configured to follow in the Language
List.

« None: Will not inherit content from any language in the workflow node. However the user can
manually change the language at the element level in the document.
« Master Languages: Can choose any of the languages from the master language list.

By default Disable is chosen which will not allow to inherit content.
Inherit Only SmartText: Specify this as True if the inheriting content should allow only SmartText.

Note: Thisis only applicable when 'Allow Inherit Content'is enabled.

Invariant: Specify this as True if translations are not required for a particular Text Document.

Note: If the Invariant is set as True, then all translation languages will be removed from the
incoming document.

SmartText Search: A list is displayed containing all global Text Document searches available on the
server.

Type of Text: Simple or Rich Text. If the Type changes from the existing type, the document status
will become Draft.

Change Master Language: This feature allows user to change master langauage. To change master
language perform the following task:

1. Select Change Master Language.
2. Choose the language you wish to make as master language.
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3. Under Keep/Revert Approval state, choose between Always revert Approval state to Draft
if Master language is changed and Keep Approval state if new Master language is already
Signed-off.

Role Mapping

This tab allows you to map Content Permissions to Roles. To specify the new set of permissions or to
specify permissions in a workflow:

1. Enable Set Permission. This will show the Permission Settings.

2. Select the Content Permission (Add Language, Editor, Approver or Content Manager).

3. Set the corresponding Language from a list of all the text content languages supported in the
system.

Select [All Other Languages]to specify permissions and role mapping to all languages without
permission assignment in one go.

E b ] Note: The Content Manager has permissions to all languages by default and cannot be
specified per language.

4. Specify the Roles corresponding to the selected Content Permissions. The drop-down lists all Roles
configured in the system.

Languages
This tab lets you:

« addandremove languages to the document or Inherit content from the language configured in
document

« update or create actual text content
To do an Action:

1. Select Language - You can either select from the drop-down (listing all the languages present in the
system)or use a SmartName in this field.

E b ] Note: If your SmartName points to a multi-value attribute, it will resolve to multiple values.

2. Specify the Action: Choose from Add/Remove/Update/Inherit.

3. You can add a condition where the workflow node can inherit/add/update/remove elements. There
may be a combinations of different conditions that may be given.

Condition Action Possible

Always Add, Remove, Update, Inherit
New Value is not empty Add, Update, Inherit

Current value is empty/not available Add, Update, Inherit

Current value is empty Remove, Inherit

Current value is not available Inherit

Current value is empty and new value is not Add, Update

empty

4. Define the corresponding Value. This is the field where you can type in the actual text content.

Warning: If alanguage is specified in more than one row, only the settings specified in the last
row will be valid.
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Approval Tab

This tab allows you to set Approval Status (per language) via workflow.

{ ' Note: You can use SmartNames in this step and if your SmartName points to a multi-value

' attribute, it will resolve to multiple values.

1. Select Language - You can either select from the drop-down (listing all the languages present in the
system)or use a SmartName in this field.

2. Specify the Status. You can choose from Draft, Pending SignOff, SignOff Rejected and Signed Off.

Update Table Content
This workflow node allows you to specify or update Table properties and Table values. You can add:

« Role Mapping

« Languages

« Approval

« Add/ Remove / update/ inherit elements and set values for nutritional facts elements

Settings

In this tab, specify the properties in the Field and the corresponding values in the SmartName
supported Value field.

You can specify or update the following properties and their values in this tab:
« Approval Setup:

« Default: Only one member has to approve. For example, if the Approver permission is assigned
to two Roles, only one member (from any Role) has to approve.

« Oneofrole: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member
or user from that Role can approve.

« All of Role - One per Group : At least one member from each Role-Group has to approve. If there
is an individual User, then he or she has to approve as well.

« Auto Suggestion: If specified as True, the Document will suggest matching text when the user
starts typing.

{ ' Note: This will work only when Saved Search is enabled.

+ Inherit Content From :
You can choose to inherit content one of the options below

» Default: Will inherit the content from the language that is configured to follow in the Language
List.

« None: Will not inherit content from any language in the workflow node. However the user can
manually change the language at the element level in the document.

« Master Languages: Can choose any of the languages from the master language list.

By default Disable is chosen which will not allow Inherit content.

« Inherit Only SmartText: Specify this as True if the inheriting content should allow only SmartText.
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Note: Thisis only applicable when'Allow Inherit Content'is enabled.

« Invariant : Specify this as True if translations are not required for a particular Document.

« SmartText Search: A list is displayed containing all global Text Document searches available on the
server.

« Type: Simple or Rich Text. If the Type changes from the existing type, the document status will
become Draft.

Values

This tab lets you add / remove /update table statements and their values. Use a single row per element
or statement.

Update Table Document % |

Settings  Role Mapping | Values | Approval

Element Instance Sequence Language Action Condition Value
serving Pev | [] | 1 [1| english -« |[] | Add ~ | [1 Aways - |[]| r[List] [1
serving i~ | [] | 1 [1| French - f~ | [1]| Inherit ~ [] || current va~ | [] []
talories ~ [] | 1 [1| engiish - v | []| update ~ [] || Always ~ | [] | r[List] []
Total Fat + | [] || 1 [1| english -~ | [] | update = | [] || Always | [] | rList] [1
Total Fat + | [ ] || 1 [1!| French -f~ | [] | Inherit ~ | [] || Always ~ | [] [1
Cholesterc~ | [] || 12 [1| engiish - v | []| update ~ [] || Always ~ | [] | r[List] []
Cholestercw | [] | 1 [1!| French -f~  [1 | 1inherit ~ | [] | Always ~  [] [1
Sodium Mez~ | [] || 1 [1| engiish -~ | [] | update ~ | [] || current vaw | [] | [List] [1
Sodium Pov~ | [] || 2 [1| english - ~ | [] | update ~ | [] || Always | [] | [List] [1
Total Cartw | [] | 1 [1| english -« | [] update ~ | [] | Always | [] | rList] [1
Total cart~  [] | 1 [1| French - f~ | [1| zoherit ~ [] || Always ~ | [] []
pietary Fiv | [] | 1 [1| engtish -~ | [] | update ~ | [] || Always | [] | [List] [1
Dietary Fivw | [] | 1 [1| French -f~ | [] | 1nherit ~ | [] || current vaw | [] [1
sugars  ~ [] 1 [1| engiish - v | []| update ~ [] || Always ~ | [] | r[List] []
sugars Pov> | [] | 1 [1| english -~ | [] | update = | [] || Always | [] | rList] [1
Added Sugew | [] || 1 [1| english -« |[]| Add | [1| Aways = |[]| r[List] [1
Added Suge~  [] | 1 [1| French - f~ | [1]| zoherit ~ [] | Always ~ | [] []
Protein Mev | [] | 1 [1| english -~ | []  update ~ [] | Always | [] | rList] [1
Protein PL~  [] | 1 [1!| French -f~ | [1 | 1nherit ~ | [] || Always ~ | [] [1

-

@ coce

« Element - Contains a list of all the table Element Types supported in WebCenter. There is a special
field "[All Table Elements]" which will do bulk addition of master table elements into a translation
language.

- Instance Sequence - Specify the instance sequence number. This number indicates how many
occurrences of an Element is present in a Table. The default value is 1.

» Language - You can either select from the drop-down (listing all the languages present in the
system)or use a SmartName in this field.
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If the specified SmartName resolves to multiple languages, then the specified configuration(from

that row) will be applied to all of them.

« Action: Choose from Add / Remove /Update/ Inherit .

« Condition You can add a condition where the workflow node can inherit/add/update/remove
elements. There may be a combinations of different conditions that may be given.

Condition

Action Possible

Always

Add, Remove, Update, Inherit

New Value is not empty

Add, Update, Inherit

Current value is empty/not available

Add, Update, Inherit

Current value is empty

Remove, Inherit

Current value is not available

Inherit

Current value is empty and new value is not

Add, Update

empty

« Value - Field where you can specify the actual content. You can enter the data or use SmartNames.

[ ( ] Tip: Use List SmartNames(pointing to an Excel sheet based List) to provide contentin a
smart way.

E b ] Note: If you specified the action as Add for an existing value, the value is updated. If the
element does not exist in the document, the element and the value will get added. However,
if the action is Update and the element does not exist, the row is ignored.

E b ] Note: If you are updating a SmartName table using this node, the value from this node will
replace the SmartName in the table.

Approval Tab

This tab allows you to set Approval Status (per element, per instance and per language) via workflow.
This allows you an automated way of approving the nutrition fact statements.

E ) ] Note: You can use SmartNames in this step and if your SmartName points to a multi-value
attribute, it will resolve to multiple values.

1. Select the Element or the statement.
2. Specify the Instance Sequence of the element.

3. Select Language - You can either select from the drop-down (listing all the languages present in the
system)or use a SmartName in this field.

4. Specify the Status. You can choose from Draft, Pending SignOff, SignOff Rejected and Signed Off.

Layout Tab

«  Remove empty rows from Grid Layout is unchecked by default.

Upload to Asset Management System

The Asset Management configurations allow you to push a document to the asset management
system. The Upload to Asset Management System node allows you to specify the Asset Management
connection or a cloud connection and their metadata mapping.
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Specify the Parameters

Choose the Asset Management Connection from the searchable drop-down. You can choose from
either

1. Esko Cloud connection which has an Archiving service connections that are already set up in the
system by the admin user.

Then the Workflow node allows you to configure the following parameters:

« Only archive old Versions of a Document when this option is selected, the versions uploaded
into the Esko Cloud are limited to all the versions that are no longer being linked to from within a
Project in WebCenter.

For example, if there is a Document with 3 versions: version]1, version2 and version3 and two
Projects

ProjectA and ProjectB where ProjectA contains Document version3 and

ProjectB contains Document version2.

On executing this workflow node, only the Document version1(oldest)is uploaded to the cloud.

When this option is not selected, all versions of the Document are uploaded to the Esko Cloud.
» Remove Document from Filestore after upload to Esko Cloud: When this option is chosen,

(selected by default), the documents are removed from the File store on successful upload to
the Esko Cloud.

Note: At atime, only one Document version can be uploaded to the Esko Cloud and an
uploaded version cannot be overwriten.

2. Asset Management Connection

Note: If you leave this field blank, the workflow will look from an Asset Management system
that acted as the source for the incoming document. This step will fail if it cannot find any
Asset Management configuration.

Define the DAM specific parameters

» Asset Path
« Specify if the zip files should be expanded on the MediaBeacon server on upload.

. Specifyifitis a New Asset or a New Version of an existing asset.

- Specify the MediaBeacon Namespace and any parameters with its value.

Wait for View Files
With this node, you can

» have view files available before starting an approval cycle or starting a task
« detect warningsin the view file generation.
« re-generate view files after they are flushed

For example, before starting an Approval Cycle.
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Trangiation

During execution, the node waits for the view file generation of the incoming documents and proceeds
to one of the output pins according to the view files status:

« [Ifthe view files are available or if the document is not viewable, the document is sent to the
Succeeded output pin

« If the view files are available but if it contains a warning, the document is sent to the Warning
output pin

{ = ] Note: The Task Details of the view file generation has the text “Task(s) generated warnings”

- If the view file generation failed, the document is sent to the Failed output pin.
« |fthere are noincoming documents, the node fails and the token is sent to the Error pin.

If there are multiple documents in the incoming token, the node will wait until the status of all the
document(s)is known, and then proceed to the appropriate pins.

{ = Note: If the view files were deleted, the node will re-start the view file generation first before
waiting for its status.

Manually force the node to an output pin

Any user with Change Task rights can force a node to an output pin. To force the node to the output
pin, right click on the token of a running workflow node and choose either

1. Force to Completed pin: This will put the token on the green completed pin.
2. Force to Error pin: This will put the token on the red error pin.

When one of the option is chosen, a confirmation window appears and the action is logged in the
project history.

Wait

Use this node to pause the workflow for a certain amount of time (for example to wait for a user action).
The next node will start processing after the wait time is over.

Parameters
Release date:

By default, this is set to the current date (using the SmartName [Current Date]). You can change
it using any SmartName that resolves to a date (not only the SmartNames from the Date category but
also for example an Attributes or Specifications category SmartName resolving to a date).

i = ] Note: When using an attribute or specification SmartName, the attribute category must
be set on the project in which you run the workflow, or the specification must be set on the
workflow task. See Project and Document Attributes in the Administration Guide for more
details about attributes, restricted sets and attributes categories.
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In Days offset, Hours offset, Minutes offset and Seconds offset, you can add a number of days,
hours, minutes and seconds to wait after the Release date. For example, if you set the Release date to
[Current Date] with an Hours offset of 2, the node will pause the workflow until two hours after
the workflow was started.

You can use SmartNames in all these parameters.

Select Count only working days if you are setting the node to wait a number of days and you only want
to count business days. For example, if you set it to wait two days and start it on a Thursday, it will start
again on the Monday after that. This is selected by default.

Manually force the node to an output pin

Any user with Change Task rights can force a node to an output pin. To force the node to the output
pin, right click on the token of a running workflow node and choose either

1. Force to Completed pin: This will put the token on the green completed pin.
2. Force to Error pin: This will put the token on the red error pin.

When one of the optionis chosen, a confirmation window appears and the action is logged in the
project history.

15.14.6. Task Types

424

A Task Type can be either Manual or a Task Type with a Workflow. Both types can be added to a
workflow from the canvas.

The manual tasks require human intervention and they can be used as either individual tasks or as
workflow nodes.

Editing a Task Type

You can edit a Task Type in a workflow by double-clicking on a node and specifying details in the Edit
Parameters dialog. This dialog is task specific and has SmartNames-enabled tabs:

« Parameters

« Specifications
« Due Date

- lterate

« Notifications

«  QOutput

{ = ] Note: Click the [] icon to use SmartNames in this node.

Parameters Tab
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Parameters | Spedfications | Due Date | Iterate | Motification | Duu:lut|

Task Type: 2,1 Document Brief

Mame: 2,1 Document Brief [1
Description: []
Status: In Progress [1 ~

[ Update the Task if existing {otherwise add incremental number ¥

Assignee

i@ Select Role

Role:

Assign To:
(7 Select Group

(") Select User

@

:Dne of Role -

[Froject Manager] [1 ~

Ok ] [ Cancel

Fields Description

Name The name of the task.
By default, the name will be derived from the
Task Type.
When a task is executed multiple times, the task
name will automatically get the suffix _1, _2, and
so forth.

Description Type in a fixed description for the task assignee.

Status The initial status of the node. By default, the

drop down will have the following statuses:

+ Created
+ InProgress

« Completed

Note: It will list all the statuses

configured in the task type. Read in:
Add Task Statuses on page 308

Update the task if existing

By default, this is off. The task will create anew a
task.

425



ESKO

426

WebCenter

Fields Description

Enable this to update the task if it already exists.
If this happens, the task will get back from a
completed status to an in-progress status.

Assignee Specify the task assignee:

- SelectRole (Default):
+ Select Group

« Select User

Read more below:

Task Type Assignments

Select Role (default): You can select the assignee from a SmartName enabled drop down with all
the roles in the system (visible to the current user):

Project Manager (default): The project manager of the project containing the workflow.
Project Creator : The user who created the project.

Note: In case the project was created earlier than 18.1 or when the project creator does
not have access to the project, and the creation of task fails.

Sales Person: The sales person of the project in which the workflow runs.

Note: The Sales Person should be invited to the project.

Workflow Master: User/group/role to which the workflow is assigned (task assignee of the
workflow task).

All other configured roles visible to the current user.

Use the Assign To field to specify the iteration settings for the task:

One of Role setting for creating and assigning one task for the role.

All of Role - One per Group setting for creating and assigning individual tasks for each group /
user in that role. Only one task is created and assigned per group.

All of Role setting to create and assign individual tasks for each unique user in the role (including
users in groups assigned to the role).

Select Group: You can select the assignee from the drop down listing all the visible groups. Specify
the Assign To field as:

One of Group to create one task assigned to the group.
All of Group to create and assign tasks for each user in the group.

Select User from the drop down of all the users visible to the current user. The user should be
invited to the project.

Note: Therole / group /user should be invited to the project. If you are using a SmartName or
free text, the resolved role / group name should be invited in the project.
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Note: If the Project Manager or the Workflow Master is role / group, it follows the Assign To

settings.

If your Assign To field settings create multiple tasks, the workflow will wait until all of these tasks are
finished to progress to the next step.

Specifications Tab

Use this tab to set the values for the task specifications. These values can be either fixed values or
selected using the SmartNames.

Parameters | Spedfications | Due Date | Iterate [ output|

Languages:
Number:
Numbers:
Numbers Copy:
ProjectPrefix:
Rich Text:
Text:

Volume{cu ft,cu m):

Weight{lbs,ar):

Weight{lbs, kg):

Volume{cu in. ,cu cm):

English
[Number]
3

[Document name]

[Project Name]
[Volume(cu ft,cu m) (Project)]

[Volume(cu in. ,cu cm) (Document)]

[1~
[1
[1~
[1 ~
[1
[1
[1
[1
[1

Volume{cu in. ,cu dm):

m

[1
[1
1 -

oK H Cancel ]

Note:

If you want to see the specifications in the specifications tab you should add them in the task

type.

Output Tab

Specify the output documents in this tab. The fields on the Output tab are:

Fields

Description

Add as output

All task documents: Output all the documents
that are attached.

Only new task documents: This excludes all
the task documents and the documents that
were previously available. This resultsin the
new task documents.

Note: If there are new versions,

these are also considered as new
documents.

No documents: Set no documents as output
of the task.
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Fields Description
Name Filter the output document by name or document
extension. For example, *_1.pdf files.

Parameters | Spedifications | Due Date | Iterate |§OUtDUt |

Add as output: |all Task Documents 1~

Name: = [1

oK ] [ Cancel

Iterate Tab

You can iterate task creation from a Task Type node. The Task Type node will create tasks depending

on the lterator value.

aranges_hig JPG, ., applesjpag |'_,I] Completed: 0/3

Y, .1

-

Start Select Document

The default option is Do not Iterate.

=

-
Simple Task with Docs - English_L - In Progress (ADMIN (ADMIN) )
Simple Task with Docs - Dutch_1 - In Progress (ADMIN (ADMIM) )

Simple Simple Task with Docs - Spanish_1 - In Pregress (ADMIN (ADMIN] )

Docs

To create multiple tasks over a Project /Document attribute or a Task Specification, select it in the

Iterate over Attribute field.

428

| Parameters I Spedifications | Due Datel Iterate | Motification I Duh:»ut|

Iteration/Mo Iteration
(@) Iterate over Attribute

Attribute: |[BAMT Languages (Document)] [1

() Do Mot Tterate
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You can select this attribute via a SmartName or by manually typing in the attribute. Based on the
resolved value of this attribute, this node will create the tasks. For example,

If the SmartNames resolves to a multi-value (text) attribute indicating languages, the node will
create tasks based on the language variants. You will get the same result when you type in the
attribute values.

For example, if youtypein Dutch | Spanish | English,the iterator value will be “Dutch”,
“Spanish”and "English". As a result, there will be three new Tasks corresponding to each language
attribute value.

M
(=%
=

Simple Task with Docs - Spanish 1

M
(=%
=

Simple Task with Docs - Dutch 1

M
(=%
=

Simple Task with Docs - English 1

CENENE

For each iterator value, the node will create a task with the value of ‘iterator value’ filled in as the
value for the corresponding parameters.

- Ifthe attribute/task specification is Integer type or if the SmartName resolves to an integer or if

you type an integer (for example, you type 3), the projects will be created based on these numbers.

For example, if the value resolves to 3, the iterator value will be 1, 2 and 3. As a result, this task type
will create three new tasks.

"B Note:

« If the attribute is missing in the Project, you will get an error:
Attribute not found
« Iftheresolved attribute is empty, your error message will be:

Resolved
iterate attribute value is empty

If you iterate over a project attribute or task specification, all incoming documents are added to the
tasks.

When you iterate over a multi-value document attribute (for example, Dutch | Spanish |
English):

- if the incoming document has two values for the Languages (the Iterator) attribute, Dutch and
English, this document will be attached to the Dutch and English Tasks.

- if you have documents where this attribute is empty, they will not be added to the iterated tasks.

« if you have documents without this attribute, they are attached to all the created tasks. However,
these documents will be transferred to the output pin (of the task type node) only once to avoid
duplication.

’ ' Note: The output of this task type node will depend also on the Output Tab settings.

=l
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Tip: You can use the Iterator Value in combination with other node parameters such as Role.

Assignee
@ Select Role

Role: Editor_[Tterator Value] [1] -
Assign To; _AJI of Role - One per Group -

) Select Group

1 Select User

If you select multiple assignees (for example, by selecting All of Role) for a task, the node will
execute the Iterate over an attribute function first. Based on the Iterator value and Assignee,
it will then create tasks for the multiple task assignees (all of role in this example).

This allows using the iterator SmartName in the assignee fields for roles and groups. Read in:
Parameters Tab on page 424.

Notifications Tab

This tab allows you to create and send Notifications without adding a Send Notification node.

The configuration is almost the same as the Send Notification on page 403 node. However, the are

extra SmartNames available in this tab to refer to the just created/updated task.
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Parameters Specifications Due Date lterate Motification Output
¥| Send Motification
To [Current Task Owner (E-mail)] []
Subject []

Paragraph ~ FontFamily «~ Font Sizes - () o -
T B 7 U & x x A~ A~

T % B LR E H =
6 o = [

° cvcet N

In the To field, type the e-mail addresses of the receivers or select them using SmartName [l .The
following SmartNames are supported:

« Project Manager

« Sales Person

+  Workflow Master (the project member who is assigned the whole workflow as a task in the project)
« Groups

« Users

- Roles(the e-mail will be sent to the current holders of this role in the project)

« Current Task Owner (E-mail). Filled in by default.

Note: This is not available in the Send Notification node.

In the Subject field, type the subject of the e-mail. The subject can be configured using SmartNames.

In the Message field, type the body of the e-mail. You can use the buttons and options at the top of the
field to format your message.
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B Tip:

the Project name or a User name).

Select some text and click to create a hyperlink.

’ T 1.

Select the icons to change the text direction from right to left or back when
working with languages like Arabic or Hebrew.Use SmartNames Link to Current Task from
the category Links and Current Task Due Date from the category Date.

Note: This is not available in the Send Notification node.

Due Date Tab

Due Date Tab

| Parameters | Spedifications | Due Date | Iterate | Motification | Duu:lut|

Due date

(@) Fixed lead time

Based on date:  |[Current Date] [1
Lead Days: 2 [1
Lead Hours: a0 [1
Planning: Forward [1 ~

(7 Percentage lead time {compressing)

Minimum lead days: |0 [1
Minimum lead hours: |0 [1
QK ] [ Cancel

In this tab you can setup the due date by configuring the following fields according to your needs.

Fixed Lead Time

Specify the Based on date as the reference. This field is SmartName enabled and you can use values
such as[Current Date], [ Workflow Duedate], [ Workflow start date]and any date-attribute as the
reference.
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Also specify the Planning as either Forward or Backward.
The lead time is added or subtracted to your reference date depending on this setting:

« If your Planning is set to Forward, the Lead days and hours are added.

- If your Planning is set to Backward, the Lead days and hours are subtracted.

Percentage Lead Time (Compressing)

Another way to specify the due date is by specifying the lead time in percentage. A percentage of the
difference between the current date and the reference date.

The Based on date is the SmartName enabled reference date. Use [Current Date], [ Workflow
Duedate], [Workflow start date]and any date-attribute as the reference.

If your workflow due date is on 27th Thursday and the current date is the 13th,

« The number of days is calculated as 10 working days.
« If your percentage set as 20, the task will add two working days to the current date to calculate the
task due date.

August 2015
1
2 3 4 5 6 7 8
19 10 11 12 13 14 15
Task/ Sub-
Task
Execution
date?
16 17 18 19
Taskor Sub-
Taskdue date!
based on
Perecentage
Lead Time
Compressing
23 24 25 26
Date (Eased on
Date)
30 31 *  Thelead time is calculated based on the percentage=20

. 10 working days between the start date (13%) and the Project Due
date. S50 2 working days are added to the task execution date.

*  When the task is started on 20%, there are 5 workign days before
the due date and task due date is the 21,
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15.14.7. Workflow Constructs

Workflow constructs are "tools", nodes that help you build the workflow. They help control the flow of
data and/or documents through the workflow.

Data Splitter and Data Collector

Data Splitter
Use the Data Splitter if you want the next step in the workflow to process each file individually.

You cannot specify parameters for this node. When a token arrives with multiple documents, Data
Splitter will be split them up as separate tokens with a single document.

Data Collector
Use the Data Collector workflow control

« tocollect all files that travel separately as individual tokens in the workflow and then merge them
before sending the group the next step.
« towait forall files before continuing the workflow.

In the example below, four files arrive at the Data Splitter node and are outputted as four tokens with
a document each. The Design steps (a task per token) collect the design documents and sends it to
the Data Collector. This step outputs the processed files as a single token to the next step.

BackLabel ai

Active Ingredients Header_Conbury.wcc
Conbury_cookie.pdf

Cross Sell_Conbury.wcc

Active Ingredients Header_Conbury.wcc
BackLabel_Visualizer.ai

BackLabel.ai DESIGN1.ARD

Conbury_cookie.pdf DESIGN_UNO.ARD

BackLabel_Visualizerai|  split{intojfour

DESIGNT.ARD tokens singleitoken

: kv]
DESIGN_UNO.ARD fed
DESIGN1 ARD

BackLabel_Visualizer.ai

- o @ N . e R .

[« » =] ° e

Start Upload Idea Data Spliter Design Data Colledor
singletoken

BackLabel.ai
Conbury_cookie.pdf
BackLabel_Visualizer ai
DESIGN1.ARD

Cross Sell_Conbury.wce
Conbury_cockie.pdf

Active Ingredients Header_Conbury.wcc
BackLabel ai

You can set the Error Policy:

- to Fail when errors occur

« ortolgnore Errors
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Error Handler

The Error Handler node is a workflow construct with a single output pin. You can attach this to any
other node.

Note: This node will not accept input connections.

When a workflow node has a failure, the system will check the error dot of the node. If this dot is NOT
connected to anything, and there is an error handler node on the canvas, the system will put the token
on the output dot of the error handler.

In the example below, if Start Approval Cycle fails because there is no approval setup:

« the Error Handler will check if the error pin of the node is connected to any other node. When the
error pin is not connected to any workflow path, Error Handler will receive the error.

« the Send Error Mail node will send an e-mail to the person specified in this node.
- after the notification email, the token will be placed on the original node.

The person receiving the e-mail can then take action and retry the approval node.

S @[ 8 @ U

Start Upload design Start Approval = Data Collector Produce Complated
Cyele

@o

Edit design

Py O ] @
=)

Error Handler Send Error Emall

Note:

« Do not connect the Error Handler node and its following nodes to the main Workflow to
avoid unexpected results.

« Youonly can add one Error Handler node in your canvas.

Feedback from the Error Handler node

To know the source of the error, click on the output token of the node connected to the Error Handler.
In the example below, the green output pin of the Send Error Email will show the error.
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@o

GetLegal

2
B @:

- 7 @ 3 o
[ @o .
Start Upload design Start Appraval Data Collector Produce
Cycle'

@o

Edit dasign

Fork and Join
The Fork step automatically tags

« every file running through it

% I Gy

Error Handler Send Ermor Email

« and all the files that those files are related to in the next steps

This creates a tag for the group.

"4

Complated

board selector.png Emrors: One of the documents has already an approval started ffinished

WebCenter

The Join step then groups all the files with the same tag and outputs it together.
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Active Ingredients_Conbury.wcc

ArtworkUpload_2 x
@ @ @ < 1ef1] > RN @ © @ 9 [FinProges L
Zoom step Through Navigation Workflow Comtrols  Undo/Redo vigw
In Progress X
Cross Sell_Conbury.wce
BackLabel.ai Active Ingredients_Conbury.wce h
Active Ingredients_Conbury.wcc BackLabel_Visualizer.ai
Corfbury_conkle,pdf QPO_U ps:
Active Ingredients_Conbury.wee the /| Active Ingredients Header_Conbury.wce
BackLabel.ai BackLabel_visualizer.ai content /| Active Ingredients_Cenbury.wee
Conbury_cookie.pdf Active Ingredients_Conbury.wee based ﬁ"h o Conbury_cookie.pdf
BackLabel_Visualizer.ai @) @ onjtags)
= — o In Erof
ﬁ @ -'/ @ I: @ @ Provide Content o g Active Ingredients Header_Conbury.wce |
e (legal} -:- P @) Active Ingredients_Conbury.wece i
Start design Data Splitier TF"’k o create Fing BackLabelai
I R |
'na %% Rroceeds o |
i o
fl-lé)—s— @) ® Active Ingredients Header_Conbury.wce individualjartworks
: @ creationsteps

Provide Content
(Marketing)

©

Provide Content
(Regulatory)

@
o

In the example workflow:

« the Fork node tags these three files separately

BackLabel.ai

Active Ingredients Header_Conbury.wcec
Active Ingredients_Conbury.wce \
Conbury_cookie.pdf

Cross Sell_Conbury.wee

Active Ingredients_Conbury.wcc

BackLabel_Visualizer.ai

- the designer uploads packaging designs (three files). This task will send a single token of three
files to the next steps.
- the Data Splitter separates them into three tokens

- eachdesign file gets tasks for collecting its own legal, marketing and requlatory content. This
resultsin 9 tasks to gather content.
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- the Join node groups individual design files with related content using the tags. This step will
result in three groups of files and three create final artwork steps.

Mark and Select

The Mark and Select nodes are used as a pair. You can use Mark to tag files in the workflow and use
Select to select those files later in your workflow.

You can have several pairs of Mark and Select in your workflow. By default, the tags will be set as
tag-1, tag-2, etc.

Mark

To specify your own tag, double-click the node and enter the tag in Mark all incoming items with tag
field.

Select

You can use the drop-down in the Select all items with tag field to specify the tag for this node. The
drop-down list will contain tags specified during the Mark step.

o O O=, i D~ &-'\
g ) ﬁ \ yd @ o \|'|
j!'l design M \\ .-4/ Seledt Provide Content |
ﬁ Ch:\\ Tag mandesign \ V4 Tag: mandesgn (Marketing)
\ ag mandesig % Y, g g !
Start i \ / l'\
| . A e — g
S 7 ® Sy ) @ —_———— % V
o w0
CAD _design Start Approval @ _
Cyle

Router

The Router workflow control ﬁ serves to automatically decide the route that your workflow (tokens)
should follow.

When a workflow arrives at this node, the workflow will continue over one of the configured output pins
based on the specified rules. You can also create SmartName powered rules for routing.
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[\

Mkt- NPD - Reg

rad VN

KRJA DW 4.2
Approval Setup

Select PDF and
_# RTF

Os

KRJADW 3.33
Mew Version
Upload

The screen shot above shows how to route a document through different paths depending on its

project attribute. The router decides which department should approve the document based on this
project attribute.

« These are the settings in the Router:

Route based on: | Project Attribute

Attribute: |KRJA RES DW Routing Options

[ Case sensitive

Project Attribute Route to Add
is | Marketing = NPD >Regulatory [1 | [© Marketing > NPD >Regulatory  w | Remove
is | |Marketing > Reguiatory [1 +| [© Marketing > Reguiatory =
:iS v: Regulatory (Only) [1 ~ :0 Regulatory (Only) v:
is | [NoApproval Needed [1 +| [© NoApproval Needed -]
no match :0 Error -
)
[ oK ] [ Cancel ]

The rules were defined based on the attribute values. The Route to names correspond to these
values.

Note: The rules are executed from top to bottom. Their order can be changed with
=== Move Up / Move Down. The last rule, no match will be applied when the other options
are not applicable. This will result in Error or a custom label.

Routing can be based on many different criteria(see the list below).

You can make all of them except the Project Status Case sensitive. Enable this option to match the
exact case.
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E ] Note: The leading and trailing spaces are always ignored.

Adding and deleting rules
You can Add or Remove rules. Use the options on the right hand side.
To Add arule:

1. Click the Add button. For each additional rule another output dot is added to the node.
2. Anew line appears under the current selected row (no match always stays at the bottom of the list).
Select the operator and value for your rule.

E b ] Note: The name of the output will be the same as the matching value by default. However,
you can edit the name.

3. You can choose Move Up or Move Down to change the order of your rules, except for the no match
rule. The no match rule stays at the bottom.

[ ( ] Tip: You can also set the same output token for multiple rules. To do this, select the same from
the drop down The node will then have less output dots than there are rules.

To Remove arule:

1. Select the rule you wish to remove.
2. Click the Remove button.

It is not possible to delete the no match rule.

Routing on Text Content Properties

Router

Route based on:

Routing on Text Content Properties can be setup during execution, when setting main routing
dropdown on Text Content property, the Field selector allows following values:

Depending on the Text Content property, different options appear in the rule.
The Text Content Fields become available only if PCM license is enabled:

« Text Content Status : this is the overall status of a Text Content document. Options available are
Draft and Signed Off

- Text Content Element Status: This is a status of a particular language that needs to be selected
from language drop down. Options are Draft, Pending Sign off, Signoff Rejected and Signed off.

« Element type: All the Text Content element types supported in the system
« Approval Type: Default, All of role, one per group and One of role.

« Invariant: True or False
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« Isvalid if the Text Content Property value equals the value in the drop down field of the
rule

» Isnotvalid if the Text Content Property does not equal the value in the drop down filed of
the rule.

«  When a workflow comes in router having Text Content Property rules, the incoming documents will
be checked and put on the corresponding output pin as per the routing rules. If you have multiple
documents coming in, each of them is routed and put on the right pin.

Anomaly Handling: If there are no input documents, a No Input Documents error is put on the error pin.
If the Text Content Property cannot be found (for other type of documents), a Text Content Property
not found error is put on the error pin.

Routing on Project Field

Route based on Project Field

Route based on: | Project Field -

Field: |Project Mame -

[7] case sensitive

Praject Field Route to Add
contains vl Design| [1 IIO Match vI Remove
nao match :0 Error -
Field list As an example, use this to...
. Project Name Decide which part of the workflow to follow based

. Project Description on naming conventions of the project name.

- Project Manager Note: Use SmartNames to make the

» Sales Person rules dynamic.
« Customer Name

o Customer Location

Routing on Project Status

Route based on Project Status

Project Status Route to Add
s ~ | |1.1PCOLLECT approve release complete [1 ~ ||0 1.1 PCOLLECT approve release complet e e
no match :0 Error -
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When a workflow comes in a router checking on project status, the status of the project in which the
workflow runs is checked at that moment and matched against the values in the rule list.

Field list As an example, use this to...

Project Status assign a different path depending on the status.

Choose from: For example, 'Design’ versus ‘Correction'.

« All project statuses (Select from the drop
down containing all the statuses including the
custom ones.)

Routing on Project Attribute

Route based on: | Project Attribute -

Attribute: |00 Brief Revisions -

Case sensitive

Project Attribute Route to Add
contains ~||B [1||©8 - e e
no match £ Error =
Field list As an example, use this to...
All attributes in the system Decide where to go based on the value of an
attribute 'Project Type'.

Routing on attribute values

When you configure the routing based on the attribute values, the behavior depends on the attribute
type.

For Text attributes:

- Isempty: applies when the attribute is not filled out.

- Is Equal To: valid if the attribute value equals the value in the input field of the rule.

« Is Not Equal To: applies if the attribute value equals the value in the input field of the rule.

. Contains: applies if the attribute value contains the specified rule value.

- Does not contain: applies if the attribute value does not contain the specified rule value.

« Matches: applies if the attribute value matches the specified rule value. This value can contain
wildcards and regular expressions.

« Begins With: valid if the attribute value begins with the rule input.

{ . Note: Leading spaces are ignored.

« Example: Attribute value = Sales Belgium and the rule says [ Begins with]“Sales".
- Ends with: Similar to the Begins with option. The rule applies if the attribute value begins with the
rule input.
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(f ’ Note: Trailing spaces are ignored.

For Restricted Sets and Cascading Attributes:

« If the selected attribute is a restricted set, the rule options will be limited to is and is not. The input
field will have a drop down list with the restricted set values.

If your restricted set is a check box, the unchecked value resolves to no match instead of no.

« The cascading drop-downs defined by a list will be treated as text attributes, not as restricted set
attributes.

For Numeric Attributes (integer, float, weight, dimensions...):

The rule drop-down now has the following options:

iz greater than or equal to
iz greater than

lies between

i= not equal to

You can specify one or two floating point values in the input field.

(f Note: When you specify lies between, the lower and upper limits will be taken in. For example,
4 lies between 4 and 6. To exclude 4, type in 4.00001(or 5 for an integer attribute).

When a project does not have the selected attribute (not part of the attribute category), the router will
always take the no match route.

For Multi-value Attributes:

If you are routing based on a multi-value attribute, the values are compared individually to the
specified rules.

For example, if your "Packaging Type" attribute has values:
« Label|Folding Carton
and the rules:

« isequalto Label
« 'isequal to Folding Carton'

the router will have two outgoing pins with tokens.
Using SmartNames:
If your rule value is a SmartName that resolves to a multi-value attribute, the rule is evaluated as “OR".

If your packaging project has a language attribute with multiple values, you may want to use this to
filter the documents (language variants with a Language attribute) to direct them through different
paths. To do this:

« Configure your Router to route based on Project Attribute L.anguages.

« Configure your rule to specify Languages (Document)
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Route based on: Project Attribute -
Attribute: BAMT Languages -
[ Case sensitive
Project Attribute Route to Add
:iS - [BAMT Languages (Document)] 1 ~ O BAMT Languages (Document) - Remove
no match | © No Match =
ove Up
|&|
oK l l Cancel l

If your project attribute “Languages” has the the value “English”, the router will select documents
with the attribute (a multi value attribute with values as different languages) that resolves to the value
“English”.

If the document attribute values are English and Dutch, the rule will be evaluated as:

« Project “English”is Document “English” OR
« Project "English"is Document "Dutch"

In this example, the router will direct all the documents with "English" to the first output pin and the
others with "Dutch” to the no match.

Routing on Document Reference Attributes: If you are routing on document reference attributes, the
router will treat it like text attributes. If you have a multi-valued document references, it is possible to
route based on the referred documents. It will route based on the document name of the references.

Routing on Reason(s) for Rejection
You can use the router to redirect the workflow based on the reasons selected for rejection.

The Router workflow node can collect information on the reasons for rejection of a document in any
(every)stage of the approval cycle. You can choose to enable the Handle Reasons of All Stages option
in the Router workflow node. If the option is not checked, the document is by default routed on the
reasons for rejection for the latest approval stage only.
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Router
Route based on:
Reason(s) for Rejection
Handle Reasons of All Stages
Handle Reasons Separately
All rules operate on the string 'reason (@ category’
Reason(s) for Route to
Rejection
contains - Barcode wrong or missing [ ] barcode wrong -
contains - Base Artwork reference incorrect [] Base Artworkr: -
contains - Incorrect Languages [ ] Legal -
contains - Missing Languages [ ] Legal -
no match Error -

You can choose Handle Reasons Separately to ensure each stage is checked against the rules
separately.

Reasons chosen for rejection may be in different categories and you can route the documents
specifically on a particular category of the reason. To do so, specify the rule as 'reason @ category'.

Routing on Document Name

Route based on: | Document Mame =
[] Case sensitive Indude the file extension
Document Name Route to Add
jmmﬁins - .ard [1 jo Design - Remove
no match | Error -]
) Move Up
Move Down

JYNA
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Field list

As an example, use this to...

{ =

Note: Select Include the File Extension
if the entire document name has to be
checked for.

Otherwise, the extension is parsed off
before doing any comparison.

Decide where to go based on naming conventions
of the incoming document.

Your incoming documents will be routed and put
on the right pin based on the name.

Example: If you have three documents “A.jpg”,
“B.jpg” and “C.png” with two rules “contains jpg”
and “contains png’,

« thetwo .jpg documents will be in the output
pin .jpg. These two will follow the workflow
together

« and the .png document will be in the .png pin.

If you are including the file extension, you can
check for types of files using ends with rule.

Routing on Document Attribute

Route based on: | Document Attribute

Attribute: |DC_2_Artwork Draft Approval

[ case sensitive

Document Attribute Route to Add

s | |Yes [1 v |©Yes - Remove

is - | Na [1 ~| | ©HNo -

no match | @ Error - Move Up
Field list As an example, use this to...

All attributes in the system

Decide where to go based on a document
attribute such as "Packaging Type" which can
have values like Label, Folding Carton, Corrugated
Box, etc..

The incoming documents will be checked for the
specified attribute and will be moved to the right
pin based on the first matched rule.

If you route on a multi value attribute of the
document, that document can occur on multiple
output pins(each value is evaluated separately,
which isin line with routing on a multi value
project attribute or task specification.
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Read about using different types of attributes and
441

Routing on Workflow Specifications

WebCenter

SmartNames in Routing on attribute values on page

Field list

As an example, use this to...

All specifications of the workflow task(so not all
specifications in the system).

Decide where to go based on decisions taken
earlier in the workflow and saved in the workflow's
task specifications.

Note:

If you want to see the specifications, you
should add them in the task type.

For example, you can use Set Workflow
Specification node first to set the specification
values and use them in the Router later on in the
workflow.

Routing on Text Content Properties

You can route your Text Content statements according to their Text Content Property.

When a workflow arrives at this node, this step wil

[ filter the statements and documents based on the

Text Content Property and route them based on the rules.

When you select Route based on Text Content Property, you have the following options:

Text Content Status

This is the status of the overall document includin

g the individual language statements. You can route

based on whether the document is in Draft state or is Signed Off.

You can add one Language parameter in the nod
SmartName is used.

DRAFT
Route based on:

Text Content Pronerty '
xt Content Frop Thejroutingjrulejis;

Eield configurediforiMaster,
textielements Routes
are,configuredjfor:

Text Content Elerment Status d

e.Inthis example, the Master Language

r | By

/|5 “
f L "—\l_ LI
[ select Children ’:

' (Document

Language Braftiand|NotDraft
07 (Anyiotherstate) [1
TR Route: to Routing Aftrigute Aftribute -4 Atribute - 5 Attritsute: - 6
based|on
status
5 v F v Draft
: {0 Select Children
{Document
not v o * [1 not Draft = Referance) - 3
no match Eror - =
O - o | @ eyl L O
= L \J
ﬁ Me 2o ©e Ea 4
Start Select Document Assign Document Collate Artwork = Text Completed
Attripute Category Flow
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In the example above, the routing step:

« redirects Draft documentsto Set Document Attribute step.

Text Content Element Status

This is status of a particular language Statement that needs to be selected from language drop down.
You can route based on:

« Draft
« Pending Sign-off
- Sign-off Rejected

« Signed Off

Q a Check Master Lang Status

5 a
'z

X e =
Zeen Route based on: 2 Wigw

Text Content Property v
Field

Text Content Element Status v
Language

English - United States v

Text Content Route to
Proper
Is v Signed OFf v Is Signed Off -
is L Pending Signaff v Pending -
is L4 Signoff Rejected v is Signoff Rej =
no match Error -
i 0K
w - Rouer B,
— 7 hd
o Camglerd

In this example, the Router routes the Signed off elements to the next step, whereas the other
elements are sent back to the editors.

Element Type

All configured Element Types are available and you can create routing rules based on a type. For
example, you can route all Warning statements to Legal Approver.

See the example screen shot below.
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Router
Route based on:
Text Content Property
Field

Element Type

et Content Property

@

no match

-3

Warning statements

Erand name

Acti

ve ingredients declaraticn

Route to
LEGAL -
MARKETING -
RO -
Emor -

WebCenter

You can route documents based on it's Approval Type. Configure the routing rules based on the fields

below.

« Default
« All of Role - One per Group

« One of Role

Invariant

To route documents based on whether translation is needed or not, you can use the Invariant

parameter.

Variant / Invariant
Route based on:
Text Content Property
Fiald

Invariant

Text Content

Property
is v Fals
o= is v True
@
e @ no match

In the example screen shot,

o (il =

Variant

Invariant

Error

T

cno
o— [ o
o B, -]

[ vartant/ mvastani L L r—
P

) \_q._u

oK

« the documents marked as Invariant =True are routed to Completed.

« the documents marked as Invariant =False are routed to the Translation flow.

CampkEa-t
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Use the Stop node to stop the workflow before being completed. When a workflow token arrives at this

step, it stops the workflow.

E Note: The task status will be set as Completed if at least one route of the workflow gets
completed. If none of the workflow routes are completed, the workflow will end in error state.

15.14.8. Statuses

Use statuses node to give the workflow task in the project the desired status. The workflow task can
have any of the statuses defined in the Task Type it was created from.

This means that you need to:

1. think about which statuses you need before creating the workflow,
2. askyour Administrator to create them if they don't exist in the system yet,
3. add them to the Task Type you want to create the workflow from (see Add Task Statuses on page

308),

and then create the required workflow.

If you didn't add any particular status to the Task Type, the workflow will only have the Completed

status node.

15.15. Workflow Example

The example below describes a workflow from the Start node to the Completed state.

Start

(@Y

Cnm plete
Creatlve Brief

briefing DDI'I1 plete

Completed

The Router(in the example renamed as Briefing Complete?)in the workflow will verify if the

briefing is completed.

« ltchecksif all specified Project Attributes are filled out. If it is all completed, the workflow will
continue to the Conceptual Design node.

« If the Project Attributes are not all filled out, a manual task Complete Briefing Data is created and
will be assigned to its assignees.
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« Inthe Conceptual Design phase, the workflow takes parallel paths. When one of the tasks is
completed its token moves to the Data Collector node. The Data Collector node will wait for the two

tasks to complete and send the tokens to the Start Approval Cycle step.

« Depending on the outcome of the Start Approval Cycle step, the workflow moves forward or sends
the token back to Design phase.

(9

Complete Briefing Qo —
e Start Approval Q—‘__j')
e C‘,IDI_EQ

Type: Use default app...

a1

Create Rendering  Data Collector Set Stage2 Completed

Status: Stage 2

Start Briefing o
Complete?
Route on: Project Attribu...

Tag: 1-Complete? @ ()

-y ] Calculate
o Complexity Level

Set Stage 1

Status: Stage 1

Conceptual
Design

When the workflow is Completed, it will show up as completed in the Project > Tasks list. All tasks that
were created during the workflow will show up as subtasks of the workflow task.

15.16. Working with Workflows

Note: A workflow can be started by Administrators, Project Managers and people with the
2= Change Task right in the Project.

The workflow starts when its task in the Project (created from the workflow task type)is put in an
active status (typically In Progress).

15.16.1. Workflow Feedback and Actions

Viewing the Workflow Feedback
You can view a workflow's feedback from Project > Tasks page. To open the workflow feedback page
either:

’ £

hover over the task name and click the Workflow icon.

?‘? Tip: You can use the Edit button to access the Workflow Editor and edit it.

>
ey

or click the Show Active Nodesm and Expand the mini Feedback view.
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PCM Create Artwork Flow_1 (Curre. & X
I_L, In Progress

-
(X]

< 1ef1 >

s@4 Tip:
Show Active Nodes View zooms to the currently active node(s). If there are more nodes use
the Step Through . Read below in Troubleshooting tools on page 452.

Project: PCM Artwork Library Update00001 ([[d Copy Task
e ° Manager: Varghese, Shalet (SKVA)
s Upload Multiple Documents y Customer:
- Due On:
Mail link to . “ Modified: May 9, 2016
More...~ Description:
Documents Tasks @)  Attributes  Project Information  Approval  Members  Security  Configure

Task Information  Specifications  Documents  Checklist  Discussions  Workflow

i o —
Q@ Q @ < 1of 1 ? III s ® © ® S L2l InProgress PCM Create Artwork
Zoom Step Through Mavigation Woaorkflow Contrals Undo/Redo
I_z] In Progess
@O T I .___-—-'-'_i"‘ @ .—'--—_p, ) O———
03
L o Ve | o
St PCM Texd Library Select Document Simple Task PCM Generate Completed
update Flow and Apply GS1
Flow - Master

Note: When the workflow is not running, all controls are disabled.

In the toolbar of the workflow editor, you will see:
« some of the workflow tools,

« controls,

« the status of the workflow,
« the name of the Task Type,
« andview tools.

Read more below:

The following workflow statuses are self-explanatory.

la InProgress
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[=] Workflow Canceled
Workflow Paused

= Created
.4 Completed

E] Workflow Error

Workflow Controls

Use @ to Hold Workflow
Use @ to Resume Workflow

Use @ to Cancel Workflow

Note: These actions can be performed only on Active Workflows.
Read more about Pausing and Resuming a Workflow on page 453.

Troubleshooting tools

Use ~m®to Highlight the Active Nodes and Error Nodes. The workflow fades out everything else.

Use ¢ '3 > toStep Through all active or nodes in error state by zooming into them one by one.

Stepping into Sub-workflows

When you have embedded workflows, you can step into a sub-workflow from a master workflow's
canvas. To do this:

« Right-click on the In Progress

Right-click on the token above the sub-workflow node or on the sub-workflow node itself. Select the
Step into Workflow option from the context menu.

CTRL+Double-click on the token above the sub-workflow’s task node or on the node itself.

To access the master, click on the link from the top right corner of your subworkflow.

Note:

« Thisis only possible when your master workflow is in progress.
« You can use your browser's Back and Forward buttons after you step into the sub-workflow.
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Pausing and Resuming a Workflow
The administrators, project managers and users who can edit tasks can pause the workflow by clicking

the Hold @ The tokens (in a node) that are in progress will be paused after they finish.

E b ] Note: The workflow status will change to in Hold.

To resume the workflow, click the Resume @ button. This control becomes active only when a
workflow is paused. This will move the tokens to the next step in the workflow.

[ ' ] Tip:
You can try holding and resuming to get out of workflow “hangs”.

After resuming, the workflow status becomes the current status.

Cancel a Workflow

A user with task edit rights (Admin, Project Manager and members with task edit rights) can Cancel @
a workflow in progress.

The ongoing workflow tokens will be cancelled and these will be moved to the error pin.

E ] Note:

- Stopping a workflow will delete all the subtasks that are not completed yet.

« The status will change to Workflow cancelled. This is logged in the Project History. A
canceled workflow will always show the task status as canceled regardless what is already
completed. You have to enable Include in Project History > Workflow Canceled to include
the cancellation events in the Project History.

Solving a Workflow Failure
When a node goes into failure, you can either:

« retry the failed node after correcting the cause of failure,
« stop the workflow,

« relaunch(first, correct the cause of the failure) the workflow.

E A ] Note:
+  We recommend you use the Error Handler node for troubleshooting your workflow.
«  When a workflow has more than 5000 tokens (for example documents traveling through

it), it will be canceled and reported in the Project History. This typically happens when the
workflow is stuck in an endless loop.
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Retry a Workflow Node

If you workflow failed due to anissue ( for example a missing approval setup)and you have corrected
the problem, you can retry the workflow.

Right-click on the failure icon (the red ellipse) and right-click again to Retry. Do this after you have
fixed the issue that caused the workflow failure.

Note: The Retry is accessible when the user has Task edit rights

Approval_cycle 1 %

a a @ Tof1 kD@ ®

Zoom Step Through Navigation Waorkflow Controls Undo/Redo

m Workflow Error

L)
L (3]

View

o O AL, e o Je-
o 19 o o o V'
Start [ND Documents] FeUN Error X CAD_design Compled
[No Documents] Task Tm)tnd

The @ remains to indicate the workflow’s history.

Relaunch a Workflow at a Certain Point

A user with task edit rights (Admin, Project Manager and members with task edit rights) can right-click
on any output token with a number and relaunch.

This will re-create a new workflow task that is similar to the task that gets relaunched.
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*Approval_cycle_1

@A Q Q ¢ | No Active Nodes » S ELNIEORECREO) - |

Zoom Step Through Mavigation Woaorkflow Controls Undc/Redo

[=] Workflow Canceled

A
L (3]
View
[ E o 5| @ 5 ® - G
ﬁ % [ ] Yo o @ o a
Sian E Relaunch E“'J" WHPFFH%«!&: CAD_dasgn Comple®d

Note:

1. The workflow needs to be stopped first (see Cancel a Workflow on page 453).
2. This only works for first-level workflows, not for workflows which are already started from
another workflow.

Note: When a workflow is re-launched, WebCenter automatically makes sure that any
dependent tasks will depend on the new workflow task, rather than on the cancelled one.
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16. Packaging Content Mangement in
WebCenter

16.1. Introduction to Packaging Content Management in
WebCenter

16.2.

WebCenter Packaging Content Management offers a simplified platform for creating, translating,
approving and managing text / copy assets.

The Packaging Content Management module offers:

arepository / library for your text content with GS1tagging

re-use of your content across multiple projects

support for a translation based or single language workflow.

export to and import from industry standard formats

ability to view and edit your text in the context of your artwork in the WebCenter Viewer.
a complete approval workflow

established content rights facilitating the ownership at different stages

Working with Text Content

16.2.1.

456

With the right permissions, you can edit, start approval or approve in all the following pages:

Text Information tab. Here you can only view and perform actions on the single text document and
its elements.

In Copy Sheet (Text Document References)attached to an Artwork or a Project. You will have a view
of multiple text documents. You can perform actions on their Master or Translation Elements. Read
more in: Creating a Copy Sheet on page 336.

In a Task Document Rendering. Here also, you can view and perform actions on Master or
Translation Elements of multiple text elements.

In the Viewer Text Content Widget. You can perform the same actions, but you can use viewer filters
to filter text content. Read in: Viewing Text Content

Text Document Details

When you click on a Text Content Document Type icon, the Document Details will have the Text
Information tab with the following sub-tabs:

Text Content

Role Mapping
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« Compare
Text Information Decumnent Information Approva Action History Annotations Projects Attributes Ti
Content  Role Mapping  Compare
Preparaticn instructions = M: SEEE T (] G
Master Text
£ English - International
Q2
BE English - United States
Q
@
L]
Translations
B Dutch - Belgium
Q2
11 French - France
Q2

» Show languages which are not part of the Project.

Text Content Tab
The Text Document > Text Information > Content tab displays all the content of the document along

with its classification and languages. To Configure Content, click on the ﬂ‘ (gear)icon to expand and
view the following info:

+ Element Type
« Approval Setup
« Type of Text

« SmartText Search

+ Auto Suggestion
« Allow only Single SmartText
+ Allow Inherit content
+ Inherit Content from
+ Character Limit

« Invariant or not

{ = Note: When you (as the Content Manager) change the text type, the Text Statements
= affected by this change will be put into Draft status.
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« Languages: The Master and Translation languages will be listed here. You can see the language
flags and the respective names. You can customize the language flags by following the steps given
in the WebCenter Customisation Guide.

Note: If the language selected is typed from right to left like Hebrew or Arabic, the text is
displayed or edited right to left.

Content  Role Mapping Compare
Packaging claim M: =& T: BHI+1
Element Type Packaging claim - Master ;:.Ei English - International
Language
Approval Setup All of Role - One per Group -
Translation  |f Jj Dutch - Belgium
Text Type SmartName - Language I"I Erench - Canada
SmartText Search PCM Text Content Library Search -

[C] Enable Auto Suggestion

[ Allow only Single SmartText

[] Make this an Invariant Document
Allow Inherit Content

Inherit Only SmartText

Inherit Content English - International -
from
Character Limit 100

Read more about the concepts in: Basic Concepts.

Working in the Content Tab
You can perform Text Content related actions in this tab if you are a Content Manager / Editor /
Approver or Add Language permission. You can perform the actions for which you have permissions
enabled.

If you are a Content Manager, you can do the following:

« Select the Element Type of the Text Document.

Note: The Element Type drop down is configured as a List and is only editable by Content
Managers. The regular users can see only the specific Element Type of the document as a
label.

» Select the Type of text: Text can be Simple, Rich text, or Smart Name. When you choose the text
type as a Smart Name, you can view the SmartText Search field.

« SmartText Search drop down displays all the saved searches for the text content document
type. This field is optional and can be left blank. Read more in Create Smart Text in Text Content
on page 460.

You can resolve the Smart Content (containing both SmartName and SmartText) by clicking -
or saving the document.

» Enable Auto Suggestion: Suggested existing text content is shown, while you type the text
content. This option is enabled only if SmartName is chosen as the Type. When you are trying
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to add text, the suggested text is visible as a tooltip for exceptionally long text statements
for accurate selection. Auto suggestion texts are taken from the results of configured saved
search.

+ Allow only Single SmartText: Restrict to allow only one SmartText in all of the languages
present. This option can be used when you have to restrict the content to a Smart Text like a
value (weight in grams).

« Make this an Invariant Text Document: Enable this, if translations are not required for a
particular Text Document. For example, Brand Names.

Text documents can have only one master language, when the document is marked as invariant.

Note: Invariant content which existed prior to 18.1and has more than one master
language, will become non-invariant.

« Allow Inherit Content : You can choose to either follow the Master Language or Default to the
element type choice or choose None.Read in detail about this option here.

« Character Limit: You can set the number of characters that are visible in the widget. Warning
message will be displayed if the limit set is exceeded.

« Define the Approval Setup:
« Default: Only one member has to approve. For example, if the Approver permission is assigned

to two Roles, only one member (from any Role) has to approve.

« Oneofrole: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member
or user from that Role can approve.

« All of Role - One per Group : At least one member from each Role-Group has to approve. If there
is an individual User, then he or she has to approve as well.
« Addor Delete Master and Translation Languages

This list will contain the document's selected languages. You may have more languages to add from
if they are present in the Project's Attribute Category.

If you are an Editor or a Content Manager with Editor permissions, you can

« Modify text and save changes

« Edit content and start Approval in the text widgets if you are an Editor. Read in: Editing Text
Statements and Starting Approval on page 471.

« Start Approval or change the status back to Draft.

An Approver can:

« Approve or Reject Text Content

« Addnew Comments as an Approver/Editor

A user with Add Language permission can add specific languages for which permission has been
assigned.
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E ] Note:

« Itisimportant to click Save after every action to save changes to the status element. A new
document version is created after each Save action. You can view these changes in the
Document's Action History page.

- The older versions of the Text Content Document are displayed as read-only (even when you

have the right permissions). To Reload latest version, click 0

: [ ( ] Tip: There is no direct way (even as the Content Manager) to change the status of
the Signed Off Text Documents. Only an Admin user can make this change.

Create Smart Text in Text Content

Smart Text can be created for text contents which are reused frequently. The referenced Smart text
content may be within the same project or could be in multiple projects.

Changes made to the referenced text content in any one of the project, creates warning message
wherever the document in referenced in other projects. Although the text content is updated, the
approval of the text content has to be done in each project. This allows flexibility to retain the old
version of the text content or to update to the latest version.

Getting Started with Smart Text
Ensure you have a:

« Saved Search configured with text content which is chosen as a Reference Source.

«  Document reference attribute named SMART_TEXT_REFERENCE added to the text content
document.

Add Smart Text by Clicking

Smart Text can be created by any user with Content Manger or Editor Permissions.

When user clicks on % icon, configured Saved Search results chosen in SmartText Search Field is
shown to the userin a pop-up.

User can select one or multiple Text Content documents to add. Selected documents are shown as
Smart Text in the Text Content editor. If saved search is not configured, or Reference Source is not
chosen, then Smart Text cannot be added.

Add Smart Text by typing text in Text Content editor

Select Enable Auto Suggestion to get prompts automatically when you type in the text content box.
Minimum of four characters should be typed for the search to be performed. You can choose any one of
the text content from the list of suggestions shown. Selected Text Content is shown as Smart Text in
the editor. Auto suggestions are not shown, if no matches are found for the text keyed in. You may add
any number of Smart Text in the text content editor.

E b ] Note: If saved search is not configured, then auto suggestions are not shown even if the
Enable Auto Suggestion is selected.

Editors or Content Managers while editing an existing Content Sheet or an Attribute category or
creating a project, may want to add a text statement that is not available in the text library.
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A new text statement can be created on the go in the same page, and it is instantly added to
autosuggest and creates a smart reference even before saving the page.

Resolve Smart Content

The Language statement’s smart text will be resolved automatically on save of the document.

Alternatively you can also click - to resolve the Smart Content that are added to the text content
editor.

E b ] Note: When Smart Content gets resolved in any language, other statements following that
language are resolved automatically.

For Example, if French and Dutch languages are following English language text, while resolving
English both French and Dutch language contents are also resolved.

Warning messages will be displayed when the Smart Text:

« added areresolved and it contains no text

« isemptyorisbroken

« characterlimit set is reached

« isnotresolved although the user has permissions

« arenot of the latest version and reference is made to an older version of the text document. You can
click on the Smart Text, where the user can optionally update to the latest version.

Copy Smart Content
SmartText Language

When a SmartText is added, by default current language is selected for the SmartText. You can change
from current language to any of the Master or Translation language by clicking on the SmartText pop up
window.

A'language inherits content from another language:

« |fthe source language in the SmartText language is configured to current language, then the
inheriting language will get content for its own language

« If the source language SmartText language is configured to a specific language, then the inheriting
language will get the same content of the source language

Approve Smart Content

Smart content has to be resolved before the element is approved.

Delete Smart Text

You can delete Smart Text in the text content editor. On save, the text content is removed from
Document Reference attribute also.

Smart Text pop-over
You can click on the SmartText to view the referenced content in a pop-over.
Pop-over contains the following:

« View of the referenced text statement
« Text Document Name along with the Version
« Project Name where the referenced text statement is present
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« Language selection dropdown, which allows you to change the SmartText language to any of the
languages available.

You can select the languages available in the referenced text statements even though the language
may not be available in the current project.

Added Sugars PDV

2 P

M Variant Project:
TextContentl.wce (1) TL_WCR_15401_Update Text Pro...

Select a language |
Low mineral content (old) "t anguage
aster Language
English - International
English - United States
Translation Language
Dutch - Belgium
French - France
Additional Statement Lang
Italian - Italy

Current Language

« Warning message if the referenced text is not the latest version and an option to Update to Latest.

M Brand name
Brand Name.woc (86)

| *
ncura-:old 65 Q

Project: PCM-NFT English - United States - X

Waming! This reference is made to an older version of the text document. Update To Latest

Note: You cannot revert back to the previous version if you update the referenced text.

Editing Smart Reference in popover

When you click on a smart reference, a popover is opened to show the used smart reference text. The
referenced text can be edited provided you have the permission. You can then either save the changes
or cancel.

A new version is created for the referenced statement with all the changes made.
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55 English - International
W Packaging claim Preject: mjn_porm_test Cument Language -
Translations »
B8 Dutch - Belgh B Marketing copy Project Current Language - X
ULTIMATE SOURCE D
OF ELECTROLYTES E
11 French - France
1 Content has changed since last Save m cancel

When Latest Version is selected, then the current statement is resolved automatically and you can
save the document. When Selected Version is selected, then along with save, referenced statement is
also be updated to latest version automatically.

Any change made at any level of the smart text reference, has to be saved at the same level and also in
all the levels further.

16.2.2. Role Mapping Tab

Role Mapping

This tab displays all the permissions enabled in the Text document.

In Role Mapping page of a TextContent/TableContent document, Role field contains SmartName
support. The supported SmartNames are Language code, Language description and Responsible
values from the permission row where the role is configured. In preview mode the SmartNames will be

resolved and mapped with the corresponding Roles.

Content Permission €9

EDITOR

EDITOR

EDITOR
APPROVER
APPROVER
APPROVER
ADD LANGUAGE
ADD LANGUAGE

ADD LANGUAGE

Language

£ English - International
B Dutch - Belgium

11 French - France

&= English - International
g1 Dutch - Belgium

11 French - France

£ English - International
I 1 Dutch - Belgium

i 1 French - France

Role

GLISH -IN TERNATIDN
5 LANGUAGE DUTCH - BELGIUM EDITOR
25 LANGUAGE FRENCH - FRANCE EDITOR

Prefix‘and Suffix'in Role Names

2= LANGUAGE DUTCH - BELGIUM APPROVER

2= LANGUAGE FRENCH - FRANCE APPROVER
8- LANGUAGE ENGLISH - INTERNATIONAL ADD
27 LANGUAGE DUTCH - BELGIUM ADD

27 LANGUAGE FRENCH - FRAMCE ADD
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In this tab, you can see:

« the Content Permission

WebCenter

Note: Content Manager is not associated with any language.

- the Language relevant for each permission. For the Editor and Approver permissions, the language

is listed.

« the Role assigned to each permission. The roles will be links if you are a Project Manager or an

Administrator.

Note:

« The Roles list will have links only if these roles are invited to the project and exists in

WebCenter.

« If you do not see Roles as links, check if you are looking at the latest version of the
document. In older versions, this data will be read-only.

« the Assignees (Groups or Users) assigned to a particular role with a certain permission.

16.2.3. Compare Tab

464

You can now compare different versions of the same document in the Compare tab in read only mode.
This allows you to view the differences between two selected versions of the same text content

document.

You can navigate from Document > Text Information > Compare . This tab is divided into two parts
where, two versions of the text content document is shown side by side. By default, left side block
is loaded with the current version of the document and the right side block is loaded with previous

version with clear indication of differences.

Note: If the document has only one version available, then the right side block is empty.

Document: Ingredients Declaration.wce

& Mail link to

Q Open -

o | HGREDIENTS
DECLARATI
Meeo | om—

Text Informasion

Description:
Projoct: F

5 Compare

% Show only differences

Ingredients declaration

# English - United Stares

RW g ik, sugar, pocoa bustes full cream mik powrder, almonds, lecithin, vanilla and cocoa.

B Dutch - Belgium
®

18 French - France

@) Laiz sucre, bewrre de cacac, lalt entier on powdre, smandes, lecithine. vanills ¢t cacao.

™ Gacman - Garmany

Miilch, Zucker, Kaksobutter, Volmilchpulver, Mandsin, Lecizhin, Vanille und Kakac.

L I

Ingredients declaration

I(av)

& English - United Stanes

Wik, sugar, cocoa butter, full cream ik powder, coooa liquor, lesih

Veersion Mumbes: 9 (Mas 1, 2018 st 318 PM)
Veersion Author! Sharma, Pankaj

Version Comment. Added [de-DE] INGREDIENTS DECLA_

helk, suiker, cacaaboter volle melkpoeder, lecithine, vanille en cacac.

B French -France

Qi

Lait, sucra. beurre de cacac, lak entier on poudre, liguedr 6 cagan. kcthine, vanilla & cacao Qi

™ German - Germary

©

A drop-down is provided on the header of the both blocks to change the version of the document to
compare. Navigation arrows are provided to go to the next or previous versions of the document.
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Hovering on the drop-down option or on the navigation arrows displays the Version Number along with
the modification date, Version Author, and Version Comment in a pop up window.

You can expand to view the content properties by clicking on the header and both versions are shown
simultaneously.

Selecting Show only differences option shows only the languages which have some difference in the
text content and languages not having any differences are hidden.

When a language is not added in one of the compared version and is available in the other version, then
the language widget is shown as not added.

{ . Note: Compare is done only on the content of the two versions of the document and not on the

' settings.

16.2.4. Managing Text Permissions

Ensure that:

« you have invited the right Roles in your Project or Template with the Text document.

» you have added the Master and Translation Languages to the Project's Attribute Category to
configure Language specific Editor and Approver permissions. It is important to do role mapping in
a smart way.

» you have enabled the right Preferences.

If you are a Project Manager / Admin, you can manage and assign content permissions.

{ ' Note:

]
A user without any of these permissions can only view (depending on the view permissions) the

text content documents.

1. To manage Permissions, go to the Document details > Text Information > Role Mapping.

When you click on a Text Content Document Type icon, the Document Details will have the Text
Information tab with the following sub-tabs:

» Text Content
+ Role Mapping

« Compare
2. Click on Manage Permissions. This will open up the Role Mapping page.

3. Click Add Permission. Repeat this for as many permissions as you want.

465



ESKO

WebCenter
Content  Role Mapping  Compare

Content has changed since last Save. m Cancel

For each Content Permission, select the Language. If the [ALL OTHER LANGUAGES] opticn is selected under Language,
SmartMame is applied automatically to derive the Roles (if Role is not selected).
Click here to Manage Roles

Content Permission Language Role
CONTENT MANAGER - PCM_CONTENT MANAGER - X
EDITOR - [ALL OTHER LANGUAGES] - PCM_CONTENT MANAGER - X
AFPPROVER - [ALL OTHER LANGUAGES] - PCM_CONTENT MANAGER - X
ADD LANGUAGE - English - International - PCM_LEGAL - X
ADD LANGUAGE - Dutch - Belgium - PCM_TECHNICAL - X
ADD LANGUAGE - French - France - PCM_CONTENT MAMNAGER - X

4. Choose the Content Permission from the drop-down listing:

. Content Manager
- Editor
« Approver

« AddLanguage
5. Forthe Content Managers permission, define the appropriate Role.

Read about the permissions below:
1. CONTENT MANAGER:

The WebCenter Role with this permission facilitates the entire content management process
to ensure accuracy and compliance. For example, the role Marketing could have this permission
where the Marketing has the responsibility of the packaging content. The Content Manager will
manage the Master and Translated statements.

Note: The Content Manager Role is not associated with any specific language.

This role will manage all the permissions and the settings for the current document.

. Note: Content Manager Role cannot act as an Editor or Approver unless this permission
“=% jsgranted to the same role.

2. EDITOR
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The Content Manager typically assigns this right to the dedicated roles who will create, edit,
revise or translate the text. This can be assigned per language.

An Editor Role (for example, a Translator) can edit when a document is in the Draft state, not in
Signed-0ff or Pending Sign-off state.

If the Editor also has Approver permission, then the documents are directly moved to Approved
state instead of pending sign off.

Note:

« The Content Manager Role has to configure the list of translation languages to make
use of multiple language based Editor permissions.

« You can configure Roles for all languages to which the content should be translated
and grant them the Editor permission.

3. APPROVER: A Role with this permission can approve the text content. This permission can also
be configured per language. The approver puts the Text Statement to Signed-0ff or Rejected
state.

4. ADDLANGUAGE:

Any user with Add Language permission can add language to a text or table content document.
The users can be assigned with permission to add only specific languages.

Content Permission Language Role Assignee(s)
COMTENT MANAGER PCM_CONMTENT MANAGER MRJN
EDITOR g English - International PCM_CONTENT MANAGER MRJN
EDITOR #= English - United States PCM_COMTENT MANAGER MRJN
EDITOR g 1§ Dutch - Belgium PCM_COMTENT MANAGER MRJN
EDITOR 1 I French - France PCM_CONTENT MANAGER MRJN
APPROVER g English - International PCM_CONTENT MANAGER MRJN
APPROVER #= English - United States PCM_CONTENT MANAGER MRJN
APPROVER p1 Duich - Belgium PCM_CONTENT MANAGER MRJN
APPROVER § i French - France PCM_CONTENT MANAGER MRJN
MRJN

ADD LANGUAGE

g English - International

PCM_LEGAL

MRJMN_USR2

. _ MRJN
ADD LANGUAGE Dutch - Belgium PCM_TECHNICAL '

L g - - MRJN_USR3
ADD LANGUAGE g § French - France PCM_CONTENT MANAGER MRJN
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. Note: You may choose to give more than one permission to a Role. For example, the
“=% Content Manager can have Editor and Add Language permissions as well.

6. Define the Editor permission and assign it to a role. Select the corresponding Language from the
drop-down.

You can automatically create Editor and Approver Roles for all languages in one go. Read about
Smart Role Naming on page 469. To do this for the editor permission:

a) Make sure that the Admin preference section has the right Prefixes. Read here.
b) Next to the Editor permission, select All Other Languages.

Content Permission €9 Language Role

EDITOR & English - International GLISH - INTERMAT IDN
EDITOR § 1 Dutch - Belgium 25 LANGUAGE DUTCH - BELGIUM EDITOR

EDITOR 1 I French - France 2= LANGUAGE FRENCH - FRANCE EDITOR

APPROVER g English - International Preﬁkl’—'ﬁid\.gﬁﬁﬁﬁn Role Names

APPROVER 11 Dutch - Belgium 2= LANGUAGE DUTCH - BELGIUM APPROVER
APPROVER 11 French - France 25 LANGUAGE FRENCH - FRANCE APPROVER

ADD LANGUAGE £ English - International 2 LANGUAGE ENGLISH - INTERMATIONAL ADD

ADD LANGUAGE B Dutch - Belgium 27 LANGUAGE DUTCH - BELGIUM ADD

ADD LANGUAGE 1§ French - France £ LANGUAGE FRENCH - FRANCE ADD

7. Define the Approver permission and assign it to a role.
Select All Other languages to create Approver roles with default names in one go.

Note: You can configure Editors and Approvers individually for some languages and choose
=== the Smart Role Naming for the rest of the languages by selecting All Other languages.

8. To edit Content Permissions, click Manage Permissions and edit or change the assignment of a
permission.

« The Role Mapping page will list all the Content Permissions, respective languages, Roles and their
assignees (individual or Group).

The Roles will be clickable if they exist in the system and are invited to the Project.

» The Master Language of the Project will be highlighted in bold.

If you would like to give content editing and approving permission during Project Creation, assign
Editor and Approver permission to the REQUESTOR role.

For example,if you assign Editor permission to the  REQUESTOR role, the Editor can draft the text
during project creation.

2 BO, Manager (BO_MANAGER)

ish - Uni L] IEQUESTOR .. . \
EDITOR ge English - United States 8 REQUESTOR ‘s, Keizer, Debbie (DEKE)
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Warning: During a Project's creation, you can assign another user as the Requester. If this
happens, the permissions defined for the REQUESTOR role does not get transferred. In this
scenario, some updates done during the Project creation may be lost.

Smart Role Naming

When your content workflow contains translations into different languages, you can have Editor

and Approver permissions assigned to Roles (text authors/editors and approvers such as legal or
marketing) associated with these languages. To automate the naming of such Roles, you can specify
prefixes for these placeholder Roles.

Content Permission €3
EDITOR

EDITOR

EDITOR

APPROVER

APPROVER

APPROVER

ADD LANGUAGE

ADD LANGUAGE

ADD LANGUAGE

Language

g English - International
§1 Dutch - Belgium

11 French - France

Z= English - International
g1 Dutch - Belgium

11 French - France

gl English - International
g1 Dutch - Belgium

B 1 French - France

Role

GL]SH SN TER‘NATIDN

25 LANGUAGE DUTCH - BELGIUM EDITOR
25 LANGUAGE FRENCH - FRANCE EDITOR

Prefix‘and'Suffix'in Role Names

25 LANGUAGE DUTCH - BELGIUM APPROVER
2= LANGUAGE FRENCH - FRANCE APPROVER
2 LANGUAGE ENGLISH - INTERNATIONAL ADD
7 LANGUAGE DUTCH - BELGIUM ADD

7 LANGUAGE FRENCH - FRANCE ADD

The names of the Roles will have the specified prefix and Suffix (In the example screenshot, Language
Editor) and the respective language code.

16.2.5. Adding and Deleting Languages in a Text Content Document

Go to Projects > Attributes page and assign the Master and Translation Language Attributes. This will
make them available in your Project's text documents.

In the Text Content Document Details > Text Content tab, you can view and add / delete the Master
Text Language and Translation Language(s).

It is also possible to view, add and delete these Languages in the Copy sheet view. Read also: Creating a
Copy Sheet on page 336

Note: You can add or delete this only if you have Content Manager or Add Language
=% Permissions.

- Toadd alanguage, hover over the blurred flag indicators and click + on the flag image to add a
language.
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The languages that are added in the list have clear flags. Only four of the selected Translation
Languages (Flags)are displayed. Click on the ellipsis ... to view the expanded list of the other
selected languages and “# to collapse the list. Languages are displayed in the order of the
Language Index specified in the language list irrespective of the sequence it has been added.

« Hover over and click x on the flag image to delete a language. You can add or delete multiple
languages in one go by clicking multiple language flags.

« Inthe basic view, to delete alanguage of the text content from either the master languages or the
translation languages, click on ellipsis

After deleting a language, you get * icontoadd the language again in basic view. Similarly in

attributes, if the translation languages is not added to the text content, then *is displayed. You
can also add back the language by clicking twice on the widget.

« Todelete alanguage that is not present in the Project Attributes, and is available in a text
document, click W.

The language is marked for deletion in the element status. Click * to revert the action.

Ensure that you save the modifications.

Content  Role Mapping Compare
Packaging claim M: = T: B+
Element Type Packaging claim - Master % English - International
Language
Approval Setup All of Role - One per Group -
Translation | |j Dutch - Belgium
r - Language
Text Type SmartName quag Jof French - canada
SmartText Search PCM Text Content Library Search -

[} Enable Auto Suggestion

[CJ Allow only Single SmartText

[] Make this an Invariant Document
Allow Inherit Content

Inherit Only SmartText

Inherit Content English - International -
from
Character Limit 100

Adding any of the available languages is possible based on permissions on all text content in the page
including documents that are from other than current project. Similarly, it is possible to remove the
language when it is added recently but not saved.

The following conditions apply when you delete Master Text Languages:
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Note:

« If only one Master Text Language is present, it cannot be deleted.

« Iftwo or more Signed Off Master Text Languages are present, then any one of them can be
deleted. But if there is only one Signed Off, that language cannot be deleted.

« If none of the Master Text Languages is Signed Off, then any of them can be deleted.

« Alanguage can be deleted even if the Text Content document is linked with multiple
projects.

16.2.6. Editing Text Statements and Starting Approval

Editing Content
With the Editor permission:

«  Youcan edit adocument in Draft state.

« Auto-Approve. If you are assigned the role of an Editor and an Approver, you can approve the
content you created immediately.

Approving after Editing (Auto- Approval)
For example, Marketing can create and approve Master Text of certain statements. Essentially, you can
skip Start Approval and Approve actions. To do auto-approve:

« Hover over Draft state next to the Text widget. You see options to Approve or Start Approval.

« Approve and Save. The document statusis now Signed Off.

ONE-A-DAY 56 TABLETS Q
Al INSTRUCTIONS
ﬁn:"' Adults: Take only one tablet ©)
every day. Do not exceed the 7

Note:

If saving fails, check if:

« your Editor permission is revoked.
» thereisany conflict from another user regarding content update.

You can Start Approval by clicking o (even after you auto-approve).

Note:

« You cannot Reject, when a document is set for Auto approval.

- You can auto-approve from all the pages where you have the Text widget (Text Document
Details, Task Execution Page, Document Attribute Category, Project Attribute Category,
Project Creation Page and Viewer ).

Starting Approval or Reverting to Draft

Hover over Draft status to view and click Start Approval to kick start the approval process.

4N
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ONE-A-DAY 56 TABLETS Q
INSTRUCTIONS
Start

Approval @

To put the status back to Draft, hover and click the Revert button.

When you save, the status changes to Draft.

Note: After starting the approval process, users with Editor permission can revert the status
2= back to Draft.

On clicking on the Reject button, the element will be marked for reject and the Approve/Reject/
Revert to Draft button will disappear and replaced with a Revert button. Content won't be
editable, even if user has editor permission for this statement.

Approval Information

You can click on the Approval Info icon for a Text Content element, and it opens a pop-up which
displays approval cycle information.

Master Text

Click to get the
pop up window

=8 English - United States

REFRESHMENT WITH ZINC & CHROMIUM

Approval Overview for English - International

B Contact infoermation

One of Role
Revert to Draft ADMIN, [ADMIN) Jul 17,2018 at 11:40
(", Start Approval ADMIM, (ADMIN) Jul 18,2018 at 15:14
+ Approved ADMIN, (ADMIN) Jul 18,2018 at 15:14

This pop-up window provides information on

» Language on the header
« Element type
« Approval type
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« Approval Information along with user details and date of the action.

16.2.7. Approving or Rejecting Text Statements

Approving Text Content Statements
To Sign-off text statements(as an Approver), hover over the Pending SignOff icon next to the Text
statement and Approve. When you save, the status changes to Signed Off or Pending SignOff (You
Approved) when there are more approvers.

G‘; OME-A-DAY 56 TABLETS o
el INSTRUCTIONS
M Adults: Take only one tablet 0]

[T every day

You can revert your action (before you Save) by clicking Revert .

Note: Once Signed Off, you cannot makes changes to the text content or the text status.
Translation languages can be edited even if the master language is not yet signed off.

Rejecting Text Content Statements

To Reject, hover and click . When you save, the status changes to SignOff Rejected.

If there are more approvers, status remains Pending SignOff (You Rejected) until all Approvers
approve or reject.

ONE-A-DAY 56 TABLETS o

Adults: Take only one tablet @
every day

Note:

If the Admin user has enabled Required password for Approvals/ Rejections in Preferences,
your Approve/Reject actions requires a password.

Other tools

@ View the Approval Overview. It will show

« The last updated state along with the date of change done with the user
associated with the change

- Element type and Approval Setup ( All of Role, or One of Role or Default )

» Language for which approval was done
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Approval Overview for English - United States

MW Packaging claim
Default

(C, start Approval Bakshi, Sourita (SOBK) Nov 30, 2018 at 12:50
«/ Approved Bakshi, Sourita (SOBK) @) Nov 30, 2018 at 12:50
® View the comments associated with a text statement. It allows you to view earlier

comments and also add a new comment.

@) Adds a new comment. This button indicates that there are no comments. Clicking it
enables you to add comments, to hide and show existing comments.

Note: In case the user has delegated the tasks, any comment updated by the
delegate will mention the same.

16.3. Text Document Actions

You have additional Project Documents Actions for Text Documents. These actions allow you to

« Export text documents
« Import XLIFF files
« Copy documents with their Approval State

16.3.1. Importing and Exporting Text Documents

Export and Import XLIFF

You can export your text documents to be translated into XLIFF files. Once translated, import the
XLIFF files back to WebCenter.

Project: VIKR_TEMPLATE_PROJECT = [[EiN
N o Manager: viks, viks (VIKR)
& f

Customer:

: Upload Multiple Documents TG
= Mail link to. Modified: May 30, 2016
Description:
More...~
Documents € | Bl Of Matecials €@  Tosks )  Discussions ()  Attributes  Projectinformation  Approval  Notifications  Member
s % ISR ooV | Dot | § Dt Dcument) | Morer

[ Project Documents &) Documents €3

@ sswn VActive Ingredients Declaration Kelloggs General.wee: (1.2x8)

iz, Active Ingredients Declaration Kelloggs General.wee: (2.2x6

..... Allergen Statement Kelloggs General.wee (1365)

[ B Add 1o Bil of Materials
susemy  Assembly Instructions Kelloggs Generalwee: (4.k8) XUFF

& Export to XLIFF
& Export to GS1

How to Export to XLIFF from a Project:
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« Select the Documents and click Export to XLIFF in the Actions menu or bar.

Note: You may have these actions in the More drop down menu depending on your menu
&= configuration.

» Intheresulting Export to XLIFF pop-up, select Source Language and Target Language and click
Download.

« There are other options which can be selected.

Export to XLIFF

Source Language *

English - United States -

Target Language *

—select language— -

# Export Statement(s) only if the Master is signed off

Export Statement(s) only if Target language is specified in
the Document

Export Statement(s) only if Target language is not signed
off

- Export Statement(s) only if the Master is signed off By default this option is checked. When
checked all the text statements which are signed off are exported and other statements are
ignored.

- Export Statement(s) only if Target language is specified in the Document By default this
option is unchecked. When checked only the text statements that has translations are added
and rest of the text statements are not exported.

- Export Statement(s) only if Target language is not signed off By default this option is
unchecked. When checked, only that statement for which translation language is not signed off
is added to xliff file.

Note: If there are no text content documents to export to XLIFF, then a warning
== message is displayed that No text content document(s) available to Export to XLIFF

The downloaded file contains the approved source language text and an empty statement of the target
language. Comments added in the text content document will be exported to XLIFF file.

To Import XLIFF files after translation:
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« Click Import XLIFF in the Actions menu or bar. Click Browse to select the file for importing. The
translated XLIFF file are added to the corresponding Text Content Document(s).

«  When you import the XLIFF file, you can directly Approve Translation by enabling the option.

« You can view the XLIFF Import Report which gives the status of the import. If the import of the
document(s)fails for any reason, then the reason is updated in the Warnings column.

« Any new comments given during translation can be viewed in the XLIFF Import Report.

Note: When you configure translation Workflows, you can use the Export and Import XLIFF
content nodes.

16.3.2. Exporting to GS1XML

You can download a GS1XML file containing all the content documents (Dynamic Content) including
text, table and Artwork files. In the Artwork creation process, this GS1 XML file can be sent to the
designer to place the content on the artwork in Adobe lllustrator with Dynamic Content. The Dynamic
Content plug-in will match the placeholders in the artwork with the GS1XML content.

Note: Any User with download permissions will be able to generate and download GS1 XML
content.

Generate GS1Export function supports below Text or Table Content and Artwork file types.
To generate a GS1 XML, follow the steps below:

« Gotothe Project where the artwork or Text content document(s) or Table document is stored and
select the document to be exported

« Select Actions > Export to GS1.

« |fthe selected artwork document contains reference property filter values either at the Document
Attribute level or at the Project Attribute level, then the Export to GS1pop up window display the
filters, from which you can select the Reference Property filters and Languages along with Locale.
Reference property filters are used to filter the content to be downloaded to the XML format.

« Choose Include Empty Content in GS1to view all the elements in the table document else only
elements with content are exported.

« Thelocale mapping values are pre-populated from the Document or Project attribute in the pop-up
window, which holds unique values and these values are editable. When the locale mapping is not
available in both the Project or in the Document attributes, then you can manually provide locale
mapping and locale value will start with zero. Order of priority to pick locale value is Document
attributes followed by the Project attributes.

- Specify the Target Language (one or more)in the Export to GS1pop-up window.

The Target Language drop-down lists the master and translation languages specified in a project.

Note: If the project does not have specified language attributes, this drop-down then lists
the system wide language lists (Master and Translation).

« Click Download.
The GS1XML will contain the dynamic content of the specified Target Language(s) including:

« the approval status

« thelnstance Sequence value
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{ = Note: If the instance sequence number is not available, then unique instance sequence
=% s auto generated and exported. When a GS1document, if the referenced documents have
EXPECTED_NUMBER_OF_OCCURRENCES (hard-coded) reference property, then the
GS1 file will export this data for every dynamic element (Text Content, Table, Bar Code,
Graphics). If this reference property is not available, then GS1will have “1” as value for this
field.

« The generated GS1 XML will include only content for which the user has read permission.

In18.1release we worked on "EXPECTED_NUMBER_OF_OCCURRENCES" while exporting to GS1
XML. But in that documentation we didn't mention what should be the value (format) so while
exporting, right value is exported.

The value of this field should be JSON format {"locale_Id":"value”} where locale_id is the mapping
integer to language. This locale_id should be same as what is used when we export to GS1.

16.3.3. How to get Attribute Category Report for Text Content

You can get a report of all the attributes present in a Project or in a Document Attribute Category.
Attribute Categories report can be downloaded and accessed by any users who has the permission and
the Admin user has configured the report and uploaded it. Read more about it here.

Users who have access to the report, will have the report icon in the Attributes page of the Document
or the Project. Labels defined to the attributes while creating are shown in this report for all attributes
except the document reference type.

477



ESKO

WebCenter

Note: If the attribute name is derived from SmartName or if internationalization is done for the
2= attribute, then the label name is not considered and only the attribute name is shown.

While generating the report you can further filter the report based on the languages and the
reference properties.

Download Attribute Category

Report
mrjn_pcm_scope(D) EXCEL

Languages

PCM Scope Flavour
PCM Scope Size
PCM Scope Output

Spring
Winter

Cancel

To know more about configuring Attribute Category report, read this section in the Admin Guide. An
example Attribute Category report is shown below.
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Master Text

PCM Table Reference

Document Name

Instance Text

Last Modified

Content_0001687.wtc
Nutrition facts

PCM Text Reference

Document Name

Instance Text

Last Modified

Content_0001692.wcc

Active ingredients declaration

958 Coconut And Berries

4/21/20 12:44 PM

Content_0001673.wcc
Additional product variant
information

1 Create new document
Update is being Done
Be careful, you'll have to join the Avengers

5/8/207:23 PM

a Content_0001674.wcc 1 ENERGIES DRINK ; IMMEDIATE 3/10/20 6:01 PM
Product features SUSTAINED
ENERGIES ; ENERGIES DRINK
ENERGIES DRINK
ENERGIES DRINK
B®  content_0001675.wee 1 100gm 3/3/203:12PM
‘=== Net content statement
a Content_0001676.wcc 1 ENERGY DRINK!! 3/2/203:18 PM
Packaging claim

16.3.4. Copying a Document with Status

You can copy a Text Content Document to another project along with their status.

When you select one or more documents in a Project (Signed Off, Pending Sign off..) and choose Copy
Documents(s) Action

« You have the option to Copy Text Content Status. If you do not select this, the copied document will
be in Draft state.

Project: VIKR_TEMPLATE_PROJECT 1 (29

Copy Document(s}

Manager:viks, viks (VIKR)
Customer:
Due On:

°
] Modified: May 30, 2016
Description:

Selected Document(s)
1 Active Ingredients Declaration Kelloggs General wee
® Copyinside the current Project

Copy to other Project(s)

Show Projects

Copy Text Content Stetus

Copy Viewer Annotations

Rename Document

1 Active Ingredients Declaration Kelloggs General.wee

# Destination Projects

1 VIKR_TEMPLATE_PROJECT
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If you are copying from the Document Details Page, you can:

« Enable or disable the Copy Text Content Status option. If this is disabled, the copied document will
be in Draft state.

Copy Document Administration route.wecc

If you are copying the Text Content Document in Attribute Category or Task execution Page, you can:

« Enable or disable the Copy Text Content Status option. If this is disabled, the copied document will
be in Draft state.

(f ’ Note: User must have the following permissions on the target folder for the copy to succeed:
« View and Download on the source folder
« Add
» Lock Document
« Change Properties

16.3.5. Preformatted Text

When you copy a Smart Text type Text Content document from any deep copy configured document
reference attribute, all the attributes are also copied. These Smart Text can be modified immediately
by opening Smart Reference popover. The popover shows no Save button, but an OK button. To save
click the document table Save button. The text changes will be reflected immediately in deeply copied
smart references.

16.3.6. Smart Reference language change effect on inheritance

When you change the language of a Smart Text in the Smart Reference popover which is being followed
by other languages, it doesn't change the text of translation languages. Similarily when you change the
language of Smart Text in the Smart Reference popover of a translation language it doesn't break the
inheritance.

16.4. Nutrition Facts Tables

480

The Nutrition Facts Table (also known as the nutrition information panel, and other slight variations)is
a highly requlated and required component in food and beverage packaging.
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WebCenter Packaging Content Management offers a platform for data management of your nutrition
facts, review in the context of artwork and reuse.

The solution will address the following:

« Complying with regulatory requirements. For example, FDA and USDA requirements in the USA and
complex, multilingual Nutrition Facts Tables with predefined templates.

« The complexity of data management. SmartName can pull data from your data system for use in
your nutrition fact tables.

« Established table rights facilitating the ownership at different stages. For example, who can fill in
the data and who can approve, etc.

« Integration with Adobe lllustrator®

« Automation of Nutrition Facts Table creation. A content manager can pick a template which already
has the SmartName mapping to point to the right data.

« Smart content reuse. You can use our template system to create different tables from the same
pool of data. This is supported with a repository / library for your Table content.

» Support for a translation based or single language workflow.

« Exporttoandimport fromindustry standard formats

» Approval workflow

Table

A Table in WebCenter is a collection of statements. The table is treated like a single document with
multiple statements. A Table has Content Permissions mapped to certain Roles, and specified
Languages.

Tables are created based on a Templates (Document Templates). An administrator user can import
Table Templates into your system. For example, an FDA approved template with pre-selected nutrition
fact statements. The best practice would be that the content manager adapts a series of table
templates with specified table statements and permissions and other users create tables based on
these templates (and localize them).

Table Statements

A Table contains statements with a text label and an editable field. You can define different approval
processes for these statements. While the Table Templates contain a pre-determined set of such
statements (based on FDA regulations, for example), it is possible to add and delete statements.

- Element Type: This indicates what the value of the element represents(e.qg.: “Calories”, “Vitamin A”,
"Saturated Fats”, ...).

Note: Althoughitis possible to use your custom Types, the Templates come with GS1
nutrient element types.

« Instance: This will be a number indicating the numbered occurrence of a particular Element Type
in the table. By default, it takes the value “1" except when there are multiple occurrences. If you have
three daily values for every nutrient, their individual instances will be “1", “2" and “3".

« State: The statements can be in one of the following states: Draft, Pending Signoff and Signed Off.
Users with corresponding permissions can change the state of each element.

+ Value: The actual value of this element that will be displayed in the table (e.g. 230", 10 ¢", “2%", ...)

- Static and Variable part: The text part of the table is treated as static and the numeric fields as
variables. This means that users won't be able to edit or adapt the design components of the layout.
There are exceptions to this rule: for example, the “Serving Size” in “cups”.

481



ESKO

WebCenter

16.4.1. Table Content Document in WebCenter

Table Content Document

A Table in WebCenter is a collection of statements (either nutrition fact statements or text
statements). The table is treated like a single document with multiple statements in it.

The WebCenter Table Content Document (. wtc)is an XML file that has the following features:
« Table Content that goes on in the Artwork. You can manage the values of the table.

This includes both the master and the translated content of the table

« Approval states for individual Table statements as well as for the whole Table.

« Clearly defined ownership rights for the Table.

« Storesthe Layout type as either Grid or Default. If the layout chosen is Grid, then the layout
information additionally also captures the indentation, column span and Instance ID.

« Element Type for text statements within the table.

» Revisioning

» Download rules

« Attributes

« Document references from other documents. For example an artwork can refer to various text
content documents.

» Can be streamed through a workflow

Content 000106.wcc

Mail link to ot Document: Content 000106.wcc(54 2K8)
Q Open

Description:
NUTRITION

More...+ [T  Approval: NoApproval Required

Text Information | Document Information ~ Approval  Action History ~ Annotations  Projects  Atiributes  References  Characteristics  Discussions

Content  Role Mapping
Nutrition facts  M: &= | Ti+11 (] D10 Preview (GS1) US. Vertical Simplified (5 ) o]
Approval Setup Default - N mgw
utrition Facts
pe | Smarame - 35 g Serving(s) per container
Make this Table Invariant (Table will have no translations). servin size 1 Box
Master Language [ English - United States _
- |JAmount Per Serving
Translation Language  mpem Finnish -

o e Calories 130cal

% Dailly Value*

Total Fat Og 0%

> & English - United States e e} Saturated Fat 2g 0.01%

Trans Fat Og
» + Finnish o Sodium 100mg 0.04%
Total Carbohydrate 29g 0.11%
> 11 French - France ° T, 5 Total Sugars 8g
O|[x Incl. 15¢g Added Sugars 0.29%
Serving Per Container Serving Size Protein 49
1 & [y |
Calories |- %DV = %Daily Value |

Table Properties Widget
Table Widget on page 485
Preview

Translation Widgets

SN~
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Table Properties
The content manager of the table can modify the table properties such as:
« add ordelete translation languages
« make the table invariant
» choose the text type
« choose the layout of the table
Nutrition facts ~ M: gse T m=1 o 1o
Approval Setup Default . - Master %E; English - International .
L _ ) .
Text Type SmartName . - angraes EE English - United States
SmartText Search pcm_ss - Translatior‘ i Dutch - Belgium

=== Dutch - Netherlands .

l i French - France

Language
Enable Auto Suggestion

Make this an Invariant Document .

#| Allow Inherit Content .

Inherit Content None -
from
Layout Default . -

Click the Configure icon to define the properties such as:

1.

The tool bar with Configure icon and tools to:

- Resolve SmartName (only if the table is of SmartName Type)

« Export to GS1tool to export the table in GS1-XML format.

. Approval Setup

Type: Select from Simple, Rich Text or SmartName. If you choose Smart Name, you can choose the
Reference Source from the drop down.
Translations: Enable Make this an Invariant Document if translations are not required for the table.

Choose the Allow Inherit Content option to follow a particular language for all the elements in the
table. You can either choose None where no language is selected by default or Default to follow the
language chosen at the element level or one of the Master language in the project.

Choose Layout as Grid to customize the Language Layout view. If you have chosen the Grid Layout,
you can perform the following actions in the language widget:

« Define the number of columns and rows for a table
« Dragand Drop support for rows and column
« Addordeleterows

{ = Note: If no option is chosen, default layout remains. When you export table content

=% documents to GST, layout information of the document like indentation, column span,
and concatenation strategy are all included in the XML only when the layout chosen is
grid.

Master Language is specified in the Project's attribute category.

Translation Language : This list will show the document's translation languages. You may have more
languages to add from if they are present in the Project's Attribute Category. Add more languages
by hovering and selecting the language.

483



ESKO

484

WebCenter

Text Approval

The Packaging Content Management module offers separate approval processes for the Master and
its translations. All the Approval information with regard to the Master and Translations stay within the
Text or Table Content Document.

{ ' Note: This approval process is different from the regular WebCenter approval process.
]

The Approval process starts when a content Editor starts approval on a text statement or a table
element.

When you have configured the right permissions, the users who has the Approver permission can
perform the approval actions. To automate the approval, you can configure manual tasks in a workflow
and assign them to the relevant Roles.

Once approved, the master and the translated text remain locked for the reqular users.

{ ' Note: Only the Content Manager has the rights to change the text element to draft.

The text element can be in one of the following states:

« Draft: Theinitial state of the Text Document where the content is still being worked on.

« Pending Sign-off: When drafting is complete, and the status is ready for its approval cycle. An
approver can review and approve or reject the document.

- Signed-off: When the approval cycle is completed and the content drafted in the document is
‘Signed Off".

- Sign-off Rejected: When the approval cycle is completed and the content drafted in the document
is'Rejected'.

{ . Note: Approver will be requested to re- enter the password before approving or rejecting

' any text content document, provided the option is enabled by the Admin user.

Approval Types

Content Managers can set up the Approval Type for Text Content Documents. There are three Approval
Types:

« Default: Only one member has to approve. For example, if the Approver permission is assigned to
two Roles, only one member (from any Role) has to approve.

« One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member or
user from that Role can approve.

« All of Role - One per Group : At least one member from each Role-Group has to approve. If there is
an individual User, then he or she has to approve as well.

Table Approval Status

The approval process can be done at two levels: approval of each nutritional fact statement and as a
composite table.

The status of the Table widgets (Master and Translation) depends on the approval state of the table
statements. If all the elements are signed off but one is still in the Draft state, the widget status will
also be Draft.
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It is also possible to bulk approve all the statements within a particular language for both the Master
and Translation languages. During bulk approval of statements, if the status is reverted before saving
the change, previously signed off statements are not affected.

(f ’ Note: This option is available only for users with Editor and Approver permissions.

See the approval states below:

1. Signed Off

2. Ready for Approval
3. Draft

4. Rejected

The Approver user can approve the entire table (per language) in one go. To do that, hover over the
statusicon and click Approve.

In the case of individual statements, the Approver can change the status to the next possible
Approval State. For example, if a statement is in Draft state, the user can put it to Ready for Approval.
Translation languages can be edited even if the master language is not yet signed off.

(f ’ Note: If Require Password for Approvals/rejections option is enabled, then the Approver is
asked to enter the password for approval or rejection. The same information is also updated in
the Action History.

Table Widget

The Master Language Widget contains the Statements or actual table content. The Editor users can
enter datain the specific fields.

If the table has translations, they will appear as widgets below the master table.

Table Tools
In the Configure tool bar:

« youcanadd Table Elements.

« change the approval state of a document. After the data entry, you can approve or start the approval
process.

Nutrition facts =~ M: == T: mn R~ B * ]

~ B English - United States : T} ]I[l E E r':.i

Active Ingredients Notes

! |

Added Sugars Adgditional Info
z - @ Approval Status
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Table Statements

The individual statements or elements can have it's own approval state. The statements have a name
label(for example, serving size) and an editable field. Read about adding more elements in the table in:
Table Element Types on page 487.

Language Widgets

If you have added Translation languages to the document, you will have translation widgets below the
master table.

Click on the configure 'ﬂ‘ icon and T+ to add table elements to your translation widgets. You can add all
or some of the Table Elements present in the Master language.

However, you cannot add elements that are not in the Master language. Each Language has it's own
approval process and approval can be done at the language level or as individual elements.

Content Manager or a user with Add Language permission can add a empty Master or Translation
languages widget into the Table Content document. This allows the Content Manager to plan the
languages required for the document ahead, although the elements can be added later as per the
requirements.

Rows and Columns
Add or Remove columns / Rows in Grid Layout

You can easily add or delete Rows by clicking on any cell in the Grid layout by selecting the context
menu for the table documents. This can be done only by the users who have the Content Manager or
Editor permissions on the particular table document.

* 1 Dutch - Belgium . Il = =
A B c D E F I
=y Added Sugars Added Sugars POV Sugars Sugars PDV
L i s i & &
Calcium Calcium POV

ra
L[]
u

Calories

[ ]

Cholesterol Measure Cholesterol POV

Dietary Fiber Meaasurs Dietary Fiber POV

wn
[ ]
u

ron POV

[ [}
u

Protein Measure Protein POV

Sarving Per Container Sarving Size Serving Metric Quantity

[ ]
u
L1}

Rows can be added above or below the selected row, using the options available in the language
header.

Similarly, the columns can also be added to the left or the right of the selected column using the
options available in language header.
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Context Menu in Master Languages

When the master language is configured, you can easily access the context menu by a simple right-
click.

You can merge or split cells in a table document. When you want to merge any cell in the language
section and if the next cell is empty, then the selected cell is merged with next cell.

If any widget is present in the next cell, then it shows an alert message. Similar functionality is followed
inversely for split cells. You can add cell level indentation up to ten levels of indentation. Row (A, B,
C....)Jand column(1, 2, 3...) headers cannot be indented. Indentation is shown in preview but not inside
the cell. Indentation is applicable only for Grid Preview and is not available for the standard/default
Preview.

T. I

Row Header Icons Column Header Icons

Reorder Table Rows and Columns

Rows and columns in the Table document can be reordered by drag and drop. You can also re-size the
width of a column by using the column re-size handler.

Hide and Show Rows and Columns

Rows in the Table document can be hidden by selecting any cell in the Row and selecting the Hide
Row option in the language header. To show the hidden row, select the row and choose the Show Row
optionin the language header.

Show and Hide columns also function similarly by using the Show Columns or Hide columns in the
language header.

Layout configuration in Master Languages

When there are multiple master languages in the table content document and if the layout is
configured in one of the master Language, changes made impacts the other master languages as well.

Table Element Types

The individual Table statements can have a particular Element Type. The default Table Types have
Element Types corresponding to the GS1standard. However, you can add custom fields to suit your
particular needs.

You can add multiple instances of one Type and it will be indicated with a suffix number.
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(7, l Note: You can add elements to the Master Table and the Translations have the same fields as
the master. You cannot add custom types to the translations.

As a Content Manager, you can add or delete fields.

Click on the configure ﬂ‘ icon.
To add an Element Type, click T+
«  Whenyou have selected a particular Standard, the corresponding table element types are available.

If your template is a Standard, you can add more from the Add Preview Fields ...section.

2 Elemant for Engfish - United Siases

= 2t Prewiem Flckda (551} U5 Vertieal Standsrd]
ol achgied v Tabe Preview Fields

A ) Eariloe fickd 1 able

ﬂ Eanc
« You can choose from:
Options Description
Add Preview Fields To add Element Types of the particular

Standard you selected, just click on the field.
Use << to take all elements out of the table and
use >>to add all fields to the table.

Add aListed Field To add one, click on that specific Field. Read
below.
Add a custom field To add a custom Field. Read below.

+ Youcan store your GS1(or custom) Table Element Types in a List and use them in a Table.

a) Create a List with the Nutrition Fact Element Types with the name TABLE ELEMENT TYPES.
These Types will be available to you in your Table Documents
b) To add one field from the List, select Add a listed field.

The gallery lists all the types from the List.
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Add Elenent For English - United S3ates

Add Preview Fiedds ({51) U8 Vertical Slasdard)

. Source=
"TABLE_ELEMENT_TYPES®
List

* Judd a lated field b table
Gallery

« You can also add custom fields that are only relevant in one Table. To create such a field select
Add a custom field option. You can use this option when you have to create Custom fields in some
tables or when you are using the Custom Templates on page 495.

a) Enter the Element Type Code, the code that will be used for a the added element type. This is
used to highlight the field in the custom previews.
b) Also specify the Instance Sequence to identify each instance of the same element in a table.
c) Click Add.
« After modifying the table Elements, remember to click OK and to Save the table.

Note: The Element Types are used when Dynamic Content Tables get imported into
WebCenter.

Text Content / Table Ownership via Permissions

Text Content Ownership

offers established ownership for different phases of the text and table creation and the approval
process. You have four default content permissions:

« Content Manager
- Editor
« Approver

- AddLanguage

These permissions, when mapped to the WebCenter roles, allows their assignees to perform specific
functions on the document.
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Note:

« To configure these permissions, the project manager needs to assign at least the Content
Manager rights to a relevant Role.

For example, you can configure a Role, Marketing to have the Content Manager function.

. The Content Manager can then activate the Editor, Approver and Add Language
permissions by assigning them to relevant WebCenter roles.
If you do not assign a role to a specific permission, the specific permission will remain
inactive for the document.

- The permissions are set at each text/table document (.wcc or .wtc ) level and will be passed
on along with the document and its versions when copied or moved.

« Itisnot possible to add custom permissions.

Four Types of Permissions
1. CONTENT MANAGER:

The WebCenter Role with this permission facilitates the entire content management process to
ensure accuracy and compliance. For example, the role Marketing could have this permission where
the Marketing has the responsibility of the packaging content. The Content Manager will manage
the Master and Translated statements.

Note: The Content Manager Role is not associated with any specific language.

This role will manage all the permissions and the settings for the current document.

Note: Content Manager Role cannot act as an Editor or Approver unless this permission is
granted to the same role.

2. EDITOR

The Content Manager typically assigns this right to the dedicated roles who will create, edit, revise
or translate the text. This can be assigned per language.

An Editor Role (for example, a Translator) can edit when a document is in the Draft state, not in
Signed-0ff or Pending Sign-off state.

If the Editor also has Approver permission, then the documents are directly moved to Approved
state instead of pending sign off.

Note:

« The Content Manager Role has to configure the list of translation languages to make use
of multiple language based Editor permissions.

« You can configure Roles for all languages to which the content should be translated and
grant them the Editor permission.

3. APPROVER: A Role with this permission can approve the text content. This permission can also be
configured per language. The approver puts the Text Statement to Signed-0ff or Rejected state.
4. ADD LANGUAGE:

Any user with Add Language permission can add language to a text or table content document. The
users can be assigned with permission to add only specific languages.
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CONTENT MAMAGER
EDITOR

EDITOR

EDITOR

EDITOR

AFPPROVER

AFPPROVER

AFPPROVER

APPROVER

ADD LANGUAGE

ADD LANGUAGE

ADD LANGUAGE

-REQUESTOR Role

Language

g English - International
g English - United States
§j Dutch - Belgium

1§ French - France

gz English - International
g= English - United States
g Dutch - Belgium

1 I French - France

g English - International

§§ Dutch - Belgium

1 | French - France

Role

25 PCM_CONTENT MAMAGER
25 PCM_CONTENT MAMAGER
25 PCM_CONTENT MAMAGER
25 PCM_CONTENT MAMAGER
25 PCM_CONTENT MAMAGER
25 PCM_CONTENT MAMAGER
25 PCM_CONTENT MAMAGER
25 PCM_CONTENT MAMAGER

2= PCM_CONTENT MANAGER

85 PCM_LEGAL

25 PCM_TECHNICAL

25 PCM_CONTENT MAMNAGER

WebCenter

Assignee(s)

MR.JN

MR.JN

MRJN

MRJN

MRJN

MRJN

MRJN

MRJN

MRJN

MRJN

MRJMN_|

MRJN

MRJN_

MRJN

To create new Text/Table Documents, edit, approve or to reuse content during the Project Creation
phase, you need to grant the relevant permissions to the _REQUESTOR role. You can give these
permissions in the libraries of Text/Table Document Templates, or Projects with approved Documents.

Delegation of Approvals in Text Content and Tables

An user can delegate his WebCenter tasks to another user. The delegated user can perform all actions
on behalf of the delegator. When the delegate approves text or table content, the password validation
is done on the delegate's password.

When a user has logged in on behalf of another user, and approves any text or table content, the
same can be viewed by clicking Approval Info in the ellipsis. Alternatively, it can also be viewed in the
Document > Action History.

Nutrition Facts Preview

The Preview lets you view the data being edited and it adapts according to the changes you make in the
nutrition fact statements. You can see the preview of the table document.

Note: The preview is an approximate representation of how it would appear in the artwork. It
does not support editing the design elements.
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Configuring a Preview

The Preview is configurable and you can select from different Nutritional Facts table formats. To
specify a Preview:

« click Configure Preview
« selectaType

« specify the Standard

[ Defaut |

. ) FDA hubilun Fac.s Ve lical Tabies 2070
Preview Settings FDA hutriton Fac:s _ineer Tables 206
FDA hutrition Fac:s Tabuiar Tables 2016

Typeo'[m Mutrition Facts Linear Tables 201 g::lb"nTahle

Custom
Sandard {G51) U.S. Linear Sandard (GS1) LS. Vertical Standard

Locale
Mapping
1 English - United States

Locale Language

1. Available preview templates (default and custom). The following templates are available by default:

« FDA Nutrition Facts Tabular Tables 2016
« FDA Nutrition Facts Linear Tables 2016
« FDA Nutrition Facts Vertical Tables 2016

e Grid
« Custom Table
o Default

2. Standards available for the selected template.

3. Thelanguage of the Preview (If you select French, your preview will be updated to show the French
content)

You can also add or delete table elements to the master language table to update the document. Read

—
in:Table Element Types on page 487. Position Preview [ icon allows you to configure, where the
preview is displayed.

Note: To know more about Grid layout of the table, read hereTable Properties on page 483

Download Preview

You can download the preview of a Nutritional Facts table in pdf format. PDF downloaded document
contains all the mandatory elements and other elements which has values in the same format, font and
styling as shown in the Preview.

If any custom fonts are used, then add the fonts also in the application server pcm/TablePreviews/
custom/fonts folderlocation to view and download the preview.
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. Note: Download PDF option is not available if Default type is selected.
]

16.4.2. Creating Tables

Creating a Simple Table

You can create Tables for your artwork from scratch and store them in WebCenter. These tables can
be exported in GS1-XML and use it to communicate between different systems during the artwork
management workflow. You can involve various stakeholders through an approval process.

An intuitive preview section adjacent to the edit fields displays the data in the context of the table
design. The changes you make are highlighted on the go to give you a very visual data entry process.

{ . Note: You need Table Templates in the system to be able to create a new Table. An

' Administrator or Project Manager can import Text or Table Document Templates into the
system.

« ImportaProject or Template with Table Templates and adapt the settings. When users will create
documents from this document template, they will inherit these settings.
a) Go to Document Details > Text Information > Content tab of the Template to modify the Table
Properties on page 483. You can specify the Approval Type, Table Type, Languages etc.
b) Inthe Role Mapping tab, assign the Content Permissions to have Roles mapped as Editors,
Approveres and Content Manager.

{ ' Note: Specify _REQUESTOR as a Content Manager of the template if you want to create

' Tables during Project creation.

c) Optionally, adapt the settings of a template to make it a SmartName based table. Read more in:
Creating Smart Tables on page 494
» Tocreate new tables from these Templates, plug these as a Document Source in your Project
Template. Follow the steps below:
a) Inthe Template's Project Details page, Configure > Document Templates.
b) Select Project or Template and select the Project your created in the first step and Save.
« Create an Attribute Category for your Template.
a) Add Language Attributes and restrict them to Language Lists.
b) You need Document Reference Attributes. Create and add them to this Category.
c) Configure the Document Sources and Rendering of this attribute.

Tip: Use a Saved Search configured to search for Table Templates as a document
source for better user experience. You can, for example, add a Search Panel.

« Optionally, create and add workflows for approval and translation. You can also create a Library for
your approved tables.
When creating a Project from this Template, the user can click New and select a table template
from the Templates library to create new documents.
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Template: PCM Artwork Library Update

2 Upload o Manager: Dazmen, Karsten (KADA)

. WL Customer:
st Upload Multiple Documents: /‘-l-.\-/u Modified: Jan 30, 2017
Mail link to \ 4 Description: This 1emplate is used to create a project that will update or create a new arwork files in "PCM Artwork Library”
More...x

Documems @) Bill Of Materials @ Tasks Characteristics | Atribites  Projectinformation  Approval  Nowfications  Members  Securty  Comfigure

Attributes in Category PCM Artwork Library Update ACat 4 [ &

Priority | —Please Select—

Artwork Languages
e Masterlanguage: | English - United States v
LLanguagelists
Translation language(s): | —Please Select— o
Project Details
Product Code v
Project Date [m] - - @
Project Briefing
Show Rich Text Controls

Market List —Please Select— -

Brand —Please Select— -

Sub Brand —Please Select— -

Project Types —Please Select— -

Driver | —Flease Select—

Reference Artwark
+ FromLibrary = = From Template =+ Upload

DoecumentiReferences

withiSeurces Nutrional Facts
+ Create Table

m Export 1o JOF Import from JDF

After creating a new simple table, you can enter the data either as a workflow step usting the Update
Table Content on page 419 node. The users (Editors) can also enter the values manually and send it
through the approval process. You can export this table in GS1 XML format (either using an action or a
workflow step) for merging it to the artwork in lllustrator with Dynamic Content.

Creating Smart Tables

You can automate the data collection process required in creating or updating the nutrition facts
tables. The process starts with a Table Template with dynamic data fields(SmartNames). These fields
can be constructed to point to an Excel based List or any WebCenter SmartName such as Attributes.

SmartNames are resolved as actual entries in the context of a Project. This way, you can source the
data instead of typing in the data manually. This approach helps you to avoid data entry errors in
nutrition facts. Also, when you require corrections to any of the data fields, you can just edit a single
data source instead of updating all related tables.

To set up a SmartName based Template, follow the steps below:

1. Inthe Table Document Template > Text Content > Content tab, open the Table Properties on page
483 widget.

2. Specify the Type as SmartName.

3. Specify WebCenter SmartNames for each field from WebCenter list. For example, you can select
Attributes as the SmartName.

The Content Manager can approve the SmartNames to lock these fields. It is also possible to
delegate the approval to specific Roles based on permissions.
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4. Plugthe smart table as a document source in a Project template to create a new smart table. Read
more from: Creating a Simple Table on page 493. SmartText Search drop down lists the Text Saved
search.

After creating a new Table in the context of a Project, the Content Manager can click Resolve
SmartNames to update the table with numerical values.

In the example screenshot, the SmartNames are from a List based on the specified Product Code of
the Project. You will also be able to see the original SmartNames when you hover over the values.

. Note: If one or more element of the table content has unresolved Smart Content, you will
=== not be able to approve the table nor the elements.

After the approval of the resolved table, the content remains locked. You can export this table as GS1
XML and finalize the table in Illustrator.

Custom Templates
To install custom preview templates, follow the steps below.

1. Place the HTML templates in WebCenter\WebServer\tomcat\webapps\WebCenter Inst
\custom\pcm\table layouts folderandalsoinpcm/TablePreviews/custom/folder
of the application server. If any custom fonts are used, then add the fonts also in the application
server pcm/TablePreviews/custom/fonts folderlocation.

Register the custom preview template in a“list.xml” in both the above mentioned folders.

G(}' ~ Computer = Local Disk (C:) = Artios ~ WebCenter = WebServer ~ tomcak = webapps ~ WebCenter_Inst = custom ~ pcm = table_layouts - &
Organze * (2 Open ~ Sharewith »  Prit  New folder
r Pavorkes Name * Date modfied Type Size:
I Desitop Cereal_Classic 1/16/2017 11:43AM  HTML Document
I Dowrioads < st 1202017 2:12PM XML Document 1KB
1 Recent Places
E¥C:\Artios\WebCenter\WebServer\tomca
4l Lbraries DI ,—L| —
= o < y 2] Criamios\webCenteriwy O “1 @ criartiosty
My Documents ~
o Music
O O
B ideos
1 Computer v
&, Local Disk (C)

s Local Disk (E5)

€ Network
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2. Foreach HTML Preview, create a layout entryinthe 1ist.xml file. This XML file has to be placed

in the same folder as above.

See the format of the entry below:

<layouts>

<layout>

<type>Name of the Table</type>

<name>Type of the Table</name>

<path>Path to the Preview Template</path>
</layout>

</layouts>

‘ ' Note:

The Type and Name fields will be used in the user interface drop-downs. If a Type is not
specified, it will be called “Custom”.

Read more in: Table Preview

The custom templates will be available in the Preview selector and you can use the Type and Name

fields in the interface to select a Preview.

16.4.3. Workflow Tasks for Tables

496

Import Dynamic Table

The Import Dynamic Table node extracts the Tables from your artwork(s) as Table Content
Documents. You can configure this node to import these Documents with a link to specific document
reference attributes and table document templates.

{ . Note: You need an Attribute Category with Table document references as a pre-requisite to

‘ configure this node.

If there are multiple artworks coming into the documents, the node will iterate and extract tables from
all of them.

Parameters- Configuration tab

« Specify the Upload Folder to store the extracted documents.

« Select the Document Reference Attribute for the table. Select the appropriate document
reference from the drop-down listing all document references.

« Add Imported Table Documents to Output . Check this if you want the document sent to the output
pin.

« Reuse existing Table Documents. The document version specified in the document reference will
be reused to store the data instead of creating a new Table Document. If there are no matching
tables in the system,new document will be created.

Document Template Tab

+ Specify the corresponding Document Template. Select the Table Template (either simple or Smart)
that corresponds to the incoming Table.
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Select the Document Template Project at the top of this tab. Enter the name of the Project(s)
where you have configured your table templates. You can either specify multiple project names with
a'l'between them or provide SmartName which resolve to multiple project names. Read more in:
Creating a Simple Table on page 493

« Add all Document Template elements Check this to import all statements present in the document
template.

« Set values from Document Template. Check this to take values from the Document Template for all
matching statements. If there are no matching statements, the incoming values will be used in the
table document.

Parameters- Language Mapping tab
You can map the Locale ID of the Dynamic Table to the corresponding language in WebCenter.

Language Index: When you create the first row, this field will have the value 1 by default. When you
create more rows, they will be numbered serially.

« Language: Select the language from a list of languages. Or use a SmartName to dynamically assign
the languages.

i = ] Note: By default, an imported table is imported as Translated language if it does not exist
as a Master Language in the Project's language attribute.

For new Table documents created from this node, the master language table will be added
in the Draft state, even if that language is not available on the artwork.

{ = Note: If you do not specify language mapping for the imported Dynamic Content, the node will
try to find the language in the Lists (Master and Translation languages).

-Read also: Import Dynamic Text on page 384.

- R b 7858

Selest Document CopyMove Assign Document \ mpart Dyna mic J Data Collecor Router
Document Alribute Calegory % Content ¥,

mport Dyna mic
Table
It will import the Mutritional Fact
Table from Arwork

In the example, when an artwork with Dynamic Content arrives at a Packaging Content Management
workflow, the following steps happen:

1. The workflow assigns a Document attribute category to the artwork (parent). This ‘copy sheet'
category contains the Document reference attributes to which the text and table content will be
imported.

i =l Note: If this stepis notin the workflow, the Import node will use the Project's attribute
as the default.

497



ESKO

WebCenter

The category contains the Document reference attributes for:

« text statements,
« and nutrition facts table

to serve as the copy sheet template.

2. The Import Dynamic Text on page 384 step maps the various Element Types to appropriate
document reference attributes as configured.

3. The Import Dynamic Table extracts the table matching it to the document reference and the
table document template.

After the extraction of the content, the workflow processes the content based on the requirements.
You can, as in the example, update the incoming table and text using the workflow.

Update Table Content
This workflow node allows you to specify or update Table properties and Table values. You can add:

« Role Mapping

« Languages

« Approval

« Add/ Remove / update/ inherit elements and set values for nutritional facts elements

Settings

In this tab, specify the properties in the Field and the corresponding values in the SmartName
supported Value field.

You can specify or update the following properties and their values in this tab:
« Approval Setup:

« Default: Only one member has to approve. For example, if the Approver permission is assigned
to two Roles, only one member (from any Role) has to approve.

- One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member
or user from that Role can approve.

« All of Role - One per Group : At least one member from each Role-Group has to approve. If there
is an individual User, then he or she has to approve as well.

« Auto Suggestion: If specified as True, the Document will suggest matching text when the user
starts typing.

{ . Note: This will work only when Saved Search is enabled.

« Inherit Content From :
You can choose to inherit content one of the options below

« Default: Will inherit the content from the language that is configured to follow in the Language
List.

« None: Will not inherit content from any language in the workflow node. However the user can
manually change the language at the element level in the document.
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« Master Languages: Can choose any of the languages from the master language list.
By default Disable is chosen which will not allow Inherit content.

+ Inherit Only SmartText: Specify this as True if the inheriting content should allow only SmartText.

Note: Thisis only applicable when 'Allow Inherit Content'is enabled.

« Invariant : Specify this as True if translations are not required for a particular Document.

« SmartText Search: A list is displayed containing all global Text Document searches available on the
server.

« Type: Simple or Rich Text. If the Type changes from the existing type, the document status will
become Draft.

Values

This tab lets you add / remove /update table statements and their values. Use a single row per element

or statement.

Update Table Document |

Settings  Role Mapping | Values | Approval

Element Instance Sequence Language Action Condition Value
Serving Pev | [] | 1 [1| english -« |[]| Add | [1| Aways = |[]| r[List] [1
serving siv | [] | 1 [1| French - f~ | [1| 1oherit ~ [] || current va~ | [] []
Calories + [] | 1 [1| english -~ | []  update ~ [] | Always | [] | rList] [1
Total Fat + | [ ] || 1 [1| english -~ | [] | Update ~ | [] | Always | [] | rList] [1
Total Fat ~ | [] || 1 [1]| French - ¢~ | [] | tnherit ~ | [] || Always | [] [1
Cholestercw | [] || 1 [1| english -« | [] update ~ | [] | Always | [] | rList] [1
Cholesterc~ | [] || 1 [1| French - f~ | [1| zoherit ~ [] || Always ~ | [] []
Sodium Mez~ | [] | 1 [1| english -~ | [] | update ~ | [] || current vaw | [] | [List] [1
Sodium Pov~ | [] | 1 [1| english -~ | [] | update ~ | [] | Always | [] | [List] [1
Total cart~  [] | 1 [1| engiish - v | []| update ~ [] || Always ~ | [] | r[List] []
Total Cartw | [] | 1 [1!| French -f~ | [1 | 1nnerit | [] | Always | [] [1
Dietary Fivw | [] | 1 [1| english -~ | [] | Update ~ | [] | Always | [] | [List] [1
Dietary Fiv | [] | 2 [1| French - f~ | [1| 1oherit ~ [] || current va~ | [] []
sugars o+ [] ] 1 [1| english -~ | []  update ~ [] | Always | [] | rList] [1
Sugars POV~ | [] | 1 [1| english -~ | [] | Update ~ | [] | Always | [] | rList] [1
Added Suge~ | [] || 1 [1| english -~ |[] | Add ~ | [1| Aways | []| r[List] [1
Added Sugew  [] | 1 [1| French - f~ | [1| Inherit ~ [] || Always ~ | [] []
Protein Me~ | [] | 2 [1| engiish - v | []| update ~ [] || Always ~ | [] | r[List] []
Protein L~  [] | 1 [1!| French -f~  [1 | inherit ~ | [] | Always ~  [] [1

-

o oot

« Element - Contains a list of all the table Element Types supported in WebCenter. There is a special
field "[All Table Elements]" which will do bulk addition of master table elements into a translation
language.
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- Instance Sequence - Specify the instance sequence number. This number indicates how many
occurrences of an Element is present in a Table. The default value is 1.

» Language - You can either select from the drop-down (listing all the languages present in the

system)or use a SmartName in this field.

If the specified SmartName resolves to multiple languages, then the specified configuration(from

that row) will be applied to all of them.

« Action: Choose from Add / Remove /Update/ Inherit .

« Condition You can add a condition where the workflow node can inherit/add/update/remove
elements. There may be a combinations of different conditions that may be given.

Condition

Action Possible

Always

Add, Remove, Update, Inherit

New Value is not empty

Add, Update, Inherit

Current value is empty/not available

Add, Update, Inherit

Current value is empty

Remove, Inherit

Current value is not available

Inherit

Current value is empty and new value is not

Add, Update

empty

Value - Field where you can specify the actual content. You can enter the data or use SmartNames.

| @g| Tip: Use List SmartNames(pointing to an Excel sheet based List)to provide contentina
smart way.

| . Note: If you specified the action as Add for an existing value, the value is updated. If the
element does not exist in the document, the element and the value will get added. However,
if the action is Update and the element does not exist, the row is ignored.

| . Note: If you are updating a SmartName table using this node, the value from this node will
replace the SmartName in the table.

Approval Tab

This tab allows you to set Approval Status (per element, per instance and per language) via workflow.
This allows you an automated way of approving the nutrition fact statements.

|

Note: You can use SmartNames in this step and if your SmartName points to a multi-value

' attribute, it will resolve to multiple values.

Select the Element or the statement.
Specify the Instance Sequence of the element.

Select Language - You can either select from the drop-down (listing all the languages present in the
system)or use a SmartName in this field.

. Specify the Status. You can choose from Draft, Pending SignOff, SignOff Rejected and Signed Off.

Layout Tab

Remove empty rows from Grid Layout is unchecked by default.
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16.5. Product Content Sheet

Artwork design involves coordinating information from many different sources and stakeholders.
There could be many possibilities for errors and hence it is important to keep all the assets related to a
product saved at one place.

Product Content Sheet (PCS) or a copy sheet in simpler terms is a high level document that describes
the contents of multiple related products. The PCS will be a repository of all the constituents that are
going to be used on the products, like recipes, text, bar codes, symbols, images, nutritional tables
and so on. PCS are stored in a file type called Components. Components are unique file which has

no physical presence but acts a placeholder for all the documents related to the product. Read more
about component file type here Component File Type on page 58.

With Product Content Sheet, you can:

« Specify the constituents, and also list the usage of these elements.

Campaign
fiar a Brand

Mulipack
Flavour X ; { k Flavour Flavour X =
f Flavour Y

10dig

I:I = Product Content Sheel

For example, to ensure that a certain recipe is only applicable to the Flavor X of the product or that a
certain text statement should only be applicable for a certain serving size.

« Extract all the applicable content elements for a certain artwork, provided you specified the correct
usage for the artwork.

For example, when creating the artwork for a multipack, you could specify the requirements as the
contents of the PCS that are tagged with "Flavor X" and "Flavor Y". When creating the artwork for the
enclosed single flavor product, you would specify that the artwork is only applicable for either the
"Flavor X" or "Flavor Y".
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16.6.

Using Reference Property Filter in a Product Content Sheet

For example, Artwork 1has the Reference Property Filter 1(RFP 1) which has some of the content
extracted from Product Content Sheet. Similarly, Artwork 2 has the Reference Property Filter 2(RFP2)
with some of the content extracted. You can notice that Symbol 1has both RFP 1and RFP 2 defined and
hence are part of both the Artwork 1and Artwork 2.

iy
o

Refarence Pmperr_.-"x,
Filter (RFF)
* [Symboi1 | [Tet1] [ Textz |[ image2 |
Reference Property Barcode
Fiter (RPF) 2 a

| Symbol1 | | Text3 |

It is now possible to compare the Dynamic Contents in Artwork to actual content referenced to the
Artwork in the Content Widget in the WebCenter Viewer. Details on how Artwork comparison works in
Viewer here.

Dashboards are also enabled now to view the content sheet and Dashboards can be configured to
compare content sheets in them. More information on Content sheet in Dashboards can be found here.

Comparing Content Sheets in Dashboard

502

Dashboards are now enabled to view the content sheets and also compare two content sheets using
Content Sheet block. You can compare any of the two different

« content sheetsor
« versions of the same artworks or
« artworks which has the same attributes



ESKO

WebCenter
Get Set.ai Version: 1 / Tropical blend sheet .wpc Version: 1€ E moolm K]
Delta Position Variant Pack Type  English - United States
w PCM Technical DocRef
Corrugated
Manufacturer statement [1] - - Box
Manufacturer staternent.wcc Back Coconut PACKAGING POWERED BY
& Berry
) Front _
Ingredients header - ed EACH 200 mL SERVING CONTAINS:
Ingredients header wcc - Coconut g;rugal '
& Berry
Coconut
& Berry
Net content statement Tep | Geten 560 mL
Net content statement woe Front g;’“ga‘m
w PCM Legal DocRef
Consumer guarantee [1] Back - _ed 2
Consumer guarantee_1.wcc & Coconut B{;ﬂ(‘.lmlgal
& Berry
Consumer guarantee [2| Back - _ed .
Consumer guarantee_2 wcc Coconut w
& Berry

When you choose to compare a document with another document, the Delta column shows the status
whether the contents have Changed or Removed or Added.

The differences are shown specifically in each of the content for changes as follows

« Text: Color coded highlights on the exact location of the change on the text content itself for each
of the language present.

« Table: Changes to the values of every element type is compared and status is shown.
« Images: Change of values to the EXTERNAL_IMAGE_PATH are shown.
« Symbols: Change of values to the SYMBOL_NAME are shown.

- Barcode:Change of values to the BARCODE_BASECODE and
BARCODE_COMPOSITE_COMPONENT are shown.

Note: EXTERNAL_IMAGE_PATH , SYMBOL_NAME, BARCODE_BASECODE and
=2 BARCODE_COMPOSITE_COMPONENT are all hard coded attributes.

Apart from the changed and unchanged statuses, the content Removed from the Source document
and content Added to the source document are shown specifically in the each of the tabs.

16.7. Compare Artwork with the requirements In Viewer

Many a times, there is a challenge to compare the requirement provided to the Artwork designers
tand the actual artwork that is created. The new features in the Content Widget in Viewer shows
the comparison for Dynamic Contents in Artwork to actual content referenced to the Artwork in
WebCenter, in a click of a button and bridges this gap.
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The planned requirements are also visible in the viewer in the Content widget and can easily identify
the Dynamic Content that are newly added or removed with color-coded visual feedback. This saves a
lot of time and effort in performing this action manually.
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Compare Mode in Text Content Widget

Three options are available to view the changes of the Dynamic Content in the Artwork with the

Attribute Category namely

« Collate Content: Shows all the Dynamic content in the arwork and referenced contents. In this

mode user can edit Text Statements.

« Compare Content Icon: Shows the compared status inicon if content has changed/added/

removed.

« Compare Content Label: Shows the compared status in the label, if content has been changed or

added or removed. You can view the changed status as shown in image below.
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Hovering on the content in the Compare Content Icon or Compare Content Label mode, presents the
detailed information about the compared document based on the Dynamic Content selected. For
example, a Barcode document is shown below.
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16.8.

Il EAN_13.whc

Barcode Element Type : EAN_13
Base Code : 9876543212349

Barcode Element Type : EAN_13
Base Code : 9876543212344

Below image shows an example of how Text Compare is viewed in the Viewer.

I Conlent
6 TmACHE

P prad

Sl i 1 Pl T 3T oo b T g PO AU TS T 7 DA TR ACS P0G TRADOD OO T T ARTE TR WAGT & Coconui_Blesherry_ DOWP_G
TW parl

Auto Translation
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On a Document Table, the Auto translation button is available if the APl key is configured. Click here for
more information about how to configure the API key.

Auto Translation button is available only for translation languages and one master language is required
to be present on that document table. On clicking the Auto Translation button on a translation
language, all available text content documents on which you have edit rights for this particular
language are translated.

To promote the concept of generic master text, an attribute of text type named
"SOURCE_MASTER_TEXT_LANGUAGE"is configured, which holds the description of expected
master language for translation. If this attribute is not configured on the documents table, then the
first master language is taken as source for the translation.
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17. Structured Content In WebCenter

17.1.

Introduction to Structured Content

17.2.

What is the Structured Content module?

The Structured Content Management module manages the creation of longer, more complex content
streams as used in e.q. leaflets and 'Instruction For Use'(IFU) documents. As is the case for the
Packaging Content Management (PCM) module, focus is on allowing for content creation/reuse and
manageability through an approval process with unique functionality to provide impact analysis across
all documents in the system.

What is Structured Content?

Structured Content is a standard way of managing documents which serve as the source for multiple
assets(i.e. requlatory submission documents and printed leaflets). These kinds of documents usually
contain similar sections of content across documents. The main benefit of Structured Content is
that each document, figure, table, section, and phrase can be individually managed, controlled, and
approved, all with usage tracked.

What is DITA?

Structured Content in WebCenter is based on DITA, an open standard for authoring and organizing
technical documentation.

A Content or DITA topic (.dita file) is a re-usable rich, structured content, logically similar to a section
in a document. By splitting off content in topics, modularity and re-use is ensured in the authoring and
approval process.

A Content or DITA map (.ditamap file) allows collecting DITA topics (and other DITA maps)into a
complete document. The DITA map groups elements and organizes topics into ordered hierarchies and
relationships.

How can Structured Content be useful?

The DITA-based solution integrates seamlessly with images and symbols managed as separate
documents in WebCenter. In addition to being used for leaflets, there are also regulatory submission
documents which must contain all packaging content (QRD documents). As such, it is possible to insert
packaging label text from the WebCenter PCM module directly in these structured documents, serving
a similar purpose as a content sheet. This integration ensures full traceability and a single source of
truth across all content types.

Getting started

Structured Content relies on some assets (category, attributes)in WebCenter and the functionality
relies on some configured searches. Different configurations for the Structured Content setup can be
done via Admin > Configuration > Structured Content Configuration.
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Deployment Package

The Structured Content Configuration page checks whether mandatory assets are available. If all
assets are installed, an info message is shown saying that the assets are available. If not, a message is
displayed saying that required attributes are missing. You can then click Check for Updates... which
takes you to the import dependencies page where you can easily check/import the assets.

The deployment package also includes non-required assets such as a Library Project, a Work in
Progress Project Template,... The idea of the deployment package is to set up in a minimal yet working
environment for Structured Content.

When a new project is created based on the “SC_WORK IN PROGRESS TEMPLATE", a project creation
formis shown where the user can upload a package (.zip) and/or when he can create new Structured
Content documents from a template or from an existing Structured Content template. When a package
is uploaded, a workflow will start which will unzip the package and store the Structured Content
documents in the project. An approval cycle will be started and when approved, the workflow will move
the documents to the Library Project.

On the project creation page you need to specify the language code on the DITA content you are
importing. This is a fallback when the DITA XML would not have the xml:lang attribute filled in. When
importing a package as a translation of existing content in the system, check the checkbox next to
"This project is a translation.”

Configuration
Also see Configure Structured Content
Following searches can be configured:

- Saved Search for Reusing Documents: Saved Search that is used when a user wants to re-use a
topic or map in the Structured Content editor. This search is accessed when the user clicks Insert
Existing Topic within the editor.

{ ' Note: SmartNames can be used in this search and look at the parent map from where the

' existing topic was inserted.

- Saved Search for New Documents: Saved Search that is used then a user wants to add an image in
the Structured Content editor.

{ ' Note: SmartNames can be used in this search and look at the parent map from where the

' existing topic was inserted.

« Saved Search for Graphics: Saved Search that is used when a user wants to add an image in the
Structured Content editor. This option comes up when the user clicks the Figure with image or
Inline image options within the editor.

- Saved Search for Text Statements: Saved Search that is used when a user wants to add label text
in the Structured Content editor. This option comes up when the user clicks Statement from the
Structure menu within the editor.

. Saved Search for DITA Conrefs (Reuse Content): Saved search that is used when a user wants to
add a DITA conref (Reuse content)in the Structured Content editor .

Optionally you can configure dashboards on this page. See Impact analysis of changes on page 518

Creating topics and maps

508

Topics and maps can either be created by:
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« Creating a new document on page 509
« Import external DITA on page 511

17.3.1. Creating a new document

Using a template

A new Structured Content document can be created via a template. This will create a new instance of
the document. This document can be opened in the Structured Content editor.

The Structured Content Editor

Authoring of DITA content in WebCenter is done in a dedicated best-in-class content editor. The editor
is opened by clicking on the document thumbnail or via the View and Annotate action.

The editor/viewer will show you:

« The text content of the document that was opened

« Anyextra documents which the root document is referring to. For example: a map that has multiple
topics

« Anyimages that areincluded in topics

« Anytables, footnotes, warning statements and other DITA constructs which are supported

« Aheader at the top of the screen with: file name, version number, project name and user name

« A menu structure with a few tabs

» Sidebar tabs that can be expanded (right side):

« Qutline: showing a structural view of the document that are open in the editor
« Comments: A way to add annotations on the structured content
» Dashboard: When one or two dashboards are configured, this tab will show information about
the opened document(s). See Configure Structured Content
« Search: opens an advanced search panel for search/replace on all the opened documents
+ XML code: shows the XML code of the currently focused document
» Buttons(top right):

+ Openreview: to open an optimized view on the currently focused document for reviewing and
making annotations
« Show changes: to compare the currently focused document with its older versions
« Search: to search for text in all the opened documents
« Breadcrumbs of the current cursor position (bottom left)
« Buttons for the notification center, keyboard shortcuts and info abour the Structured Content
Editor build (bottom right)

Editing Structured Content

When a user starts editing a piece of text, the related document becomes locked in WebCenter.

If another user is looking at the same document version, the document shows up as locked in the
Structured Content editor (and becomes viewable only). There is a message indicating who locked the
document. When the user saves the changes, the document(s) are unlocked again and a new version of
the documentis created.

When a user is looking at some documents and there is a new version (of the same parent document
version), a refresh button becomes available to see the latest changes. Refreshing will simply load the
new version and has no further impact.
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When opening a Structured Content document (e.g. a map)and that map is using a non-latest version
of a topic (or another map), the Structured Content editor will indicate that there is a newer version
available of the document available. It is indicated both in the document, and in the outline view in the
editor. You can click on the indication on the document to open a side-by-side view. which shows the
current version on the left, and the latest version on the right. For both versions the modified date and
time is available (info icon). An option is available to update the topic to the latest version. Save the
map to save the change. The same "new version indication" can appear on referenced content inside a
topic(e.g. images)as well.

Formatting options

The Structured Content Editor has a lot of formatting options and elements that can be inserted.
These formatting options can be found in the different menu tabs.

« Bold, Italics, Underline, Subscript, Superscript - normal text formatting settings

« Generic table, Simple table, Simple table in figure - tables with rows and columns

« Definition table - can describe a term and its definition

« Parameter table - can describe a parameter and its definition

« Property table - can specify property a term and its definition within a topic

« Reuse content - DITA conrefs

« Text Statements - WebCenter PCM text statements

« Symbols - like special symbols such as copyright, trademark etc.

« Intro - Short description and abstracts

. Sections and examples - a section within a topic

» Groupsinsection and body division

« Several types of hazard statements and notes - Statements which specify Hazard, Caution, Danger,
Notice etc. along with the steps to avoid can be specified

« Long quotes and footnotes - for repeating content on the footer of topics
- External reference links - which specifies hyperlinks to external websites
« Phrase and quotes within paragraphs - phrasing or quoting a specific section of a paragraph

Inserting and reusing topics and maps

Click Insert existing topic or Inset new topicfrom the Structure menu. A Saved Search popup is
opened where you can select the topic you want to insert. Do not forget to save the map after inserting
atopic. Note that an existing topic will just be referenced, while a new topic will be a new instance of an
existing topic, a copy. Use the same buttons to add maps.

Inserting and reusing images

Click Figure with image or Inline image from the Structure or Inline menu. A Saved Search popup is
opened from which you can select an image. An existing image can also be replaced by clicking on the
image, and selecting Replace.

Reusing parts of topics (DITA conrefs)

You can select phrases and paragraphs to be reused within the currently opened document from all
topics within the system. Click Reuse content from the Structure menu to open the Saved Search
popup. After selecting a document, a preview of the document is shown. You can select reusable
content from this preview. Supported types or reused content are:

- Paragraphs(<p> tags)
« Phrases(<ph> tags)
- Tables(<table> tags)
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« Sections(<section> tags)

» Section divisions (<sectiondiv> tags)
- Notes(<note>tags)

« Ordered list (<ol> tags)

« Unordered list (<ul> tags)

« Simple list (<sl> tags)

« Divisions(<div>tags)

The content you select will be included in the document.

When a conref is shown in the Structured Content editor (so based on import or by inserting here), you
can click it and a popover will open.

That popover has 3 buttons:
« Remove: to remove the conref. A conref can also be removed by selecting it and pressing delete/
backspace.

- Show the origin: this opens a preview of the document where the original text sits. The selected
element is highlighted.

« Edit: to edit the conref. This opens the same preview again as when selecting the document in the
Saved Search. You can pick another element and click replace to replace the original conref with
the new one.

Inserting PCM Statements

You can select PCM Statements from a Saved Search to insert them in a DITA topic. Click Statement
from the Structure menu to open the Saved Search popup. Select a document, click insert and the PCM
Statement is added to the topic you were editing.

Import external DITA

Structured Content documents can be uploaded to WebCenter and these documents will be
recognized as Structured Content documents. Dedicated functionality such as Search and Viewing
functionality is enabled on these documents.

When importing a structured content document, it is important that all related documents be
packaged together prior to upload, even if they already exist in the system.

If structured content documents already exist in the system, then the existing documents will be
referenced instead of the uploaded ones.

« Forimages, the file name determines whether it is the same.

« For DITA maps and topics, the ID(SC_ID)and language (SC_LANGUAGE) are used to determine this.
Note that any file name differences or similarities are ignored.

Also see: Import Structured Content on page 390

DITA keyrefs

The Structured Content Management module supports DITA keyrefs. DITA uses keys to insert content
that may have different values in particular circumstances. Keys provide a way to reference something
indirectly. This can make it easier to manage and to reuse content in various ways.
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Introduction

Keyrefs allow for an indirect link between a DITA Topic, and a piece of text or an image that is included
in the Topic. The same Topic can now have different content depending on the DITA Map itis used in.
The Map typically has a link to one or more Keymaps containing the key definitions to resolve Topic
keys within that context. There are two types of keys: text and images. Use the ctrl-k shortcut in the
Structured Content Editor to see what keys are available at your cursor’s location. New keys can be
added via importing DITA keymaps, or by configuring document references in WebCenter.

Setup

To work with keyrefs in WebCenter, the system needs to have a set of attributes and attribute
categories. These can be imported using the Structured Content Deployment Package.

Importing keyrefs

WebCenter supports the import and export of DITA keymaps. The file name of a keymap must end in
'_keys.ditamap'in order for WebCenter to recognize it as a keymap. The import of keymaps is handled
in the same way as the import of a DITA package. The Import Structured Content workflow node
allows you to specify a folder name where the created keys will be placed in the project.

« Image keys are imported as graphic files.
« Text keys are imported as Segments. Segments are a special type of PCM Statement with the
following properties:

« aSegmentonly has one language

« aSegment only has one line (no newlines)

« aSegmentin DITA is always shown inline

« aSegment has no permission model like other PCM Statements
+ aSegmentisaninvariant

« aSegment has a fixed element type

Keymaps are imported as Component documents with the extension .keymap'. The attributes of the
keymap documents define which keys are in the keymap. The order of the keys in the keymap in the
XML is retained in WebCenter. Each reference will have an SC_KEY reference property that holds the
name of the key.

During export WebCenter will recreate the keymaps based on the configuration of the keymap
Component documents to comply with the DITA standard.

Examples

Example of a keymap with only text:
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<map id="myproduct_text_keys" xml: lang="en">
<title></title>
<keydef key="medical-product-name" processing-role="norms:
<topicmeta>
<keywords>
<keyword>My Medical Product<tm tmtype="reg"/:
</keywords>
</topicmeta>
</keydef>
</map>

The text of the “medical-product-name” key when it is resolved will be “My Medical Product®”.

Example of a keymap with one image key:

<map id="myproduct_image_keys" xml: lang="en">

<title></title>
<keydef keys="IFU_diagram" format="jpg" href="myimage. jpc
</map>

Adding keys to a keymap

Keys can be added to a keymap document by changing the document references of the keymap. Make
sure to give each new key in the keymap a unique value for the SC_KEY reference property. The name
of the key needs to be unique within the same keymap.

Adding keymaps to DITA Maps

One or more keymaps can be linked into a DITA Map by using the SC_LREFERENCE_KEYMAP document
reference attribute.

Resolving keys in the Structured Content Editor

Keys will be resolved based on the context of the DITA Map that is opened. If the same key name is used
for a key in two different keymaps, then the resolved value will be the value of the key in the keymap
that is most specific in the hierarchy of maps(closest to the topic). If a key cannot be resolved, a
warning icon will be shown. Keys have a light green background in the Editor.

Adding a key in the Structured Content Editor

Use the ctrl-k shortcut to see what keys are available at your cursor’s location. Alternatively, you can go
inthe menu to add a key. The list of keys is sorted in the following way:

« image keys come at the bottom
« keys from more specific keymaps appear lower in the list
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» keys from the same keymap are ordered based on the order in the document references

17.3.4. Working with Segments

514

Structured Content Management has support for PCM Segments. Segments represent single invariant
words and phrases which are managed from PCM. Segments can be added, viewed and managed
within Structured Content much like how PCM Statements are currently managed.

Adding Segments

Users who have the permission to edit a topic in the Structured Content Editor can add Segments to
that topic. Click Inline > Existing Content to bring up the Reusable Content Panel which contains a
Segments from Library tab.

The Segments tab will display a Segment search which can be configured via Admin > Configuration
> Structured Content Configuration. The Saved Search for Segments should be configured to only
return Segments.

You can select a single Segment from the results and to insert it into the topic. The Segment will be
added at the position of the cursor in the topic and will display in line as plain text.

Any Segments associated with a topic can be referenced as attribute values of the Referenced
Segments attribute SC_REFERENCE_SEGMENT.

Viewing and managing Segments

While viewing a Topic within the Structured Content Editor any Segment values will appear with a slight
yellow highlight to indicate that the content being viewed is a Segment value.

If there is a newer version of a Segment value, the Structured Content Editor will display an icon
informing the user that there is a new version of Segment value available. A user can update the
Segment to the most current version by left clicking on the Segment and clicking Use Latest Version.

A Segment can be removed from a topic by right clicking the Segment in the Structured Content Editor
and choosing Remove. A user needs edit permission on the topic to be allowed to remove a Segment.

Users can update a Segment value on a document by right clicking on the Segment and choosing the
View option. This will bring the user to the Segment interface. Users can update the Segment value
from this interface by changing the Master Text value. When the value is updated in WebCenter the
user must refresh the document in the Structured Content Editor and then update the Segment to the
new value.

Importing Segments from DITA Keys and Structured Content Documents

When importing a ditamap WebCenter will attempt to create Segments for all Key values presentin
the document.Segments are unique by value within a system. If the Key Value already exists within
WebCenter as a Segment no new Segment will be created. The DITA will not be modified to have Key
References changed to Segments.

When importing a Structured Content document that contains Segments any Segments present on
the document which cannot be found within WebCenter will have Segments created for them using the
value present in the document for that Segment.
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Transforming Structured Content Documents containing Segments to Word

When a Structured Content document containing a Segment is transformed into a Word document
Word will output the value of the Segment in the document.

Reusable content search

Adding Reusable Content to a topic is possible via either the Structure or the Inline menu. A panel will
open where you can search for and select different types of Reusable Content.

« Click Inline > Existing Content to enter a Key, Fragment or Segment.
» Click Structure > Insert Content > Existing Content to enter a Key, Fragment, Topic or Statement.

Each of these options has its own tab. When a tab is loaded the user is presented with a search for that
Content Type. The Search that is displayed for each Content Type (except for Keys)is configurable from
the Structured Content Configuration page. When a single search result is selected from any of the tabs
the user can choose to insert the selected content into the topic at the current position of the cursor.

The Reusable Content interface also contains a single search field. When a string is entered all the tabs
will filter their results by doing a content search on that string. This is in addition to any other filters
currently configured on those Saved Searches.

Configurable Ul for the Structured Content Editor

System Architects can now override the default Ul of the Structured Content Editor, allowing them to
configure which Tabs, Buttons and Sub Menus should be visible.

- Configuring an Override File

Solution Architects can find the Override File Template in the following directory of the Application
Server:\WebCenter\WebServer\tomcat\webapps\WebCenter Inst\custom example
\Jjavascript\default

The Override file is a JSON which lists a hierarchy of Ul objects. Each object has an “isVisible”
property which can be set to either true or false. If an object’s visibility is set to false all of that
object’s children will also be hidden.

« Deploying the Override File

Once configured the Override file can be placed in the following location on the Application
server:\WebCenter\WebServer\tomcat\webapps\WebCenter Inst\custom
\javascript

Once placed the server does not need to be restarted for the changes to be recognized but any
currently opened Structured Content Editors will not get the changes.

« Setup or Configuration
The following is a complete list of Ul items which can be hidden:
+ Structure Tab
+ Insert Content Button
« Existing Content Option
« New Topic Option
« Table Button

« Generic Table Option
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« Simple Table Option

« Simple Table in Figure Option
« Definition Table Option

« Parameter Table Option

» Property Table Option

Figure With Image Button

« Figure With Image Option
+ Inline Image Option

Section Button

« Section Option
+ Example Option
« Reference Syntax option

Group Button

« Division Option
« Body Division Option
« Section Division Option

Note Button

« Generic Option

« Attention Option

« Caution Option

« Danger Option

« Fastpath Option

« Important Option
+ Notice Option

+ Remember Option
+ Restriction Option
« Tip Option

« Warning Option

« Other Option

Long Note Button

Footnote Button
Related Links Button
Quote Button

Long Quote Button

Inline Tab

Existing Content Button
Trademark Button

« Trademark Option
+ Registered Option
« Service Option

Link Button

WebCenter
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+ Hyperlink Option
+ Crosslink Option
Inline Image

+ Inline Image Option
« Figure With Image Option

« Advanced Tab

Alternate Title Button

« Navigation Title Option
« Search Title Option

Term Button

Keyword Button
Hazard Statement Button

+ Hazard Statement Option
« Attention Hazard Option

« Caution Hazard Option

« Danger Hazard Option

+ Fastpath Hazard Option

+ Important Hazard Option
« Notice Hazard Option

« Remember Hazard Option
+ Restriction Hazard Option
« Tip Hazard Option

« Warn Hazard Option

+ Other Hazard Option

Reference Button

» Reference Syntax Option
+ Property Table Option

User Interface Button

« Screen Option

+ Window Title Option
« Shortcut Option

« Menu Cascade Option
+ Ul Control Option

Programming Button

+ Code Block Option

« Parameter Table Option
« APIName Option

« Code Phrase Option

+ Option Option

« Parameter Name Option
« Syntax Phrase Option

WebCenter
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+ ToolsTab

« Source Button

Impact analysis of changes

17.5.

There are two side panels available when viewing a content map or topic within the Fonto Editor. Both
are configured from Admin > Configuration > Structured Content Configuration

+ The Root Document Dashboard represents the (root) content map. Most customer attributes
(brand, country, etc) will be located with the map, and so will be useful to view within the editor.
Regardless of the topic or section from which the user accesses, the root document dashboard will
remain unchanged.

« The Focused Document Dashboard represents the content on which the user is focusing and will
change as the user navigates the document. This helps provide additional insight on what the
impact would be by changing/updating a specific topic, as you can see to how many maps it is
linked.

= ] Note: These dashboards will appear regardless of context, though they do respect

permissions. This means that regardless of whether the user is viewing the map from a change
request or in the library, the user will have the exact same options unless conditional rules are
applied.

Structured Content Management in WebCenter will keep track of the structure of the document

using document reference attributes. References to DITA documents are stored in the document
reference attribute "SC_REFERENCE". References to images are stored in "SC_REFERENCE_IMAGE".
And references to PCM statements are stored in "SC_REFERENCE_STATEMENT". This allows setting up
saved searches that can do impact analysis. This way it is possible to see all the places where a certain
reusable part of the structure is currently being used.

Showing Document History

518

History of modifications done to a structured content document can be viewed in the Document
History user interface.

When a DITA or DITAMAP document is opened in the Structured Content editor, a Show changes
button (also referred to as "history button”) is available in the header bar on the right side of the
Structured Content editor window.

When you click Show Changes, the Document History mode of the editor is opened.

« User can see the outline of the opened document on the left. For any documents in the Map that
have changes, this is indicated with a blue dot. If a document would be added or removed, this is
also indicated in the outline.

« Usercan see the selected document in the center. Selecting a different document in the outline
shows this document in the Changes in the document are shown in balloons next to the content.

« Foreach change the username and time is visible.
« Theuser can mark a change as seen or unmark as seen. It is possible to hide/show the changes
marked as seen from the document history navigator on the top right of the document.



ESKO

17.6.

WebCenter

« User can use the View in Editor functionality in the change balloon to switch back to the editor
mode, with the changed text.

« Thereisadocument history navigator on the top right of the document. Using this navigator, User
can step through all the changes in the selected document. It is possible to hide/show the changes
marked as seen from the document history navigator.

« Thereisatimeline on the right.

« Usercan select a date to compare the current state of the Map. User can also select a few other
time periods like "last 24h” and “last 7 days”.

« Usercanalso select “Last visit”. This will show the changes in the whole Map that happened
between now and the last time User visited the document history mode for the opened (root)
document, with this browser.

« Thereisatab ontheright containing versions. For the currently selected document this shows all
the versions. Selecting a version will set the date in the timeline to this date and time (timestamp),
and the whole map will show a comparison between the current state and the timestamp that was
selected.

« Onthe top left of the Document History header there is a button to return to the editor. This will
take the user back, and the currently selected topic in the history mode will be in focus in the editor
mode.

Comments on Structured Content

Comments can be made on the content inside the Structured Content editor as well as in the Review
Mode of the Structured Content Editor. This Review mode has an optimized Ul for making annotations.

Comment Balloons

In the Structured Content editor there is a Comments button which expands upon clicking. It shows the
comments in ‘balloons’ next to the content of the open documents.

Review Mode
Review Mode can be accessed in a few ways:

« Viathe Structured Content editor by clicking on the Open Review button in the header. This will
open the review mode for the document (map or topic) where the cursor is located at the time the
button is clicked.

« Viathe Open Review document action configured on the document details page of structured
content documents.

« Viathe Open Review button configured in a Saved Search or Dashboard.

In the Review Mode, all the documents are read-only. When selecting some content in a document, a
popover allows for easy creation of a comment or a proposal.

Making a Comment

You can make a comment by selecting text, image or other content and clicking on the comment
button. There are three types:

«  Comment: simple comment on some content. Can be general, editorial or technical.
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Note: The classification of comment is useful for filtering purposes, but is not connected
with any other feature.

« Proposal: a proposed change to the content in the documents. Also, a motivation can be provided.
« Global comment: a comment that is not linked to some content in the documents, but to the whole
publication. Can be general, editorial or technical.

Saving the comment will allow this comment to be visible by other any other user that is looking at the
document the comment was made on. The comment will receive an index shown in square brackets:
e.g.[1]. The reason for this is to simplify referencing of the comments in the audit trail (Project history).

Replying to a comment

Users can reply to comments. Saving a reply publishes it for everyone to see. Replies also get an index.
The format is[<comment index>.<reply index>](e.g.[1.1]). Comments and replies can be changed and
removed by the person that made the comment or reply.

Applying a change

When a proposal is submitted, a user can apply the change from the Fonto Editor. Like a comment,
they can accept or reject a change and provide justification.

Note: This option is not available from within the Fonto Review, only from within the editor.

Note: Applying a change does not resolve the proposal. That must be done separately.

Resolving Comments

Every comment can be resolved by either Accepting or Rejecting it. Anybody with view rights on

the document can resolve a comment added to the document. A resolution comment (reason for
accepting/rejecting) can be added. Once a comment is resolved it becomes read-only and cannot be
deleted or changed anymore.

Audit trail

All creation events, changes, resolution and deletion events to comments and replies are tracked in the
audit trail provided by WebCenter's Project history.

Filtering of Comments

The Structured content editor (both Edit and Review modes) provides a set of predefined filters that
can be used to narrow the comments displayed in the Comment balloons. You can configure the filters
by clicking Filter button in the header of the Comments Navigator in the top right of the document.
Only comments complying to currently selected filters are shown. If no filter in given category (type,
resolution)is selected it's the same as if all would be selected.

Enabling Show Changes in Review Mode

Show Changes button in the header of Fonto in Review mode allows user to switch to Fonto document
history directly to check history of particular document(s).

17.7. Annotations on Structured Content

520

Users can make Annotation to a Structured Content document which will persist as part of that
document. This is useful if a user wants to make an Annotation which is relevant to the content of the
document and any future copy of that content, but which is not part of the content itself. An example
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of such an item would be justification of a Product Claim, the business would want this information to
be easily available to users reading the document but would not want it printed as part of the content.

Adding an Annotation

Users with rights to edit a topic can add Annotations to topics. Add an Annotation to a specific cursor
positionin a topic by opening the Annotations navigator in the top right of the document and selecting
the option to Add an Annotation

When an Annotation is added the user can add the text which makes up the Annotation. The name
of the user and the time at which the Annotation was made is logged. When an Annotation is made
at a cursor point the system will display an icon. If an Annotation was made to a section of text that
section of Text will be highlighted to show the user that there is an Annotation.

When an Annotation is added, it is also added to the resulting DITA XML. This allows the Annotation to
persist with the content when the topic is referenced or copied.

Viewing Annotations

Users can click the icon or the highlighted text to bring up information about that Annotation in the
Annotation Balloon. The Annotations balloon will display information about the Annotation such as, the
text, the author and the date.

Editing and Reviewing Annotations

Any user who can edit the topic can delete Annotations on that topic. To do so, click the Annotation
icon and make the required changes in the Annotations balloon. Deleting an Annotation removes the
annotation from the DITA XML.

In Review Mode Annotations can only be viewed. A reviewer can see any annotations made on a topic
within the Structured Content Review tool. If the Annotation is for a single point in the document the
Review Tool will highlight that point in the view pane. If the Annotation is for a section of text the text
will be highlighted. Annotations differ from Comments in that Annotations are actually stored within
the XML of the Document. This means that Annotations have persistence and will be copied along with
the document. If a topic containing an Annotation is transformed into a Word Document the Annotation
will not be printed in the Word Document.

Variants and Translations

What is a Variant?

A Variant of a Structured Content document is created when the users decide the master content (or
translation of the master content) cannot be used as-is for a local market (or for a specific purpose),
and certain elements (sub-maps, topics, images, etc) must be altered. The master (and master
translation) should still be used in most places, just not in the specific region that pertains to the
variant.

How to create a Variant?

You already have a structured content document structure in a project. Let's say this is your library
project. To start creating a variant you first copy the root map of your structured content structure

to alocal project. At this point the copied root map will still use all the topics that are in the library.
When opening the copied root map in the Structured Content editor you will probably see that you are
not allowed to change the topics, because they are still in the library and approved (depending on the
setup).
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You can now select one of the topics in the Structured Content editor by putting the cursorin it and
copy it to the local project by clicking Create Variant in the menu. The document is now copied into the
project with the intention of making a slight difference in the content.

The system will keep track of what documents are variants of which other documents with document
references (SC_MASTER_VARIANT document reference attribute).

Note: Using the Create Copy option will not cause this document reference to be used.

Note: User must have the following permissions for create variant to succeed:

« View and Download on the source folder
. Add

« Lock Document

« Change Properties

Variant Permissions

When creating a Variant or a Translation as Variant, the system will look for a folder with the name
"Variant"(not case sensitive) in the target project. In case the folder is there the variant will be created
in the Variant folder. In case the variant folder is not there, then the behavior is the same as with the
Copy Topic or Translate buttons: the document will be copied into a folder with the same name as the
folder in the source project.

Translations in the Structured Content Editor

A user opening the Structured Content Editor in Edit or in Review mode can open the Translation

View in case the opened document has a translation master (meaning that the opened document is a
translation of this master). The Translation View can be opened by clicking the Compare Translation
button in the Tools tab of the menu in the Editor. The Translation Mode will show the Translation Master
on the left of the screen. This master is not editable. It is possible to navigate in the master document
and open the history for the master. On the right side of the screen the translation is still visible. In
case the Editor was opened in Edit mode, the user can make edits on the right while looking at the
master on the left. Scrolling is synced between the two panels. When the scrolling of the panels is out
of sync, the user can click on a document in the outline of the right panel to sync the scrolling again.

There are two ways in which translations are handled in WebCenter. The first and most common is
through an external agency.

1. Usingthe Export Structured Content on page 379 workflow node, all associated content can be
exported as a package (a compressed ZIP file)

2. This package can then be sent to an external translation agency, who is able to unpack and
translate each DITA file contained within.

3. Once the translation is complete, the agency will change the language within the DITA(i.e. the
“xml:lang” tag), and it can then be re-imported.

4. Usingtheid and language, the translated content will be linked with the master language content.

Note: User must have the following permissions on the target folder for the translate as
variant to succeed :

- View and Download on the source folder
« Add

« Lock Document

« Change Properties
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The second method is internally. This method is simpler, though more manual.

1. A workflow would create a copy of master content and change the language (the “SC_language”
attribute) associated with the DITA file.

2. Theuser would then change/update the text with the new translation.

Translation Source change Indication

If a user is viewing a DITA Map which is a Translation of another DITA Map stored in the system they will
now see an indicator if the Source Content the Translation was based on has changed. This indicator
will appear in both the Document View the and the Outline. There will be an indicator for each Topic
within the Map which has updated content. Clicking on the indicator will launch the Translation View so
the user can compare the current content with the updated Source Content.

Updating Content

If a user wants to update the content but not necessarily update it to match the latest translation,
they can make their changes and save the Topic. On Save if the Topic edited has the Source Content
Changed indictor the user will be prompted whether they are updating the content to match the latest
translation. The user should select to not update to match the translation. Doing so will save the new
content and the Source Content Changed indicator will remain.

Updating a Translation

If a user wants to update the content to match the latest translation, they can make their changes
and save the Topic. On Save if the Topic edited has the Source Content Changed indictor the user will
be prompted whether they are updating the content to match the latest translation. The user should
select to update to match the translation. Doing so will save the new content and the Source Content
Changed indicator will be removed. Internally this document will now reference the latest translation.

Saving multiple documents at once

Within the Structured Content Editor a user can save all Topics within the map at the same time by
using the save button in the main Ribbon. When doing this if there are any changes to Topics which are
showing the Source Content Changed indictor the user will be prompted to select which Topics are
being updated to match the latest translation. The user can select one or many of those topics. Topics
selected will be updated and reference the latest translation. Unselected Topics will be updated and
still show the Source Content Changed indictor.

17.9. Managing Output Styles in the Structured Content
Editor (DITA outputclass)

The DITA outputclass XML attribute on an element (e.qg. a paragraph) can be used for styling during
output processing. For example, a <p outputclass="highlight..."/> can be used to give a paragraphin
the Word output a grey background. Note that this is only the case if the plugin used for outputting the
document is configured to print elements with this outputclass with a grey background.

There are buttons in the Start, Inline and Structure menu of the Structured Content Editor to add
output classes to elements. Put your cursor to the element or select a piece of text and click on the
output class to apply.

Supported types

Following types of output classes are supported:
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« block level output classes: those can be assigned to block level elements(e.g. p, h1, div, title...)and
always span the whole block level element they are assigned to

« inline output classes: useful when an output class needs to be applied to just a part of the text. The
marked text will be wrapped in a <ph> element.

Available Output Classes

The list of available output classes is defined in a WebCenter list 'SC_Outputclasses_Definition'. It can
have following columns:

« label: The label of the Output Style to display in the menu of the Structured Content Editor.

« operationname: The type of Output class which can be 'block’ or 'inline'. This defines the behavior of
the Output class within the Esko dita editor and determines where it is placed in the menu.

« outputclassname: Name of the class to be inserted for the XML element.

« fontostyle: Indicates the visualization in the Structured Content Editor. For example: background-

color=grey will show any ph with this outputclass with a grey background. Only background color is
supported. For block level elements, this is only visible in a popover when clicking the element.

» groupname: Name of the group that can add this output class. This way, one can make a different
lists available for template builders or content authors.

« description: Explanation of what the style sheet will do.

« elements: Which DITA elements the output class can be applied to. This is a comma delimited list.
Not setting a value will allow the style sheet to be used on all elements.

« formats:Which output templates the output class is restricted to. This is a comma delimited list.
Not setting a value will allow the style sheet to be used on all output templates.

« indd:Whether or not the output class is relevant to InDesign. Acceptable values are Yes and No.

How do you know if an Output Style is applied to an element in the Structured Content Editor?

« the menuitemis active
- for block level elements, a title is shown
« apopover is available with details on the Output Style

Selecting Output Styles

When clicking on the Output Styles button the user’s cursor position in the document is used to filter
the options down to only Output Styles which can be applied to that DITA Element. Users can also
select to show all available elements to filter the list down to the element the user’s cursor is on and all
of its parent elements. When filtering the available output styles are grouped under the element which
they apply to. Users can also search the currently displayed output styles by name to further filter their
options. When selecting an output style it will be applied to the element it was selected for.

Output Styles which are applied will show in the Editor on the Element which they are applied to. If
more than one output style is applied to an element the Ul will group output styles to conserve space
and inform the user there is more than one output style. Clicking on the output style name in the Editor
will show the user alist of applied Output Styles and allow the user to remove individual output styles.

Output Styles can also be removed by highlighting the element they are attached to, clicking the output
style selector and clicking the selected output style again.

Some elements do not have a lot of space to show output classes and the user may need to use the
element breadcrumb trail in the Editor to select the specific element they wish to set or unset output
styles.

Setup or Configuration

The most up to date Output Class List must be uploaded into the system as the List
SC_Outputclasses_Definition
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17.10. Managing Structured Content

To best manage structured content, it should be split between two types of projects - library projects
and work-in-progress projects. This ensures permissions can be managed accordingly.

Permissions

Similar to PCM, all structured content (even topics) should have an owner - a role in the system
responsible for authoring each section. There may be sections specific to requlatory sections, safety
sections, etc.

To maintain these permissions, project folders can be used to store content for each role. However,
these folders must be named the same from project to project (even from WIP to library).

{ =1 Note: When copying a document with references, the referenced content will attempt to

== Dbe copied to the folder in which it was originated (e.qg. if you have a content map with a topic
located ina REGULATORY folder, then when copying the map, the topic will try to gointo a
REGULATORY folder.) If this folder does not exist, it will be copied to the root folder.

Transferring Imported Content

When content is initially migrated into the system, it is recommended to be done as part of an import
project, separate from the library. Once content is imported into this project and you are ready to
transfer it to the library it is critical that imported content be MOVED into the library, as the ID(SC_ID)
will be updated when content is copied, and newly imported content will not be able to find it.

Transferring Updated Content

Due to the inherent nature of structured content (i.e. as a collection of maps, topics, images, etc),
transferring approved content from a WIP project to the library project is a delicate process.

This can be done via the Copy/Move Document on page 362 workflow Node. When the Copy Local
Referenced Structured Content Documents option is checked, the node will copy the document
and its structure. This means that documents that are referenced via the SC_LREFERENCE document
reference attribute are copied along to the target project.

{ =] Note: Only documents that sit in the source project of the file that is originally copied (i.e. are
== ’localto the source project)are copied.

{ = Note: user needs both the Add and Lock Document permissions to copy a Topic or create a
t=% variant.The request is to add the Change Property Permission.

Removing Untitled Map Text from Fonto Outline

In the Outline view of the Structured Content Editor any Map or Topic which does not have a Title set
will show as an empty string in the Structured Content Viewer's outline view.

Searching Reusable Content

There have been improvements to how users can search for reuseable Content in the Structured
Content Editor.

Item Count
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In the Structured Content Editor when a user clicks the Existing Content button the search interface
will now display how many items were found for each Content type. This number will update on every
search.

Hiding Content

WebCenter Admins can hide any Tabs they do not wish to see in the Reusable Content search by not
configuring or removing the configuration for the corresponding Saved Search in the WebCenter
Admin Structured Content Configuration page.

Setup or Configuration

If Saved Searches are not mapped to the following field in the Structured Content Configuration page
the listed Tab will be hidden when searching for reusable content in the Structured Content Editor.

Saved Search for Reusing Documents >Topic Tab
Saved Search for Text Statements >Statement Tab

Saved Search for Segments >Segment Tab

Showing changes between two Versions of a Word Document

For system which have Structured Content License there is a new Task called Compare Word
Documents. When configured, this task will accept two MS Word Document Versions, compare them,
and return a single MS Word Comparison file (Legal Blackline). This operation should be comparable to
performing the MS Word Compare operation on these files with all options selected but Fields.

This task has the following parameters:

« Current Doc Version: A Document Version Reference to the changed file.
« Reference Doc Version: A Document Version Reference to the original file.

» Target Document Name: The name of the resultant output file. If left blank the output file will be
named using the document name and version of the input file.

« QOutput Folder: The name of the folder the output file will be placed in.

When creating the output file if a file with the same name already exists in the Output Folder the file
will be versioned.

Setup or Configuration
The site must have the Structured Content License enabled for this task to appear.

The task accepts two File Version References not two documents. It is recommended to define these
inputs as SmartNames which point to Task Specifications on the task which represent the two file
versions.

Keeping the Referenced Content Version

Users can now choose to resolve the Newer Version Available warnings within the Structured Content
Editor by keeping the version of the content on the document.

Keeping the current Content Version

In the Structured Content Editor users may see the New Version Available warning when there are
newer versions of the Content being referenced. Users can now choose to keep the current version of
the Content by clicking on the warning and selecting the “Keep Current Version” option. When this is
done the warning will be replaced by a new checkmark icon. The user who made this decision and the
time at which they made the decision will also be logged for audit purposes.

Updating the Content



ESKO

17.11.

WebCenter

If a user would like to update the content after a decision to keep the current Content version was
made the user can click the checkmark icon. This will bring the user back to the update version
interface and the user can click the Apply Version button.

If the Content is versioned again after the decision was made to accept the current Content, the
original warning will be restored and the user must choose to keep the current version of the content
again.

Auditing the Decision

If a user would like to see who made the decision to keep the current Content version they can click on
the checkmark icon. The user will now see who made the decision and when the decision was made, in
the update version interface

The decision can also be checked from within WebCenter by using the Project Action History.
Setup/Configuration

Three new WebCenter Attributes need to be created to use this functionality:

« SC_KEEP_VERSION_NAME

» SC_KEEP_VERSION_TIMESTAMP

» SC_KEEP_VERSION_VERSION

Granular Mapping in Structured Content

WebCenter now has support to map smaller parts of a ditamap to an InDesign Artwork Template as
opposed to mapping the entire ditamap.

Extracting InDesign Tags

Before a user can map Structured Content to an InDesign Artwork Template the InDesign Tag
information needs to be extracted into WebCenter. To do this a new Task Type has been created called
Extract InDesign Elements. This task will take one or many documents as an input and extract their Tag
information.

If any file fails to process an error pin will be created for the file which failed.

Selecting an InDesign Artwork Template in the Structured Content Editor

A user can link a ditamap to an InDesign Artwork Template using an attribute template which is
configured as described in the configuration section. If this configuration is based off of the existing
PCM Artwork Template Configuration please ensure not to fill in a value for Element Type when the
ditamap is linked as doing this will map the entire ditamap ignoring any granular mapping which may
have been set.

Once a ditamap has been linked to an InDesign Artwork Template a user can launch the ditamap in the
Structured content editor. When the ditamap loads the user will see a new Tab called Artwork Mapping.
From within this tab a user can load an InDesign Artwork template to map by clicking Select Artwork
Template. The InDesign Artwork Templates which can be selected are controlled by the Saved Search
configured in the Saved Search for Artwork Templates value of the Structured Content Configuration
page.

If the selected Artwork Template has not has its Tags Extracted or has not linked to the ditamap or an
error will be thrown.
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If a ditamap is linked to multiple InDesign Artwork Templates, then the user can switch which Artwork
Template they are mapping by clicking Select Artwork Template again.

When an InDesign Artwork Template is loaded any mappings saved between the Template and the
loaded ditamap will be restored.

Mapping Structured Content to an InDesign Artwork Template

To map content from the Artwork Mapping Tab a user can click the Select Content for the Tag they
want to map. This will open up a new hierarchical view of the loaded ditamap which the user can
navigate and select an element to map.

To map content from the View Pane a user can right click on the element they want to map and choose
the Map to Artwork option. If an element is a child of other mappable elements the parent elements
will also be selectable with their own Map to Artwork options. Clicking any Map to Artwork option will
open a popup displaying the Topic the selected element resides in. To change the selected Contentin
the view the user just needs to click on another mappable element. To map this content to a specific
Tag the user will select the Tag from the Select Tag dropdown. In this dropdown any Tags which are
already mapped will show a Dark Tag icon. When attempting to map Content to a Tag which already has
amapping a warning will be displayed.

When Content is mapped to a Tag the view of that Tag will change in the Artwork Mapping Tab to show
the element which is mapped, a preview of the content. Clicking either of these items will focus the
view pane on the mapped content and briefly show an outline of the mapped Content.

To see what a Tag is mapped to a user can click on the Go to Mapped Content button for that Tag in the
Artwork Mapping Tab. This button will also show the user what element type has been mapped.

To remove a mapping a user can click on the Remove Mapped Content button for that Tag in the
Artwork Mapping Tab.

To edit a mapping, a user can click the Edit Mapped Content for that Tag in the Artwork Mapping Tab.

A user can filter the Tags in the Artwork Mapping Tab to show All Tags, Mapped Tags or unmapped Tags
by using the filter.

To save their mapping a user can click save in the Artwork Mapping Tab.

Mapping Content from Multiple ditamaps

A user can map content from multiple ditmaps to one InDesign Artwork Template. To do this the user
must link all of the ditamaps which will provide content to the InDesign Artwork Template. The user
will then open each ditamap within the Structured Content Editor, select the linked InDesign Artwork
Template and perform the mapping. In this scenario users need to be careful not to map the same Tag
to Content from multiple ditamaps as a Tag can only render content from one source.

Mapping Content from Multiple Locales

A user can map an InDesign Template which supports content from multiple locales. To do this make
sure that your InDesign Artwork Template is using the WebCenter naming convention for locales so
that each Tag which needs to support multiple locales has its own Tag ending with the locale index.

In this simple setup lets assume that the Template contains a PRODUCT_INFORMATION Tag for two
locales. The WebCenter format for these Tag names would be PROBDUCT_INFORMATION_I1_L1and
PRODUCT_INFORMATION_IN_L2. The user will then link a ditamap with the content for Locale Tand a
ditamap with the Content for Locale 2 to the Artwork Template. The user will then open the ditamap for
Locale lin the Structured Content Editor and map the PRODUCT_INFROMATION_I1tag to the desired
content for this Locale. The user will then repeat the process for the Locale 2 ditamap. The user will
then specify which locale maps to which language using the Artwork Template attribute category.
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This allows a user to swap languages between locales without having to remap all of their content to a
specific locale Tag.

Generating Artwork

For a user to generate the InDesign Artwork they will need to run the Apply Content in InDesign Task.
This task will replace the content of any Tags pointing to Granular Structured Content with the Content
that tag was mapped to when it is run.

If there are any errors in this process an Error pin will be created.

Setup or Configuration

Configure a new Task to Extract InDesign Tags. As there are multiple ways to initiate this Task make
sure that the input to the task is limited to a list of InDesign files.

The SC_TAG_ELEMENTS attribute needs to be created in the system.

A new Document Reference attribute must be created (or an existing one edited) to contain the
SC_TAG_ELEMENTS attribute as a Reference Property. This new Document Reference need to be
added to alink between in InDesign Artwork Template and ditamap. It is strongly suggested to add
this reference link to the existing PCM Artwork Template setup for mapping a ditamap to an InDesign
Artwork Template.

The users performing the mapping need to have edit rights to the SC_TAG_ELEMENTS attribute.

As new saved search needs to be configured which will search for all InDesign files who have a
reference to the passed document. Document Name =“*.indd” and Reference = [ Document Version ID]’
On the Structured Content Configuration page this new Saved Search will be set as the value for “Saved
Search for Artwork Templates”. This configuration will ensure that only InDesgin files which are linked
to the loaded ditamap will be shown as available Artwork Templates in the Structured Content Editor.

Apply Existing Mapping
If a user has performed a content mapping between a DITA Map and an InDesign template they can now
use that mapping when creating a new mapping.

The Artwork Mapping Tab in the Structured Content Editor will now have a new button for Reuse
Mapping. When clicked the user will be shown a list of DITA Maps which are already linked to the loaded
InDesign Template.

Users can also search for a specific mapping to reuse by using a configured saved search for an
InDesign file which has mappings. On selecting an InDesign file its mappings will be displayed and one
can be chosen.

When a mapping is selected, the system will attempt to import any mapped elements where the
InDesign Tag ID and BDITA ID are the same between the selected mapping and mapping | am working on.

If an imported mapping has one or many conflicts with current values on the mapping the system will
prompt me to overwrite all values or stop the import.

Setup or Configuration

On the Structured Content Configuration page the value for Saved Search for Artwork Templates
That Have Been Mapped needs to be configured to point to a Saved Search which returns a list of
InDesign Files which have mappings.

The SC_SOURCE_ID attribute must be configured. It is a text value. It should be part of the
SC_DITAMAP and SC_TOPIC attribute categories.

The SC_LHAS_MAPPINGS attribute must be configured. It is an integer value. It will hold how many DITA
Map references are mapped to an InDesign File.
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17.12. XREF Support in Structured Content
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The Structured Content Editor now has support for creating and managing references to locations
within the same ditamap and external URLs.

Adding and Managing Internal References:

From within the Structured Content Management Tool a user can add an Internal Reference to a point
within the loaded ditamap by placing their cursor in the View Pane, clicking on the Link button from
the Inline ribbon and choosing the Cross-link option. This will bring the user to a hierarchical view of
the loaded ditamap. From this view the user can navigate to the element they wish to link to within this
ditamap. When the user had made their selection they can click Insert to add the reference or cancel.
If a reference was added the user can choose to enter text for the link in the View panel. The reference
will show in the View panel as a hyperlink.

To edit an internal reference a user can click on the reference in the View Pane and choose the edit
option. This will bring the user back to the Hierarchical view of the loaded ditamap.

To delete an internal refence a user can click on the reference in the View Panel and choose the
Remove option.

Aninternal reference can also be created by highlighting existing text in the View Panel and then
clicking on the Cross-link button. If a reference is made this way the text of the reference will be the
highlighted text.

A user can see the full contents of the internal reference by clicking on the reference and choosing the
show more option. The referenced content will be displayed in a new popup.

Adding and Managing External References:

From within the Structured Content Management Tool a user can add an External Reference to a

URL by placing their cursor in the View Pane, clicking on the Link button from the Inline ribbon and
choosing the hyperlink option. This will pop up a window in which the user can enter the URL they want
to reference. When the user has entered a URL they can click Insert to add the reference or cancel. If a
reference was added the user can choose to enter text for the link in the View panel. The reference will
show in the View panel as a hyperlink.

To edit an external reference a user can click on the reference in the View Pane and choose the edit
option. This will bring the user back to the URL pop up.

To delete an external refence a user can click on the reference in the View Panel and choose the
Remove option.

An external reference can also be created by highlighting existing text in the View Panel and then
clicking on the Hyperlink button. If a reference is made this way the text of the reference will be the
highlighted text.

A user can navigate to the external URL from within the Structured Content Editor by clicking on the
reference and then clicking on the URL displayed in the popup.

Versioning References

If a user updates Content within the ditamap and that content is the target of an external reference the
external reference will be updated to point to the updated Content.
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Importing References

If a ditamap is imported which contains an XREF element the XREF elements on that Topic will

be shown as references in the Structured Content Editor. If the imported XREF is areference to a
document outside of the ditamap or is an invalid reference, then the XREF will be shown as text as
WebCenter would be unable to resolve the reference.

Exporting References

If a user added Internal or External references to a Topic they will be saved as XREF elements in the
exported DITA.

17.13. Structured Content Improvements

Advanced Logging for Indesign Tasks
The following Tasks in WebCenter now have a new configuration option called Debug Folder:

« Apply Contentin InDesign
« Extract InDesign Elements
» Export InDesign to PDF

If a value for Debug Folder is set for a task and an error occurs while InDesign is executing that task
the system will create a compressed bundle of files which can be used by Esko to troubleshoot why

the task failed. This file will be uploaded to the project folder with the name specified by the value of
Debug Folder. If that folder does not exist on the project it will be automatically created. The file will be
named based on the filename which is the input to the task. If there is already a debug file for that file
the debug file will be versioned.

Setup or Configuration

The Debug Folder value must be set on the Task. It isrecommended to use a SmartName as a value
so that a user can enable the debug functionality on a project by project basis or even in between
executions of the same task.

The Apply Content in InDesign, Extract InDesign Elements and Export InDesign to PDF tasks now all
have an additional Error Pin to capture failures that occur as a result of processing in InDesign.

Choose a Newer Content Version

Content Editors can now choose which version of referenced content to update to when clicking on the
New Version Available warnings within the Structured Content Editor.

Selecting a Version

In the Structured Content Editor users will see the New Version Available warning when there are
newer versions of the Content being referenced. Upon clicking the indicator, the user will be able to
see the Current and Latest version of the content side by side and the version of the content being
displayed. If the content being referenced has multiple new versions the version indicator for the New
version will be a dropdown containing all of the newer versions. By default, this dropdown will be set to
the latest version of the content being referenced. When a version is selected from this dropdown the
content will update so that the user can compare the selected version with the current version of the
referenced content.

Updating the Content
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To update the referenced content to the selected version the user can click the “Apply Version” button.
The New Version Available icon will now show as a clear icon until the user saves the document.

Upon saving the document the icon will disappear if the latest version of the referenced content was
selected or will reappear as a solid icon if an intermediate version of the referenced content was
selected. The icon remains if a user selected an intermediate version so that they can make a decision
to update or keep the current version.

Reverting the Content

While the New Version Available icon is in the clear state the user can undo or change their selection
by clicking it and choosing either the current or another version of the referenced content.
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